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1 Preface
1.1 About this Manual
This manual is the user documentation of the open source part of the OpendTect
seismic interpretation system. In this document detailed information on windows
and parameter settings are described. The lay-out follows the organization of the
software menus. Information about attributes and filters is given in Appendix A.

This document was written using MadCap Flare. Two versions are published: an
html manual for online use and a pdf version for printing. The option to download the
html version along with the OpendTect software is presented during the download
process within the OpendTect Installer. Both the html and pdf manual can be sep-
arately downloaded from the documentation of the dGB website.

While every precaution has been taken in the preparation of this manual, it is pos-
sible that last minute changes to the user interface are not reflected in the manual,
or are not described accurately. Please help us improve future editions by reporting
any errors, inaccuracies, bugs, misleading or confusing statements you encounter.

Please note that apart from this user manual, the following additional doc-
umentation manuals exist that can be accessed from the Help menu or downloaded
from the same documentation on the dGB website:

User documentation commercial parts:

l OpendTect Pro and dGB Plugins
l ARK CLS Plugins
l EarthWorks & ARK CLS Plugins

Other Manuals:

l How-To Instructions - a document describing a multitude of workflows listed under
topic headings.

l Training Manual - a more step-by-step layout for many of the same workflows
described in the How-To Instructions.

l Administrator's Documentation - an extremely useful Doc for reference to System
Requirements, Setup Licensing, Settings and Troubleshooting.

l Programmer's Manual with Class Documentation

https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm
https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm
https://doc.opendtect.org/7.0.0/doc/HTML_TM/Default.htm
https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm
https://doc.opendtect.org/7.0.0/doc/Programmer/Default.htm
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1.2 Release Notes
This is the user documentation for release OpendTect v7.0 - an open source post-
processing, and seismic interpretation system created by dGB.

OpendTect is released via the internet. Users can download the software from the
download page of the OpendTect website. It will run without license protection.

OpendTect v7.0 is released under a GNU GPL license.

Under the GNU GPL license OpendTect is completely free-of-charge, including for
commercial use.

OpendTect Pro, the commercially extended version of OpendTect is protected by
FlexNet license management software. OpendTect Pro offers extra functionality
and allows commercial users to extend the system with additional (closed source)
commercial plugins that can either be purchased or leased. These commercial plu-
gins for OpendTect Pro are also protected by the same FlexNet license managing
software. To obtain a license key for OpendTect Pro and the plugins please contact
dGB at info@dgbes.com.

Under the Academic license agreement universities can get free licenses for
OpendTect Pro and commercial plugins for R&D and educational purposes.

OpendTect is currently supported on the following platforms:

l Linux (64bit)
l Windows 10 and 11 (64bit)
l macOS 12 (Monterey), 13 (Ventura) and 14 (Sonoma)

For more information please see the System Requirements.

https://dgbes.com/software/download
mailto:info@dgbes.com
https://dgbes.com/software/system-requirements
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1.3 About OpendTect (Pro)
The OpendTect Pro suite of software products consists two parts: an open source
part and a closed source part.

The open source part is called OpendTect. This is a seismic interpretation software
system for post-processing, visualizing and interpreting multi-volume seismic data,
and for fast-track development of innovative interpretation tools.

The closed source part is called OpendTect Pro. OpendTect Pro offers extra func-
tionality for commercial users. OpendTect Pro has the capacity to be extended with
a range of commercial plugins that are for sale and rent. The plugins offer unique
seismic interpretation workflows for specialist work.

Commercial users can create their own system by picking and choosing from an
extensive list of commercial plugins. Bundles of plugins have been combined into
bundles that are made available against discounted prices. The following bundles
exist:

l Geoscience
l Machine Learning
l ARK CLS Seismic Toolbox
l ARK CLS Broadband Toolbox

1.4 Copyright
The information contained in this manual and the accompanying software programs
are copyrighted and all rights reserved by dGB Beheer BV, hereinafter dGB. dGB
reserves the right to make periodic modifications to this product without obligation to
notify any person or entity of such revision. Copying, duplicating, selling, or oth-
erwise distributing any part of this product without any prior consent of an author-
ized representative of dGB is prohibited.

OpendTect license holders are permitted to print and copy this manual for internal
use.

https://dgbes.com/software/bundles
https://dgbes.com/software/bundles
https://dgbes.com/software/bundles
https://dgbes.com/software/bundles
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2 Getting Started
2.1 System Overview
OpendTect v7.0 is a project-oriented seismic interpretation system. Projects are
organized in Surveys - geographic areas with a defined grid that links X,Y coordin-
ates to inline, crossline positions. 3D seismic volumes must lie within the defined
survey boundaries. 2D lines and wells may be positioned outside the survey box or,
in the case of 2D lines, continue from within to beyond the survey boundary. It is pos-
sible to load multiple 3D volumes with different orientations, bin-sizes and temporal
sampling rates into one survey. Volumes that do not match the defined inline, cross-
line survey grid parameters are rotated and re-sampled onto the grid.

In addition to 2D and 3D seismic data OpendTect also manages prestack seismic
data, well data (tracks, markers, logs), horizons, faults, fault- sticks, geobodies,
mute functions, velocity functions, pointsets, polygons, and wavelets. All of these
can be imported and exported using standard file formats. OpendTect's internal
format is called CBVS (Common Binary Volume Storage) format but it is not
required to use this format. OpendTect operates equally well on data in SEG-Y
format that only needs to be scanned once. (OpendTect Pro users have direct
access to the Petrel* data store and they can also license Workstation Access to
facilitate IO to and from SeisWorks/OpenWorks and GeoFrame-IESX data stores.)

Multiple OpendTect surveys can be stored in the OpendTect Survey Data Root dir-
ectory. This is normally created during installation of OpendTect, but additional data
roots may be added at later stages via the Survey Setup Window (under the Survey
> Select / Setup menu).

OpendTect supports 2D and 3D viewers. 3D viewers can display data in two-way
time and in depth, and data that has been flattened along a horizon. Trans-
formations are done on-the-fly. 2D viewers exist for seismic data, well logs, cross-
plots and prestack gathers. (Commercial users (that is, users of OpendTect Pro,
also benefit from a Basemap and, depending on which plugins they have, from 3D
Wheeler scenes, well correlation panels, semblance gathers and more.)

* Petrel is a mark of Schlumberger.
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OpendTect Applications

OpendTect can be used among others:

l To perform 2D and 3D seismic data interpretations - horizons, faults, geobodies.
l To evaluate attributes and to compute attribute volumes (/ sections in the case of 2D
seismic).

l To enhance seismic data with various poststack filters.
l To visualize prestack gathers and to compute AVO attributes.
l To process grids and logs.
l To find relationships between seismic data and wells and to predict reservoir prop-
erties.

l As a platform to develop new applications or plugins.

Attributes

OpendTect started life as an attribute and pattern recognition system. Attribute ana-
lysis remains one of the core competences of the system. Attributes (and filters) are
evaluated interactively by applying the attribute to a display element. Calculations
are done on-the-fly and it is possible to movie-style evaluate attribute (filter) para-
meters. OpendTect supports an extensive range of standard and unique attributes
and filters that can be combined in any way by computing attributes from attributes.
You can also create your own set of attributes and filters by using maths and logic
(IF, THEN, ELSE, AND, OR etc.).

OpendTect works with an active attribute set (You can auto-load an attribute-set
which will be active the next time you open the survey. Do the following: open an
attribute set window, then select File > Autoload Attribute set). Only attributes in the
current active set can be used to make displays. You must select an existing attrib-
ute set or create a new one before you can apply attributes. If you wish to test a dif-
ferent attribute or, in case you simply wish to change the parameters of an attribute,
you can do so by modifying the current attribute set.

Multi-machine Batch processing

Attribute computations can be time-consuming, which is why on-the-fly computation
is not always efficient. Retrieving data from a stored volume is much faster. Attribute
volumes can be processed in batch mode on a single computer or, on all computers
and clusters OpendTect has access to. Multi-machine processing requires a bit of
extra work in the installation but it is highly recommended in a professional setting.
How to prepare OpendTect for multi-machine processing is described in the System
Administrator's Documentation.
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Memory

OpendTect does not load all data from current projects to memory (RAM), unlike
other Seismic Interpretation Software. Only the necessary data is loaded in RAM
and released as soon as possible. For instance when displaying a stored 3D data-
set along an inline only the traces of that inline are read from disk, converted and
sent to the visualization. When a seismic attribute is displayed along that inline, all
inputs are read from disk before the computation starts. Only the required inline and
possibly some extra traces (if the attribute uses a lateral stepout) are loaded. As a
result browsing inlines, crosslines, Z slices can be slow as it will systematically read
data from disk.

Performance can be improved drastically by explicitly pre-loading (parts of) data-
sets in memory (see pre-loading chapter), and to a lesser degree by storing data on
a Solid State Drive (SSD) instead of storing on a traditional magnetic harddisk drive.
Pre-loading is forced and automatically done by some batch calculations like all
volume builder processing steps. Also OpendTect’s 3D horizon auto- tracker
requires pre-loading of data. For other workflows pre-loading is not mandatory but
preferred. For example, visualization along random lines, and attribute calculations,
are much faster when data is pre-loaded.

Some modules, which require large amounts of memory to be allocated (like pre-
loading) will check available memory before allocating the required space. If require-
ments exceed available free memory an error-message is returned. The software
only checks the physical memory (RAM). However, most operating systems also
support virtual memory, which extends the physical memory with space reserved on
attached devices (harddisks and/or removable disks). SSDs exhibit very high
input/output speeds even up to a point that SSD IO speeds approach RAM I/O
speeds. Consequently, SSDs offer a cost-effective solution to increase a system’s
virtual memory to several TerraBytes (TB). OpendTect supports using virtual
memory through an environment variable OD_USE_VIRTUALMEM that needs to
be set to “Yes”.

Please note that it is strongly recommended to exclusively assign SSDs for virtual
memory usage. OpendTect may become unresponsive if you assign traditional mag-
netic harddisk drives. A short tutorial for Windows is given here.

Finally, please note that available- and free-memory levels are displayed in the
lower-right corner of the main OpendTect window. The returned figures are for the
total memory (physical + virtual) that is available / free.

User Interface

https://en.wikibooks.org/wiki/Operating_System_Design/Physical_Memory
https://en.wikibooks.org/wiki/The_Computer_Revolution/Hardware/Virtual_Memory
https://www.thewindowsclub.com/increase-page-file-size-virtual-memory-windows
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OpendTect's user interface is centered on an area that holds one or more 3D visu-
alization scenes. Each 3D scene has its own display tree from which the user con-
trols and manipulates the content of the 3D scene. The tree is NOT a reflection of
the project database! Instead it reflects which data is shown in each display ele-
ment. Data in a display element can be retrieved from the project database, or it can
be computed on-the-fly (attributes, volume builder processing flows, neural network
outputs). Display elements can hold up to eight layers of information. This feature
allows co-rendering of attributes and is especially useful when used in combination
with (semi-)transparent color bars.

To populate the 3D scene the user should right-click on the tree element and select
the data. Attributes (neural networks) can only be selected if an attribute set (neural
network) is defined ( , , , icons, respectively). Many display elements (in-
lines, cross-lines, Z-slices, random lines, horizons, 2D lines) can also be displayed
and interpreted using flat (2D) viewers ( , ). OpendTect Pro users can populate
a 3D scene and open 2D viewers via the basemap ( icon).

At the top of the OpendTect main window you will find a series of menus from which
various processes are started. Many processes can also be started from icons,
which is faster and therefore more convenient.
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2.1.1 Distributed Computing & Parallelization
To speed up processing time OpendTect supports batch processing of attribute
volumes and other computer intensive processes. The user has the option to run
batch processes on all computers (Linux, macOS or Windows operated work-
stations and clusters) in the network. Distributed computing is highly recommended
in operational settings. Corporate users are advised to contact their system admin-
istrator to enable multi-machine processing. Please see the System Administrator's
Documentation for details.

In addition to distributed computing OpendTect also supports multi-threading (par-
allel processing) of many algorithms. A thread of execution is the smallest unit of
processing that can be scheduled by an operating system. It generally results from
a fork of a computer program into two or more concurrently running tasks. The imple-
mentation of threads and processes differs from one operating system to another,
but in most cases, a thread is contained inside a process.

Multi-threading allows multiple threads to exist within the context of a single or mul-
tiple process. These threads share the process' resources (such as memory) but
are able to execute independently.

OpendTect uses the power of multi-threading to run different applications in data
loading, visualization, processing etc...

Processes that use Multi-threading

Dip-Steering Algorithms
Compute a Steering Cube with
BG Steering

Completely re-designed in
Nov. 2015

Compute a Steering Cube with FFT Completely re-designed in
Nov. 2015

Apply Full Steering dip-steering in attrib-
utes and filters
Apply Central Steering in attributes
and filters

Attributes
Convolve (all except Wavelet option)
Curvature
Dip Angle
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Velocity Fan Filter (=DipFilter)
Energy (all except Gradient option)
Event
Frequency Filter multi- threading imple-

mented in March 2014
Frequency multi- threading imple-

mented in March 2014
HorizonCube Data
HorizonCube Density
HorizonCube Layer
Hilbert
Instantaneous multi- threading improved in

March 2014
Local Fluid Contact Finder
Maths (except when expression is recurs-
ive)
Polar Dip
Position
PreStack
Reference
Scaling (all except scaling type AGC and
stats type = detrend)
Semblance
Similarity
Spectral Decomposition multi- threading imple-

mented in March 2014
Texture
Tutorial
Volume Statistics

Processes that do not (yet) use multi-threading

Attributes
Constant Steering
Convolve (Wavelet option)
DeltaResample
Energy (Gradient option)
Event Steering
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FaultDip
FingerPrint
GapDecon
HorizonCube Curvature
HorizonCube Dip
HorizonCube Spacing
Horizon
Match Delta
Maths (recursive expression)
Perpendicular Dip Extractor
SampleValue
Scaling (scaling type AGC and stats type =
detrend)
Shift

*multi- threading implemented in March 2014
**multi-threading improved in March 2014
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2.2 Toolbars
Many OpendTect processes can be launched most easily by clicking the cor-
responding icon. We distinguish two types of icons:

l Icons that perform one specific action, e.g. moves the current display element
(inline, crossline, Z-slice) N-steps forward.

l Icons that open a menu with multiple options, e.g. launches either the
2D attributes-, or the 3D attributes-definition window.

Icons are organized in toolbars. Some toolbars are always present, others only
appear when their action is appropriate. For example the display element toolbar
(upper left corner) only appears when a display element in the tree is selected and
its content varies with the type of display element.
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2.2.1 OpendTect Toolbar
The OpendTect toolbar contains icons to launch OpendTect specific modules:

starts the Survey definition module

starts the Attribute module 3D or Attribute module 2D

starts the 3D output module or the 2D output module

starts the Volume builder

starts Attribute vs. Attribute crossplot or Attribute vs. Well Data crossplot

leads you to the Rock Physics library

starts the import utility
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2.2.2 Manage Toolbar

From the manage toolbar you can start management utilities to copy, delete, and
rename various data objects in your OpendTect project.

Opens the Seismics Manager (options for 3D, 3D Prestack, 2D and 2D
Prestack)

Opens the Horizons Manager (options for 3D and 2D)

Opens the FaultStickSets Manager

Opens the Well Manager

Opens the PointSet/Polygon Manager

Opens the GeoBodies Manager

Opens the Wavelet Manager

Opens the Stratigraphy Manager
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2.2.3 Graphics Toolbar

From the graphics toolbar you can start processes to manipulate the 3D graphics
window. The following options are available:

When this icon is visible, you are in Position mode. Click on the display element
you wish to move or edit. If the element is an inline, crossline or Z-slice, a frame with
handles (green squares) appears around the clicked element. The handles are
used to re-size the frame. Clicking and dragging inside the element is the way to
move the entire element in the in-plane direction. Tip: For accurate positioning of a
data element, use the Position option from the right-hand mouse button pop-up
menu in the tree, or press the position icon .

When this icon is visible, you are in View mode. In this mode, you can rotate, pan
and zoom using Left-Mouse operations.

View Mode is a relic from the past. It is expected to disappear in future releases
because as of v6 rotate, pan and zoom are available in all modes (Position, View,
Interpretation) as Middle-Mouse operations, see:Mouse Controls.

Resets the view to the position that was saved when you pressed the "save
home position" icon, one below.

Saves the current view as the home position that can be recalled with the pre-
vious icon

Allows to reset the view such that all data are visible.

Toggles the view between orthographic and perspective view.

Use this icon to set the scene orientation to a particular 'standard' direction.
Options include 'View Inline', 'View Crossline', 'View Z', 'View North' and 'View North
Z'

Will open the directional lighting dialog box.
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The display rotation axis is used to show/hide the N-E-Z (North-East-Z) ori-
entation arrows.

Toggles the colorbar on and off.

Opens the snapshot window, so that the user can grab pictures of the scene, win-
dow, and/or the desktop.

Sets the selection to polygon or rectangular modes and allows the user to select
an area (or elements within an area, i.e faults sticks...)

For removal / deletion of selected elements.

Displays selected element only. When more than one element is displayed in the
tree, one can quickly view a single element and toggle between elements by clicking
the different elements in the tree.

Tool to measure distances by drawing a polyline on an inline / crossline or on a Z-
slice. The tool returns horizontal distance (meters or feet), vertical distance (ms in
time survey or meter / feet in depth survey) and the inline or crossline distance
respectively. For time surveys the vertical distance is computed with a user-spe-
cified constant velocity.
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2.2.3.1 Take Snapshots

It is possible to take different kinds of snapshots in OpendTect. Three options
are available: Scene,Window, and Desktop.

The Scene option allows the user to grab the displayed (selected) scene within
OpendTect.The OSG (OpenSceneGraph) 3D library is used, allowing the output pic-
ture to have a higher resolution than the screen resolution. Every element displayed
in the scene will be in the output picture, including the annotations (color bar, ori-
entation etc) if displayed. Any overlapping windows will be neglected.

You can change the image properties e.g. height, width, resolution etc. If you save
the settings, they will appear by default in all sessions next time you grab new snap-
shots. The 'Screen' parameters correspond to the parameters of the picture as dis-
played on your screen.
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TheWindow option grabs the whole window, including the sidebars. It can be either
the main window or any 2D viewer opened when the snapshot button was pressed.
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The Desktop option is similar and will snap the entire user desktop. Both options
use the Qt library for grabbing the picture. As a result the output is limited to the
actual screen resolution, and overlapping windows will appear on the snapshot.
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2.2.3.2 Directional Lighting

The directional lighting feature is used to illuminate the objects (displayed data)
at a specific inclination (or dip angle) and azimuth. The feature controls the main
headlight i.e. the intensity of the camera light and the intensity of the directional
light. The dialog is launched by clicking the icon shown above.
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Directional light Dialog

The directional light dialog updates the scene instantly to reflect the changes made
to the properties. If the OK button is clicked, the changes are retained, whereas, the
Cancel button rules out all changes.
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Apply light to: The directional lighting is independent for each scene, i.e the selec-
ted scene will be illuminated. However, selecting the option All in the drop down list
will illuminate all scenes that are currently open.

Camera mounted light: Use this slider to change the percentage of intensity of the
camera light or the head light. 0% corresponds to total darkness while 100% cor-
responds to full intensity. Similar to the directional light dialog, the changes made to
the azimuth and dip are instantly reflected in the selected scene(s).

Intensity: Sets the percentage of the intensity of the additional directional light. 0%
corresponds to total darkness while 100% corresponds to full intensity.

Dip: This slider is used to set the dip value (in degrees) of the directional light. The
directional dip is limited from 0 to 90 degrees.

Azimuth: This slider is used to set the azimuth (in degrees) value of the directional
light. It can be any value from 0 to 360 degrees.

Show polar diagram: The azimuth and dip can be visualized using this diagram.
This diagram can be used in combination with the sliders of the main dialog in order
to position the directional light around the scene.
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Polar diagram dialog

This is a dialog that displays the polar diagram for setting the azimuth and the dip
values of the additional directional light. The location of the pointer (the red dot)
determines the properties of the directional light. The pointer can be moved around
by using the mouse within the polar diagram. The azimuth value can be read off the
circumference of the outermost circle while the dip value is given by the location of
the pointer along the radius of the circle.
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2.2.4 Slice Position Tool

The slice position toolbar is used to position a display element (inline, crossline or
timeslice) and to step through a 3D volume with a user-defined step. The slice pos-
ition and number of steps are manually entered in the fields. The forward and back-
ward arrows of this toolbar are used to move the selected slice in increasing or
decreasing directions. The workflow is very simple. Add an inline in a scene. By
default, the slice is positioned in the middle of the survey box. Use the arrows to
move the inline position according to the given step.

A progress bar appears by default every time when a user moves the display ele-
ment. This can be avoided by changing the Personal Settings (Utilities, Settings,
Look and Feel). Provided the computer memory is sufficient it is highly recom-
mended to load the seismic data into memory (Survey, Preload). Progress mes-
sages are switched off for preloaded volumes!

Keyboard shortcuts can be used to ease the sliding: Keyboard shortcuts. The step
used will be the one specified in the slice position tool.
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2.3 Mouse Controls - Scenes and Graph-
ical Interaction
3D scene interaction

There are three interaction modes for 3D scenes, each has its own cursor:

l Position mode for positioning and moving display elements (arrow cursor)
l View mode for zoom, rotate and pan (hand cursor)
l Interpretation mode for picking and editing data points (cross cursor).

Important notice: Historically OpendTect supported two main display modes: View
mode and Position mode (in older versions called Interact mode). The user
switched between these two modes either via the switch display icon ( , ), or by
pressing keyboard ESC. In version 6.2 and newer this is no longer necessary. All
view mode operations (zoom, pan, rotate) are accessible at all times via middle-
mouse button manipulations. We continue to support View mode - Position mode
for now but we expect that this mode of operation will be phased out in future. In any
case we recommend users not to use View mode and instead to use middle-mouse
button manipulations.

Zooming and Rotating views is also possible using the wheels in that appear in the
upper and lower left corners of the graphical area when you hover over these
corners with your cursor.

Short-keys & mouse-controls

Positioning, zooming, panning, rotating and interpreting data in the 3D scene are
core interactions in OpendTect which are done with mouse clicks and drags. Some
operations require holding a Shift or Control key while clicking. OpendTect supports
a range of short-keys to speed up various interactions. The default settings of the
most important short-keys and mouse-controls are given in the tables below:
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These tables assume a mouse with left and right buttons and a wheel in the middle.
Touch-pads, and other input devices will support similar functionality but the actions
might be mapped differently. Mouse controls and a number of short-keys can be
modified from Utilities menu > Settings > Look and Feel and Utilities menu
> Settings > Keyboard Shortcuts.

2.4 Color Tables
A colortable is a predefined group of color settings that can readily be applied to any
attribute. This group includes items such as the primary colorbar, undefined color
settings, color segmentation, and opacity. Changes made to the colortable are
applied universally to any item that uses that colorbar.

A colorbar is the specific colortable for a particular element's (line/horizon) attribute
that is displayed in a scene. Updating the colorbar can update the selected ele-
ment's attribute. The image below is an example colorbar:

The colorbar is composed of four elements: the color display itself, the minimum
and the maximum value of the variation for the colortable (as it is defined for the cur-
rently selected item), and a set of colortables.

This drop down list of predefined colortables appears when the user clicks on the
name of the colortable being used in the colorbar (ex: Channels). If no item is selec-
ted in the tree, the colorbar will not show any value/range although it can be manip-
ulated. The colortable is manipulated by right-clicking on the colorbar.

The pop- up sub-menu contains several manipulation functionality. These are
described in the following:
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Flip causes the scale to be flipped. (The color assigned to the high value, now
becomes the color assigned to the low value, etc.)

Ranges/Clipping allows the user to change the range of the color scale, or clip a
certain percent of the scale. Please be aware that only 2000 random sampling
points are by default used to clip data. The clip values may therefore change from
one data set to another. (An alternate method for clipping is described in the Inline,
Crossline & Z-slice sub-chapter).

The Number Format chosen for the clipping may be selected as one of the following
options, along with the level of precision for the specified format:
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Set as default sets the current color settings as the default color scheme for all ele-
ments in the tree.

Manage is used to modify the current colortable and to create new colortables with
the current one as a starting point. Colortables are modified by adding, removing,
changing colors, varying opacity, and defining the colorbar to be gradational or seg-
mentized. The effect of the changes on your displayed element can be seen dir-
ectly. Colortables can be removed from the list by pressing the Remove button.
(OpendTect Default colortables can not be removed). Moreover, the user can
import user-defined colortables by pressing the Import button.

Colortable Manager window

The Colortable Manager window opens when the user selects the Manage option
described above.
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A marker is the color you see in the colorbar. The black lines, in the white field
above the colorbar, are the marker boundaries. The marker boundaries are where
the settings for the markers are defined. Right-clicking on a marker boundary shows
the following options: Remove color, Change color, and Edit Markers.

Remove color deletes the marker boundary from the colortable.

Import colortable file: The colortables can also be imported by pressing the From
other user... button. The default colortables are stored in a file (ColoTabs) that is loc-
ated in the OpendTect installation directory (e.g. /home/your-
username/opendtect/7.0.0/data/ or C:\Program Files\OpendTect\7.0.0\data\).
Moreover, the colortables saved by a user are stored in a file (settings_coltabs.user)
that is located in the user home directory (e.g. $HOME/.od/ or C:\Users\your-user-
name), here user is the OpendTect username. These files can be modified or impor-
ted by using import color table window (see below).
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Marker color brings up a standard color definition window, where this defined color
can be changed.

Edit Markers opens the Manage Marker window that displays all markers: marker
ID, position, and current color. The marker's position, in relation to low and high val-
ues, can be specified by number. The standard color definition window can be
opened from here too, by double-clicking the marker color.

Opacity: A thin red line, capped on each end by small red nodes, is visible at the
bottom of the histogram located in the top panel. By moving these nodes, or adding
additional nodes, the user can vary the opacity of the colors below. One can add
opacity nodes by double-clicking in this area. These opacity nodes can be dragged
up or down to increase or decrease, respectively, the transparency of the color dir-
ectly below it in the colorbar. A hatched area (visible in the color toolbar in the main
window of OpendTect) indicates the part of the color bar that will display with some
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level of transparency. The darker the color of the hatch marks, the higher the level of
transparency.

Transparency performance depends on the graphics card. When displaying two ele-
ments in exactly the same position, transparency may not work as you expect. It
may help to set transparency values to the maximum to get the sort of display you
desire. In addition, it may help to change the transparency of the element as a whole
by right-clicking the element in the tree, and selecting Properties.

In the background of the opacity panel, a histogram is shown in light grey. This his-
togram shows the distribution of attribute values in the selected element. This helps
you to tune the colorbar to the value range you may want to highlight. To alter the
histogram see Show Histogram in the Inline, Crossline & Zslice sub-chapter.

Segmentation allows the user to segment the colorbar into a user-defined discrete
number of colors. This can be done in a Fixed or Variable manner. Fixed allows the
user to define the number of segments they would like to have, but does not allow
the marker boundaries to be moved. Variable allows the user to both define the num-
ber of segments, and move the marker boundaries to suit specific needs. Fixed is
good for purposes such as velocity and contour lines, while Variable is good for use
with waveform segmentation.

Undefined color specifies the color that will be used to display undefined values in
the data.

Color Table Manual Creation

Color tables can be created manually from the color table manager, and can be
imported from external files, provided that the relevant format is used.

The easiest method by far for adding a new colorbar would be to copy one from the
software template: the file ColTabs is in the root of the application folder (ie: C:\Pro-
gram Files\OpendTect\6.6.0\data or equivalent). Note that the color tables are dis-
crete, i.e. it is encoded by a fixed number of points for which a color (RGB) and
transparency (Alpha) is provided. Values in between are interpolated. It is up to the
creator of the color table to decide how many points are needed to correctly rep-
resent it.

For one point, each row should be looking like:

XX.Value-Color.YY: POS`Red`Green`Blue`Alpha
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where XX is the colorbar index within the file, YY is the sequential point index within
a colorbar (0 to N-1), and POS is the relative point position, from 0 (left/bottom) to 1
(right/top).
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2.5 General Selection Window

The window contains following standard buttons:

renames the object.

toggles the object to Read only. Use this option to protect any object from over-
writing.

removes the object.
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turns the selected object into the default object.

2.6 2D Viewer
The 2D Viewer is a flat viewer for visualizing and interpreting 2D and 3D seismic
data. When zoomed in use middle-mouse click and drag to pan through the entire
section. 2D viewers can be launched in different ways:

l From the main OpendTect window using the View menu, option 2D Viewer.
l From the variable density and wiggle display icons that appear when the display
element is selected in the 3D window.

l From the Basemap utility (only if you have access to OpendTect Pro)

Tree. Each 2D viewer features a tree to populate and manipulate the graphics win-
dow. Use right-click on the object to open the corresponding menu. The 2D Viewer
supports two modes of visualization: variable density and wiggles + variable area.
Per default the same attribute is used in both modes but the user is free to select dif-
ferent attributes per mode (Select attribute menu).
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2D Graphics area. For 2D seismic lines you can open a crossing 2D line using
right-click on the annotated cross-line. When the 2D viewer displays an inline you
can open a crossline or a time-slice at any position using right-click. It is also pos-
sible to change the display properties by right-clicking in the graphics area. Altern-
atively use the icon. For details, see Display Parameters below.

Position and Color toolbars. To interpret every Nth line set the step to N and use
the arrows (or Keyboard short-keys to jump to the next line. For details see Slice
Position Tooland Graphics Toolbar.

Display toolbar.

Rubberband zoom.

Zoom in with a fixed step (same zoom for horizontal and vertical).

Zoom out with a fixed step (same zoom for horizontal and vertical).

Zoom in vertically with a fixed step (horizontal zoom does not change).

Zoom out vertically with a fixed step (horizontal zoom does not change).

Cancel zoom (displays the entire element).

Maximize the display to fit the screen.

Sets the home zoom level. There are three different home zoom levels:

l Set the zoom level for current window only.
l Set the zoom level for all 2D viewers that will be launched thereafter.
l Set horizontal and vertical levels manually.

Return to the home zoom level.

Flip left and right.
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Grab the image and save as a picture.

Print the image.

Display the scalebar.

Set display parameters (see below)

Launch Help.

Display Parameters. can be modified in the Specify Display Properties window,
which features three tabs:
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Please note that under the 'Annotation' tab, the user may choose between different
distance values to be displayed on the Axis-distances:

l Trace number (only for 2D): This will display the traces number on the X axis
l Reference position*: This displays the SP (shot points) number that is available in the
shot point header field of the original SEG-Y

l X-Coordinate: This shows the X coordinate in the axis
l Y-Coordinate: This displays the Y coordinate in the axis
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Horizon tracking toolbar.

Interpretation mode toggle. If the toggle is on you can add seed positions to the
horizon you are tracking. In this mode the cursor is a cross. When you toggle this
mode off you are back in Position mode. The cursor is an arrow.

Pops up the horizon tracking setup window.

Polygon selection tool. Use this to select areas that need to be removed. Altern-
atively, when you are in manual draw mode, use Control - Left Click + Drag to
remove parts of a horizon.

Delete the selected area.
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2.6.1 Pre-Stack 2D Viewer
In this window one or several prestack dataset can be viewed simultaneously. In
this viewer you can:

l Display gathers from one datastore at different locations.
l Display gathers from different datastores side by side.
l Use the two modes above in combination.
l Display mute definitions that were either imported or computed before starting the
viewer.

l Apply a pre-processing on the gathers: AGC, application of the mute functions (stored
or computed on the fly), ...

l Display an angle gather by providing the corresponding velocity model using a stored
cube.

Gathers position selection

You can set the gathers to be displayed from this window. The top part is used to set
a grid of regular positions from provided ranges. Keep in mind that you can get
another 2D prestack viewer if you wish to have data from several inlines. From this
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regular grid, you set the position where gathers should be displayed. You can also
manually change a crossline number. Press Apply to reload the view.

Selection of several datasets

Multiple gathers can also be added together in the 2D panels by pressing this
icon.
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Display of angle gathers

In this window you can set the parameters for creating the angle gather that cor-
responds to the prestack datastore. For each sample of the input seismic prestack
gather, the incidence angle in degrees will be computed and color-coded with the
rainbow colorbar. The seismic data will then switch automatically to wiggle display.
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Example of prestack gathers (wiggle) with a mute functions, and the corresponding
angle gather on the background:
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3 OpendTect Trees and Ele-
ments
Each scene has a corresponding detachable tree to control the elements to be dis-
played. A tree consists of several elements of different type, which are described in
detail below. Tree elements containing elements one level down can be expanded
by clicking on the markers (+ or -) left of each main element. The order in which
items appear in the tree can be changed by selecting the item that you want to
move, then press and hold shift, and press the arrow up or down keys on your key-
board.
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The tree is a utility window that can be moved outside of the main OpendTect win-
dow. To do so, first click once on the small squares at the top-right corner of the tree
scene, then drag by clicking (left-click) on its title bar to place it anywhere.

Some operating system hide utility windows when the main window is inactive.

A common issue with certain Linux distributions is this: decoupling the tree causes
tree to disappear when using, for example, the attribute engine or when the pro-
gress bar is showing. To resolve this, please do the following:

l Go to the KDE Start button
l Applications
l Configure desktop
l Under 'Workspace Appearance and Behavior' click on 'Window Behavior'. You should
see this window:

l Make sure the option 'Hide utility windows for inactive applications' is not checked.
l Click on Apply button.
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3.1 Scene
In OpendTect, a Scene is a main working window associated with a tree. In the
scene, it is possible to work in three separate domains i.e. Time-domain, Depth-
domain, Flattened and Wheeler-domain. A time/depth-domain scene can be inser-
ted via Scenes menu. Each scene has its own tree elements so that the elements
and scene settings can be modified accordingly.

The scene Properties can be changed by right-clicking on a scene name in the
Tree e.g. Scene 1 > Properties. This will pop up the following window:
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In this window, the following options can be set for the specific scene:

l Survey box: If checked, a 3D survey box will be shown in this specific scene.
l Annotation text: If checked, the survey box annotations (inline, crossline, TWT) will be
displayed in the scene.

l Annotation scale: If checked, the numeric values of inlines, crosslines and Z-values will
be displayed.

l Background Color: The user can specify his/her own background color for particular
scene. By default it is black.
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l Mouse Marker Size: This option is used to increase the Mouse Marker (a marker point-
ing mouse location on multiwindows) size on various windows in multiscene view.

l Mouse Marker Color: The color of Mouse Marker can be changed from here. The
default color is white.

l Annotation color: The color of Annotation can be changed from here. The default color
is white.

l Line/Surface separation: The user can change the setting between Line and Surface
separation as shown below

The Top/Bottom image...

This option allows to display images at the top and base of the survey area, with or
without transparency. The picture will be stretched to fit into the TopLeft and Bot-
tomRight corners of the survey (in a north view). The proposed coordinates are the
survey ranges.

This feature is specially useful to add any reference map of the survey to under-
stand the geographical position and corresponding seismic profile in a better way.
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You can use the Google export tool to convert the survey boundaries to latitude and
longitudes. They can be then imported into a mapping program (like Google Earth)
in order to take the appropriate screenshot.

The Scene Color Bar Settings can be used to set the position and size of the col-
orbar in the scene:
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The Export scene option is only made for the debugging purposes. The export
option dumps the scene information into a .osg file (OpenSceneGraph), which can
be sent to OpendTect and used for bug analysis.
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3.2 Inline, Crossline & Z-Slice

Inline, Crossline and Z-slice elements can be added into the tree by clicking on the
element name and selecting Add/Add default data/Add color blended from the pop-
up menu. The Add option will insert an inline/crossline/Z-slice with a blank line in the
middle of the survey (ready for an attribute or stored cube to be loaded). If a well has
been loaded in the project and is within the survey box, it is possible to Add at Well
location an inline or crossline. The inline/crossline loaded will be according to the
surface coordinates that can be found in the well manager information summary sec-
tion. Once added, a selection window will pop up to select the attribute to display:
Stored volume, Attribute from the active attribute set,... If cancel is clicked, the attrib-
ute line will stay blank in the scene and the tree entry will read <right click>.

Prestack stored cubes will appear in the list surrounded by curly brackets {}. They
can be displayed on the slices of the 3D scene as common offset volumes, in a sim-
ilar way to the components of multi-components volumes.The prefix "O=" is then
presented with the offset value in XY units (meter or feet). Attributes may be com-
puted on common offset volumes like for components or multi-component volumes.

Any desired cube can be selected from the list. The selected cube will be added as
an attribute for the displayed inlinecrossline/Z-slice number. The added attribute
can also be replaced at any time by right-clicking on it (see the figure below).
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The check- boxes are used to show/hide the corresponding sub- element of
inline/crossline/Z-slice.

After an attribute is displayed in the scene, it can be manipulated further by right-
clicking over it (see figure below). The explanation for this list is described at the end
of this section.

Pop-up List Menus

Each individual element (Inline/Crossline/Z-slice) has a similar pop-up list menu
(see below). There are two different ways to open this list. Either display it from the
Tree (as shown below) or display it in the scene. In the latter case, place the mouse
over the inline/crossline/Z-slice and right-click to launch the tree. This menu list has
several functions that are described in following text.
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Add

l Attribute: Add an additional blank attribute for the corresponding inline/crossline/Z-
slice number. The attribute data (stored cubes or the attribute definition) can be dis-
played by right-clicking on it and selecting the desired attribute. Up to eight different
attributes can be displayed within one element (inline, crossline, Z-slice).

l Volume Processing attribute: This option will add the volume processing attribute.
l HorizonCube Display: This will display the HorizonCube. It requires the HorizonCube
plugin.

l Systems Tracts Display: This adds system tracts interpretation. It requires the SSIS
plugin.

Display

Histograms: The histograms of all added attributes of an element can be displayed
using the right-click option of the parent element (inline number, surface name...). It
is a useful tool to clip the ranges of an attribute by using vertical green lines in the
histogram: The vertical green lines show the current amplitude range and can be
moved left or right using the left mouse-click. The display is updated when the
mouse click is released. This is performed independently for each attribute. Please
note that this will toggle off the automatic clipping.
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A multi-histogram display for an inline containing two attributes (DSMF Seismic and
Energy).

The green lines do not appear on histograms displayed fro single attributes.

Positions: Change an inline/crossline/Z-slice number. This option is used to manip-
ulate (sub-select a range of traces/time) a line or to quickly scroll through the data
for visualization.
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(L to R) Manipulate or scroll the inline; Manual Scroll and Auto Scroll

By pressing the Scroll button, elements are moved either manually (select Control
Manual), or automatically (select Control Auto). Scroll in the inline/crossline dir-
ection by specifying a fixed Scroll step. In the manual mode, the line/Z-slice is
stepped to the new position after each subsequent click on the Advance button. In
the automatic mode, the line/Z-slice is updated in a movie-style with a fixed time
interval (in seconds) - Time between updates. The auto-scrolling can be paused by
pressing the Pause button. To resume the auto-scrolling again pressGo button.

Gridlines: Enables displaying grid lines on the particular element. A new menu
appears where the grid line spacing, style, color and width can be set.
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Resolution: Edit the graphical resolution of the element. The Default does not
involve any rescaling before the data is sent to the graphic card. The options Moder-
ate and High do some pre-interpolation before the data is sent to the graphic card
and generally results in a cleaner picture. If the memory of your graphic card does
not allow high resolution, the element becomes black.

If Shading is on, the resolution option is not available anymore(except for the hori-
zon element).

Properties: Access display parameters; Transparency, Ambience/diffuse relflection,
texture and mouse movement (scroll and pan settings).
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Duplicate: Add a new duplicate/copy of a selected element in the tree.

Reset Manipulation: Reset changes made in the position of the line/Z- slice.
Restore the original configuration.

Display PS Gather: Pop-up a prestack viewer perpendicular to the inline or cross-
line.

Note: It is also possible to display the offset of each CDP gather similarly to any
poststack data. The prestack data is available in the list of stored cubes and is
marked with quotes { }, at the end of the list.

Correlate with wells: This will correlate the line with 2D well

Lock: Lock the selected object. Prevents accidental removing, moving or displaying
data on the object. After clicking Unlock, all editing is again enabled.

Remove: This removes the element from the OpendTect tree and the graphics
area.

The options available for attribute pop-up menu list are briefly described here:
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Select Attribute: When selected, data can be displayed from stored cubes or an
attribute from the current attribute set (if available). To display an attribute, select or
create an attribute set first.

Save Colour Settings: Save color settings for a specific stored volume and make
them available for future use.

Move:Move the attribute up, down, to top of the list, or to bottom of the list.

Display

Show Histogram: Display data statistics (selected attribute) of the defined volume
as a histogram in a pop up window.
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Show Amplitude Spectrum: Amplitude vs frequency plot will be shown in pop up win-
dow. Moving the mouse over the spectrum displays the Values.

Show F-K Spectrum: A two-dimensional Fourier transform over time and space
where F is the frequency (Fourier transform over time) and K refers to wave-number
(Fourier transform over space).
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Pressing Ctrl+P in either the Histogram, Amplitude- or F-K Spectrum windows pops
up a settings window where you may define parameters for a snapshot:
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l Change transparency: Change the transparency of the attribute item to view one or
more overlaying attributes simultaneously.

l 2D Viewer - VD / Wiggles: Display an attribute in the 2D viewer as "Wiggle" or "VD"
(Variable Density). For more details, please refer to: 2D viewer

Remove: Removes the attribute item from the tree.
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3.3 Volume
A volume can be added by clicking on Volume element in the tree and selecting Add
option. A small volume box with blank attribute is added to the scene. An attribute in
the newly inserted volume can be displayed by right clicking on the volume and
selecting the Select Attribute option. This works similar to inline/crossline/Zslice.

You can display either the stored volumes or calculate the attribute within the sub-
volume. For faster response times, pre-load the data you wish to visualize using this
tree element.

The pop-up menu for the Volume element resembles that described in the previous
section for inline/crossline/Z-slice:

Select Attribute: Select/change the data in a volume.

Display
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Properties: Change display parameters such as transparency and ambiance
reflectivity:

Add isosurface: Compute arbitrary iso value surfaces and convert them into bodies.
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If the option Add > Iso surface is selected, the following window pops up with choice
of modes:
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The window displays the histogram of the data collected within the loaded volume
(left), or from seeds only that are stored in a pointset (right). "Update" will update the
display in the 3D scene (requires some computation time) while leaving the window
open. OK will accept the currently selected (or updated) value and dismiss the selec-
tion window.
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Right-click to display the iso surface menu and convert the iso surface into a stored
body that in turn can be retrieved:

l Amplitude Spectrum: Pop-up amplitude vs frequency plot.
l Histogram: Display data statistics (selected attribute) of defined volume as histogram
in pop up window.

l Position: Change the inl/xline/Z position within the survey boundaries.
l Duplicate: Create a duplicate/copy of the sub-volume.
l Reset Manipulation: Reset the changes made in the position of the sub-volume. This
option is only available if the user has made any changes.

l Save color settings: Save the color settings.
l Lock: "Lock" option with lock the selected object, this will prevent accidental removing,
moving or displaying of data on the object. After clicking "unlock" editing is enabled
again.

l Remove: This will removes the element from the display.

In Interact mode, (see Mouse Controls) the cursor will return the position (inline,
cross-line and X,Y,Z) and the data value at that position in the horizontal status bar
of the OpendTect window.
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3.4 Random Line
If you click on the Random line in the tree, four options will be available: Add Empty,
Add Stored, Add Color blended and New.

Add Empty: Right-click on Random line and select 'Empty'. The new line will be
added as a sub-element of the random line. By default, this is the centre inline of the
cube. To create the new arbitrary direction of random line, the user can modify
nodes by editing or inserting nodes:

With multiple nodes, the random line can also consist of multiple flat sections. The
sections of one single random line may intersect one another. In interact mode, the
little plane of a node can be used to drag the node laterally, and the vertical tube can
be used to shift the edge of the random line vertically. Nodes can be added from the
pop menu by right clicking on the random line in the Interact mode.
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Add Stored: Select from a list of (previously stored) random lines to display it in the
scene.

Add Color blended: A color blended Random Line may be added. This may be
either a color blended version of a previously-stored random line, or an 'Empty' color
blended random line:
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RGB(A*) color-blended attribute display is used to create a normalized color-blen-
ded display that often show features with greater clarity and enhances a detail map
view. Though traditionally, it is used to blend the iso-frequency responses (Spectral
Decomposition), RGB(A) can also be used to blend three or four different attributes
that define a comparable spectrum. For instance, spectral decomposition outputs
the amplitude at discrete frequencies. So, it renders the same output (unit-
t=amplitude). Depending upon a geological condition or the objective, FFT short win-
dow or CWT (continuous wavelet transform) can be chosen.

* Once you have your inputs selected for the appropriate color attributes, it is also
possible to add a fourth attribute (the 'A' or 'Alpha channel') to highlight structural
features such as faults/fractures (ie: add a similarity attribute).
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New: There are several ways to create a new random line:

l Interactive:When creating a random line from interactive mode, a horizon or Z slice
must be loaded in the scene first, a random line can then be created by picking nodes
on the displayed horizon/Z-slice.

l Along Contours: Create random lines between specified contour ranges. Note that a
interpreted horizon grid will be required to provide the contours.

l From Existing:Generate random line(s) from existing random line(s). There is an
option available to generate random line at some distance away from existing random
geometry and store it in new random line geometry.

l From Polygon Create random line from a saved polygon.
l From Table: Create random line from table. The input will be X/Y coordinates,
Inline/Crossline and Z ranges.

l Create FromWells: Connect several wells by a random line. The line follows the devi-
ated well paths (optional). By right clicking on the random line tree, and selecting
Create from wells, a dialog box appears with a list of wells that can be selected in order
to set up the random line path.

Use in HorizonCube creation, when it is created in a 2D line-section that follows the
well paths.

When right-clicking on the newly created random line, the following options are avail-
able in a pop-up menu:
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Add

l Add attribute:When selected, choose to display data from stored cubes, from an attrib-
ute from the current attribute set or from an output node of the current neural network.
To display an attribute or neural network, select or create an attribute set or neural net-
work first.

l Add Volume processing attribute: Display volume created from the volume builder
l Add HorizonCube display: Display the stored HorizonCube
l Add System tracts display: This option will add systems tract interpretation.

Display:

l Histogram: Displays multiple histograms for the randomline. If there are more than one
attributes displayed, it will show the histograms of each in a pop-up view.

l Resolution: Choose the resolution between standard/higher/highest
l Position: It is used to manipulate the nodes / position of a random line. To read more,
please go to the Manual mode sub-section of this chapter.

l Insert node: Insert a new node before the selected node.
l Properties: This option refers to display parameters such as Ambient reflectivity, Dif-
fuse reflectivity, Transparency.
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Duplicate: Duplicate the line as an empty element in the tree. This option displays
different attributes on the duplicated line whilst keeping the original data.

Reset Manipulation: This will reset any change in the position of the random line
(or its nodes) that you have applied and it will set line to its original position. This
option is only available if changes have been made to the position of the element.

Create 2D Grid: The random lines (with two nodes only) can be used to create a 2D
grid with a fixed grid spacing. When selected, the Create 2D Grid window is
launched (see below). Here, specify the input 3D seismic volume and the output
data set name. The output grid is generated according to the dip (parallel) and strike
(perpendicular) direction of the selected random line. The prefix labels are used as
prefixes to the output line names, stored to the specified new data set name. The
grid spacing is the constant spacing between the two lines. At the bottom, the total
number of parallel and perpendicular lines will be updated according to the grid spa-
cing. By pressing OK, a batch process will start to generate the 2D grid. When the
batch program is finished, the data can be displayed in the scene (see 2D Seismic
section for details).

Save As: Save the random line as a new name or overwrite the existing.
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Save As 2D: Creates a 2D line from a Random line. Right-click on the random line
in the tree and select Save As 2D. A window will pop up, as shown below. Select the
Input cube, the output line and the line name. The first trace nr number of line is also
necessary.

The survey type should be 2D as well if you want to view the 2D line created from a
random line.

Correlate with wells: This option is used to correlate a random line with wells. Well
- seismic correlation is normally done in the Well Correlation Plugin (WCP), which
requires a commercial license.

Lock: Locks the selected object. This will prevent accidental removing, moving or
displaying data on the object. After clicking lock again, editing is again enabled.

Export to Google KLM: Export selected random line to a Google KML file. Specify
the KML file parameters in the pop-up dialog.
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Annotate the start and end of the random line with a user defined line annotation in
the output file settings.

Remove: Remove the random line from the tree and the scene. Do ensure to first
'Save' (any changes to) the random line before removing it.

The options available for attribute pop-up menu list are briefly described here:
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Select Attribute: When selected, data can be displayed from stored cubes or an
attribute from the current attribute set (if available). To display an attribute, select or
create an attribute set first.

Save Colour Settings: Save color settings for a specific stored volume and make
them available for later use.

Move:Move the attribute up, down, to top of the list, or to bottom of the list.

Display: There are several display settings / features that are briefly explained
below:

l Show Histogram: Display data statistics (selected attribute) of the randomline as a his-
togram in a pop up window.

l Show Amplitude Spectrum: Amplitude vs frequency plot will be shown in pop up win-
dow.

l Change transparency: Change the transparency of the attribute item to view one or
more overlaying attributes simultaneously.

l 2D Viewer - VD / Wiggles: Display the selected attribute in the 2D viewer as "Wiggle" or
"VD" (Variable Density). For more details, please refer to: 2D viewer

Remove: Removes the attribute item from the tree.
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3.4.1 Manual Mode (Empty)
Manual Mode. In manual mode, the random line will first be displayed in the 3D
scene. Nodes may be added and their position changed interactively, in a second
step. This starting random line will have two nodes, one at each end of the central
inline. More nodes can also be inserted in the right click menu of the random line in
the tree (see figure below). Please note that the same menu is available with the
right-click on the random line in the scene.

Adding/inserting new nodes between the existing nodes

The node on the left-hand side of the newly created random line is designated node
0, and the one in the right hand side node 1. It is possible to insert a node before
node 0, before node 1, and after node 1. The node will be created half-way between
the two surrounding nodes. In order to move a node to a desired position, click on
the random line to make the nodes visible/editable. In the interact mode, click at the
node plane (horizontal/vertical) to move the node location. A purple surface appears
around the node and the node can be moved in any direction inside the survey area.
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The node can be moved in two directions (horizontal and vertical). The node's ori-
entation can be changed by placing the mouse pointer over the node and pressing
the Ctrl key.

Editing or modifying the position of the nodes is also possible through clicking the
option Edit nodes.... The following windows will pop-up and the nodes are editable.
Modifying or inserting new nodes is also enabled. In this table, each node is defined
by its inline/cross-line or X/Y position. The nodes can also be removed by right click-
ing over the desired cell and selecting the 'remove node' option. Similarly, for the
pop-up menu, more nodes can be inserted before/after the selected cell (node).
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3.4.2 Create from Existing
This option allows the user to generate random line offset from an existing random
line. There is an option available to generate a random line at some distance away
from existing random geometry and store it in new random line geometry.

Create Random line from existing line geometry in left/right or both directions. The
direction is defined by the path described by the nodes, in the order seen in the
table.

The first generation parameter is the input random line, which has to be chosen
between the already existing random lines. Then, define the distance from input in
meters and the direction in which the node will be added. There are three directions:
left, right, and both. The final step is to name the output random line.

Click on the Display Random line on creation box to immediately visualize the ran-
dom line.
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3.4.3 Create from Polygons
This option allows the user to create random line definition from already created
polygon. In the parameters, select the existing polygon and sub-select the Z-range
for the random line, which will be generated. Write an output name for this random
line and optionally, set check to display random line on creation so that after cre-
ation it will be displayed in the scene/tree. Press OK to proceed.
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An example random-line generated along the white colored polygon. The polygon
approximates the closure of a gas anomaly.
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3.4.4 Create From Wells
A random line can be created in such a way that it follows wells path. By right-click-
ing on Random line in the tree, and selecting Generate > From Wells ..., a dialog
box appears with a list of wells that can be selected in order to set up the random
line path.

Use the arrows to add and/or remove wells. Use the second set of arrows to setup a
well sequence. Specify whether you want to use only the well top position or not.
When you use all well points, you can specify the order by clicking the Change
Order arrows.

The Extend outward allows the extension of the random lines in both sides away
from wells.

Press the preview button to see a top view of the random line that will be created. If
the preview does not show exactly the desired random line, then change the para-
meters (the wells involved or the order in which they are listed). You can save the
newly created random line by specifying the name in Output Random line(s) field. If
you want to display the random line on creation, check the box Display Random
Line on creation.
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The following picture is an example of random line created from wells.
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In this picture, a random line goes through four wells following a random path
between these wells (which are used as constraints).
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3.4.5 Create From Table
This is launched from: Random line > right click > New > From Table

This allows the user to create a random line from table. The input here are whether
X/Y coordinates or Inlines/Crosslines and Z range.

The random line resulting from this table is shown below
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3.4.6 Interactive Mode
This option is launched via right-clicking on Random line > New > Interactive...

This allows the user to create random line from interactive mode. A horizon or Z
slice is first loaded in the scene, then a random line can be created by picking
nodes.

A window pops up asking the user to create a randomline from Polyline.

The user can now pick nodes on Z -slices or Horizons, as shown below:

After clicking OK, a random line is created:
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An attribute can then be displayed:
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3.5 2D Seismic
By clicking on the 2D Line entry in the tree, it is possible to either add 2D seismic
lines, create a 2D Grid form 3D data, create new lines from 3D data or generate 3D
cube from 2D data set (see picture below).

l Add: select one or more 2D lines

Chose how you would like the 2D line(s) to appear in the scene from the three
options shown below when clicking Ok:

l Display projection lines only: shows only the position of the 2D line(s) at the top of
the survey.
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l Load default data: the 2D line(s) are loaded into the 3D scene and displayed with the
data selected as default in the 'Manage 2D Seismics' window.
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l Select Attribute: loads the projection lines into the scene and brings up the 'Select
Dataset' window to choose what to display: stored, steering (if present) or attributes
from the active attribute set (if present).
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l Create 2D Grid from 3D...: This option can be used to create a 2D grid with a fixed
grid spacing. When selected, the Create 2D Grid window is launched. Here, specify
the input 3D seismic volume and the output data set name. The output grid is gen-
erated according to the dip (parallel) and strike (perpendicular) direction of the selec-
ted volume. For more detail, go to 6.1.2.1 Create 2D Grid.

l Extract from 3D...: Extract 3D data onto selected 2D lines. Input data is required in
the form of a stored 3D volume. One or more 2D lines can be selected for the 3D data
to be extracted onto. (Note: If just one line is selected, you may also sub-select a trace
range.) The output data set needs to be given a name.

Once several lines displaying data are loaded, additional actions are available (see
picture below). Selections can be made for all displayed lines.
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l Add attribute: Select an (additional) attribute to be added to the lines. (See above for
details).

l Replace attribute: Select an attribute from those displayed on the line(s). Once selec-
ted, this will launch the 'Select Dataset' window and a replacement can be chosen.

l Display attribute: Choose which of the available attributes to display.
l Remove attribute: Remove one of the loaded attributes (Only available if lines in the
tree have more than one attribute loaded in the tree).

l Display Attribute: Checks on the selected attributes to display them on the lines show-
ing in the scene.

l Hide attribute: Checks off the selected attributes to stop them displaying on the lines
showing in the scene.

l Edit Color Settings: Select an attribute and set the color bar and ranges:
l Display all/Hide All: Display or hide the line names, 2D planes and line geometry (pro-
jection lines).

l Show/Hide all items: Shows or hides all lines in the scene and checks/unchecks the
line names in the tree.

l Remove all items: Removes all lines from the scene and the tree.
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For each individual 2D line loaded in the tree, the right-clicking menu gives the fol-
lowing options:

l Add: Add either an attribute from the selection pop up window, a HorizonCube display
(if plugin available) or a System tracks display (if plugin available).

l Display: Allows the following:

l Histogram: The histograms of all attributes in the tree can be displayed using the
right-click option of the parent element (inline number, surface name...). It is a useful
tool to clip the ranges of an attribute. The vertical green lines show the current amp-
litude range and can be moved left or right using the left mouse-click and drag. The dis-
play is updated when the mouse click is released. Please note that this will toggle off
the automatic clipping. Histograms can also be displayed for each attribute inde-
pendently.
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l Properties: Use this option to set theMaterial, Texture and Line Style properties.
o Material: Set the base color for the projection line (2D geometry) and set the
reflectivity and transparency properties for the displayed attribute.

o Texture: Set the texture type.
o Line Style: Set line thickness.

l Resolution: Set the resolution of the displayed data.
l Show linename/2D plane/line geometry: Toggle on or off each of the 2D line com-
ponents per line.

l Position: Set the number of traces and Z-range of the displayed line.

l Duplicate: Duplicates the 2D line as displayed in the scene, including its displayed
attributes. Can be a useful option to compare colorbar settings, or be used to 'extend'
the eight-per-line attribute limit by replacing existing attributes with others on the duplic-
ate.

l Lock/Unlock Treeitem: Lock the selected object. It prevents accidental removing,
moving or displaying data on the object. Clicking "Unlock" enables editing again.

l Remove from Tree: remove that 2D line from the tree and thus from the 3D scene.
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3.6 Pointset & Polygon
A pointset is a set of locations. They have multiple uses in OpendTect such as for
data extraction in crossplot or neural network workflows.

The drop down menu gives the option to Add… an existing pointset or to create a
New one. The new pointset will either be manually picked in the 3D scene or auto-
matically generated.

A Polygon is a close line defined as connected points. It defines an area that can be
used to define an area of subselection for example. The drop down menu gives the
option to either Add… an existing polygon or to create a New… by manually picking
on a loaded surface (either horizon or Z-slice) in the 3D scene.
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3.6.1 Manual & Empty Pointsets
When an empty pointset is added to the scene, the locations (of object) can be
picked manually. This type of pointset is generally used for supervised neural net-
work training (see the dGB plugins help documentation).

To create an empty pointset :

1. Click on the pointset element
2. Select New > Empty from the drop down menu.
3. In the pointset Creation window, give a name and press OK to insert an empty pointset

in the tree.

4. Start picking locations in the 3D scene on data displayed in the 3D scene (inline, cross-
line, z-slice or horizon).
l To start picking, please make the pointset active by clicking on it in the scene or in
the tree (If active, it will be highlighted).

l Each click will add a point. If the point is wrong, it can be removed by using Ctrl key
and left mouse-button click.

5. In the tree, right-click on the name of the pointset you are interpreting and select Save
as… to save your pointset. The pointset will be saved as a *.pck file - the default
OpendTect format for pointsets and polygons, which consists of position information
(X/Y coordinates) and Z (in sec, meters or feet). In some cases the .pck file may also
contain directions, inline/crossline dips, inline/crossline numbers and text information.
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Example of manual picking. These points will be used in Neural Network training.
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3.6.2 Generate Random Points (3D)
Randomly generated points are very useful especially for property prediction or
object detection. This type of pointset has been defined in first place for unsu-
pervised neural network training (see dGB Plugin documentation for more details,
specifically: Unsupervised waveform segmentation (UVQ)).

To generate a random pointset, click on the tree element pointset/Polygon and in
the drop down menu, select: New pointset > Generate 3D.... The following window
pops up.

Generate locations by provides several extraction options (see below).
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A user-defined number of random points are created depending on the specified loc-
ation type. If selecting:

l Range: specify the inline, crossline and time range (or depth range if in a depth survey)
l Well: select one or more well(s) and specify a time range (or depth if in a depth survey).
Optionally add traces in the inline and/or crossline direction around the well track for
the location selection.

l Polygon: select a stored polygon and specify the time range (or depth range if in a
depth survey).

l Table: select either an already saved pointset or a Table file. The table file needs to be
X-Y-Z with no header.

l Horizon: select a horizon and select if you want the points to be extracted along the
selected horizon or the interval from that selected horizon to a second horizon to be
selected.

l Body: select if you want the extraction to be inside or outside the body that you selec-
ted. If outside, you need to specify the inline, crossline and z ranges for the extraction.
By default the outside box is the full survey box.

Optionally, a rejection filter can also be applied by selecting Remove locations (see
window below). It passes each random position according to a selected filter (ran-
dom, polygon, subsample, table, surface…). It is useful to avoid random points in
unwanted regions e.g. by providing a polygon.
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The number of random location to be extracted needs to be specified.

The pointset creation is finalized by giving it an appropriate name, selecting a color
to be used for its display and clicking Ok.

The name can always be changed later from the pointset manager. The
color can also be modified later on from the right-click menu on the pointset
name > Display > Properties.
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3.6.3 Generate Random Points (2D)
Random points for the 2D data can also be used for the same purposes and wor-
flows as random 3D picks.

The 2D pointset creation window (see below) is launched by clicking in the tree on
pointset/Polygon and selecting in the drop down menu New pointset> Generate
2D...

Random (2D) pointset creation window

The number of points to be in this given set needs to be specified. As this extraction
is done in 2D, the 2D line(s) where the locations will be extracted need to be selec-
ted. The location can be restricted with the Geometry selection (see below). It
depends upon the purpose/objective. For instance, if the objective is to detect facies
by using random vectors (points) on a surface, then horizon geometry shall be
provided.
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If selecting:

l Z Range: specify the inline, crossline and time range (or depth range if in a depth sur-
vey)

l On Horizon: select a horizon alomg which the positions will be picked.
l Between Horizons: select two horizons in between which the points will be extracted.

The pointset creation is finalized by giving it an appropriate name, selecting a color
to be used for its display and clicking Ok.

The name can always be changed later from the pointset manager. The
color can also be modified later on from the right-click menu on the pointset
name > Display > Properties.
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3.6.4 Polygon
A polygon is a close line connecting locations.

A new Polygon can be created by clicking on pointset/Polygon and in the drop-down
menu select New Polygon... The following window pops up.

The polygon creation is finalized by giving it an appropriate name, selecting a color
to be used for its display and clicking Ok.

The name can always be changed later from the pointset/Polygon manager.
The color can also be modified later on from the right-click menu on the poly-
gon name > Display > Properties.

To start interpreting a polygon, it needs to be activated by clicking on the element in
the tree. Polygon are picked only on z-slice and horizons. Display a plane in the 3D
scene, activate the polgon and start picking. The points will be connected by a line.

Double-clicking will close the polygon. Save the polygon by right-click on its name in
the tree > Save. When the polygon is active in the tree, each click will results in a
new point. To remove a point, press Ctrl and click on the point to delete. Move a
point by clicking on it and dragging it.

In the following picture we can see two examples of polygon pointsets, closed poly-
gon (deltaic facies belt), and non closed polygon (fault pointset).
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3.6.5 Pop-Up Menus
pointset/Polygon Element Pop-up Menu

This is the menu right-click menu accessed from the main pointset/Polygon element
when at least one pointset/polygon is already loaded (see pictures below).

It contains the following menu items.

l Add …: load a stored pointset/polygon in the 3D scene and tree.
l New: Create a new pointset/polygon (see 3.6 pointset & Polygon).
l Display only at sections: Display points only intersecting the displayed elements (plane
(s) and/or horizon(s)) in the 3D scene. This mode enables picking in a new location
without being distracted by previously picked points throughout the survey box.

l Display in Full: Display all the points of the pointset or the full polygon within the sur-
vey box.

l Merge Sets: (for pointsets only) Merge stored pointsets into a new pointset. A window
pops up and the sets can be selected. A name for the output set should be defined.
pointsets can also be merged from the pointset Manager.

l Save changes: The pointset/polygon changes can be saved and reloaded at any time
during the building process.
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When more than one pointset/polygon are loaded in the tree, the menu has addi-
tional entries:

l Show all items: Display all the pointsets/polygons from the tree in the 3D scene.
l Hide all items: Unselect all the pointsets/polygons from the tree. They are no more dis-
played in the 3D scene.

l Remove all items: Remove all the pointsets/polygons from the tree

pointset / Polygon sub-elements Pop-up Menu

If at least one pointset or polygon is loaded in the tree, then the following options are
available from the right-click menu (see picture below):
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l Calculate Volume: In OpendTect, an estimated volume can be computed from a poly-
gon to a given surface. The velocity default is set to 3000 m/s. Negative thicknesses
can either be discarded or taken into account.
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l Convert to body: (for pointset only) Convert the pointset into a body.
l Create Body: (for polygon only) Create a body using the polygon as a constraining
area. It requires a top and bottom horizon between which the body would be created.
This feature is only enabled if SSIS plugin is loaded (or licensed).

l Close polygon: (only when interpreting a new polygon) During, and at the end of a
picking session, pointsets should be stored.

l Display:
o Display only at sections: Display points only intersecting the displayed elements
(plane(s) and/or horizon(s)) in the 3D scene. This mode allows to pick new locations
without being distracted by previously picked points throughout the survey volume.

o Properties: In this window the Type, Size and Color of the point markers in the 3D
scene can be set. The type Arrow is also automatically used when the point is given
directional information in the Set directions option under the pointset pop-up menu.

o Set direction: (for pointset only) Display direction, guided by the Steer-
ingCube/attribute. This helps to understand the geological dips and fluid flow. It is
assigned by setting a direction to each point based on dip and azimuth information
(attributes). In the pop-up window (see below), specify either a SteeringCube or two
attributes providing the polar dip and azimuth in degrees. A velocity of 2000 m/s will
be used in time survey to convert the dip from degrees to µs/m if the dip angle data
is read from a stored cube instead of the dip angle attribute. Do not forget after set-
ting the directions to save you pointset and change the display type to "Arrow".
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An example of setting direction (black arrows) to a pointset.

When setting the direction for a given pointset, you can select to get the direction
from a SteeringCube or from the Azimuth and Dip attributes (stored or on the fly)
(see picture below)



- 131 -

l Save/Save As: Either overwrite the stored input by using option Save or store as new
pointset / polygon by using Save As option.

l Lock / Unlock: Lock the selected object. It prevents accidental removing, moving or
displaying data on the object. Clicking "Unlock" enables editing again.

l Remove: Remove pointset/polygon from tree.

Removing any unsaved pointset/polygon will result in complete loss of the
unsaved interpretation.

l Export to Google KML: Export selected polygon to a Google KML file. When selec-
ted, the following export window is launched. Fill in the output KML parameters and
write/select the output file location. Press the 'Ok' button to export the polygon in the
selected location. The feature will prompt an additional conversion dialog if the con-
version settings for the survey are not defined. For further information, please refer to
the Survey Selection section.

Export the polygon to a KML file
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3.7 Horizon

An existing horizon can be displayed in the scene by selecting Add option from the
pop-up menu (see above). It will launch a horizon selector window from which mul-
tiple horizons can be selected. See also Add color blended.

Once at least one horizon is displayed, there is an addition to the pop-out menu, Dis-
play All, which contains several options: only at sections, in full or both at sections
and in full.Only at sections results in a horizon display (as a line) on the inline/cross-
line/timeslice. Full displays the complete horizon in 3D space.
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Track new sub menu is used to start a new horizon interpretation.

The popup menu from a displayed horizon has several options, which are covered
in the following sections:
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3.7.1 Add Attribute
This allows choosing the data to display on the horizon from stored cubes, a cal-
culated attribute from the current attribute set, or horizon data that were included
with the horizon already. For Horizon data a dialog will popup where you can select
multiple data files. After loading you can browse through the data by pressing the
'Page Up' and 'Page Down' buttons on your keyboard.

For PgUP and PgDn to work, the mouse pointer must be in the scene.

Once a horizon is added (with its Z-values displayed in the scene), it is possible to
also right-click on 'Z-values' in the tree to give you other options:
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Furthermore, once a horizon has an attribute displayed, it is also possible to 'Save
as Horizon Data'... and will be visible in the 'Manage 3D Horizons' window:
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3.7.2 Color-Blended Display

ð becomesð

The load color blended sub-menu displays an RGBA (red-green-blue and alpha)
blended horizon(s) in the scene. This is used to blend multi-attributes with similar
spectral outputs. This is an interactive tool especially to color blend the iso-fre-
quency grids (or attributes).

Color blended display:

RGBA* blending attribute display is used to create a normalized color-blended dis-
play that often show features with greater clarity and enhances a detail map view.
Traditionally, it is used to blend the iso- frequency responses (Spectral Decom-
position), but a user can blend three/four different attributes that define a spectrum
that is comparable. For instance, spectral decomposition outputs the amplitude at
discrete frequencies. So, it renders the same output (unit=amplitude). Depending
upon a geological condition or the objective, FFT short window or CWT (continuous
wavelet transform) can be chosen. Results are best displayed on time/horizon
slices, volume.
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A color blended map view (image on right) of the spectral decomposition (red-10hz,
green-20Hz, blue-40hz). Compare the results with the coherency map (image on
left). Note that the yellowish colored fault bounder region is thicker as compared to
the surrounding regions. The faults throw (red-color) are also clearly observable.
Semblance/similarity together with color blended spectral images can reveal better
geological information.
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3.7.3 Tools
Several processing algorithms may be applied to horizon and will be described
here:

l Adding points to existing horizons by interpolation (grid)
l Filtering interpretations
l Snapping an existing interpretation to a given amplitude event.
l Storing the Reference Z as an attribute

The recommended workflow order after horizon tracking is:

1. Snap the interpretation to a given event (min/max/zero crossing).
2. Grid the snapped grid since snapping can generate holes.
3. Filter the output grid.
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3.7.3.1 Grid
This utility is used to grid/interpolate a horizon having gaps/holes or to filter (aver-
age/median) a horizon grid. There are several gridding algorithms supported in
OpendTect.
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Gridding Parameters:

l Geometry: There are different types of geometries that are used to do interpolation.
The Full survey is used to interpolate (in-/out-wards) the Horizon-Z values within the
entire survey box. The Bounding Box defines the rectangle fitting the horizon geo-
metry, which is generally smaller than the survey box. The Convex hull type of area fit-
ting also restricts the gridding geometry within the horizon boundaries. To grid the
gaps or holes in a horizons, the Only holes type of gridding geometry is used.

l Inl/Crl step: The default steps correspond to the sampling rate of the input horizon.
The step can be decreased up to the survey sampling rate to get a higher resolution
horizon.

l Algorithm(s): Inverse distance algorithm uses an inverse distance method of inter-
polation. Inverse distance requires the search radius with optional parameters (step-
size and number of steps). The step size of '1' means that one bin would be used in all
directions to interpolate the horizon Z-values. Whereas the number of steps define the
number of concentric circles for inverse distance computation. For these steps, the
grid computation can be set to the corner points for the defined radius or not (default
option).

l Triangulation is a fast gridding algorithm, which uses triangulation method of inter-
polation. The interpolation can also be defined by providing an optional maximum dis-
tance (radius) by setting interpolate option checked.

l Extension uses a simple linear interpolation algorithm to extend the horizon Z-values
outward using the number of steps (bins), which need to be defined in the following
parameter field (Number of steps).
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l Continuous Curvature (GMT) is a continuous curvature algorithm of interpolation,
which is a part of the GMT Plugin of OpendTect. Please check the GMT website for fur-
ther details. This algorithm only requires the tension parameter (ranges from 0-1),
which controls the smoothing. The tension 0 gives minimum curvature type of surface
interpolation, while the tension of 1 gives a harmonic surface.

l Nearest Neighbour (GMT) is also another interpolation algorithm coming from the
GMT Plugin of OpendTect. This algorithm requires the search radius to be defined. It is
mostly useful for a regularly spaced grid data. Please check the GMT website for fur-
ther details.
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3.7.3.2 Filter
The "filter" utility enables filtering of the horizon using either median or average fil-
ter. The inline and crossline step-out should be defined. The larger the step-out, the
smoother the result of the filter.



- 143 -

3.7.3.3 Snap-To Event
In case the horizon is not correctly snapped to a seismic event, this option can be
used. The user should define the input data, the event type (peak or trough, zero-
crossing etc.), the search gate relative to the original horizon, and whether the
snapped horizon should be saved as new or overwrite the original horizon.
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3.7.3.4 Variogram
For any horizon data displayed on a horizon, a horizontal variogram can be com-
puted:

The variogram describes the spatial continuity, here in the horizontal direction but it
can also be computed vertically from the crossplot tool. It is commonly represented
as a graph that shows the variance in measure with distance between all pairs of
sampled locations. Modeling of relationship among sample locations to indicate the
variability of the measure with distance of separation is called Semivariogram or
Variogram modeling. Variograms are important when doing inversion as it allows to
predict a value at a location where it has not been measured.

To compute the variogram, parameters need to be provided: the maximum range
(maximum distance allowed between the pairs for the analysis), the step and the
minimum pairs per log distance:
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Once the variogram has been created, the analysis consists in finding the model
that best fits the measured data in changing the variogram type and changing the
sill and range:
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3.7.4 Display Contours
Add Contour Display: This option displays the contour on the horizon. That the
contour step (interval) is automatically calculated but can be edited at any time. The
input for the contour display can be either a reference Z or any surface attribute like
Similarity, Energy, Dip etc ...

The contours properties can be manipulated by right-clicking on the Contour attrib-
ute in the horizon element.

A user can adjust contour range/index, color and line thickness.
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The images below show a horizon with both reference Z and Similarity contours,
respectively:
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3.7.5 Calculate Isopach
Calculate isopach: This option will compute the time or depth difference between
two horizons. The computed grid will be displayed as a new layer on this horizon
and may be stored as a surface data. The output will always be in seconds, meters,
or feet.
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3.7.6 Flattening
Write Flattened Cube: It creates the flattened seismic at specified time value of
horizon. The output is stored as a new flattened cube. The user can choose the
benefit of this option by flattening the cube at the horizon.
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Create flattened scene: This option enables the user to create a second scene in
which the data is displayed relative to the flattened horizon. This can be a very use-
ful tool in specific situations. By flattening a horizon, the user gets an idea of the
approximate section at the time of the deposition of this horizon. The tectonic history
can be derived from the difference between the original section and the "restored"
section. Another advantage of flattening the horizon is that it becomes easier to eval-
uate the depositional environments.

Unflattening the cube: Should you need to unflatten the cube then please refer to
the following: Delta Resample Attribute
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3.7.7 New Horizon
3D Horizon > New right- click menu in the Tree allows user to create new
3D horizons using one of the following:

l Auto and Manual Tracking: interpret a horizon in a highly interactive 3D Auto-track-
ing workflow, or perform traditional interpretation using Section Auto-tracking and
Manual Draw.

l With Constant Z: create a horizon with constant Z value
l Track Unconformity (requires Dip-Steering plugin): create a horizon from picked
seed positions by inverting the dip field (given in the form of a Dip-Steering Cube). This
tool can be used to track unconformities, seismic events corresponding to well mark-
ers, and/or create a quick geologic model with minimal input from the interpreter. For
more details refer to the dGB Plugins documentationdGB Plugins documentation.

https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm
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3.7.7.1 Auto and Manual Horizon Tracking
3D horizon interpretation in OpendTect can be conveniently started from the right-
click menu of 3D Horizon > New > Auto and Manual Tracking in the Tree of either
3D scene or 2D viewer.

Basemap (requires OpendTect Pro license) significantly enhances any inter-
pretation workflow. For example, it allows to conveniently operate random lines
when QCing results of 3D auto-tracking.

3D Auto-tracking

3D Auto-tracking is the primary, highly interactive workflow for horizon interpretation
in OpendTect. The user starts with a few picked seeds, auto-tracks in volume, inter-
actively QCs, as needed re-tracks with updated parameters and/or edits, and locks
QC-ed interpretation. Then interpretation continues by iteratively repeating the
steps. The advantage of this workflow is that the horizon is QC-ed while interpreting
and, therefore, saves time on editing. Any remaining holes can be filled at a later
stage using one of the gridding algorithms.

The workflow operates in the 3D scene via Horizon Tracking Settings window, Ctrl +
right-click menu, and/or keyboard short keys (Shift + ? to see all).
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, and/or
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A seismic event in 3D volume is tracked starting from user-picked seed locations fol-
lowing user-set rules (Horizon Tracking Settings window) on:

l which seismic event (min/max/zero-crossing) to follow within a search window;
l and when to stop auto-tracking by comparison of the current tracking position with
either a user-picked seed location (Seed Tracemethod) or a preceding auto-tracked
position (Adjacent Parentmethod) based on event amplitude (either relative difference
threshold or absolute amplitude cut-off) and (optionally, but recommended) trace
cross-correlation within comparison window.

Optionally, seismic dips can be used to guide the auto- tracker (a Dip-Steering
license is required).

The Seed Trace method is more conservative and is recommended in structurally
complex areas. The Adjacent Parent method tracks larger areas with the same set
of input seeds and tracking parameters, which makes it faster to produce horizons,
but the risk of loop-skipping increases. It is recommended only for continuous hori-
zons.

Section Auto-tracking

Using Section Auto-tracking mode without 3D Auto-tracking functionality is a tra-
ditional interpretation workflow, in which the interpreter points a horizon on a certain
grid (usually regular: for example, every 10th inline and 10th crossline). It can be
done both in 3D scene and in 2D viewer. The interpreted horizon is then inter-
polated using one of the gridding algorithms.

Manual drawing

This option is used to manually pick horizons in areas where auto-tracking is not
feasible.
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3.7.7.1.1 Horizon Tracking Settings

3D horizon interpretation in OpendTect can be conveniently started from the right-
click menu of 3D Horizon > New > Auto and Manual Tracking in the Tree of either
3D scene or 2D viewer.

Horizons can be tracked in various modes:

l Section Auto-tracking
l Volume Auto-tracking
l Manual Drawing with and without snapping

OpendTect supports the following ways of picking:

1. Auto-tracking mode:
l Recommended: Left-click to add seeds (seeds are stored with a horizon).
l Optional: hold Left-click and draw along the section, seeds will be automatically
added.

l Ctrl + Left-click to remove seeds.
2. Mouse draw:

l Recommended: hold Left-click and draw along the section to create an individual
patch (patches can be connected by simply drawing with overlaps).

l Optional: left-click to pick an individual patch and double-click to finish it.
l Hold (Ctrl + Left-click) and drag to erase interpretation along the line.

Horizon Tracking Settings window.

Right-click 3D Horizon in the tree and select New > Auto and Manual Tracking. This
will launch Horizon Tracking Settings window which contains several tabs. Option-
ally, the dialog can be retrieved by right clicking on the horizon in the Tree
and choosing Tracking > Change Settings.

Mode Tab
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Choose the tracking mode:

l Section Auto-track is used to auto-track a horizon along a section (inline, crossline,
and random line) of a given volume. If a sub-volume is preloaded, only the sub-volume
area will be auto-tracked. When this mode is selected, the volume auto-tracking icon

will be active, which requires seeds.
l Seed Trace is an auto-tracking method which only compares seeded traces to do
auto-tracking.

l Adjacent parents utilizes the last known trace positions to compare amplitudes to
do auto-tracking. This increases chances of loop skipping.

l Manual Drawmode will manually pick a horizon (interpolated line) between two clicked
or mouse dragged positions. Optionally, it also snaps to a selected event between the
picked positions. This mode is used in difficult areas, for example to cross faults, noise
zones or to interpret unconformities.

Event Tab
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Event Tab contains the defining parameters for Section / Volume auto-tracking.

l Input data: The input data is automatically selected when you pick on a section. This
can be the original seismic volume, or a filtered seismic volume (preferred) or any
other attribute. The horizon is linked to this input seismic. you can change the input
seismic at any time: it won't change your saved interpretation. If you change the data
during interpretation, the next click on the new data may show a warning message. If
you continue, then the new data will be used to do auto-tracking.

l Event type: Specify the event type you want to pick. The tracker can track negative
reflectors (Min), positive reflectors (Max), a Z-type zero-crossing (0+-), or a S-type
zero-crossing (0-+). If the tracking does not seem to work, check that the event type
corresponds to the event you actually interpreted the seed(s). If Seed Tracemethod is
chosen then one can interpret a mixed phased horizon.

l Threshold type:
l Cut-off amplitude: Here, an absolute amplitude is used as the stopping criteria for
the tracker. When the tracker encounters a value below this threshold value it stops
tracking. (For a max-event the tracker stops if the value is below this threshold
value, and for a min-event when it is above this threshold value). Tip: point your
mouse at the event and the amplitude value is displayed at the bottom of your
screen.

l Relative difference: The tracker will compare the amplitude of the last tracked point
to the amplitude of the point that is candidate for tracking. If the difference exceeds
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the chosen percentage, the tracker stops tracking. Further explanation on Steps is
given below.

l Search Window: The tracker searches for the chosen event type based on amplitude
in a time window relative to the last tracked sample.

l Display Window: This controls the display of WVA/VD of the surrounding trace seg-
ments near the last picked seeds. One can control the display window and number of
traces. This gives an overview of the picked location. In the display, one can also
change the search window by moving the green lines up/down.

At the bottom of this tab, one may see a status note on picked/current data on which
interpretation is being performed.

Correlation Tab

A trace segment around the last tracked point is compared to all the trace segments
on the neighboring traces around the points that lie within the Search window (See
figure below).

In this tab, one can do auto-tracking by turning the correlation ON. The correlation
window should be small enough to ensure a waveform. The threshold is generally
strict (80% or higher) to track only high quality amplitudes. The correlation window
size can be changed by moving the green lines in the display window.
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Properties Tab

This tab is used to adjust the display properties of the horizon and corresponding
seeds. Optionally, you can also change the color codes for various parts (parent
paths, selection of a horizon if you intend to remove through a polygonal selection,
locked tracking areas) of the horizon.

Dip Steering Tab
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A SteeringCube can be added as a constraint for horizon interpretation. This will
improve the horizon tracking especially in the areas of dipping reflectors. Dip steer-
ing gives structural information.

3D Auto-Tracking Menu

A dedicated 3D Auto-tracking menu is generally launched by CTRL + right click in
3D scene.
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Using this menu, you can control several tracking features.

Tracking Workflow

After adjusting the parameters in the tracker setup (which can remain open during
tracking), start picking seeds on a displayed inline/crossline.

Please refer to How-to instructions for step-by-step workflow on 3D Auto-tracking
and Tracking in 2D viewer.

Auto-tracking in a 3D volume

Auto-tracking in 3D is done in following steps:

1. Pre-load a sub-volume (Survey > Pre-load > Seismic) within which you intend to do
auto-tracking. If the volume size is small, you may pre-load the entire volume in the
memory.

2. Launch the basemap window (View > basemap) to move the sections and QC the inter-
pretation.

3. Add inlines / crosslines / random line.
4. Add a new 3D horizon in the tree.
5. Pick several seeds on inlines / crosslines / random lines and adjust the tracking para-

meters.
6. Press the auto-track button.

https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm
https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm#tm7/workflows/general_interpretation/auto-track_3d.htm?TocPath=General%2520Interpretation%257C_____2
https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm#tm7/workflows/general_interpretation/tracking_in_2d_viewer.htm?TocPath=General%2520Interpretation%257C_____3
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7. If the tracking result is good, you may lock (CTRL + right click) the results so that
they are not changed. You may unlock the old tracking paths if you want to change
them during interpretation.

8. Otherwise, you add more seeds and choose re-track from seeds .
9. You can optionally, remove the wrong paths at a mouse location by using CTRL + right

click menu (Select parent / children paths and relaunching the menu to remove the
selection).

10. Another option is to launch a 2D Viewer of parent paths to edit auto-tracking errors. If
you do that, then you may have to re-track from seeds again.

Some Important Tracking Short-cuts:

l CTRL + Z:  Undo the last action.
l CTRL + Y: Redo the last action.
l CTRL + S: Saves the horizon.
l k : Auto-track.
l SPACE bar: Switches between picking (cross) horizon and dragging (green
pointer) sections.

Manual Drawing on Sections (2D/3D)

You can manually interpret a horizon by drawing on the seismic section. OpendTect
supports both picking methods: drawing like a pen (Tablet/Touch screen) or mouse
clicks. If you have picked a part of a reflectors, a green colored (temporary) line will
appear. To confirm interpretation, you will required to double click. This will show a
horizon segment in actual color. This method is very useful for picking in difficult
areas (noisier zones or unconformities).
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3.7.7.2 Create Horizon With Constant Z
3D horizon with constant Z-value can be created from the right- click menu of
3D Horizon > New >With constant Z.
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3.7.8 Shift
Shift: The scrollbar allows the user to scroll the 3D horizon vertically. The shift
range allows the user to define the upper and lower boundaries of the scrollbar
range. The step size defines the distance between each possible horizon position.
(e.g. A range of -100 to +100 with a step of 10 allows for the user to scroll through 20
possible horizon positions, centered about the original position.) Different attributes
can be calculated for the horizon in this user defined shift range. The user can then
use the scrollbar to move up and down and view the attribute as it would appear on
that horizon at the various shift positions. This shifted horizon can be saved as sur-
face data to be viewed later.
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3.7.9 Calculate Volume
Calculate volume: It is used to calculate the volume between the two horizons.
The volume is calculated within an existing polygon. Select the polygon and press
Estimate Volume button to calculate the volume within the polygon. To read more
about this, please go to the chapter pointset: Pop-up Menus
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3.7.10 Other Options
Properties: The Material window allows changing of the graphical settings like
transparency, line style, and thickness.

Resolution: The resolution of a horizon can be changed for performance reasons.
When using a low-end graphics card, performance during rotating and moving the
scene may suffer. By showing the horizons in a lower resolution, scrolling and rotat-
ing becomes smoother. By default, the resolution is set to Automatic. This setting
uses higher resolution in areas where a horizon has a complicated shape, and low
resolution in relatively flat areas. Also, when rotating, the resolution will be set to low
in order to enhance responsiveness of the rotation action. When released again, the
resolution is set higher again. Attributes displayed will always have full color res-
olution, only the shape of the horizon surface is affected by this setting.

Horizon default resolution and colortable settings can now be defined under the
'Horizons' tab via Utilities > Settings > Look and Feel....

Quick UVQ: This option is related the Neural Network plugin license, if it is avail-
able. It is used to create a quick unsupervised facies map. For further information
please refer to the plugin documentation.

Use single color:When this option is selected, the horizon is displayed in a single
color, which can be chosen from a standard color selection window.

Display: The horizon can be displayed on the sections (inline/cross-
line/2Dline/timeslice) as a line, as a 3D surface or both.

Tracking: Horizons can be edited and tracked through the survey. The various
tracking options are described in here.

Save: The save option gets highlighted when changes are made to the surface geo-
metry. Save saves the new geometry of the horizon. If a horizon consists of
patches, you can save a sub-selection of these patches.

Save as: Save a sub-area or the complete horizon using an other name.
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Position: It is used to re-position (selected inline/crossline range) the displayed hori-
zon. In the position dialog, set the ranges of the inline or crossline to sub-select the
horizon display.

Lock: This will lock the selected object. It prevents accidental removing, moving, or
displaying data on the object. After clicking unlock, all manipulations are possible
again.

Remove: This option removes the horizon from the tree and the graphics area.



- 170 -

3.7.11 Store Z as Attribute
This option gives the possibility to store 'Z' values as a Horizon data for an horizon.
Subsequently, this newly created attribute can be used to change 'Z' values of
another horizon by means of Set Z values.

The name of the new 'Z' attribute and in which units it will be saved need to be spe-
cified.
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3.7.12 Set Z Values
A 'Z' value surface attribute (see Store Z as attribute) can be used to shift a horizon
or completely change its 'Z' positions using the Set Z values option.

Specifying values as Relative (deltas) will shift the horizon; infact the software adds
the attributes 'Z' values to the 'Z' values of horizon to achieve this shift. Absolute is
used while completely changing the 'Z' values of the horizon to the 'Z' values of the
surface attribute. Specification of units of 'Z' values (i.e. in 'milliseconds' or
'seconds') is also required.
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3.8 2D Horizon

Add... an existing 2D horizon into the scene.

Track new... Allows a new 2D horizon to be created.

Create from 3D...Generate 2D horizons from existing 3D horizons by right-clicking
on 2D Horizon in the tree and selecting Create from 3D. A window pops up where
you can designate the 3D horizon, the 2D data set and 2D line(s) where you want to
create the new 2D horizon. This function allows for the 2D horizon to be created on
one line, or on as many lines as a data set contains, all at once.

Once you have selected a 2D horizon, two other options become available:
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The selected horizon(s) will be displayed in the scene. To start a new 2D horizon
interpretation, read the chapter How to interpret Horizons.

The displayed 2D horizon pop-up menu contains the following items:

These options are described in the following sub-sections.
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3.8.1 Display

Properties: Change the display settings for a horizon (color, reflectivity, line style).

Only at sections: Display the tracking horizon at section. This is especially usefull
for QC purposes to check if the tracked horizon lies on the expected reflector. Can
be toggled back to In full
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3.8.2 Tracking

A 2D horizon displayed in the Scene can be re-interpreted by enabling the tracking
option. Once it is enabled, it will launch the Tracking Setup window to start 2D hori-
zon interpretation on 2D lines. It will also enable the tracking toolbar. Furthermore,
the seed properties (e.g. color/size) can also be changed using this option.
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3.8.3 Tools

Snapping: This option allows for the selected 2D horizon to be 'snapped' to the
nearest event defined in the Event option (see below).
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Horizon before snapping(red), after snapping (green)

Interpolate: This is a 2D gridding option for horizon interpolation by filling the
gaps/holes in interpretation. If this option is selected for a horizon, it will pop-up the
following Horizon Gridding dialog box.

Keep holes larger than: By checking this box, the gridding interpolation area can
be defined i.e. by defining a threshold e.g. 2500m. By setting this value, the gridding
is restricted and gaps/holes up to a radius of 2500 meters will be filled.

Algorithm: Interpolation algorithms for 2D horizon(s). Currently, OpendTect sup-
ports linear and polynomial types of interpolation.

Output horizon:Overwrite or create a new horizon from the selected horizon .
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3.8.4 Workflows

Derive 3D horizon: Create a 3D-horizon from a 2D horizon. As soon as a 2D hori-
zon is tracked, a 3D horizon can be derived by right-clicking the 2D horizon in the
tree and choose Derive 3D horizon. A window pops up in which you can select the
algorithm (inverse distance interpolation or triangulation), shown in images below.
The results can be displayed immediately by selecting the Display after generation
option.

Create Flattened Scene: The 2D line(s) can also be flattened using this option.
Once clicked, it will create a new flattened scene based on the selected 2D Horizon.
(see also: Flattened Horizon Scenes)
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3.9 Fault

The fault option enables interpretation of either a new fault or loading an existing
one.

Add: Adds selected faults into the tree and displays them in the scene:
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New: Adds an empty fault in the scene (New fault 1) that needs to be named and
saved once the interpretation is completed.

Display all: If more than one faults have already been displayed or added in the
tree, this option will be available. It is used to display all faults in full, only at sections,
or at horizons, or both. It is also used to toggle On/Off the fault plane, sticks and
both displays.

Show all items: It is used to check all items, which means that all items would be
displayed in the scene.

Hide all items: It is used to hide all (check out) the displayed faults.

Remove all items: To remove all faults that are added in the tree, this option is
used.
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An example of a picked fault line on a seismic section:

Once a fault has been added, right-clicking will pop-out the following menus :
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Add

Attribute: Add a new attribute for fault element. Right click and choose 'Select attrib-
ute' to select the desired seismic volume. The attribute will be displayed along fault
planes. The example line with interpreted faults in a 3D volume has been shown
below. Note that the faults have seismic data displayed as an attribute along their
planes.

Volume Processing Attribute: It is used to add a special sub layer to the fault that
belongs to volume processing attribute. To read more about this, please go to the
Volume Builder Setup chapter.

Display

Histograms: It shows multiple histograms of the displayed data along the selected
fault plane.

Only at sections: It is a toggle that is used to display a fault plane on a section as a
stick.

Only at horizons: To display a fault plane on a horizon as a fault trace, this option
could be toggled On/Off.

Fault planes: If a fault has been displayed either on a section or a horizon, it can be
back into a 3D fault plane. This option toggles On a fault plane display.

Fault sticks: To see the fault sticks only in 3D, this option should be toggled on.

Use single color: It sets a single color to a fault plane display. Any displayed attrib-
ute along the fault plane will become hidden an only the fault color would be dis-
played.

Properties: Set the Type, Size, and Color of the point markers on the graphics
area.

Save: It saves the selected fault.

Save As: To save the selected fault with a new name, this option is used.

Lock: Lock the selected object. Prevents accidental removing, moving, or dis-
playing data on object. After clicking on Lock again (i.e unlocking), editing is
enabled.
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Remove: It removes the selected fault from the scene.

The sub-menus for the displayed attributes are explained below:

Select Attribute: It is used to select and display various types of data(see below).

Stored Cubes: Any stored volume could be displayed along the fault plane in 3D.

Attributes: Any attribute defined in the Attribute set window could be displayed.
This requires a pre-defined attribute set in the Attribute set window. It will be inactive
if no attribute is defined in that window.

SteeringCubes: If a SteeringCube has already been pre-processed it can be selec-
ted and displayed along the fault plane.

Save Color Settings: The active color table could be stored permanently or
updated for the displayed stored attribute. For instance, if you do not like the color
bar for a particular seismic data (say PSTM) that is Red-white-blue (color table) and
you want to change it into Magic, you could set it here. It will save the colour settings
for this specific stored volume (PSTM).

Move: To change the display level of an attribute, it can either be moved up / down
or placed to top / bottom.

Display: To make a fault semi-transparent, the transparency is used. One can also
visualize the histogram of the attribute.

Remove: It remove the selected attribute from the tree.
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For Fault interpretation, please see the interpret faults chapter
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3.10 FaultStickSet
A FaultStickSet is a set of sticks for faults interpretation. Sticks are segments that
are created by connecting two or more nodes.

The FaultStickSet tree item allows the user to create a new FaultStickSet or to load
an existing one.

The new FaultStickSet is inserted by selecting the New option in the tree. The blank
fault New sticks 1 will be inserted as sub-element of FaultStickSet.

The user can then interpret the fault sticks on inline/crossline/Zslice and/or on 2D
lines as well.

In order to create and edit a faultstickset, check first that the faultstisckset is active
in the tree, then do the following:
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1. Click along the fault to create your first fault stick for one specific section .
2. The second fault stick in the same section is created by shift + leftclick for the first point

then just leftclick for the next faultstick(s)
3. To remove a fault stick node, Ctrl+leftclick on the already picked nodes.
4. Once you are done with one section, move to another inline/crossline/timeslice/ or 2D

line to create new fault sticks. A simple click will start the fault stick creation.
5. If you want to edit one stick while being busy with another, just click on one of it nodes

to make it active. While editing, you can click and drag a node to another position.

After interpreting the FaultStickSet, use the option Save to save your set with an
appropriate name.

An example of a picked FaultStickSet with nodes, the active stick is the second from
right (the node connecting line is thicker)
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3.10.1 FaultStickSet to Fault
In OpendTect, newly interpreted faultsticksets (or a selection) can be transformed
into 3D faults and vice versa, from 3D faults the user can output faultsticks.

The conversion between faults and faultsticks is done in a special toolbar as shown
below:

In the toolbar, they are two modes: The Edit mode and the Selection mode:

Edit Mode: In this mode, nodes are yellow, the user can add nodes (click), remove
nodes (Ctrl+click). Nodes can be dragged from one location to another. New sticks
are created by Shift+click for the first node then just click for other sticks.

When using Space+click, this will duplicate the node(s) and new sticks can be
added to the user-defined direction.
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Nodes are yellow in Edit Mode

Selection mode:When this mode is active, Faults/Faultsticks are selected, copied
(or moved) to new or already existed faults/sticks group. The outputs are: New
group, merge to existing one, replace (overwrite) the already existed group.

Creating new group of faults/sticks in series will automatically rename group by
adding a suffix to the first new group name provided by the user. If the name is e.g
Fault-Area then automatically generated names will be like, Fault-Area_1, Fault-
Area_2, Fault-Area_3 etc ....

In Selection Mode, Nodes are green (selected) and pink (unselected)

When converting faultsticks into faults, please keep in mind that OpendTect doesn't
support the files that contain (1) Crossing fault sticks, (2) Fault sticks interpreted on
vertical (e.g. inline) as well as horizontal (e.g. Z slice) planes. If the input file
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contains such type of stick sorting, you might encounter problem in OpendTect to
get a regular fault plane.

Clicking the icon allows you to set the transfer (or conversion) settings which will
be applied after the copy or move is put into action:
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3.11 Body

Bodies are displayed and created from this tree item. Using the option "New poly-
gon body" the bodies can be drawn by picking on vertical and horizontal slices. The
body will always be the convex envelope around the picked locations.

It is also possible to create bodies from:

l An isovalue surface (implicit representation): The body is extracted from a volume
based on the amplitude distribution.

l A polygon projected between two horizons.

Bodies may be used for display but also the creation of volumes using the volume
builder: The inner and/or outer parts of the body are filled with constant value(s).

Stored bodies may be displayed in the scene by using Add...
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3.12 Well
Clicking the well-element in the pops up a menu with 3 options: Add, Tie Well to
Seismic and NewWellTrack

Basic Well Pop-up Menus

Add:Wells are added and displayed in the scene using Add option.



- 194 -

Tie Well to Seismic: Access the seismic to well tie module. Generally, three para-
meters are needed for a successful well-seismic tie: sonic/velocity log, density log
and a reference wavelet. The wavelet can be either imported or extracted in
OpendTect. Logs can also be created in the Well Manager.

New Well Track: Create new well tracks interactively in the 3D scene. After select-
ing this option the system will prompt for a well track name. After specifying the well
track name, display an element (inline/crossline/2D line) in the scene. Drawing the
well track on the selected element is enabled. After drawing the well track, right click
on the well track name and select the Save option. Note that drawing a new well
track works similarly to editing a existing well track. Well track-nodes can be picked
on the active elements displayed in the scene. Also note that a display with a Z-
scale (View - Z-scale) other than 1 distorts the appearance of distance in the 3D
view.

After loading new wells, items are added to the right-click menu as follows:
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Well popup menu (multiple) and menu for individual wells.
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Multiple Well Options

These options are available only when more than one well is loaded in the tree, and
can be accessed by right-clicking Well in the tree. The new options available when
multiple wells are loaded. Items described in the previous sections above will not be
described again here.

Create Attribute Log: creates selected seismic data as a log for multi-wells.

Constant Log Size: keeps a well log display width relative to a scene zoom ratio
i.e. a log display width increases with the zoom in and vice versa. However, this
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option can be toggled off by clicking on the sub menu item (Basic Well Pop-up
Menus). In the later case, a log display width is adjusted opposite to the zoom i.e. if
a scene is zoomed in, a log display width is reduced relative to the scene zoomed in
ratio and vice versa.

Show all: allows the user to toggle on all well names (top),well names (bottom),
markers, marker names, and logs.

Hide all: allows the user to toggle off all well names (top),well names (bottom),
markers, marker names, and logs.

Show all items: allows the user to toggle on all wells currently loaded and visible in
the tree.

Hide all items: allows the user to toggle off all wells currently loaded and visible in
the tree.

Remove all items: allows the user to remove all wells currently loaded and visible
in the tree. This only removes the wells from the scene, it does not delete them from
the disk.

Individual Well Options

Once a well has been loaded into the scene and is visible in the tree, right-clicking
an individual well pops-up a window with the following options:

Create attribute log: allows to create a new log by calculating an attribute along
the well track. A new window pops up where the attribute, log name, and the depth
range should be provided. The Depth range is defined as start depth, stop depth,
and sample distance.

Create log cube: enables to create a volume of a selected log. The log is duplic-
ated on a user-defined number of traces around the well location. More than one log
can be selected at once and one volume for each log will be generated. This allows
easier comparison between well logs and seismic data.

Properties: sets various display settings of a well track, the logs, and the markers.
The properties can be set for each well and can also be updated for all wells dis-
played in a scene. The later can be done using the button Apply to all wells available
in the Well Display Properties window.
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Log display, Markers display and Track display properties

Well Log Properties: In a scene, the log are displayed using the Left Log and Right
Log tabs. The logs are displayed on the left and/or on the right of a well track accord-
ing to a current view. The log properties include the log selection, log range, fill color
and the the thickness of the log line. None refers to no log selection/display. If the
logs are already imported, the Select log should contain the name of the logs in the
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drop down list. The data ranges and the color ranges are updated automatically
from the selected log. However, both fields are editable. Two types of log displays
styles are supported. For a standard log trace display style Well log radio button is
selected. For a wiggle display, the Seismic radio box is selected. The well logs can
be filled with any selected color table. The color ranges can also be manually
set/clipped. However, the seismic style contains different settings. The synthetic
seismic traces can be displayed by toggling the Seismic radio box ON. The seismic
traces can be repeated by specifying the repetition numbers in the spin box adja-
cent to the Repeat text. The Overlap field refers to the overlap percentage of the
repeated traces. Optionally, dual logs spectra can be displayed together on the
same side by displaying one log as a trace and filling the color with another log (Fill
with Log).

Well Track Properties: The track properties are modified in this tab. The track line
thickness is changed by scrolling the Line Thickness spin box. The well track/name
color is updated by pressing the colored button. The well name can be displayed
above and below the track. The name size can also be increased or decreased. It
may be noted that the name size is adjusted relative to the 3D zoom.

Well Marker Properties: Well marker properties tab include the settings for
marker's name size, color, shape (3D), etc. The marker size is adjusted using the
spin box (up/down). The limits for the size are set from 1 to 100. The color of all
markers of a well track can be changed in to a one unique color. This is supported
by the 'use single color' option. If the same color is to be assigned to all available
well markers, set check to this field and select the color. Additionally, three different
3D shapes are supported (Cylinder, Sphere, Square). The cylindrical shape is
added for orthographic camera displays, which is better for the visualization pur-
poses. The height of a cylinder is supported.

Edit Welltrack: Allows you to add or delete nodes to the well track. Deleting nodes
is done by holding CTRL and clicking a node. Adding nodes is done by making
"node points" on any of the active elements on your screen. Remember that the Z-
scale caused a vertical stretch, distorting the appearance of real distance in the 3D
view.

2D Log viewer: This property allows you to display a well log in a 2D scene. The
display in log viewer is driven by the 3D scene. To interactively display different
logs, go to the well properties and make the desired changes.
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Save: Stores a new well or saves the changes that were made to an existing one.
Provide a name for a new well, and if a depth to time model is available, select the
file. The file should have the same format as when importing a welltrack. Optionally,
you can examine the file using the corresponding button. Specify if the model uses
TVDSS or MS, also the measurement units.

Lock / Unlock: Locks the selected object. This prevents accidental removing, mov-
ing, or displaying data on the object. After clicking unlock all manipulations are pos-
sible again.

Remove: Removes the well from the tree (not from disc).
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3.13 Pre-Stack Events

This tree item allows you to display picked or imported prestack events in the 3D
scene. Note that this tree item is only display when there are prestack events in the
current project. Otherwise it is hidden.

There are five display modes:

l None: nothing is displayed.
l Zero offset: A point shows the location of each prestack events, and the Z value of the
zero offset.

l Sticks from sections: points show not only the location but also the moveout curve
described by the picked events.

l Zero offset on sections: Same as zero offset, but only the events that exists on dis-
played inlines/crosslines will be shown.

l Sticks to gathers: Same of sticks from sections, but only the events that exists on dis-
played 3D prestack planes will be shown.
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The displayed points are always linked with a thin line. Regardless of the display
mode the points are colour-coded with respect to the following color settings:

l Single: Default mode, one single color for all points of the prestack events.
l Quality: The color of the points is related to its quality. This attribute is either imported
with the prestack event or set when picked in the Velocity Model Building plugin.

l Velocity: The color of the points is related to the corresponding interval velocity. Note
that for this to work the input prestack datastore and corresponding migration velocity
must be specified in the velocity model building plugin.

l Velocity fit: The color of the points is related to the deviation between the picked
event and velocity of the best fitting normal/residual moveout curve. Note that for this
to work the input prestack datastore and corresponding migration velocity must be spe-
cified in the velocity model building plugin.

The color of the points, except in single mode, should be adjusted using the colorbar
like with any attribute by ajusting the colorbar and amplitude ranges.



- 206 -

3.14 Pre-Stack 3D Viewer
Prestack gather selection from the tree

Prestack (PS) gathers can be displayed in the 3D scene, perpendicular to an inline
or crossline. Post stack data must first be displayed on an inline/crossline. The post-
stack data does not need to be linked to the prestack data. Once the line is loaded,
go to interact mode (graphical toolbar, second icon from the left), right-click in the
scene your inline and use the option Display PS gather. The menu will list any
prestack data available (loaded) in the survey. Please note that multiple PS gathers
can be displayed on the same inline, and moving the inline to another position will
keep the position of the PS gather and update its content.

Right-click menu of a vertical slice tree item when prestack datasets are available.
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Poststack data on an inline (left) with a prestack gather displayed perpendicular to
it.

Positioning the prestack gather

When a prestack data is displayed in a scene, the prestack positioning window also
pop-ups (look at the corners of the screen). By using this window, the prestack data
can be scrolled interactively. The crossline value locates the currently-displayed
prestack panel. That can be scrolled at given steps (increment). You can use either
the arrows or the mouse wheel over the inline/crossline value.
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Right-click options for a prestack dataset

Right-click menu on the prestack gather display to open it in the prestack 2D viewer.

Properties

There are several display properties available that are described below. Please
note that the gathers are first displayed without any processing. This can be set
together with other properties in the PS gather display properties:

l Shape: The shape tab will set the size of the gather with respect to other 3D elements
and its relative position

l Appearance: Color bar, amplitude ranges and grid lines can be set in this tab.
l Scaling: This tab is used to scale (clip) the amplitude range of the displayed data.
l Preprocessing: Pre-processing may be applied to enhance the display. The available
algorithms are presented in the prestack processing chapter.
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Resolution: Interpolates the data to get a better display (consumes more memory).

View in 2D panel: Transfer this dataset to view it in the prestack 2D viewer.
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Amplitude spectrum: Display the average frequency spectrum of the trace of that
gather, for the displayed Z range.
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3.15 Annotations
With this option, you can draw arrows, load images, and write text on the display win-
dow by right clicking in one of the items in this tree.

Arrow: You can add new arrow groups, change the properties, lock-unlock, and
remove them by right clicking on this element.

Once you have added a new arrow group, named it and saved it, you can now click
in the scene to add arrows (CTRL+left-click to remove an arrow). The arrow prop-
erties can then be changed by right-clicking on the newly inserted arrow group and
selecting the properties from the fold-out menu. In the arrow properties, arrow type
(top, bottom or both heads), color, width and size are adjusted.

Arrow style properties

Image: Once you have added a new image group, you can click in the scene to add
an image (CTRL+left-click to remove an image). It is then possible to store, resize,
change image, lock-unlock, and remove it by right clicking on the relevant image
group in the tree.
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Add a new annotation group and changing the position of the annotation

Text contains two pop-up menus:

l Add Text Group: Adds a blank text group
l Load: It is used to load the stored annotation group(s).

The text group pop-up menu can be launched by right clicking on the text group
name.

l Size: Resize the text group. It may be noted that it will resize the all inserted text sub-
elements according to the new size.

l Save/Save as: Saves the text group in to an existing name/new name.
l Change Text: it is used to replace/change the text of the selected annotation. It may
be noted that in the tree pop-up menu it si inactive. A user can only change the text of a
selected annotation. It is done by right-clicking over the annotation in a working scene.

l Background Color:Modifies the background color of the annotation.
l Lock: If lock is selected, it will prevent further modification of the group.
l Remove: It removes the group from the tree/scene.

Scale Bar: Use this option to add a scale bar to an inline, crossline or Z-slice. Once
added and saved, right-clicking on this element will also give you the option to
change the properties.

For Inlines and Crosslines, this includes the Horizontal or Vertical direction options
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For Z-slices, this includes the X or Y direction option



- 218 -

4 Survey

4.1 Select & Setup Survey
Find more detailed instructions on this topic in the Workflows Documentation.

The Survey module is used to select, create, modify, delete or copy surveys. A sur-
vey defines the geographical boundaries of an OpendTect project and relevant pos-
itioning information such as the relationship between inline/crossline and X/Y
coordinate systems. Each survey (project) stores its data in a separate directory
that needs to be specified along with the survey reference name.
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4.1.1 Survey Selection Window

The three tabs, Information, Notes and Log show their respective data:
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Notes can be edited manually.

Select an existing survey from the list of surveys on the left or create a new one with
New ... (see below). The boundaries of the survey are depicted in the field to the
right and detailed in the information field . The Notes field is a free-format text
field to store relevant survey notes.

When you install OpendTect, selected an OpendTect data dir-
ectory where all your surveys are stored:
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Any folder can be turned into an OpendTect folder, the only change being the addi-
tion of a parameter file (.omf).

Only surveys stored in the selected OpendTect folder are displayed and can be
accessed. Later you can open another OpendTect folder clicking on Survey Data
root. The current data root is always displayed on the top of the window.

Use for creating new surveys

Use for editing survey box ranges or update coordinate information (see Edit Sur-
vey Window)

Copy whole surveys from your data root to a designated location.

Allows you to compress/pack your entire survey into a zip file. This is highly
recommended when transferring your survey from a computer to another computer,
especially if they do not use the same platform. All data from this survey will be con-
tained in the zip file, with the exception of the SEG-Y and/or CBVS files that were
used 'in-place' from another location (ie: those SEG-Y or CBVS files that were used
but not actually put inside the survey folder)
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Unpacks a previously packed survey (see above) into your Data root folder.
Most zip files could potentially be unpacked, but we support only the unpacking of
survey packed using the OpendTect packing tool. If you wish to share your survey
with the community, visit our Open Seismic Repository.

Takes the user to the Open Seismic Repository. Here, one can find information
on how to share surveys with the wider community.

In the position conversion window there are two modes available for coordinate
conversion: Manual / File. In Manual mode, specify a inline/crossline pair, or a X/Y
pair, and press the corresponding arrow key to obtain the position in the other
domain. In File mode, browse the input file and create a new output file. By spe-
cifying the corresponding type conversion (XY to IC or IC to XY) and pressing the
GO button, the desired conversion is written to the output file. There is no specific
file type necessary for this input - even files without extension may be used. Simply
Select them and, if desired, Examine, too.
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is used to copy survey information to the clipboard.

is used to export the selected survey boundary in a *.kml file, which is accessible
via Google Earth. The dialog box contains the editable fields for the survey box. The
area of the survey box is filled with the selected color. The width is the horizontal
thickness of the survey outline. The border height is the altitude of the line with
respect to the ground. The Output file field is an output location of the *.kml file. On
'Ok' the file (*.kml) is written at the specified path, which can be opened directly in
Google Earth.
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Before exporting the *.kml file, specify the correspondence between X-Y coordin-
ates and latitude/longitude at any location in the surveybox :
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After pressingOk provide an output filename.
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4.1.2 New Survey Window
To launch the survey setup window select New in survey selection window.

Depending on whether you have OpendTect or OpendTect Pro installed, one of the
following windows will appear on your screen:
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Almost all setup options are available for both the Free and Pro versions, with the
exception of: Scan VDS file and Scan ZGY file.

Survey name: In the text area specify the OpendTect survey name.

Available data: Toggle on the data type(s) to be included in the survey - any com-
bination of: 3D, 2D and Wells. Note: Select only 3D, if the survey contains only a 3D
type data set. Select both 2D and 3D, if the survey is to contain both 2D and 3D type
data sets. If the survey contains only 2D type data set, select only 2D. Selection
type here affects the tree structure and what functions and attributes are available to
you once the survey is operational.

Initial setup: Determines how you set up the survey ranges and coordinates. Each
Initial Setup option will be dealt with in its own sub-topic, links below.

Z Domain: Can be in time or depth (for depth, define here the unit as m or ft)
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4.1.3 Edit Survey Window
To launch the survey setup window select Edit in the survey selection window. The
following window will appear on your screen:

All fields must be completed.

Survey name: In the text area specify the OpendTect survey name.

Location on disk: Specify a directory on disk where the OpendTect survey would
be stored. The directory would be turned in to the OpendTect survey location.

Survey type: For the survey type, there are three options:
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Select only 3D, if the survey contains only 3D data. Select both 2D and 3D, if the sur-
vey contains both 2D and 3D data. If the survey contains only 2D type data set,
select only 2D. Selection type here affects the tree structure and what functions are
available to you in the survey.

Ranges/Coordinate settings are described in the following sections.
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4.1.3.1 Survey Ranges
The survey ranges are the inline, crossline and Z-range values. The ranges define a
3D survey area for 3D seismic surveys and 2D grid area for 2D seismic surveys.
These fields can be filled manually, by scanning a SEG-Y file (2D/3D), using set for
2D only option in Ranges/coordinate settings, or by copying the ranges from
another survey. If the Workstation Access plugin is available, one will see the Get
from GeoFrame orGet from Seisworks option in the drop-down menu.

The set for 2D only option is especially used to create a 2D seismic survey. Set the
average trace distance and the x and y coordinate ranges, and these will auto-
matically be translated into suitable survey settings.

Click on the Scan SEG-Y file(s) button to select a SEG-Y file. In the new window,
you set the SEG-Y settings, see also SEG-Y san section. Pressing OK will start
scanning the file(s). After scanning, you'll get a file report containing sampling info,
data statistics, and the survey setup. The Survey ranges and Coordinate settings
will be filled in automatically.

The Z range is specified in milliseconds, meter, or feet. The steps are incremental Z-
steps of the survey i.e. the seismic sampling rate.
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4.1.3.2 Coordinate Ranges
The relationship between inline/crossline and X/Y can be specified in two ways. The
easy way is to specify three points, two of which must be on the same inline. Due to
rounding off errors, this method may not be 100% accurate.

In the I/C to X/Y Transformation tab, the exact transformation from one coordinate
system to an other can be specified. The Apply button can be used to verify results
graphically and to check the coordinate transformation formula.
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Starting in version 6.2 it’s possible to set an orthogonal coordinate system for each
OpendTect survey. At this point the following features are supported:

l if a coordinate system is set, Google KML can be exported
l single well import from another coordinate system
l for OpendTect Pro users:

l while creating an OD survey from Petrel, the new survey should be able to fetch the
CRS from the original Petrel project

l shapefiles support.
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4.1.3.2.1 Coordinate Reference System

OpendTect supports only orthogonal coordinates. Coordinate System of an
OpendTect project can be defined in one of the three ways:

Unlocated XY - spatially unaware, based on three points, two of which must be on
the same inline.

Projection Based System can be selected when a coordinate system is known.
The list of projections was created using Proj.4 filter function.

https://proj.org/
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For the Projection Based System, two additional options are available:

l View Details: pops up a dialog with concise information on the selected Pro-
jection System.

l Convert Geographical Positions option is available if Project Based System
is selected. This utility allows conversion of XY coordinate pair to geographical
latitude and longitude, and vice versa.
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In the Convert Geographical Positions window, there are two modes available for
coordinate conversion: Manual/File.

l InManual mode, the user specifies an X/Y pair (or Lat/Long pair), then press the cor-
responding arrow key to obtain the position in the other domain.

l In File mode, the user browses the input file and create a new output file. By specifying
the corresponding type conversion (XY to Lat/Long or Lat/Long to XY) and pressing
the Convert button, the desired conversion is written on output file.

l

Anchor Point Based XY - an approximate way to convert XY coordinates to geo-
graphical latitude and longitude. Error increases with the distance from the defined
point. Due to its inherent inaccuracies, this feature has been deprecated. For new
surveys, a user can no longer choose this option - it is only show this option if a sur-
vey was set up using this system.
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4.2 Session
The OpendTect session is generally used to save and to retrieve the specific set-
tings of a scene. This helps to resume work from previous settings. The session will
save all settings of the displayed elements, and can be restored at any later time.
When clicking the Survey option in the tool bar and then click Session, three options
appear. It is possible to save the session or restore a previously saved session.
When clicking Auto, the session will restore itself automatically the next time you
start OpendTect.

When a session is saved, the system stores all element positions and relevant
information to recreate the images. The content of the elements is not saved but is
re-created when the session is restored.
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The auto-load window (left) and the 'Select' option (right)

The user can enable or disable the auto-load session option. It is also possible to
choose if one of the save sessions will be used in this session. Finally the user has
the choice on whether or not to load the selected session now.

A similar function exists to auto-load one of the attribute sets.

As mentioned earlier that the contents of the elements are not saved but are recre-
ated. It is a common practice of the OpendTect user(s) to save and restore a ses-
sion. The mistake a user (s) can normally make is to save a session with the
contents of an element(s) (e.g. attributes) that takes a long time to compute. In this
way, when such session is restored, it will take a way too long time to restore,
because the session can only store the settings (or relevant information) but not the
on-the-fly attributes. Thus, it re-calculates the contents. This can be avoided by cre-
ating the attribute outputs of such attributes. If an attribute already reside in a disk (a
session is saved), the session will be restored very quickly. Similarly, the same thing
can happen in a session that contains contents of surface data (the attributes
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calculated along horizon). The attributes applied along a horizon can be saved as a
surface data. It is recommended, to save the surface data before saving a session.
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4.3 Import
The Survey > Import drop-down menu is used to import data to OpendTect.

Direct data exchange with Schlumberger's Petrel is available via PetrelDirect plugin
(part of OpendTect Pro)

Direct data exchange with Landmark's SeisWorks and Schlumberger's GeoFrame-
IESX is available via Workstation Access plugin by ARK CLS.
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4.3.1 Import Attributes
An OpendTect attribute set can be imported via Survey > Import > Attribute >
ASCII....

An OpendTect attribute set file contains a set of attribute definitions created in the
Attribute Set window. OpendTect attribute sets are stored in ../'Survey Data Root
folder'/Attribs/ and have '.attr' extensions.

In the Import Attribute Set window: locate an OpendTect attribute set, and provide
anOutput Attribute Set name to be used in the current project.

The imported attribute set can then be opened within the Attribute Set window.

More options for importing attribute sets are available in the Attribute Set window
itself.
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4.3.2 Import Color Table
An OpendTect color table can be imported via Survey > Import > Color Table... or
Manage Color Tables window > Import button.

There are two ways to import a color table:

l Other user option is used when it's possible to browse to the other user's home dir-
ectory. Navigate to the folder and type in DTECT_USER name (if any).

l Choose the File option if other users' home directories are not accessible. The color
tables created by OpendTect users are stored in a settings_coltabs.DTECT_USER file
(DTECT_USER = OpendTect username) that is located in the user's home directory
$HOME/.od/.



- 243 -

The default OpendTect color tables are stored in a ColTabs file that is located in the
OpendTect installation directory e.g. /home/your-username/OpendTect/7.0.0/data/
or C:\Program Files\OpendTect\7.0.0\data\ .
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4.3.3 Import Cross-Plot Data
Select the input Ascii file. You may display the input file by pressing the Examine but-
ton. The input file should be column sorted with one point per record (line).

The main work is to specify the presence of a file header and the file format defin-
ition. The header, if present, can be of fixed length (number of lines), or delimited on
its last line by a keyword.



- 245 -

Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.



- 246 -

You must specify in the format definition window the column numbers for the pos-
ition, in terms of an X-Y-Z or an inline-crossline-Z. The Z units can be seconds, mil-
liseconds or microseconds (meters of feet in depth surveys). All other columns with
be treated as amplitude data referenced with respect to the given position. The first
row may contain either the first vector with its position and the corresponding amp-
litudes ("Data"), or the name of the attributes in each column ("Column names").
Reading may be stopped at a specific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. Press OK when done.
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4.3.4 Import Faults
3D Faults (planes) can be imported in OpendTect via Survey -> Import -> Faults,
from Ascii files or from GeoFrameWorkstation (plugin).

Faults are non-editable objects that may be used as display element in the 3D
scene, displayed in full or a section. Attributes can also be applied along faults. If
you are looking for an editable object that can be converted at a later stage into a
fault plane, please load your data as fault stick sets.
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4.3.4.1 Import Fault Ascii 3D
Select the input Ascii file. You may display the input file by pressing the Examine but-
ton. The input file should be column sorted with one point per record (line).

The main work is to specify the type of data, the presence of a file header, and the
file format definition.

The sticks composing the planes can be either gathered automatically, either from
picked slices (inlines or crosslines), and/or based on their slope. The sorting can be
done based on the geometry of the fault sticks, on an index written in the input file,
or in the order found in the file. The header, if present, can be of fixed length (num-
ber of lines), or delimited on its last line by a keyword.

Note: that OpendTect does not support crossing fault sticks (a fault plane cannot
cross itself). If faults were picked on inlines, crosslines and horizontal slices, only
the largest subset of the three will be used to import the faults.

Predefined and saved formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format
definition window.
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You must specify in the format definition the column numbers for the position; in
terms of an X-Y pair, point column, and optionally stick index (0 = no stick index).
The Z units can be seconds, milliseconds or microseconds. Reading may be
stopped at a specific line by providing the adequate keyword.

If Coordinate Reference System (CRS) is defined for the survey, CRS conversion
will be available in the import window.
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It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. Press OK after having provided the
name of the fault to be imported.
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4.3.5 Import FaultStickSets
Fault stick sets are the editable version of the fault planes. Fault stick sets are fully
editable objects either for faults interpretation , or later as fault input to correct for
the fault throw. They can be imported in OpendTect via Survey > Import > FaultStick-
Sets, from Ascii files of from GeoFrameWorkstation (plugin).
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4.3.5.1 Import FaultStickSets Ascii 3D
Select the input ASCII file. You can display the input file by pressing the Examine
button. The input file should be column sorted with one point per record (line).

The important point is to specify the presence of a file header and the file format
definition. The header, if present, can be of fixed length (number of lines), or delim-
ited on its last line by a keyword.

Predefined and saved formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format
definition window.
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You must specify in the format definition the column numbers for the position, in
terms of an X/Y pair, point column, and optionally stick index (0 = no stick index).
The Z units can be seconds, milliseconds or microseconds. Reading may be
stopped at a specific line by providing the adequate keyword. If Coordinate Refer-
ence System (CRS) is defined for the survey, CRS conversion will be available in
the import window.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. Press OK after having provided the
name of the name of the faultstickset to be imported.
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4.3.5.2 Import FaultStickSets Ascii 2D
Select the input Ascii file. You may display the input file by pressing the Examine but-
ton. The input file should be column sorted with one point per record (line).

The main work is to specify the presence of a file header, and the file format defin-
ition. The header, if present, can be of fixed length (number of lines), or delimited on
its last line by a keyword.

Predefined and saved formats are available by pressing the icon. Otherwise the
format must be manually specified. The Define button gives access to the format
definition window.
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You must specify in the format definition the column numbers for the position, in
terms of an X-Y pair, point column, and optionally stick index (0 = no stick index).
The Z units can be seconds, milliseconds or microseconds. The name of the 2D line
(s) must also be provided. Reading may be stopped at a specific line by providing
the adequate keyword. If Coordinate Reference System (CRS) is defined for the sur-
vey, CRS conversion will be available in the import window.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. Press OK after having provided the
name of the faultstickset to be imported.
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4.3.6 Import Horizons
Horizons interpreted on 3D and 2D seismic data and (attribute) grids can be impor-
ted in a OpendTect survey via Survey > Import > Horizons. The grids are called "Sur-
face data" in Opendtect and are attached to 3D horizons. Horizon import supports
the following:

The standard input data is Ascii files. Three options are available (explained in the
following subsections):

l Geometry 3D: Import horizons interpreted on a 3D grid (e.g. XYZ)
l Attributes 3D: Import an attribute grid as a surface data, for a given 3D horizon.
l Geometry 2D: Import horizons interpreted along 2D lines.
l Bulk 3D: Import multiple 3D horizons from a single file

Import Horizon from Geoframe/Petrel: Horizons can also be imported into
OpendTect from Geoframe 2D/3D (Survey > Import > Horizon > GeoFrame > 2D or
3D). The following dialog will pop up. Select the GeoFrame project and the survey
name that contains the horizon to be imported.
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4.3.6.1 Geometry 3D
Select the input ASCII file. You may display the input file by pressing the Examine
button. Available grids (attributes) present in the input file may also be imported
semultaneously. The input file should be column sorted with one point per record
(line).

The main work is to specify the presence of a file header and the file format defin-
ition. The header, if present, can be of fixed length (number of lines), or delimited on
its last line by a keyword.

Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.
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You must specify in the format definition window the column numbers for the pos-
ition, in terms of an X-Y pair or an inline-crossline pair, and the point column. Points
that should not be read must all have the same numerical value, which is to be filled
in as the "Undefined value". The Z units can be seconds, milliseconds or micro-
seconds. Optionally, if attributes were added in the Import Horizon window, addi-
tional columns with given attribute (s) name (s) will also appear in this format
definition window. Reading may be stopped at a specific line by providing the
adequate keyword.

If Coordinate Reference System (CRS) is defined for the survey, CRS conversion
will be available in the import window.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. PressOk when done.
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It is highly recommended to scan the input file after providing its format, and prior to
the actual import. The scanned information will pop-up and error(s) or warning(s)
may suggest a change of the format definition.

The area sub-selection can be used in two ways:

l Reduce the amount of data to be loaded: By reducing the inline/crossline ranges
l Specify a new grid size if a coarse input grid should be gridded during import: By
decreasing the inline/crosslines steps to the survey steps (minimum).

The option Fill undefined parts will be toggle on if gaps were found during scan. A tri-
angulation to the convex hull with an interpolation where the maximum size is the
input grid step (in XY units, thus meters or feet), and Keep holes larger than toggled
off, should be the optimal settings in most cases.

Tied to level is additional option specifically designed to tie horizons to well markers,
for correlation purposes. In order to define the stratigraphic information of the sur-
vey, please read about Manage Stratigraphy.
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4.3.6.2 Attributes 3D
This window is used to import grids from ascii files and attached them to Existing 3D
horizons. Select the input Ascii file. You may display the input file by pressing the
Examine button. The input file should be column sorted with one point per record
(line).

Grid names must first be provided in front of Select Attribute(s) to import. This can
be done by pressing Add new right of it, and providing each time a new grid name.
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This will populate the list of importable grids. Only the highlighted grids will be impor-
ted, which is why each new grid is highlighted after providing its name.

Next, the presence of a file header must be specified and the file format definition
must be provided. The header, if present, can be of fixed length (number of lines), or
delimited on its last line by a keyword.

Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.

You must specify in the format definition window the column numbers for the pos-
ition, in terms of an X-Y pair or an inline-crossline pair, and the grid(s) column(s).
Grid values that should not be read must all have the same numerical value, which
is to be filled in as the Undefined value. Reading may be stopped at a specific line
by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
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format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. Please note that the full grid names
will be saved as provided in the format definition. Press OK when done.

It is highly recommended to scan the input file after providing its format, and prior to
the actual import. The scanned information will pop-up and error(s) or warning(s)
may suggest a change of the format definition. The area subselection is essentially
present to optionally reduce the amount of data to be imported, by reducing the
inline/crossline range(s).

Finally an horizon must be provided, to attach the grid(s) to it. Grids will be access-
ible only after having loaded this horizon in the tree. PressGo to launch the import.
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4.3.6.3 Geometry 2D
This window is used to import 2D interpretations form ascii files. Select the input
ascii file. You may display the input file by pressing the Examine button. The input
file should be column sorted with one point per record (line).

Several 2D horizons can be imported at once. Their name should be provided in
front of Select Horizons to import. This can be done by pressing Add new right of it,
and providing each time a new horizon name. This will populate the list of import-
able horizons. Only the highlighted horizons will be imported, which is why each
new horizon is highlighted after providing its name. Ctrl-left click may be used to
highlight or deselect an horizon.

Next, the presence of a file header must be specified and the file format definition
must be provided. The header, if present, can be of fixed length (number of lines), or
delimited on its last line by a keyword.
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Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.

You must specify in the format definition window the line name, column numbers for
the position, in terms of an X-Y pair or a unique trace number, and the horizon(s)
column(s). Horizon Z values that should not be read must all have the same numer-
ical value, which is to be filled in as the Undefined value. Reading may be stopped
at a specific line by providing the adequate keyword.

If Coordinate Reference System (CRS) is defined for the survey, CRS conversion
will be available in the import window.

It is recommended to save the format definition for a later use and QC, by clicking
the icon . In pop-up window, write the name of the format and store it. The format
can be stored at different levels (All surveys, Current survey, Current OpendTect
user level) depending on the usage. Press OK when done.
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It is highly recommended to scan the input file after providing its format, and prior to
the actual import. The scanned information will pop-up and error(s) or warning(s)
may suggest a change of the format definition. PressGo to launch the import.
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4.3.6.4 Bulk 3D
The bulk import tool allows for the import of multiple 3D horizons from one single
file. The data is matched by name. This has the following implications:

The horizon name must appear on each line of the input file. The horizon name
should not contain spaces, otherwise the matching with a given column number will
not work as expected.

Apart from being a multiple horizon import tool, it behaves following the rules of the
standard horizon import.

Format definition

You must specify in the format definition window the column numbers for the pos-
ition, in terms of an X-Y pair or an inline-crossline pair, the point column and the hori-
zon name. If Coordinate Reference System (CRS) is defined for the survey, CRS
conversion will be available in the import window.
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4.3.6.5 From ZMap
This window is used to import horizons from ZMap files.
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4.3.7 Import Mute Functions
Mute definitions can be used for pre-processing prestack seismic data.

Mute definitions can be imported in OpendTect using Ascii files. The import window
is launched from the OpendTect main menu (Survey > Import > Mute definitions >
Ascii). Select the input Ascii file. You can display the input file by pressing the Exam-
ine button. The input file should be column sorted with one point per record (line).
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The main work is to specify the presence of a file header and the file format defin-
ition. The header, if present, can be of fixed length (number of lines), or delimited on
its last line by a keyword. The mute definition can be either variable throughout the
survey, in which case a position must be provided in the input file for all data points,
or fixed. In this latter case, toggle File contains position to No and provide any loc-
ation for the mute definition.

Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.
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You must specify in the format definition window the column numbers for the pos-
ition, in terms of an X-Y pair or an inline-crossline pair, and the point column, in
terms of an Offset-Z value pair. points that should not be read must all have the
same numerical value, which is to be filled in as the "Undefined value". The Z units
can be seconds, milliseconds or microseconds (meters of feet in depth surveys).
Reading may be stopped at a specific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. Press OK when done.
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4.3.8 Import Navigation Data / 2D Geometry

The import ASCII file should contain X, Y, trace number and, optionally, shot point
number.

During import, Examine the file and set the number of header lines, if present, and
Define the format:



- 274 -

Once completed, clickOK to import.

The user can then switch to importing the 2D SEG-Y file.

During this import, the traces are matched to the geometry by trace number, so
ensure selection of the correct byte number, click Next.

On this next screen, use the drop-down for the Line name field to select the just-
imported navigation data and name the 2D Data before clicking Import:
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Finally, a choice will be given as to which navigation data to use.

Select No: keep the existing geometry and clickOK:
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4.3.9 Import Pointsets & Polygons
Point/vector data can be loaded in OpendTect from Survey > Import > point-
set/Polygon.

Select the input Ascii file. You can display the input file by pressing the Examine but-
ton. The input file should be column sorted with one position per record (line).
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The main work is to specify the presence of a file header and the file format defin-
ition. The header, if present, can be of fixed length (number of lines), or delimited on
its last line by a keyword.

Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.

You must specify in the format definition window the column numbers for the pos-
ition, in terms of an X/Y pair or an inline-crossline pair, and the point column. points
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that should not be read must all have the same numerical value, which is to be filled
in as the "Undefined value". The Z units can be seconds, milliseconds or micro-
seconds. Reading may be stopped at a specific line by providing the adequate
keyword.

If Coordinate Reference System (CRS) is defined for the survey, CRS conversion
will be available in the import window.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon . In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage.

The option Import as polygon will flag this specific datatype to the loaded data. It
also adds as constraint during loading that the points are ordered in the expected
way. The import tool will not apply any sorting.

Press OK when done.
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4.3.10 Import Probability Density Functions
Probability density functions can be imported in order to run Bayesian clas-
sifications. The manage tool can later be used to edit the PDF before running the
Bayesian classification.
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RokDoc formatted data is required for importing PDF in OpendTect. After having
selected the input file, the two contained variables will be shown in the import win-
dow, together with their amplitude ranges and bin size.

The variable names and parameters may be modified before pressing theGo button
that will launch the import. The icon to the right can be used to quickly extend
both variable ranges by one bin size outwards.
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4.3.11 Import Seismic Data
Volumes and 2D Lines can be imported in the Survey menu from files in different
modes:

l SEG-Y: By converting a SEG-Y file to an OpendTect file.
l SEG-Y scanned: By referencing (linking) a SEG-Y file to the survey without creating a
new file.

l Simple file: From a regular ascii or binary file, with or without header.
l CBVS: By copying or linking an existing OpendTect (CBVS) volume.
l Petrel: Import seismic data from other software (depending on system setup)
l GPR-DZT: Import the files made by GSSI Ground Penetrating Radar (GPR) systems
in the 'DZT' format.
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4.3.11.1 SEG-Y
SEG-Y is the standard way to share volumes/lines of data. In OpendTect the files
are loaded with a rigorous respect to the SEG standards using one of the two wiz-
ards:

l new SEG-Y wizard introduced inOpendTect 6.2
l Classic SEG-Y Import Tool (used to be the main utility for import of SEG-Y data prior to
OpendTect 6.2)

Most SEG-Y files will be imported in a few clicks, and a number of exceptions can
be set to load the most problematic data. Nevertheless there are a few guidelines
that must be honored:

l The traces must be sorted either by inlines and then crosslines or by crosslines and
then inlines.

l The gathers of prestack data must be consecutive and ordered by increasing offset
(i.e. no common offset sorting).

l Inlines/crosslines or coordinates (and offset) must be written in every single trace
header. Separate navigation data is only supported for 2D lines.

l The traces must have a fixed length.
l There is no support of extended textual headers.

Once the above criteria are respected, you will then enjoy a large freedom:

l Gaps can be present.
l The traces can start at any time/depth, even negative.
l The files can be merged during import, re-scaled using linear equations, and the stor-
age format can be changed.

Please, read the entire chapter before asking for support. If you need sup-
port, please send us screenshots of each step and (of possible) a scan
report together with a detailed description of your problem.
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4.3.11.1.1 SEG-Y Wizard

Generic Import SEG-Y Data wizard can be accessed by clicking on icon in
the toolbar of main OpendTect window. The wizard supports import of 2D and
3D prestack and poststack data from one or multiple SEG-Y files. The layout of this
window dynamically changes depending on the user choice of Data type.

The generic wizard also supports import of zero-offset VSP.

Data specific wizards are available via Survey > Import > Seismics > SEG-Y. The
layouts are fixed for the data type selected via the menu (Data type option isn't avail-
able in these cases).
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Input file(s): Select a SEG-Y file to import. In case of importing multiple 2D or
3D SEG-Y files select any of them first and then use the wildcard *.

Import 3D pre- or poststack data from multiple SEG-Y files: files must contain
consecutive blocks of inlines and be indexed as filename_1.sgy, filename_2.sgy...

1. Select one of the files;
2. replace the file index by a wildcard * in the input field: filepath/filename_*.sgy

Import multiple 2D lines with pre- or poststack data: files must contain indi-
vidual 2D lines and be indexed with the respective line names as filename_lin-
ename1.sgy, filename_linename2.sgy...

1. Select one of the files;
2. replace the line name by a wildcard * in the input field: filepath/filename_*.sgy;
3. those parts of file names replaced by * are used as 2D line names (press Next and see

that Line name option is greyed out and set to *).

Edit: (optionally) edit text, binary and trace headers of a SEG-Y file in Manipulate
SEG-Y File window.

Data Type: the choice is only available in the generic Import SEG-Y Data window.
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l 3D seismic data
l 3D PreStack data
l 2D seismic data
l 2D PreStack data

Table: information required to import a SEG-Y file (therefore the table layout
depends on the data type).

l Quick/Full scan result: shows results of a quick/full scan of a SEG-Y file:
o Quick scan: a partial scan of SEG-Y is performed upon file selection and after any
change of SEG-Y import set-up.

o Full scan: press on icon to scan the entire file.
l Actually use: import parameters as confirmed/overruled by a user.

SEG-Y Revision (default = byte 301 of binary header): please refer to SEG stand-
ards for details.

l SEG-Y Rev. 0:
o Data format, Number of samples, Z Range start/interval can be overruled.
o Data positioning (IL/XL, Trace/SP, X/Y and offset): byte locations can be selected
by a user.

l SEG-Y Rev. 1:
o Data format, Number of samples, Z Range start/interval can be overruled.
o Data positioning (IL/XL, Trace/SP, X/Y and offset): standard byte locations are
used.

l SEG-Y Rev. 2:
o File format options and standard trace header bytes are same as Rev.1.

Data format (default = byte 25 of binary header): (optionally) overrule data format.

Most header values and data samples are written using several bytes for
each word/sample. Therefore knowing a correct byte order is a necessity.
All SEG-Y standards (Rev. 0, 1 and 2) require using big-endian byte order.
Occasionally one can run into data written using little-endian (reverse) one.
Using standard SEG-Y data formats for reading such data results in unex-
pected scanned values of trace headers and unexpectedly large sample val-
ues (check the histogram). In this case use data formats with (byte
swapped) option.

Number of samples (default = byte 21 of binary header / byte 115 of trace header):
(optionally) overrule the number of samples per trace.

Z Range (units = seconds or meters).
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l start (default = bytes 105 laga and 109 delrt of trace headers): (optionally) overrule
start of Z-range (negative start is allowed).

l interval (default = byte 17 of binary header / byte 117 of trace header): (optionally)
overrule Z-sampling (sampling rate).

OpendTect doesn't support import of a SEG-Y file with varying trace lengths
(i.e. Z range start and interval must be constant for all traces in a file).

Data positioning:

Rev.1/Rev.2: trace header byte locations are standard, i.e. can't be selec-
ted by a user. If the file is wrongly tagged as Rev.1/Rev.2, over-rule it as 0 in
Actually use column in order to be able to select non-standard trace header
bytes.

3D poststack data is loaded based either on Inline/Crossline numbers or X/Y
coordinates (see below Use I/C and Use (X,Y) options).

Rev.0
defaults

Rev.1/Rev.2 hard-
coded standard
bytes

In-line range 9 189
Cross-line range 21 193
X-Coordinate range 73 181
Y-Coordinate range 77 185
Offset range (prestack
only)

37 37

2D poststack data is loaded based on trace numbers, reference numbers (SP) and
X/Y coordinates.

Rev.0
defaults

Rev.1/Rev.2 hard-
coded standard
bytes

Trace number range 5 5 (can be over-ruled)
Shot-Point number
range

197 197

X-Coordinate range 73 181
Y-Coordinate range 77 185
Offset range (prestack
only)

37 37
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l Trace number range:
o In file: from a specified trace header byte.
o Generate: generate trace numbers by providing the number of the first trace in a
2D line and step in trace numbers.

Trace number must be unique for each trace along the line, therefore it can
be either sequential trace number (byte 5) or CDP trace number (byte 21). A
user is always allowed to select a non-standard byte even when the file is
Rev.1.

2D and 3D prestack data additionally requires offset information.

l Offset range
o In file: from a specified trace header byte.
o From Src/Rcv (X/Y): calculate from source and receiver X/Y coordinates (standard
byte locations are used: 73 and 77 for source, 81 and 85 for receiver).

o Generate: generate offsets by providing the offset of the first trace in a gather and
step in offset values.

Store this setup: save a SEG-Y import setup at the survey data root level.

Use saved SEG-Y setup: retrieve one of the stored setups.

Scan the entire input: updates Quick scan result with Full scan result of the
entire input file.

Examine input file: opens SEG-Y Examiner window for a specified Number of
traces to examine (default=1000 traces).

(default = empty): (optionally) enter XY scalar to ignore scalco (byte 71 of
trace header). X/Y coordinates are multiplied by this factor.

Note that scalco is the scale factor for all coordinate bytes with value plus or
minus 10 to the power 0, 1, 2, 3, or 4 (if positive, multiply, if negative divide).

Histogram: displays a distribution of amplitudes afterQuick (partial) or Full scan.

l Percentage clip for display (default=0.1%): amount of data in the histogram tails
excluded from the plot.

l Zeros (default=unchecked): allows to include/exclude value 0 for histogram display.

Data specific options:
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3D (pre- and poststack) data positioning can be based either on Inline/Crossline
or X/Y coordinates of each trace:

l Use I/C (default): positioning of imported data is based on Inline/Crossline numbers,
(X,Y) coordinates are therefore calculated from a survey setup.

l Use (X,Y): positioning of imported data is based on (X,Y) coordinates, Inline/Crossline
numbers are therefore calculated from a survey setup. If Coordinate Reference Sys-
tem (CRS) is defined for the survey, CRS conversion will be available in the import win-
dow.

2D (pre- and poststack) data Z-range can vary per SEG-Y file if multiple lines of
different vintages are imported at the same time:

l File Z's (available only when multiple 2D lines are imported): if checked, Z
Rangestart/interval and Number of samples are used as they appear in each SEG-Y
file.

Overruling of Z Range start/interval and Number of samples is possible only
if File Z's is unchecked.
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4.3.11.1.1.1 Import Window

Import 3D Volume / Import Pre-Stack Volume

Copy data:

l Yes (import):
o data is imported to CBVS format (internal OpendTect format for seismic data);

l No (scan and link):
o link to a SEG-Y file, i.e. no data duplication;
o if a SEG-Y file is moved or renamed outside OpendTect, the link can be restored via

icon inManage 3D Seismics window;
o performance for prestack data may be lower than with OpendTect CBVS prestack
datastore.

Volume Subselection (default= '-', i.e. All): (optionally) a sub-set or a decimated
volume can be imported.

Null traces:

l Discard (default): null traces are discarded, i.e. shown as undefined.
l Pass: null traces are imported with amplitude values of 0.

Scale values (default=off): (optionally) shift and scale amplitude values:

l Shift: add this shift to sample amplitudes.
l Factor: multiply sample amplitudes by this factor.

Output Cube: type in a cube name to be used in the OpendTect project and choose
its format:

l CBVS: internal OpendTect format for seismic data.
l SEG-YDirect: link to a SEG-Y file.
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l PetrelDirect: write directly to Petrel datastore with a PetrelDirect link to it in OpendTect.

Depth/Time: (optionally) depth volumes can be imported to time surveys by check-
ing this box and vice versa.

They can be visualized using transformed scenes, providing that velocities
are available.

Execute in Batch: (optionally) import can be done in a single-machine batch mode.

It is a good practice to display 3D seismic data on a z-slice after import to
check for any gaps or null traces.

Import 2D Line(s) / Import Line 2D Pre-Stack(s)

Line name:

l Single 2D line: either type in a new line name or select one of the existing ones.
l Multiple 2D lines: the field is greyed out, and line names come from parts of file names
replaced by a wildcard *.

Trace Subselection (default= '- ', i.e. All): (optionally) a sub-set or a decimated
volume can be imported.

Null traces:

l Discard (default): null traces are discarded, i.e. shown as undefined.
l Pass: null traces are imported with amplitude values of 0.
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Scale values (default=off): (optionally) shift and scale amplitude values

l Shift: add this shift to sample amplitudes.
l Factor: multiply sample amplitudes by this factor.

Coordinate source (default=The trace headers):

l The trace headers: use trace headers as specified in import SEG-Y Data wizard.
l A 'Nr X Y' file (bend=points needed): (optionally) the coordinates can be specified
using an auxiliary navigation file. The format should be an ascii file with one position
per line in a fixed column format without header: trace number, X and Y coordinates.
Units to be used are the same as specified in the survey definition
o Single 2D line: select a file containing a navigation survey.
o Multiple 2D lines: navigation files must have same names as corresponding SEG-Y
files and different extension (such as .crd).

l Generate straight line: manually enter X/Y coordinates of the first trace and regular
steps in X/Y directions. Units to be used are the same as specified in the survey defin-
ition.

Output 2D Data (attribute): type in a 2D dataset name to be used in an OpendTect
project and choose its format:

l CBVS: internal OpendTect format for seismic data.
l PetrelDirect: write directly to Petrel datastore with a PetrelDirect link to it in OpendTect.

Optionally press Select to see the list of existing 2D data in a project:
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2D datasets are used in OpendTect to group data of the same kind which
can be processed and interpreted together (i.e. a particular 2D vintage or
type of data). An OpendTect survey can have many 2D datasets, which can
share common 2D geometries.
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4.3.11.1.2 Classic SEG-Y Import Tool

The Classic SEG-Y Import Tool used to be the main utility for import of SEG-Y data
prior toOpendTect 6.0. This wizard can still be launched via:

l Survey > Import > Seismics > SEG-Y > Classic tool;
l from the SEG-YWizard introduced inOpendTect 6.0 by clicking on 'Classic'.

It allows to import 2D and 3D pre- and poststack seismic data from one or multiple
SEG-Y files. The import consists of two mandatory steps: SEG-Y Import Pre-
paration and SEG-Y Import itself.
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4.3.11.1.2.1 SEG-Y Import Preparation

SEG-Y import preparation starts with the SEG-Y tool window.

Input SEG-Y file(s): Select a SEG-Y file to import.

Import 3D pre- or poststack data from multiple SEG-Y files: files must contain
consecutive blocks of inlines and be indexed as filename_1.sgy, filename_2.sgy...

1. Select one of the files;
2. replace the file index by a wildcard * in the input field: filepath/filename_*.sgy;
3. toggle onMultiple files option and specify the number of files to be merged.

Import multiple 2D lines with pre- or poststack data: files must contain indi-
vidual 2D lines and be indexed with the respective line names as filename_lin-
ename1.sgy, filename_linename2.sgy...

1. Select one of the files;
2. continue through the wizard with just one file selected until SEG-Y Import window (last

step);
3. SEG-Y Import window: check option Import more, similar files;
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4. 2D SEG-Y multi-import window replace line name in the file name with a wildcard #L
(see SEG-Y Import page for more details)

Manipulate...: opens Manipulate SEG-Y file window where text, binary and trace
headers of a SEG-Y file can be edited.

Multiple files (default = toggled off): toggle on if a single 3D dataset (pre- or post-
stack) is imported from multiple SEG-Y files (see above how to Import 3D pre- or
poststack data from multiple SEG-Y files):

l Numbers: specify indexes of the first and the last files as well as index Step.

File Type: specify which data is contained in a SEG-Y file(s).

l 3D Volume
l Pre-Stack Volume
l 2D Line
l Line 2D Pre-Stack

Number of traces to examine (default=100 traces): a number of traces at the
beginning of the file to be analyzed in SEG-Y Examiner. Looking at the output is
strongly recommended but not mandatory for a successful import. Enter 0 to skip
SEG-Y Examiner.

l Save as default: (optionally) check to save the Number of traces to examine in your
user settings.

In most cases you can press Next after you have selected input file(s). Con-
sider overruling options listed below (information coming from the file(s)
itself) only if you have a proiri knowledge about problems with the file(s).

Overrule SEG-Y number of samples (default = toggled off, i.e. standard locations
are used: byte 21 of binary header / byte 115 of trace header): (optionally) overrule
the number of samples per trace.

SEG-Y 'format' (default = byte 25 of binary header): (optionally) overrule data
format.

Bytes swapped (default = toggled off, i.e. big-endian byte order used): (optionally)
toggle on to use little-endian byte order for reading data.

Most header values and data samples are written using several bytes for
each word/sample. Therefore knowing a correct byte order is a necessity.
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All SEG-Y standards (Rev. 0, 1 and 2) require using big-endian byte order.
Occasionally one can run into data written using little-endian (reverse) one.
Using standard SEG-Y data formats for reading such data results in unex-
pected scanned values of trace headers and unexpectedly large sample val-
ues (check the histogram in SEG-Y Examiner).

Store this setup: save a SEG-Y import setup at the survey data root level.

Use saved SEG-Y setup: retrieve one of the stored setups.
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4.3.11.1.2.2 SEG-Y Revision

After SEG-Y import preparation a pop-up question asks to Determine SEG-Y Revi-
sion of the input file(s). The default choice is auto-selected based on byte 301 of the
file's binary header, but can be overruled by a user. The choice determines the lay-
out of import SEG-Y window.

For details please refer to SEG standards.

l No: the file is NOT SEG-Y Rev.1 - treat as legacy (i.e. Rev.0) - For un-lucky users
the revision 1 flag might wrongly be set to "Yes" in the line header while obviously the
file does not comply with the SEG-Y revision 1 norm. It may happen when the software
blindly copies entire headers without refreshing all the necessary characters. "Rev.0"
is an older way of loading SEG-Y files: The inline and crossline offset (bytes) must be
present in the trace headers and their offsets must be provided to the software since it
may vary from file to file.

l Mostly: It's Rev.1 but I may need to overrule some things - The file is 100% SEG-
Y Rev.1 but you would like to overrule some particular information e.g. Coordinates,
Sampling rate and Start time etc.
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l Yes: I know the file is 100% correct SEG-Y Rev.1 - For lucky people, this is by far
the most easy and quick way to import your SEG-Y file. No additional settings are
required except the final output volume/line name in the OpendTect database.

After selecting appropriate option, press Next to reach the import window.

You can save the answer to this question in your survey settings by activating the
option "Don't ask again for this survey". If you set this flag by mistake and wish to go
back you need to edit the ".defs" file (in the OpendTect survey directory) with a text
editor and remove the line "SEG-Y Rev. 1 policy:".
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4.3.11.1.2.3 SEG-Y Import

Import SEG-Y window layout depends on the user-selected SEG-Y Revision.

Rev.1

If the file is Rev 1 standard then the import is almost complete: You must provide an
output name and can optionally sub-select a range of the volume to be loaded
and/or change the output format and/or re-scale the amplitudes. Pressing Go will
launch the import.

Depth volumes can be imported in time surveys and vice versa by using the
depth/time toggle. They can be visualized using transformed scenes, provid-
ing that velocities are available.

Pre-scan file(s): launch a partial or a full SEG-Y scan.

Mostly Rev.1

If the file is mostly Rev 1 but with changed parameters you will receive three addi-
tional fields that can overrule the values to be found in the headers:
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l Overrule SEG-Y coordinate scaling: all trace coordinates are multiplied by this scalar.
l Overrule SEG-Y start time/depth (units: ms, m or ft): time/depth of the first sample of
the traces (can be negative).

l Overrule SEG-Y sample rate (units: ms, m or ft): provide the data sampling rate.

Those parameters constitute a SEG-Y setup that can be saved and retrieved using
the yellow folder icon on the right. This setup will not only contain the parameters
but also the path of the input files and settings of the preparation step. The setups
are data dependent therefore they are stored in your survey.

Not Rev.1

If the file is not Rev 1 you will get the overrule fields described above in a tab and
two additional tabs to provide the byte locations of either the pair inline/crossline or
the pair of X and Y coordinates. In the case of prestack data an additional tab will be
present to provide the offsets/azimuth byte locations.
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You need to look at the trace headers in the examine window and assign the cor-
rect settings in this import window. Once again the entire import setup may be
saved or retrieved. Once this is done you must provide an output name and can
optionally sub-select a range of the volume to be loaded and/or change the output
format and/or re-scale the amplitudes. PressingOk will launch the import.

The import of 2D lines is somewhat different: Inlines and Crosslines are replaced
by trace numbers, that must be unique for each trace (therefore it can be the CDP
but not the Shot Point).



- 303 -

Coordinates can be imported from one auxiliary file or specified manually and gen-
erated during import coordinates if missing or wrong in the trace headers (see below
on the right hand-side). This can be done by toggling off the X-coord byte field.

Generate XYs

The coordinates are generated for each trace position by providing the X and Y
coordinates of the first trace, and a regular step in both directions. Units to be used
are the same as specified in the survey definition.

Input Auxiliary file

Optionally the coordinates can be specified using an auxiliary file. The format
should be an input ascii file with one position per line in a fixed column format
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without header: File column should have the trace number, second column the X
coordinate, third column the Y coordinate. Units to be used are the same as spe-
cified in the survey definition.

The line name is most often part of the input file name. It will be used only if a single
line is loaded. Otherwise the line name is extracted as a part of the filename (see fur-
ther below).

The Output data set name represents a 2D survey that comprises one or more
lines. An OpendTect survey can have many 2D surveys (data sets), that are group
of 2D lines that can be selected together for processing and interpretation.

There is no format/scaling for 2D lines. The SEG-Y data format defines the
OpendTect format. However, there is a trace sub-selection option to select either a
trace "Range" or "All".

A default attribute name "seis" will be given to each line of the loaded data set.
This can be changed by pressing "Select" and filling the empty "Attribute" field, like
in the example below:
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Multiple 2D lines loading must be enabled using the button "Import more, similar
file" on the last line before pressing "OK". Any line can be used to go through the wiz-
ard, and the settings must be the same for all lines. If that is not the case then it is
best to run the wizard several times per group of lines of similar SEG-Y settings.

This additional window is used to specify the generic line name out of the SEG-Y file-
names. The line name must be replaced by "#L", while everything else (including
the path and the extension) is shown as text, like in the above example:

$DATAPATH/Line_#L.sgy
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There will be one progress bar per input file during loading.

It is a good practice to display the 3D seismic data on a z-slice to check for
any gaps in inline/cross-lines or null traces, after importing it.
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4.3.11.1.2.4 SEG-Y Scan

SEG-Y Scan is a useful tool to get an idea about the content of a SEG-Y file, and to
check the loading settings. It is best performed on a limited number of traces
(default is 100) when checking the loading parameters, and on the entire file when
extracting geometry and ranges.

At any moment a partial or full can be launched using the icon on the right-hand
side in the Import SEG-Y window.

SEG-Y scanning is used to derive the survey geometry for a SEG-Y file. A suc-
cessful scan will result in a successful loading, if the numerical values returned are
in line with the correct parameters (inline range, coordinate scaling ...).

Here is an example of output of a SEG-Y scan report:
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4.3.10.1.3 SEG-Y Examiner

SEG-Y Examiner can be launched by pressing on icon in Import SEG-Y window.
SEG-Y Examiner allows to check essential information about the data by inspecting
text, binary and trace headers as well as plotting seismic traces for QC. It is recom-
mended to use this tool to check your SEG-Y import set-up and adjust it if needed.

SEG-Y Examiner can stay open during import.

File header information:

l Text (EBCDIC) header (3200 bytes: 40 lines, 80 symbols each): free-format text com-
monly containing processing history, data ranges, and non-standard trace header byte
locations.
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l Binary header (400 bytes): scroll down to see a summary of non-zero values in the bin-
ary header which commonly includes info about data format, SEG-Y revision and Z-
range (sampling rate and number of samples).

Save textual header to a file.

Trace header information:

l Table:
o trace header byte numbers and shortened field names are shown in the first
column;

o trace header values of examined traces are shown in the following columns.
l Graph: plot between any individual trace header and the number of random traces
examined is a very good tool to visualize its range and inspect for any discrepancy:
o highlight any trace header (a row) in the table to see its graph versus consecutive
trace number;

o extended explanation of a highlighted trace header is given above the graph (please
see SEG standards for more details);

o Range: [...,...]: values of a highlighted trace header in the examined traces.

Use the lateral scroll bar at the bottom to locate the headers with changing
values. Those might be trace numbers, crossline numbers, offsets, coordin-
ates etc. Inline numbers are often written to the bytes preceding crosslines.
Most 3D data is inline sorted, therefore choose sufficient number of traces
to examine (several times more than the number of crosslines per inline) in
order to see the increasing inline numbering.

Display traces: It is strongly recommended to always view examined traces in
the 2D viewer.

Show histogram of sample values.
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Rubberband zoom

Zoom in

Zoom out

Cancel zoom

Flip left/right

Save image

Print image

Set display parameters
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4.3.10.1.4 Manipulate SEG-Y File

This powerful utility (available via SEG-Y wizard or classic SEG-Y import tool)
allows to edit text, binary and trace headers of a SEG-Y file. All changes made to
SEG-Y headers can only be saved to a newOutput file.

l Text Header: can be directly edited.
l Binary header: click on Change... button and in SEG-Y Binary Header window correct
Value fields for Bytes as required.
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l Trace headers: follow the steps below to trace headers:
l Select a trace header to edit in the left list and press on icon;
l In Header Calculation window type in a Formula and pressOk.

l For information about the supported operators, functions and constants please
refer to the Mathematics attribute.

l Other trace headers can be inserted in the formula by selecting them in the Avail-
able list and pressing .
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l Trace header definitions appear in the right list and may be edited or
deleted . The set of definitions can be also saved for later use and
restored when needed. Note, that the table on the right already reflects
these changes for QC (see below).

QC Trace Headers
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l Table: displays trace headers of an individual trace number Trc.
l Plot:

l Highlight trace header(s) in the table to plot against trace number.
l Press on to create a plot.
l If All is unchecked, specify the required range of traces:
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4.3.11.2 SEG-Y Scanned
Data duplication is a large problem when working with large datasets. All other
import tool generate new OpendTect files from ascii or binary files. This new type of
SEG-Y import works differently since it will not create any file but will link an existing
SEG-Y file to an OpendTect entry, selectable as any other OpendTect data.

This special import tool is only available for both stacked and prestack data.
However, it should be noted that for prestack data the performances for reading and
processing may be lower than with OpendTect prestack datastores that are optim-
ized by importing the usual way. The importation itself is 100% similar to the normal
SEG-Y import. The only difference is that there will not be any loading after com-
pleting the wizard.

Please note that since this tool links to an existing file, moving or renaming the file
outside OpendTect will break the link and make the dataset unavailable.



- 317 -

4.3.11.3 Simple File
The user can import simple ASCII or Binary file by using plain file Seismic I/O Plu-
gin. This can be reached via Survey > Import > Seismic > Simple File > 3D or 2D
(Pre/Poststack) etc.

The input file must first be selected and its data format type specified, between ascii
and binary (4-bytes floats). All data must be in the 'local' format, because a blunt bin-
ary read/write is performed.

(Part of) the input file can be visualized by pressing the examine button. The data
must consists of one trace per record (line). The samples are thus in columns,
from shallowest to deepest, with a regular step. The trace position and time/depth
index can be read from the input file, left of the trace, or can be provided. If provided,
start, step and number of samples are requested in the corresponding directions,
assuming the input file if regular and does not contain holes. Poststack volume must
be sorted by inlines, crossline, (offset), Z (time or depth).

Optionally, the user can scale the cube before loading as well by mentioning the
amount of shift and the corresponding factor. Either pass or discard the null traces
before loading.

The easiest way to see what the format looks like is by producing a little export file
from a bit of seismics. In the example below we exported inlines 500-501 and cross-
lines 600-603, Z range 1000-1020 step 4 (which is 6 samples):

l 1000 4 6
l 500 600 1456 -688 -1502 4955 8935 1209
l 500 601 1429 -640 -967 5248 8362 527
l 500 602 1353 -424 -1040 5071 8059 -64
l 500 603 1428 -587 -1244 5139 8447 13
l 501 600 1450 -411 -1414 4792 8449 1117
l 501 601 1619 -456 -1243 4695 8271 702
l 501 602 1617 -213 -1272 4675 7903 393
l 501 603 1552 -248 -1088 4875 8004 204

Below are respective examples of the import for 3D poststack, 2D poststack, 3D
prestack, 2D prestack:
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Simple poststack 3D and 2D Seismic File Import Window
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Simple Prestack 3D and 2D Seismic File Import Window
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4.3.11.4 Import CBVS Cube
Seismic in CBVS format can be import either directly from cbvs file or from other sur-
vey(s) as shown below
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From file

This module enables exchange of data between the OpendTect projects. The ori-
ginal CBVS (Common Binary Volume Storage) file can be located with a standard
file browser. Some CBVS volumes are stored in several sub files. These can be
recognized by the ^01 or ^02 (etc.) in the filename. To import the complete volume,
select the base file without any ^xx marks.

The Cube type needs to be specified in order to give it the correct label for the soft-
ware.

The Import mode indicates if the file should only be left at its original place and just
be linked to the current survey (Use in-place), or if the volume should be copied
entirely into the current survey directory (Copy the data). Moreover, while importing,
the volume can be sub-selected (selected inlines/crosslines/time ranges) by press-
ing Select button in front of the Volume subselection field. If the data contains the
Null traces, either discard or pass the traces by selecting the respective radio but-
ton. Before, importing the CBVS volume, the scaling (16bit, 32 bit etc) can be
applied to the volume. The Output Cube field corresponds to the output volume
name (that will be available in Manage Seismic window) for the input file.

From other survey(s)

Seismic cubes in cbvs format can also be imported from other survey(s)
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Few changes can be made prior to import the file: The volume subselection, the
type of interpolation (sinc interpolation or nearest trace) and the stepout in inline and
crossline.
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4.3.11.5 GPR - DTZ
Ground penetrating radar offers an accurate solution to mapping the subsurface of
the earth. It locates features of interest and subsurface layers in real time. The GPR
data visualization and interpretation can be made in OpendTect, which enables the
user to import the files made by GSSI Ground Penetrating Radar (GPR) systems in
the 'DZT' format. The result is a 2D line in OpendTect.

Prior to loading a GPR data, the 2D survey should be setup according to the GPR
acquisition setup. The data files are then imported as 2D geometries. The following
Import GPR Seismics window allows the user to select one line and import the line
according to the given setup. The time stamps or sampling rate in OpendTect is
defined in milli- seconds. However, the DZT files are often sampled with nano-
seconds sampling rate. To adjusted this, there is an input field available i.e. 'Z factor'
that allows re-scaling of Z-axis or time. In order to visualize the data in OpendTect,
this factor should be large enough. The remaining parameters i.e. Start X,Y position
or X/Y steps could be filled according to the profile location.
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4.3.11.6 Tagged Seismic Data
The imported volumes may contain any data. However several types can be spe-
cified during import and/or after:

l Depth poststack volumes/lines loaded in time surveys. A check box must be toggled
on during SEG-Y or simple file import.

l Time poststack volumes/lines loaded in depth surveys. A check box must be toggled
on during SEG-Y or simple file import.

l Velocity/anisotropy volumes must be tagged with respect to their type, when imported
from an external file. The available types are:

l Vint: Interval velocity
l Vrms: RMS velocities (time domain only). A provided surface may provide elevation
statics in meters. For time surveys a statics velocity must be provided in m/s, either
from a velocity grid or using a constant velocity.

l Vavg: Defined as the ratio between the depth and the travel time: Vavg(TWT)-
)=2*Z/TWT=Z/OWT.

l Delta: Thomsen anisotropy parameter of the same name.
l Epsilon: Thomsen anisotropy parameter of the same name.
l Eta: Effective anisotropy parameter, combine from delta and epsilon. This tag can also
be used to grid another quantity (the software does not actually check that eta values
are input).

The assignment of velocity types (and properties) to a volume is called velocity edi-
tion. This window can be opened in most windows wherever velocity volumes are
used (an exception is the attribute set window):

l Volume gridding
l Time-to-depth scenes
l Time-to-depth conversions
l Velocity conversions

Application of velocity corrections on prestack gathers
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The velocity volumes may be scanned to get the Vavg range at their first and last
sample. This allows the software to deduct and propose appropriate time/depth
ranges during conversions (on-the-fly and batch).
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4.3.12 Import Velocity Functions
Velocity functions can be imported to OpendTect using ASCII files that contain pos-
ition information (e.g. X/Y or Inl/Crl), Z and Velocity values. You may display the
input file by pressing the Examine button.

After importing Velocity Function (irregularly sampled data) use Velocity Gridder to
create Velocity Field which can be displayed and used for domain conversions.

Velocity type

The amplitude type of the input data must be specified.

l Vint : Interval Velocity, the amplitude of a point accounts for the layer above it.
l Vrms: RMS Velocity can only be used in time surveys. They will be treated with a
simple Dix for the extraction of the time-depth relationship. If this type is selected, you
need to specify if it has statics or not.

l Vavg: Average Velocity is the ratio at a given depth between depth and travel-time:
Vavg = 2*Z/TWT = Z/OWT. As a result a Vavg quantity holds entirely the data from
time-depth pairs.

l Delta, epsilon and eta functions will be vertically interpolated with linear interpolation.
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Format definition

Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the
Format definition window. If Coordinate Reference System (CRS) is defined for the
survey, CRS conversion will be available in the import window.

It is recommended to save the format definition for a later use by clicking on the
icon . In the pop-up window, write the name of the format and store it at an appro-
priate level (All surveys, This survey only, or My user ID only) depending on the
usage.
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4.3.13 Import Wavelets
Wavelets can be imported into OpendTect as ASCII files. The input file should be
column sorted with one time/depth sample position per record. The input file can be
displayed by pressing the Examine button.

Wavelets can be used for synthetic-to-seismic tie, or convolution via the convolve
attribute. Wavelets are also used to store all kinds of frequency-derived operators,
like seismic spectral blueing and seismic coloured inversion operators.

Format definition

Pre-defined and saved file formats are available by pressing the icon. Other-
wise, the format must be manually specified. The Define button gives access to the
Format definition window:

l Center sample: a number of lines between the first sample and the center sample (if
provided incorrectly, a warning message suggests an auto-predicted number).

l Data samples: a column containing amplitude values.
l Stop reading at: optional keyword to stop reading a file.
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When file header is present, both sampling interval and center sample can be
dynamically extracted from it by providing keywords for each, or indexed using
columns positions.

It is recommended to save the format definition for a later use by clicking on the
icon . In pop-up window, write the name of the format and store it. The format can be
stored at different levels (All surveys, Current survey, Current OpendTect user
level) depending on the usage. Press OK when done.
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4.3.14 Import Wells
Well data in OpendTect is organized into four sub-categories: well tracks, well logs,
markers (well tops) and time-depth models. Each category can be imported via Sur-
vey > Import >Wellsmenu:

l ASCII: single well import.
l Simple Multi-Well: simple multi-well import of vertical wells.
l Bulk: multi-well import.
l VSP (SEG-Y):import of zero-offset VSP data.

Alternatively, import (and editing) of well data is available from the Manage Wells
window (Survey >Manage >ManageWells):

l Import button in Well Track , Checkshot , Depth/Time Model and Markers
editors allows to import these tables from ASCII files.

l Import... button below Log list allows to import well logs from LAS files.
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Reference datums used in OpendTect are schematically shown in the figure below:
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Well depths in OpendTect are always referenced using their Measured Depth (MD).
The alignment with seismic data is done using well track data (deviation survey) and
time- depth (and/or checkshot) data. The well track data provides the relation
between lateral coordinates, True Vertical Depth Sub Sea (TVDSS) and MD values.
The time-depth data provides the relation between MD and TwoWay Times (TWT).
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4.3.14.1 From ASCII Files
Single well import is available via Survey > Import >Wells > ASCIImenu:

l Track: import of deviation survey and time-depth model (and/or checkshot data).
l Logs: import of well logs from LAS files.
l Markers: import of markers (well tops).
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4.3.14.1.1 Track

Importing Well Tracks into OpendTect via Survey > Import > Wells > ASCII >
Track... can be done via these three main input types:
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In time surveys, time-depth model must also be either imported using column sorted
ASCII file, or temporarily defined as constant velocity at this step.

The well track is the core part of a well, it is required for the visualization of
well data in depth and further loading of markers and logs. The well track
determines the size of the usable and displayed well data. Any log or
marker outside of the track Z range will neither be usable nor be displayed.
On the other hand the well track is not limited to the survey Z range and can
be loaded outside the survey box.

A time-depth model is another core piece of information which is required
for visualization and use of well data in time.

Reference datums used in OpendTect are schematically shown in the figure
below (note that Measured Depth [MD] is always referenced from Kelly
Bushing [KB]):
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For a deviated well, the file must contain 4 columns: position information
(X/Y or Inl/Crl), true vertical depth sub sea (TVDSS) and MD.

For a vertical well, the file must contain at least 3 columns: position inform-
ation(X/Y or Inl/Crl) and at least one depth column, TVDSS or MD (Refer-
ence Datum Elevation [KB] value must be specified in this case).

The best way to ensure that the reference datum elevation is properly set is
to have the deviation survey file starting at MD = 0 and the TVDSS of KB. In
the example below: KB elevation of a well is 34.1 m above MSL, i.e. in
OpendTect TVDSS at KB is -34.1 m, which corresponds to MD=0.0 m:

X Y Z (TVDSS) MD
623255.98 6082586.87 -34.10 0.00
623255.98 6082586.87 0.00 34.10
623255.98 6082586.87 65.90 100
623255.84 6082591.69 440.86 475

Format definition
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Use the Examine option to inspect the input file to ensure you set the Format Defin-
ition correctly:

Predefined and saved file formats are available by clicking on icon. Otherwise
the format must be manually specified by clicking on Define button and selecting
column numbers corresponding to position information (X/Y or Inl/Crl), Z and MD. If
Coordinate Reference System (CRS) is defined for the survey, CRS conversion will
be available in the import window.

l X and Y are absolute coordinates (not relative to the surface coordinates) and must
have same units as the OpendTect survey coordinates.

l Z is TVDSS, increasing downwards and equal to zero at sea level.
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l For a vertical well, either Z orMD can be left unspecified (col:0). In this case Reference
Datum Elevation [KB] value must be provided in the main Import Well Track window.

It is recommended to save the format definition for a later use and QC, by clicking
on icon. The format can be stored at different levels (All surveys, This survey
only, orMy user ID only) depending on the usage.

Well Track File

The Import Well Track window allows to select an ASCII file containing a well track,
be it vertical or deviated* (see below).

Vertical well
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The Import Well Track window allows to create a vertical well by entering its surface
coordinates, Reference Datum Elevation [KB] and Total Depth [TD].

Directional Wells (Inclination/Azimuth)

During Well import, you must select 'Directional Well' from the drop down menu
'Input Type' at the top of Import Well Track window:
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This will activate the 'First Coordinate' fields where you should enter the absolute
X,Y (surface location) of the well.

Then check the box 'Reference Datum Elevation [KB]' and enter the KB.

It is best to do the same for TD as well, as usually the last entry in the file is less than
TD.

Select the Well Track file, Examine it and Define the Format. In this option the expec-
ted data is Inclination (dip) and Azimuth :
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Above figure: (a) Azimuth and inclination when drilling a directional well; (b) The azi-
muth of a directional well is the deviation from magnetic north and the inclination is
the deviation from the vertical direction of the well. (See: https://www.re-
searchgate.net/figure/a-Azimuth-and-inclination-when-drilling-a-directional-well-b-
The-azimuth-of-a_fig2_320511730)

The remaining fields in the Import Well Track window should be filled as per a stand-
ard well.

There is also an option for the import of multiple Directional Wells (Survey -> Import
-> Wells -> Bulk -> Directional Wells...). For this 'Bulk' option it is necessary to first
enter the locations of the wells using the ‘Well Locations’ import option.

* Deviated Wells (DX/DY)

Deviated Wells may be imported via 'Directional Well', but you may also select ‘Well
Track File (XYZ)’ - both of these options support relative values.

If using the ‘Well Track File (XYZ)’ option, then you will need to use the
‘Advanced/Optional’ dialog to specify the Surface Coordinate (the equivalent of the
‘First Coordinate’ that is activated in the ‘Directional Well’ option).

It is also possible to use the option Import Well Locations - especially handy for
importing or Multiple Wells.

Once you have the Well Locations in place, you may then return to the relevant
Import -> Wells -> Bulk… option.

Time-Depth Model

If checked Depth to Time model file, a file containing the time-depth relation model
can be provided as an ASCII file containing depth as TVDSS, TVD-SRD or MD. If
time-depth model is unavailable, the check box at the left of this field can be deselec-
ted and temporary model velocity value (m/s) should be provided.

https://www.researchgate.net/figure/a-Azimuth-and-inclination-when-drilling-a-directional-well-b-The-azimuth-of-a_fig2_320511730
https://www.researchgate.net/figure/a-Azimuth-and-inclination-when-drilling-a-directional-well-b-The-azimuth-of-a_fig2_320511730
https://www.researchgate.net/figure/a-Azimuth-and-inclination-when-drilling-a-directional-well-b-The-azimuth-of-a_fig2_320511730
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Predefined and saved formats are again available by pressing the icon. Other-
wise the format must be manually specified. The Define button gives access to the
format definition window.

You must specify in the format definition window the column where depths and
times are located, and the type of data to be expected. Three types of depths are
supported for loading a check-shot/time-depth curve from a file. The supported
depths are: MD, TVDSS, TVD rel SRD. Time values can be either one-way or two-
way traveltimes. Times (lines) that should not be read must all have the same
numerical value, which is to be filled in as the Undefined value".

Time-depth models are always stored using measured depths and two-way travel
times in seconds. Therefore any other input format will cause a conversion of the
input data. Data loading can be stopped at a specific line by providing the adequate
keyword.

It is mandatory that the time-depth model obeys the following requirement:
TWT = 0.0 ms corresponds to TVDSS at SRD. The best way to ensure this
is to have such line in the imported file. For example, if SRD is 1000.0 m
above MSL, i.e. in OpendTect TVDSS at SRD is -1000.0 m, then the file
should contain a line with the following TVDSS (m) - TWT (ms) pair: -1000.0
m - 0.0 ms.

It is highly recommended that the 2nd sample of the time-depth model cor-
responds to the start depth of your sonic log, unless the input is a measured
checkshot survey.

The Time-Depth model used during import can be either a checkshot model or a
"normal" time depth curve. More information can be found in the well management
chapter.

Similarly the depth-time model reading settings can be saved:



- 347 -

Advanced/Optional

The Advanced/Optional button allows the user to provide optional parameters.
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l Surface Coordinate: if provided, the coordinates written in the first line of the track file
will be overruled.

l Replacement Velocity: interval velocity from KB to SRD.
l Ground Level Elevation: elevation of GL above MSL.
l Unique Well ID: unique well identifier which can be used during import of well logs and
markers.

l Operator, State, County, Province, County, Field: text details about a well.



- 349 -

4.3.14.1.2 Logs

Logs of a single well can be imported to OpendTect as LAS or pseudo-LAS file via
Survey > Import > Wells > ASCII > Logs... The import of well logs requires the well
track to be imported first.

Logs can also be imported or computed from the well manager.

Import Logs: The LAS file should contain depth values as MD or TVDSS. Altern-
atively, the log files can be pseudo-LAS, meaning LAS (with one line of data per
depth value) with the header replaced by a one- line definition: "Depth Gamma
Sonic" etc (without quotes). Log names should be separated by blank characters
(space or tab). For both LAS and pseudo LAS, the following units can be recog-
nized. The recognition process is case insensitive.

Once the file has been selected all recognized logs will be listed in the Select logs
section. Only the highlighted logs will be imported. Be careful that two logs do not
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have the same name. The depth interval can be limited to a sub-range. The start
depth, stop depth and step written in the LAS files are not used; instead the depths
found on the same line as the amplitudes will be used.

In pseudo LAS, units should follow directly behind the log name in parentheses, e.g.
Depth(ft) Density(g/cc). Below are examples of text string that will match units:

l Time: s, msec, µsec
l Distance:m, feet, f, ft, in
l Density: kg/m3, g/cc, g/c
l Velocity:m/s, ft/s, f/s, feet/s, km/s
l Sonic: s/m, us/ft, µsec/f, us/m, usec/m
l Acoustic Impedance: kg/m2s, kg/m2us, g/ft2s
l Fraction (porosity, water saturation):%, PU, or blank for unitless
l Permeability: k
l Gamma Ray: API
l Electric Potential: V
l Resistance: ohm
l Compressibility: 1/Pa
l Temperature: K, deg.C, deg.F
l Pressure: Pa, bar
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4.3.14.1.3 Markers

Markers of a single well can be imported to OpendTect as ASCII files via Survey >
Import >Wells > ASCII > Markers...The import of markers requires the well track to
be imported first.

Markers can be also imported from the well manager.

In the Edit Well Markers window click on Import button to display Import Markers
window.
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Input ASCII file should contain names of the markers and depth values as MD or
TVDSS and can be displayed by pressing the Examine button.

Format definition

Predefined and saved file formats are available by pressing the Open icon .
Otherwise the format must be manually specified. The Define button gives access
to the format definition window.
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Column numbers of the marker name and depth should be specified. Please mind
the spaces in the marker names that can break the fixed column format.

It is recommended to save the format definition for a later use and QC, by clicking
on the Save icon . In pop-up window, write the name of the format and store it.
The format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. PressOk when done.
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4.3.14.2 Import Zero-Offset VSP
A zero-offset VSP data can be imported for a selected well via Survey > Import >
Wells > VSP (SEG-Y)... First browse and locate the input file. Then in the Import
SEG-Y Data window check the quick scan results and press Next when done.

In the pop-up Import Zero-offset VSP window, select the type of input Z values
(TWT, TVDSS or MD), select the well to which the VSP log should be added and
press OK to import the log.
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4.3.14.3 Import Well Locations
This utility window allows the quick creation of multiple vertical wells with a constant
velocity as depth-time model provider. The table window below can either be filled
manually or by reading a file.

The following parameters are mandatory:

l Well name
l (Vertical) position along the X axis, in the same unit as the survey geometry.
l (Vertical) Position along the Y axis, in the same unit as the survey geometry.
l Reference datum elevation (KB or other): Altitude measured from sea level of the point
MD = 0., positive upwards. Can be left to 0 if unknown.

l Total depth (TD): Largest measured depth in the well. This parameter is half optional; If
not provided the well track is created such that it will reach the survey base.

The following parameters are optional:

l Seismic reference datum (SRD): Altitude measured from sea level of the point TWT =
0 ms, positive upwards.

l UWI (Unique well identifier): You can input any number, string or combination.
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To read a file containing that information, press Read file and select the input ASCII
file. One line in this file should correspond to one line in the output table.
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The main work is to specify the presence of a file header and the file format defin-
ition. The header, if present, can be of fixed length (number of lines), or delimited on
its last line by a keyword.

Predefined and saved file formats are available by pressing the icon. Otherwise
the format must be manually specified. The Define button gives access to the format
definition window.
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You must specify in the format definition window the column numbers of the X and Y
coordinates (absolute values, not relative to the surface coordinates), in the same
unit as used when defining the OpendTect survey. Reference datum elevation and
TD should also be provided, while the SRD and UWI are less frequently used.
Please note that KB and SRD both increase upwards and are positive above sea
level, whereas MD is a depth and increases downwards (MD is never negative).

It is recommended to save the format definition for a later use and QC, by clicking
on the icon. In pop-up window, write the name of the format and store it. The
format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage.
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4.3.14.4 Bulk
The bulk import tool is available via Survey > Import >Wells > Bulk menu. It allows
to import well tracks, time-depth models, logs and markers for different wells from
one or several files. The data is matched against primarily the well name and, if
available, against the Unique Well Identifier (UWI). This has the following implic-
ations:

l The well name must appear on each line of the input file. If the well already exists, then
the UWI must match the database. The same applies for the UWI if it is used in com-
bination with the well name.

l The well name should not contain spaces, otherwise the matching with a given column
number will not work as expected.
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4.3.14.4.1 Bulk Well Track Import

Well tracks can be imported for several wells in bulk from a single ASCII file via Sur-
vey > Import > Wells > Bulk > Track... The specification for the input data is similar
to the single well import.

Click Define... to pop up the Format Definition dialog:
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You will have the option to select either the well Name or UWI (Unique Well Iden-
tifier). And also to set depth as either MD or TVDSS. You may also toggle on the
'Stop reading at' choice and set a value here.
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4.3.14.4.2 Bulk Well Log Import

Several LAS files can be imported for different wells in bulk via Survey > Import >
Wells > Bulk > Logs...

If the well name in the file does not match the current well database, it may be used
to create a track and dummy time-depth model if necessary. Well tracks and time-
depth models can be later imported from the well manager.
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4.3.14.4.3 Bulk Well Marker Import

Markers can be imported for several wells in bulk from a single ASCII file via Survey
> Import >Wells > Bulk >Markers.... The specification for the input data is similar to
the single well import.

Click Define... to pop up the Format Definition dialog:
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You will have the option to select either the well Name or UWI (Unique Well Iden-
tifier). And also to set depth as either MD or TVDSS. You may also toggle on the
'Stop reading at' choice and set a value here.
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4.3.14.4.4 Bulk Well Time-Depth Model Import

Time-depth models can be imported for several wells in bulk from a single ASCII file
via Survey > Import > Wells > Bulk > Depth/Time model... The specification for the
input data is similar to the single well import.

Click Define... to pop up the Format Definition dialog:
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You will have the option to select either the well Name or UWI (Unique Well Iden-
tifier). And also to set depth as either MD or TVDSS. You may also toggle on the
'Stop reading at' choice and set a value here.
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4.4 Export
Most OpendTect data types can be exported from OpendTect via Survey > Export
drop down menu of the main window.

Direct data exchange with Schlumberger's Petrel* is available via PetrelDirect plu-
gin (part of OpendTect Pro)

Direct data exchange with Landmark's SeisWorks and Schlumberger's GeoFrame-
IESX is available via Workstation Access plugin by ARK CLS.

* Petrel is a mark of Schlumberger.
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4.4.1 Export Faults
Faults can be exported as ASCII files via Survey > Export > Fault > ASCII...

In the Export Fault window: select a fault; specify the output format; type an output
file name (to save to Survey Data Root folder) or provide a full path by clicking
Select; select a coordinate system of the output file (the option is available only if the
current survey has a defined projection based coordinate system), and press
Export.

A successful export is confirmed with a message and an option to either export
more faults or close the export tool.
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4.4.2 Export FaultStickSets
Fault stick sets can be exported as ASCII files via Survey > Export > FaultStickSets
> ASCII...

In the Export FaultStickSet window: select a fault stick set; specify the output
format; type an output file name (to save to Survey Data Root folder) or provide a full
path by clicking Select; select a coordinate system of the output file (the option is
available only if the current survey has a defined projection based coordinate sys-
tem), and press Export.

A successful export is confirmed with a message and an option to either export
more fault stick sets or close the export tool.
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4.4.3 Export Geometry 2D
2D line geometries can be exported as ASCII files via Survey > Export > Geometry
2D > ASCII...

In the Export 2D Geometry window: choose one or several 2D lines; type an output
file name (to save to Survey Data Root folder) or provide a full path by clicking
Select; and press Export. The output file contains 4 columns: 2D line name, trace
number, X and Y coordinates.

A successful export is confirmed with a message and an option to either export
more 2D line geometries or close the export tool.
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4.4.4 Export Horizons
2D and 3D horizons can be exported as ASCII files via Survey > Export > Horizons.
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4.4.4.1 Export Ascii 3D Horizons
3D horizons (surfaces) can be exported as ASCII files via Survey > Export > Hori-
zons > ASCII 3D...

In the Export Horizon window: select a 3D horizon; optionally include available Cal-
culated attributes; specify the output format; type an output file name (to save to Sur-
vey Data Root folder) or provide a full path by clicking Select; and press Export.

A successful export is confirmed with a message, and the export window stays open
to export more horizons.

Output Format options.
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Calculated attributes: one or more attributes from the stored horizon data can be
exported along with a horizon.

Horizon data can be created via Processing > Create Horizon Output, or an attribute
calculated on-the-fly on a horizon in the 3D scene can be Saved as Horizon Data.
More information about calculating attributes in OpendTect can be found here.

Use Manage 3D Horizons window to manage stored horizon data.

Output Type:

l default OpendTect horizon export format: based on either X/Y or Inl/Crl coordinates;

Column 1: X or Inline; Column 2: Y or Crossline: Column 3: Z in user-specified units
(if Output Z is Yes or Transformed) or the first selected item in the Calculated attrib-
utes list (if Output Z is No); followed by other selected items in the Calculated attrib-
utes list.

l pre-defined GeoFrame IESX (3d_ci7m) format: Settings button appears and allows to
change Horizon name in file and add Comment.

Output Z: available if theOutput Type is set to either X/Y or Inl/Crl.

l Yes: by default Z is written to the output file in Z Unit specified by a user;
l No: this option can be used when exporting attribute grids only;
l Transformed: allows domain conversion based on one of the following:

l Velocity Volume: selected interval velocity model;
l Well's Depth model: a time-depth model of a chosen well;
l Linear velocity: a linear velocity function based on a starting interval velocity Vint
and a velocity gradientGradient
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Coordinate System: select a coordinate system of the output file (the option is
available only if the current survey has a defined projection based coordinate sys-
tem).

Header: available if theOutput Type is set to either X/Y or Inl/Crl.

l No: no header is written to the file by default;
l Single line: the 1st line contains column names, the 2nd line is a separator, while data
starts from the 3rd line only;

l Multi line: column names are listed in the individual lines followed by a separating line.
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4.4.4.2 Export Ascii 2D Horizons
2D horizons can be exported as ASCII files via Survey > Export > Horizons > ASCII
2D...

In the Export 2D Horizon window: select a 2D horizon; from the list of 2D lines
choose which ones to export; specify the output format; type an output file name (to
save to Survey Data Root folder) or provide a full path by clicking Select; and press
Export.

A successful export is confirmed with a message and an option to either export
more 2D horizons or close the export tool.
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Output Format options

Select Lines: selection from the list of 2D lines on which the selected horizon is
present.

Header:

l No: no header is written to the file by default;
l Single line: the 1st line contains column names, the 2nd line is a separator, while data
starts from the 3rd line only;

l Multi line: column names are listed in the individual lines followed by a separating line.

Z: by default in seconds (or meters in Depth surveys), can be changed to mili-
seconds (or feet in Depth surveys)

Coordinate System: select a coordinate system of the output file (the option is
available only if the current survey has a defined projection based coordinate sys-
tem).
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4.4.5 Export Mute Functions
Mute functions can be exported as ASCII files via Survey > Export >Mute Functions
> ASCII...

In the Export Mute Function window: select a mute definition; choose coordinates
format; type an output file name (to save to Survey Data Root folder) or provide a full
path by clicking Select; select a coordinate system of the output file (the option is
available only if the current survey has a defined projection based coordinate sys-
tem), and press Export. The output file contains 4 columns: X/Y or Inl/Crl coordin-
ates, offset and Z (time or depth) values.

A successful export is confirmed with a message, and the export window stays open
to export more mute functions.
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4.4.6 Export Pointsets & Polygons
Pointsets and polygons can be exported as ASCII files via Survey > Export > point-
sets/Polygons > ASCII...

In the Export pointsets/Polygons window: select a pointset or a polygon; type an out-
put file name (to save to Survey Data Root folder) or provide a full path by clicking
Select; select a coordinate system of the output file (the option is available only if the
current survey has a defined projection based coordinate system), and press
Export. The output file contains 3 columns: X/Y coordinates and Z (time or depth)
values.

A successful export is confirmed with a message and an option to either export
more pointsets/polygons or close the export tool.
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4.4.7 Export Probability Density Functions
Probability Density Functions (PDFs) can be exported as ASCII files in Icon
Science's RokDoc format via Survey > Export > Probability Density Functions >
ASCII (RokDoc)...

In the Export Probability Density Function window: select a PDF; type an output file
name (to save to Survey Data Root folder) or provide a full path by clicking Select;
and press Export.

A successful export is confirmed with a message, and the export window stays open
to export more PDFs.
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4.4.8 Export Seismic Data
2D/3D poststack and 3D prestack seismic data can be exported as SEG-Y or simple
files via Survey > Export > Seismics.
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4.4.8.1 Export SEG-Y
2D/3D Poststack and 3D Prestack data can be exported from OpendTect in SEG-Y
format:

The SEG-Y revision 1 default bytes locations will be used during export, but addi-
tional positions can be used with the personal setting keywordspersonal setting
keywords listed on the right-hand side.

The point is a trace attribute stored in the OpendTect seismic files. It is most often
not used.

The reference number is most often the Shot Point for 2D data but could be used for
anything else. Please note that a SEG-Y scalar at bytes 201-202 apply for values
stored in bytes 197-200. The SP scalar will always be -10, thus the value written on
bytes 197-200 is 10 times the SP value.
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All values listed above are encoded on 4 bytes by default. The byte length can be
overridden using the following personal key words, except for the coordinates:

l SEG-Y.Nr bytes for In-line
l SEG-Y.Nr bytes for Cross-line
l SEG-Y.Nr bytes for Offset
l SEG-Y.Nr bytes for Azimuth
l SEG-Y.Nr bytes for trace number
l SEG-Y.Nr bytes for Point
l SEG-Y.Nr bytes for RefNr

The layout of the SEG-Y export window changes slightly based on the data type.
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4.4.8.1.1 Export SEG-Y 3D

Stored 3D volumes can be exported from OpendTect in SEG-Y format.

All fields are optional, except the output filename that must be provided. The export
will be launched when pressing Export.

l Volume subselection: Can be defined here in various ways.
l Null traces: They can be either discarded or written in the SEG-Y file. For 3D SEG-Y
export there is a third option in addition to the two described previously, Add. It basic-
ally adds null traces where there is NO data present in the seismic cube, such that the
output SEG-Y cube will be without any gaps for one individual inline or crossline.
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l Scale values: A linear scaling can be applied while exporting the data: a simple linear
scaling that’s applied to the trace values. Formula is: y=ax+b where a is the factor, b is
the shift, x is the original value, y is the new scaled value. Useful when storing 32 bit
data as 16 bit.

l Adjust Z range to survey range: Opt for limit to survey Z range (or not).
l Export to other CRS: By default the SEG-Y will be exported in the CRS of the current
survey. Choose 'No' to select a different coordinate system for the output file. (The
option is available only if the current survey has a defined projection based coordinate
system).

l SEG-Y format: Please note that this option may clip your data if the output format has
less bytes than the input OpendTect format.

l Text header: The SEG-Y textual header is automatically created, but may be provided
by the user, either from a text file or directly from a SEG-Y file via the 'Edit' option.

l Text header format: Choose between (default) American Standard Code for Inform-
ation Interchange (ASCII), or Extended Binary Coded Decimal Interchange Code
(EBCDIC)

l Manipulate output file after creation: Checking this box opens the Manipulate SEG-
Y file window, allowing for the editing of the text, binary and trace headers of the expor-
ted SEG-Y file. All changes made to SEG-Y headers can only be saved to a newOut-
put file.
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Multi-Component Export

Since SEG-Y files can only contain one component per file, if the input CBVS cube
contains multiple components, at the input selection stage, an option will appear to
select which component of the volume to output (see below):

The Input Cube text will then display the cubename|component as per the following
example:

Tip: It is a good practice to display the 3D seismic data on a z-slice to check for any
gaps in inline/cross-lines or the presence of null traces, before exporting it.
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4.4.8.1.2 Export SEG-Y 2D

Stored 2D data can be exported from OpendTect in SEG-Y format.

All fields are optional, except the output filename that must be provided.

l Input Data Set: Select the data set to be exported.
l Line name: The lines available in the data set are listed here. Only one line can be
selected.

l Trace subselection: Can be defined here in various ways.
l Null traces: They can be either discarded or written in the SEG-Y file.
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l Scale values: A linear scaling can be applied while exporting the data: a simple linear
scaling that’s applied to the trace values. Formula is: y=ax+b where a is the factor, b is
the shift, x is the original value, y is the new scaled value. Useful when storing 32 bit
data as 16 bit.

l Export to other CRS: By default the SEG-Y will be exported in the CRS of the current
survey. Choose 'No' to select a different coordinate system for the output file. (The
option is available only if the current survey has a defined projection based coordinate
system).

l SEG-Y format: Please note that this option may clip your data if the output format has
less bytes than the input OpendTect format.

l Text header: The SEG-Y textual header is automatically created, but may be provided
by the user, either from a text file or directly from a SEG-Y file.

l Export more lines from the same dataset: Checking this option removes the Line
Name and Trace Subselection options from the main window (above) and, on pressing
Export, the 2D SEG-Y multi-export window appears wherein the specify the file details
to be exported:
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Pressing OK will then, in one batch, export each selected line from the
dataset as an individual SEG-Y file to the specified location.
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4.4.8.1.3 Export SEG-Y Prestack 3D

Prestack 3D data may be exported from OpendTect in SEG-Y format.

All fields are optional, except the output filename that must be provided.

l Volume subselection: Can be defined here in various ways.
l Null traces: They can be either discarded or written in the SEG-Y file. For 3D SEG-Y
export there is a third option in addition to the two described previously, Add. It basic-
ally adds null traces where there is NO data present in the seismic cube, such that the
output SEG-Y cube will be without any gaps for one individual inline or crossline.
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l Scale values: A linear scaling can be applied while exporting the data: a simple linear
scaling that’s applied to the trace values. Formula is: y=ax+b where a is the factor, b is
the shift, x is the original value, y is the new scaled value. Useful when storing 32 bit
data as 16 bit.

l Adjust Z range to survey range: Opt for limit to survey Z range (or not).
l Export to other CRS: By default the SEG-Y will be exported in the CRS of the current
survey. Choose 'No' to select a different coordinate system for the output file. (The
option is available only if the current survey has a defined projection based coordinate
system).

l SEG-Y format: Please note that this option may clip your data if the output format has
less bytes than the input OpendTect format.

l Text header: The SEG-Y textual header is automatically created, but may be provided
by the user, either from a text file or directly from a SEG-Y file via the 'Edit' option.

l Text header format: Choose between (default) American Standard Code for Inform-
ation Interchange (ASCII), or Extended Binary Coded Decimal Interchange Code
(EBCDIC)

l Manipulate output file after creation: Checking this box opens the Manipulate SEG-
Y file window, allowing for the editing of the text, binary and trace headers of the expor-
ted SEG-Y file. All changes made to SEG-Y headers can only be saved to a newOut-
put file.
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4.4.8.1.4 Export SEG-Y Prestack 2D

Prestack 2D data may be exported from OpendTect in SEG-Y format.

All fields are optional, except the output filename that must be provided.

l Input Prestack 2D Data: Select the 2D prestack data set to be exported.
l Line name: The lines available in the data set are listed here. Only one line can be
selected.
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l Trace subselection: Can be defined here in various ways.
l Null traces: They can be either discarded or written in the SEG-Y file.
l Scale values: A linear scaling can be applied while exporting the data: a simple linear
scaling that’s applied to the trace values. Formula is: y=ax+b where a is the factor, b is
the shift, x is the original value, y is the new scaled value. Useful when storing 32 bit
data as 16 bit.

l Adjust Z range to survey range: Opt for limit to survey Z range (or not).
l Export to other CRS: By default the SEG-Y will be exported in the CRS of the current
survey. Choose 'No' to select a different coordinate system for the output file. (The
option is available only if the current survey has a defined projection based coordinate
system).

l SEG-Y format: Please note that this option may clip your data if the output format has
less bytes than the input OpendTect format.

l Text header: The SEG-Y textual header is automatically created, but may be provided
by the user, either from a text file or directly from a SEG-Y file.

l Text header format: Choose between (default) American Standard Code for Inform-
ation Interchange (ASCII), or Extended Binary Coded Decimal Interchange Code
(EBCDIC)

l Manipulate output file after creation: Checking this box opens the Manipulate SEG-
Y file window, allowing for the editing of the text, binary and trace headers of the expor-
ted SEG-Y file. All changes made to SEG-Y headers can only be saved to a newOut-
put file.
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4.4.8.2 Export Simple File
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4.4.8.2.1 Export 3D Simple File Format

The stored volumes in the OpendTect survey can also be exported as a simple Ascii
or binary file.

Simple 3D Seismic File Export Window

l Input Cube: Select the volume to export.
l Volume Subselection: A part of the line can also be sub-selected. If the entire line is
meant to be exported: after clicking on Select..., define the number and time ranges.
Leave the values default or select All in the trace subselection window.

l Scale values: The data can be scaled in the output. The output will be calculated with:
Output = Factor * Input + Shift

l Null traces: Null traces can be discarded or left inside the line (Pass).
l Output a position for every trace: If Yes then the output will contain a short header
information. If No, no header will be added.

l (If Yes selected in the previous option)Position in file will be: In the output file,
the position information can either be XY locations or Inline/crossline numbers
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l Put sampling info in file start: Select Yes to allow the sampling information to
appear at the beginning of the file.

l File type: Select the appropriate output file type: Ascii or Binary.
l Output file: Select/write the output file location.

Multi-Component Export

If the input cube is a stored multi-component data, an additional selection box will
appear in the window. Select the desired component to be exported as an Ascii or
Binary file.
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4.4.8.2.2 Export 2D Simple File Format

A stored data set in the OpendTect survey can also be exported as a simple Ascii or
binary file.
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Simple 2D Seismic File Export Window

l Input Data Set: Select the data set to be exported
l Line name: The lines available in the data set are listed here. Only one line can be
selected.

l Trace Subselection: A part of the line can also be sub-selected. If the entire line is
meant to be exported: after clicking on Select..., define the number and time ranges.
Leave the values default or select All in the trace subselection window.

l Scale values: The data can be scaled in the output file. The output will be calculated
with: Output = Factor * Input + Shift

l Null traces: Null traces can be discarded or left inside the line (Pass).
l Output a position for every trace: If Yes then the output will contain a short header
information. If No, no header will be added

l (If Yes selected in the previous option) Include trace number (preceding X/Y): In
the output file, it includes the trace numbers before X and Y locations.

l Put sampling info in file start: Select Yes to allow the sampling information to
appear at the beginning of the file.

l File type: Select the appropriate output file type: ASCII or Binary.
l Output file: Select/write the output file location.
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4.4.8.2.3 Export PreStack Simple File

In OpendTect, you can also export a simple seismic Ascii or Binary file from Pre-
Stack 3D seismic data via Survey > Export > Seismic > Simple File > Prestack 3D.

l Input Data Store: Select the Pre-Stack seismic to export.
l Volume Subselection: A part of the line can also be sub-selected. If the entire line is
meant to be exported: after clicking on Select..., define the number and time ranges.
Leave the values default or select All in the trace subselection window.

l Scale values: The data can be scaled in the output. The output will be calculated with:
Output = Factor * Input + Shift

l Null traces: Null traces can be discarded or left inside the line (Pass).
l Output a position for every trace: If Yes then the output will contain a short header
information. If No, no header will be added.

l (If Yes selected in the previous option) Position in file will be: In the output file,
the position information can either be XY locations or Inline/crossline numbers

l Include:Optionally you can select to include Offset and/or Azimuth information.
l Put sampling info in file start: Select Yes to allow the sampling information to
appear at the beginning of the file.

l File type: Select the appropriate output file type: ASCII or Binary.
l Output file: Select/write the output file location.
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4.4.8.3 Cube Positions

Exports the positions of a cube in the following format:

Number of inlines

(inline number) (number of segments on this inline) (start crossline) (stop
crossline) (step)

.....
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4.4.9 Export Survey Setup
Exports an OpendTect Survey Setup into a text file:
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4.4.10 Export Wavelets
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Wavelet Export Window

After selecting the wavelet to export, you can optionally also output the time (if time
survey) or depth (if depth survey). Give an appropriate name and storage location,
the wavelet will be exported when clicking onOk.
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4.4.11 Export Well

Choose between exporting Wells and Well data to ASCII, or Well Log Data to LAS
file(s).

Note that Wells and Well data can also be exported via the Well Manager.
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4.4.11.1 Export Well Data to ASCII

Well Export Facility

After selecting the well to export, you can choose which information to include in the
exported ASCII file, the time type, logs and range.

Finally choose the desired z-unit and name before you select the Base name and
output directory.
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4.4.11.2 Export Well Log Data to LAS

After selecting the desired well, choose which logs to include in the exported LAS
file.

Set MD range, step and Z-unit, choose null value and column width.

Finally, select output name and location - by default it will be sent to the /Export dir-
ectory of the current survey with the default name: wellname_logs.las
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4.5 Manage
OpendTect keeps track of the different files imported into or created by the system.
Deleting, renaming, setting as default, merging of files (in some cases) …etc are
controlled from the Manage window. Most objects (seismic volumes, horizons, well-
s…etc) have a dedicated ‘manager’ that can be called from this menu.

The most frequently used managers can be reached directly from the main user
interface:

All managers can be accessed via Survey > Manage...
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4.5.1 Manage Attribute Sets
The attribute set files can be managed from this window (See below). It is launched
from Survey > Manage > AttributeSets...

There are listed all the 2D and 3D attribute sets you have created or imported in the
Attribute Set window . You can modify the attribute set name, set as default,
remove etc. The icons are similar to the one from the general selection window.
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Use the top filter to find the wanted element(s) by typing the name or a part of the
name (complete the name with *): for example, to find ‘Demo attributes’, you can
type *Demo*.

To save or restore a selection, right-click on a listed item and select the wanted
action in the pop up menu.
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4.5.2 Manage Geobodies
Bodies created or imported to OpendTect are listed in this manager (See below).
The manager can be accessed either following Survey > Manage > Geobody… or
from the quick launch icon .

Here you can rename, lock for editing, delete and set as default any body. The icons
are similar to the one from the general selection window.

Additionally, four specific tools are available (for more information click on the links
below this page):

Body Operator

Body Region Constructor

Estimate Body Volume

Switch Body Values.
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Use the top filter to find the wanted element(s) by typing the name or a part of the
name (complete the name with *): for example, to find ‘Amplitude anomaly A’, you
can type *anomaly*.

To save or restore a selection, right-click on a listed item and select the wanted
action in the pop up menus.
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4.5.2.1 Body Operator

The body operator, accessed from the icon in the Bodies manager, enables to
perform various operations on a geological body (or combinations thereof), as listed
below.

For all the operators, click on the Input to select either a saved body or create a
body using an operator. Each operation needs 2 inputs. You can combine more
than one input using an operator as input. After giving a name to the new body, it will
be created after clicking on Run.
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Union

You can merge two or more bodies using the union operator as in the figure below:

The result of the 'Intersection' operation.

Intersection
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If you want to create a body from the shared portion of two bodies, you can use the
intersection operator.

The result of the 'Intersection' operation.

Difference
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If the operator is Difference, the output will be a result of the subtraction Input1-
Input2.

The result of the 'Difference' operation (the final body is the volume resulting from
Body 2 minus Body 1).
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4.5.2.2 Body Region Constructor

This tool allows you to create a regional body from your dataset using bound-
aries defined horizons and faults (or just a single wrapping horizon).
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4.5.2.3 Estimate Body Volume

The tool allows you to estimate the volume of any body. It can be accessed
either from the manager or from the tree (right-click menu on a body listed in the tree
or in the 3D scene).

The input velocity is an (estimated) velocity appropriate to the position of the body.
A default velocity is provided but needs to be updated according to your survey.
Click on Estimate to get the estimated volume (in m3).
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4.5.2.4 Switch Body Values

The icon activates a window with dual functionality.

l If you have built a regional body using two horizons and a fault, creating a kind of 'com-
partment', this tool allows you to 'flip' this body to create its 'negative'.

l Previous versions of OpendTect had bodies in different formats. This tools can also be
used to 'convert' these various formats into the standard format for 4.6.
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4.5.3 Manage Color Tables
The Color Table Manager gives access to the various settings used for data visu-
alization to edit an existing colour table or create a new one.

The manager is accessible from Survey > Manage > Color Tables and from the
right-click menu on the colour table in the 3D scene (See below).
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For a full description of the various options and possibilities, please see the fol-
lowing section: Color Tables
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4.5.4 Manage Cross-Plot Data
The crossplot file management is used to rename, remove, merge etc the stored
crossplot data files.

is used to rename the selected crossplot data file.

locks (read only) or unlocks the selected item.

remove the selected crossplot.
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make the selected crossplot as a default data for crossplotting. If pressed, the
selected item will be bounded by the signs (> Name <).

merge another crossplot with the selected one.

To merge two crossplots with different or similar attributes, you need to select a first
crossplot and then after clicking on the icon, choose the second crossplot in the
following window:

. When pressing Ok, opens the window where you have to provide different inform-
ation. If some columns have similar quantity in the two crossplots, it is possible to
specify for each column, which column from the crossplot2 matches a column from
crossplot1, even if they do not have the same name. If there is no match, just select
None, then you can decide to either add the unmatched columns or to ignore them.
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Then select the matching method:

l Exact match: same X,Y,Z
l Nearby match: almost same position or same depth.A horizontal and a vertical search
radius have to be provided

l Never match, add all new : add all positions, even with same or almost same (X,Y,Z).

For all of them, the replacement policy for matching positions has to be specified :
take value from crossplot1, take value from crossplot2 or take the average of the
two. Undefined value can be kept or replace if possible.

Once the merging parameters have been defined, you can give an appropriate
name and save it in clicking on Ok.
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4.5.5 Manage Faults
The faults interpreted/imported in the OpendTect project are listed in the Fault Man-
ager with the possibility to perform some basic actions: rename, remove, copy
…etc. The icons are similar to the one from the general selection window.

The manager can be accessed either following Survey > Manage > Faults… or from
the quick launch icon > Faults.
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Use the top filter to find the wanted element(s) by typing the name or a part of the
name (complete the name with *): for example, to find ‘FaultA’, you can type *A*.

To save or restore a selection, right-click on a listed item and select the wanted
action in the pop up menu.
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4.5.6 Manage FaultStickSets
The faultsticks interpreted/imported in the OpendTect project are listed in the
FaultStickSets Manager (see below) with the possibility to perform some basic
actions: change disk location, rename, remove, copy …etc. The icons are similar to
the one from the general selection window.

The manager can be accessed either following Survey > Manage > FaultStick-
Sets… or from the quick launch icon > FaultStickSets.
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Use the top filter to find the wanted element(s) by typing the name or a part of the
name (complete the name with *): for example, to find ‘SSIS-Grid-Faultsticks’, you
can type *Grid*.

To save or restore a selection, right-click on a listed item and select the wanted
action in the pop up menu.
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4.5.7 Manage Geometry 2D
2D Geometry manager is launched from Survey > Manage > 2D Geometry...

This window is used to manipulate the geometry of 2D seismic lines. The geometry
consists of X-Y coordinate pairs for each trace of the 2D seismic, identified with a
unique trace number (CDP most often). They are generally extracted from the SEG-
Y trace headers or from an auxiliary file during import.

From this manager, the coordinates of already imported 2D data can be altered.
The geometry is separated from the actual 2D seismic data and 2D horizon that are
solely referenced with respect to the trace number (CDP number). As a result the
coordinates of the geometry can safely be edited without having to re-import the 2D
seismic data and corresponding horizons.
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The icons are similar to the one from the general selection window.

Manage Line Geometry

The Line geometry manager is access by selecting a 2D line in the Manage 2D geo-
metry window (see above) and clicking on the icon. In this window (see below),
you can alter any trace number, X, Y values.

The name of the selected line is specified on top of the window. To edit a field, click
on it and type the new value. Changes will be saved on disk only after pressing OK.
Optionally, the entire geometry of the selected 2D line can be updated by reading a
text file by clicking on Import New Geometry (see section below).

Line geometry import

In the selection window (see below), select the input Ascii file. The input file should
be column sorted with one point per record (line).Optionally, you can display the
input file by clicking on Examine: you will be able to check the values and it will help
you filling it the remaining information.
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You need to specify the presence/absence of a header and its size if present. The
header, if present, can be of fixed length (number of lines), or delimited on its last
line by a keyword.

The file definition needs to be filed in to know which data corresponds to which
column.

The Define button gives access to the format definition window (see above). You
must specify in the format definition window:

l the column numbers for the position: as X/Y coordinates or Inline/Crossline. The
coordinate units must be in the same units as the coordinates of the survey corner
points. Inline/crossline can be used but it is not recommended because of the grid spa-
cing.
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l Optionally the trace number column. It is not recommended to alter (re-specify) the
trace numbers since it may corrupt the already loaded data.

l Optionally, the reading can be stopped at a specific line by providing the adequate
keyword: the reading will stop at the first occurrence of that word.

It is recommended to save the format definition for a later use and QC, by clicking
on the icon. Predefined and saved file formats can be restored by clicking on the

icon.
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4.5.7.1 Manage 2D Geometry

This window allows for selection and removal of geometry of data sets. The icon ,
opens a further window to Manage Line Geometry.
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4.5.7.2 Manage Line Geometry
In this window, line geometry can be edited on a per-trace, coordinate level.

The editing can be done manually, or you may make use of the option 'Set New Geo-
metry':
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4.5.8 Manage Horizons
Manage either 2D or 3D horizons either via Survey > Manage > Horizons... or via
the icon.
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4.5.8.1 Horizon Manager 2D
To open the Manage 2D Horizons window, navigate through Survey--> Manage-->
Horizons--> 2D... or use the icon from the Manage toolbar. In the left panel of the
window, the available horizons are displayed. It the bottom panel, information on the
selected horizon is displayed (eg. location on disk, date last modified). At the base
of the window the available disk space is noted.
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Horizons can be renamed , locked , removed , copied , set as default
or viewed as a dataset group .

The following window is used to copy horizon surfaces and grids:

The top filter is used to filter-out the objects with selected names. For instance, to
display all horizons that start with letter D use "D*".
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4.5.8.2 Horizon Manager 3D
The 3D Horizons manager can be accessed by the menu Survey > Manage > Hori-
zons > 3D or by the quick access icon > 3D Horizons.

This manager (see below) allows to have an overview of the interpreted/imported
3D horizons in the current OpendTect project (left panel), with their associated Hori-
zon Data (right panel). In the bottom panel, information on the selected horizon are
displayed (eg. location on disk, date last modified).

Additionally, the available disk space is indicated.
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Use the top filter to find the wanted element(s) by typing the name or a part of the
name (complete the name with *): for example, to find ‘Demo 2 --> FS6’, you can
type *FS6*.

The basic icons similar to the one from the general selection window are available
for the horizons management with some additional actions (see below).

Copy 3D Horizon

The copy window for 3D horizons differs slightly from the usual copy window. It is
indeed used to copy surface data and grids.

Merge 3D Horizons
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To merge horizons, select the horizons to be merged. In case of duplicate position,
the action needs to be specified: take average, use top or use base. The duplicate
positions will then be handled in the following manner (dashed line portion rep-
resents removed data after merge):

Stratigraphy
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The horizons can optionally be tied to a level, i.e. a regional marker (see below) by
clicking on the Stratigraphy button.

Stratigraphic marker can be assigned to one or more horizons. The horizons will get
the marker color, this will facilitate for example the well to seismic tie.

For more details on how to define stratigraphic markers and the subsequent units
go to Manage Stratigraphy.

Relations

The Horizon relation window is used to resolve conflicts between horizons crossing
each other. Read Horizons .... is used to select all horizons that need checking. The
horizons are then sorted automatically from top to bottom. The Check crossings...
button is used to automatically check the crossings between the listed horizons and
resolve them.
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Solving crossing conflicts

To solve crossing conflicts select the horizon that will be modified. The software will
check the number of positions where a conflict exits and modify the horizon by
removing the conflict points or by changing the values to be equal to the overly-
ing/underlying horizon. In the example below, the checked horizons have been
found to cross in 9 positions.
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To honor the requirement that horizons cannot coincide, the horizons actual pos-
itions are not exactly equal, but they are within one sample position accuracy.

If the lower horizon (red) is selected to be modified, the figure below sketches what
will happen to this horizon if you select shift or remove.
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4.5.9 Manage Layer Properties

Layer Properties - Definition window is accessible:

l by clicking the icon in the Layer Properties - Selection window of the Layer Model-
ingmodule;

l via Survey >Manage > Layer Properties...menu.
l Available property types: a hard-coded list of available property types.

Please contact support if you would like to extend the list of Available prop-
erty types.

l Defined usable properties: a list that contains layer properties available in the cur-
rent OpendTect project. Some of the most commonly used properties are pre-defined
for a user (for example, Acoustic impedance property of the Impedance type).
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The type of an existing property can not be changed. A new property of the
desired type has to be created instead.

l Store: a level at which layer properties are stored.
o For this survey only: (default option) properties are saved at the root of the sur-
vey, applicable for all users only for this survey.

o As default for all surveys: properties are saved in the parent Survey Data Root dir-
ectory (where all OpendTect surveys are located), applicable for all users and all
surveys.

o As default for my user ID only: properties are saved to home/.od file, which has
the priority over the two other sources.

The only way to restore the default OpendTect list of properties is to delete
the Properties files at all levels.

Available actions include:

l Add usable property: select a property type in Available property types list and click
on to pop up the Property definition window.

l Edit usable property: select a property in the list and click on icon (or double-
click on a property name) to pop up the Property definition window.

l Remove usable property: select a property in the list and click on icon.

The minimum possible list of properties must include at least one log for
each of the following types: Density, Velocity and Impedance.

Property definition window:
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l Name: a unique layer property name.
l Aliases (optional): specify possible aliases (useful to associate the correct log to a
property: logs with different names can thus be related to the same property).

l Default Display Color: a default color for a log display.
l Typical value range: a typical value range for a property with associated units.
l Default Value (optional, but recommended): type in a numeric value or click on For-
mula ... to set a mathematical formula in theMath property window (use RockPhysics
library to retrieve standard ones). Default Value is used to auto-fill property values
in layer definition windows (see Layer Modeling chapter), and the auto-filled value can
be changed for individual layers.

l Fixed definition (optional, but recommended for some properties: see the tip below):
type in a numeric value or click on Formula ... to set a mathematical formula in the
Math property window (use RockPhysics library to retrieve standard ones). A prop-
erty with Fixed definition doesn't appear in layer definition windows (see Layer Model-
ing chapter) as it is always auto-computed in the background.

A combination of well chosen Default Values and Fixed definitions can
significantly ease and speed up the modeling process. Default Values
should be preferably set for all properties and should be chosen such that
they roughly represent most of the modeled media. For example, specify
the default density corresponding to encasing shales and later in the mod-
eling workflow modify the auto- filled values only for target sand layers.
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Fixed definition is recommended for the properties which are defined by
specific formulas (i.e. never modeled directly, irrespective of a geological
setting): Acoustic and Shear Impedances, Vp/Vs and Poisson’s Ratios,
Lambda-Rho, Mu-Rho, etc.

The example below shows Density with a Fixed definition using Gardner's empirical
relation from Sonic values.

Math formulas can be optionally saved for later use and restored via and
icons respectively.
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4.5.10 Manage Pointsets & Polygons
Manage pointset/Polygon window is accessible:

l by clicking the icon in Manage Toolbar;
l via Survey >Manage > pointsets/Polygons ...menu.

All pointsets and polygons available in the current OpendTect project are listed
here. The object Type, pointset or Polygon, is given in the middle information area.

Available actions on pointsets/Polygons include:
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l Rename.
l Lock / Unlock (toggle read-only status on/off).
l Delete.
l Set as the default object of its type.
l Merge pointsets: several pointsets can be merged into one:

The top filter is used to filter-out the objects with selected names. For
instance, to display all pointsets that start with letter S use "S*".
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4.5.11 Manage Probability Density Functions
Manage Probability Density Function window is accessible via Survey > Manage >
Probability Density Functions ...menu.

The manager lists all PDFs available in the current project, allows to view/edit them
and generate new synthetic PDFs with user-defined specifications.

PDFs may also be imported and/or extracted from crossplots.

Main uses of PDFs in OpendTect are Bayesian Classification and
stochastic pseudowell modeling in SynthRock. PDFs can also be exported
to a file (ASCII/RockDoc format) for an external use.
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Available actions on PDFs include:

l Rename.
l Lock / Unlock (toggle read-only status on/off).
l Delete.
l Set as the default object of its type.
l Browse/Edit this PDF.
l Generate PDF.
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OpendTect supports both discrete and continuous PDFs.

Discrete PDF:

l can be created in OpendTect in one of the following ways:
o by pressingGenerate PDF and choosing either Create an editable PDF filled
with Gaussian values) or (Create an empty PDF to edit by hand

o extracted from crossplots
l up to 3 dimensions;
l each dimension has a discrete number of bins;
l can be browsed, edited and smoothed after creation.

Continuous PDF:

l can be created in OpendTect by pressingGenerate PDF and choosing Create a full
Gaussian PDF option;

l unlimited number of dimensions;
l exists only in the description form, corresponding probabilities are computed on-the-
fly;

l only the description can be modified.

Browse/Edit Discrete PDF

A discrete PDF can be browsed/edited by clicking on in the Manage PDFs win-
dow. Names of the variables (dimensions) can be changed in the Names tab, and
PDF values can be browsed/edited in the Values tab. Changes applied in any of the
two tabs will be saved only after pressing OK button. A pop-up window gives the
choice to overwrite, save as new or cancel changes.
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The first icon right of the table ( ) launches a 2D viewer that displays the values
seen in the table in a coloured density display. If the PDF has 3 dimensions, the left
and right arrows may be used to navigate through the bins of the third variable with
increasing and decreasing values respectively.
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The second icon ( ) (in Edit Probability Density Function) performs smoothing of
the PDF data. Weighted average of a central sample with 1/2 weight and N neigh-
bouring samples (excluding diagonal neighbours) each with 1/2N weight is cal-
culated at every bin, where N = 2, 4 and 6 for 1D, 2D and 3D PDF. This smoothing is
rather gentle, and can be repeated multiple times for a more pronounced effect.
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4.5.11.1 Generate Probability Density Functions
User-defined

A user defined PDF can be generated by clicking on the bottom icon ( ) in the Man-
age Probability Density Functions window.

Three types of PDFs can be generated: discrete Gaussian (Create an editable PDF
filled with Gaussian values), continuous Gaussian (Create a full Gaussian PDF),
and discrete empty (Create an empty PDF to edit by hand).

Discrete Gaussian and discrete empty PDF can have up to 3 dimensions, while con-
tinuous Gaussian can virtually contain any number of dimensions. Values of dis-
crete PDFs can be browsed, edited and smoothed after creation since they are
stored in tables. Continuous Gaussian PDF exists only in the description form, the
corresponding probabilities are computed on-the-fly.

Create an editable PDF filled with Gaussian values

The example below shows generation of a discrete Gaussian PDF with 3 dimen-
sions. Required parameters include dimension Names, Value ranges, Number of
bins per dimension, Expectations, Standard deviations as well as Correlation coef-
ficients between all dimensions (except for 1D). PDF is saved by specifying its
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name and clicking OK. It can be browsed, edited and smoothed through the Man-
age PDF window.

Create a full Gaussian PDF

The next example shows generation of a continuous Gaussian PDF with 5 dimen-
sions. Dimension Names, Expectations and Standard Deviations are specified in
the Distributions tab:



- 463 -

Correlations tab allows to define Correlations by selecting dimensions, setting their
correlation coefficient and clicking Add button. Existing correlation can be selected
from the list and edited by updating its correlation coefficient and clicking Set (Set
button will appear instead of Add), or deleted by clicking theRemove selected cor-
relation icon ( ). PDF is saved by specifying its name and clicking OK. Continuous
Gaussian PDF is stored only in the description form which can be edited through
Manage PDF window.
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Windows for generation of 1D and 2D continuous Gaussian PDFs shown below do
not have Correlations tab

Create an empty PDF to edit by hand

This next example shows generation of an empty discrete 3D PDF. Dimension
Names, Value ranges and Number of bins per dimension are required. PDF is
saved by specifying its name and clicking OK. After creating empty PDF, prob-
abilities must be filled in manually by clicking on the icon in the Manage PDF win-
dow and editing the table.
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From Crossplots

Alternatively, a PDF can be created using the Cross-plot tool by clicking on the
icon in Cross-plot window . This icon launches a pop-up dialog that can be used for
selecting attributes in order to create PDFs.

The number of PDF dimensions can be set to 1, 2 or 3 by clicking More and Less
buttons. Note that all attributes from the Cross-plot table can be selected. Attribute
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ranges are generated automatically to fit the extracted data distribution. These can
be edited before creating the PDF.
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4.5.12 Manage Seismic Data
Poststack Seismic data should be managed from these windows. There are sep-
arate managers for poststack 3D and poststack 2D. Access these via Survey > Man-
age > Seismics... or via the icon.

They all use common management icons on their right hand side:

Change the location of the file on disk

Rename

Toggle read-only on/off

Delete

Set as the default object for its kind.

The top filter is used to filter-out the objects with selected names. For instance, to
display all volumes that start with letter S use "S*".
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4.5.12.1 Manage 3D Seismic Data
The 3D Seismic file management window lists poststack volumes loaded in the sur-
vey. Information related to the selected volume is displayed in the central field and
personal/survey-related notes can be added and saved in the bottom field.
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Alongside the standard actions (change disk location, rename, remove etc), the
user may also Copy the volume to another volume (different size, format,
sampling rate, ...), Merge several overlapping or consecutive volumes and/or
Browse in the file.
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4.5.12.1.1 Copy Cube

Any volume can be copied into a new volume. The Volume subselection defines
the selection of the input cube to be copied and the Format/Scaling sub menu
allows to specify how to store the new cube. Rectangular volumes are not required
by OpendTect. Therefore null traces are dismissed by default. They can be added
back with the Null traces > Add, within the inline/crossline range of the input volume.
Larger volumes can be obtained while using the Null traces > Add option and the
volume subselection menu.
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If the input cube is multi-component (e.g spectral decomposition cube with different
components, right), an option will be available allowing the user to choose between
all available components. All components is the default setting.
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4.5.12.1.1.1 Input Selection

The input selection for copy cube can be done from the list of stored cubes or from:

SEG-Y directly

PetrelDirect link

The stored cubes in this list can be, as is standard on all input selection UIs:

renamed

locked/unlocked, or

deleted.

Users also have the option to filter the selection using the topmost dialogue box.



- 473 -

4.5.12.1.1.2 Volume Sub-Selection

This standard menu is available when importing/exporting a volume, line, or hori-
zon, copying a cube or horizon, or processing an attribute.

In all those processes, the output might be limited with respect to the available input
data. The limitation may be:

l A rectangular part of the survey, possibly with a larger horizontal and vertical stepout
l An area limited by an OpendTect polygon. The area within the polygon can be as well
by decimated horizontal by using larger stepouts

l A table of positions from an OpendTect pointset or from a text file. The text file should
contain inline and crossline values without header

l All: This last option will output the maximum number of trace with respect to the avail-
able data and possible stepouts

l The use of larger vertical stepouts will cause the data to be decimated in the given dir-
ection. Please note that an anti-alias filter (using the frequency filter attribute) should
be applied before decimating data. The copy-cube does not do it.

l The use of smaller vertical stepouts will cause the data to be interpolated with a poly-
nomial interpolation. This is mostly appropriate for seismic data.

l Volumes tagged as Vint, Vrms or Vavg are not using a polynomial interpolation of the
input amplitudes, as soon as Z start, Z stop and/or Z step are changed. Instead they
are converted to the corresponding time-depth relation that is linearly interpolated (ver-
tically), before back converting the interpolated TD function to the input type.
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l The copy-cube option does not do lateral interpolation of the data (but it can decimate).
Use the Velocity gridder step of the volume builder to laterally grid a coarse volume.
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4.5.12.1.1.3 Format & Scaling

This standard menu allows the change of the following elements:

l Change between storage type. Please note that this might clip your data.
l Scale the values given a linear equation.
l Adjust the Z range to the survey range by repeating the bounding samples up and
down.

l Optimize the horizontal slice access. This will change the sorting mode in the volume
on disk, and will cause inline/crossline accesses to be significantly slower based on the
volume size.
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4.5.12.1.1.4 Output Cube

This standard dialogue box allows the user to name the output cube and select its
properties.

The icons on the right, specifically permit the user to:

rename

lock/unlock, or

delete

Write to allows for outputting as either CBVS (OpendTect's internal format) or SEG-
Y.

Storage gives the following options:
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Optimize for Z-slice viewing processes the output cube in such a way that it allows
for faster scrolling through the volume in the vertical dimension.
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4.5.12.1.2 Merge Files

The icon is used to merge sub-volumes into one single volume. OpendTect pro-
cessing time can be reduced by distributing automatically or manually batch jobs
over multiple computers.

When merging two cubes, the duplicate traces can be stacked when merging e.g.
two seismic cubes (the merging cube will reduce noise) or the traces of the first
cube can be used. Priorities are set in alphanumerical order, as the volumes appear
in the manager from top to bottom.

Select the input files from the multiple entry list and specify the Output file name.
The user can remove the original files at a latter stage (use the Remove button in
the seismic file manager).
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4.5.12.1.3 Browse & Edit Cube Locations

Cbvs files can be browsed/edited (edit the cube locations, positions, trace samples,
etc) by pressing the icon. In the window that pops up (see below), sample values
can be changed by editing any cell (similarly to an MS Excel sheet). Editing is dis-
abled if the cube is write protected.
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Several options are available:

Brings you directly to a new position (inline/crossline).

Check selected trace information like: x/y coordinates, inline/crossline, vertical z
ranges, number of samples.

Switch to browse through Crosslines (and back to Inlines)

Step a preset number of inline/crossline positions to the left.

Step a preset number of inline/crossline positions to the right.

View the currently highlighted trace(s).
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4.5.12.2 Manage 2D Seismic Data
2D surveys in OpendTect are grouped in datasets. These datasets have their own
manager (shown below), separate from the Manage 2D Seismic Lines window.
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In addition to standard rename/delete options, the following actions can be applied
on datasets: Copy all or part of the dataset to a new dataset, Access the 2D
Lines Manager (alternatively, double-click on the dataset name), Dump the geo-
metry (positions) to a text file.
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4.5.12.2.1 Manage 2D Seismic Lines

Accessed via the 'Manage 2D Seismics' window, either by double-clicking on a data-
set name or via the icon.



- 484 -

Lines can be renamed ( ) and deleted ( ). The following actions can also be
made on the lines: Merge of several lines to a new line, Extraction (pro-
jection) from 3D volumes along the 2D lines, Export of the geometry to
GoogleEarth.
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4.5.12.2.1.1 Merge 2D Lines

Two 2D lines can be merged together to create a single 2D line. The icon opens
the merging window. The merge can be either of 2 lines with about the same geo-
metry, or to append two (consecutive) lines to each other.

There are three alternative merging methods:

l Match trace numbers: Assumes the lines are at the same location, containing different
attributes to be stacked and referenced using the same trace number array.

l Match coordinates: Same as above, but with different trace number arrays. Then the
match will be based on coordinates, with a search radius to match the traces. Please
note that traces will be renumbered in this mode.

l Bluntly append. Append the line specified at the "Add" field line after the "First line".
Please note that traces will be renumbered in this mode.
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4.5.12.2.1.2 Extract 2D Attributes from 3D Volumes

This extraction tool, started from the icon, can be used to project a 3D volume
onto 2D lines. This allows then to display the 3D volume along the lines, and to use
the data from the 3D volume with 2D lines in the 2D attribute set.

All lines may be processed, or a selection of lines made in the lines manager before
going to this window. The settings are trivial: the 3D volume must be selected and
an attribute name must be provided.

Please note that the polynomial interpolation does not fit an application of this tool to
3D seismic data.
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4.5.12.2.1.3 Export 2D Geometry to Google Earth

This window (see below),launched with the icon, is to export the 2D lines geo-
metry in to a *.kml file. Different methods are supported (Start/End or both etc.) for
labeling the line-names in the Google Earth file. The line color field is also editable.
The width represents the thickness of the lines. The Output file field specifies the
output location and name of the exported file (Format - kml).

Export the 2D lines in a Google KML file.
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4.5.12.2.2 Copy Data Set

This utility window can be used to copy (backup) a data set.

Pressing on the select button of the first line will allow the selection of which line(s)
should be copied to the new data set:
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4.5.12.2.3 Dump 2D Geometry

With this module, accessed via , an ASCII file with the geometry of one or several
2D lines can be generated. By default, the output file contains trace numbers and
X/Y locations.

This export facility may be very practical if you want to generate a base map from
2D lines for a different software package.
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4.5.13 Manage Seismic Prestack Data
Prestack seismic data should be managed from these windows. There are separate
managers for prestack 3D and prestack 2D. Access these via Survey > Manage >
Seismics Prestack... or via the icon.

They all use common management icons on their right hand side:

Change the location of the file on disk

Rename

Toggle read-only on/off

Delete

Set as the default object for its kind.

The top filter is used to filter-out the objects with selected names. For instance, to
display all volumes that start with letter S use "S*".
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4.5.13.1 Manage 3D Prestack Data
This window is opened via Survey > Manage > Seismics Prestack > 3D...
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Most options are common to the other managers: change file location, rename,
lock, delete. 'Notes' may be anything of interest to the survey and may be added to,
edited and saved multiple times.

The options copy cube and merge blocks of lines work similarly to the 3D poststack
seismic manager.



- 493 -

Prestack data stores are present on the disk in a folder of the same name within the
survey ("Seismics" sub-folder). This folder contains one file per inline for quicker
access, with auxiliary files. The manager will display information about the entire
prestack data store: Folder name, number of files etc.

A prestack specific option, accessible via , allows creation of a prestack data
store from two or more poststack volumes. This can be used to create prestack data
from a partial stack volume for AVO attributes extraction. A specific offset must be
set in front of each volume.

This option may also be employed in creating a multi-component cube for attributes
with more than one component. For example, using this option, a user may create a
multi- component Spectral Decomposition cube with each of the included fre-
quencies given a pseudo-offset value. In the example (below), a multi-component
Spectral Decomposition cube has been created, and for simplicity, the pseudo-off-
set used is a multiple of the frequency component. [The actual value used in these
pseudo is irrelevant in this case, affecting only the width of the prestack display
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(which can be altered by right-clicking on the prestack displayed in the scene and
choosing 'Properties...']

No new file is written to the disk. Therefore deleting a poststack volume used in the
prestack data store will cause problems. Please use same option to remove or
modify the previously set multiple volume selection.
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4.5.13.2 Manage 2D Prestack Data
This window is opened via Survey > Manage > Seismics Prestack > 2D...

Options found here are common to the other managers: change file location,
rename, lock, delete and set as default. 'Notes' may be anything of interest to the
survey and may be added to, edited and saved multiple times.
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4.5.14 Manage Sessions
Sessions in OpendTect are generally used to save and to retrieve the specific set-
tings of a scene. This can help the user to resume work from previous settings.

These sessions can be managed via: Survey > Manage > Sessions...

Sessions will save all settings of the displayed elements, and they can be
saved/restored at any time from Survey > Session.
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The following options are available:

Rename

Toggle read-only on/off

Delete

Set as the default object for its kind.

The 'Notes' box is a free-text field where you may add notes related to the session, if
desired, and save them.
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4.5.15 Manage Stratigraphy
The Manage Stratigraphy window can be launched with the icon from
OpendTect Manage toolbar or via Survey > Manage > Stratigraphy... This window is
designed to arrange the stratigraphic markers and the geological sub-units. It is
used as base for the Layer Modeling.

The first time you open the manager, a pop up window gives the options to either: 1)
build a new stratigraphy from scratch or 2) to open an existing one (North Sea or
Simple Reservoir). These two saved stratigraphy description are saved by default in
another type of format. If edited, the edited version will be saved as classical strati-
graphy description. Once the selection has been done, it is set as default. To re-
access the selection window click on the icon to create/open a new description.

The user can create a specific information about the project and the different
regional markers of his/her interpretation. This window is organized as units/sub-
units bounded by different stratigraphic markers. Markers are assigned to the cat-
egory the most on the right of the stratigraphic column. Depending upon user's
description, markers can have the same name as seismic horizons or well markers
and the units the names of epochs/eras.

To start, the user has two ways to display the stratigraphy tree: the time view and
the tree view. The time view is chosen to display the absolute geological time while
the tree view shows an overview of unit/sub-unit as leaves.
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Stratigraphy window: The time view

Stratigraphy window: The tree view

1. Regional Markers:

The regional markers can be associated to boundaries of stratigraphic units. These
markers are added on the right-hand panel. Right click on ---None--- in the regional
markers panel. And in the pop-up menu select the Create New... option. In the
CreateLevel window, write an appropriate name for the stratigraphic marker and
optionally provide the color. Press Ok to add the marker. They should have a coher-
ent name. In the Well Marker Manager, markers can be linked to a regional marker
and will be then renamed after it.. The inserted marker can then be assigned/linked
as a top and base of the stratigraphic unit.
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2. Stratigraphic Units:

On the left hand side of this window, the units are classified in a way that the top and
base of each unit belong to certain marker. For the initial unit, right-click on <Click to
Add>, the stratigraphic unit editor will pop up:

In this window, give a name of the unit area, the description, color, the age and litho-
logy.

The minimum requirement for creating a new unit is simply to define the name.
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To add a lithology: Click on "Edit" then give the name, and optionally specify poros-
ity then Add as new, click onOk.

To add a sub-unit, right-click the unit name and select Create sub-unit, and define it
in the same manner as a unit. Description and lithology of the unit can be added
now or edited later.
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Stratigraphic unit properties: Properties such as unit/sub-unit description and
lithology can be defined or edited by right-clicking on the unit/sub-unit name and
selecting Properties. A unit/sub-unit specific lithologic name can be entered directly
into the Lithology field. For lithologies that may occur in multiple units/sub-units, a
lithology can be defined and made universally available by clicking the Select button
next to the Lithology field. In this Select Lithology window, the lithology type can be
named, and added to a list that will be made available for all units/sub-units in this
session. (Depending on your Save settings, these lithologies can be available out-
side of this session.) These options can also be defined when the unit/sub-unit is
first added.
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Save as: The defined stratigraphy can also be saved at different levels, e.g. Survey
levels, OpendTect data level, User level, or Global level. For instance, if it is saved
at Survey level, the stratigraphy will only be available for this survey. Alternately, if it
is saved at a higher level, it will not be limited to only the survey in which it was
defined.

Assign Marker boundary:

This option links the regional markers with stratigraphic units. Right-click on bound-
ary or unit/sub-unit then click on Assign marker boundary select regional markers
top and bottom that are the appropriate boundaries for the unit/sub-unit.
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4.5.15.1 Manage Lithologies

The Manage Lithologies window can be launched by clicking on the icon in the
main Manage Stratigraphy window. It allows to define the list of lithologies possibly
present in the stratigraphic column. This list is then available when defining the dif-
ferent units of the stratigraphy. For Layer Modeling, the lithologies listed for each
units are used in the layer description.

Following tasks can be performed:

l Lithologies can be added or removed
l Lithologies can be renamed
l Lithologies can be ascribed various colors
l Lithologies can be specified as Porous/Non-Porous by toggling on/off Porous (this is
used if fluid substitution is carried out in further analysis with SynthRock plugin)
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4.5.15.2 Manage Contents

Manage Contents can be accessed by clicking on the icon in the Manage Strati-
graphy window.

This option is used to define a set of fluid contents. Afterwards, fluid(s) from the list
can be assigned to lithologies for each layer when defining Layer properties for
Layer modeling.
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4.5.15.3 Layers & Synthetic Modeling

The icon starts the Layer/Synthetics modeling feature.
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4.5.16 Manage Wavelets
This window is available from the Survey > Manage > Wavelets... menu and from
the icon. It provides management tools for wavelets. The left panel shows the
available wavelets. The selected wavelet is visualized on the right panel. The stor-
age information of the active wavelet is shown in the lower panel.

The following actions can be performed:

The Filter is used to filter-out the objects with selected names. For instance, to dis-
play all wavelets that start with letter W use &quot;W*&quot;.
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Options:

Alongside the standard 'Manage' options (Rename, Lock, Remove and Set as
Default), you may also, via this window:

Display a wavelet's properties dialog:
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Change polarity

Manually rotate a wavelet

Taper a wavelet:

COLOP: Design an operator for coloured inversion, spectral blueing
and spectral whitening.

Additional options are available below the list of Wavelets:

Import a wavelet from another survey

Import a Wavelet from an ASCII file

Create a wavelet of type Ricker or Sinc

https://peter.zahuczki.hu/
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Stack Wavelets

Extract Wavelet from 2D or 3D data
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4.5.16.1 Import Wavelet
When clicking on the Import button, the import wavelet dialog box pops up. Please
follow the instructions in Import Wavelet section.
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4.5.16.2 Generate Synthetic Wavelets

Generate a wavelet

Two types of synthetic wavelet are available - "Ricker" and "Sinc".
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4.5.16.3 Statistical Wavelet Extraction
Statistical wavelets can be extracted from the seismic data.

The User first needs to choose the input seismic, i.e 3D volume or 2D line.

If 3D seismic is selected, the following window pops up:
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It is recommended to use a sub-selection of the seismic data, e.g. every 10th
inline/crossline, and to use horizons to guide the extraction. The extract length of
the seismic data should be at least 1 second TWT.

The wavelet length should never be too small (min 50ms), or too large (200ms
max). A rule of thumb is that the first side lobe should be fully contained in the wave-
let.
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The extraction is performed using the following workflow:

1. Seismic traces are extracted and tapered
2. The auto-correlation of the seismic traces is computed, using the length of the desired

wavelet
3. The frequency spectrum of the auto-correlation is computed.
4. The square root of the modulus of the frequency spectrum is taken, the zero Hertz com-

ponent is muted to zero.
5. The inverse FFT is computed.
6. The zero phase wavelet is the real part of the inverse FFT output

The output phase rotation cannot be set in the current version. It is being imple-
mented.

TheWavelet extraction in 2D line is shown below:
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4.5.16.4 Rotate Phase
The phase of wavelets can be altered and saved using the following slider:

The new phase will be set when pressing "Ok".
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4.5.16.5 Taper a Wavelet in Time or Frequency
Domain

A wavelet tapering window is launched by pressing the icon from the wavelet
management window. A wavelet is tapered in time or a frequency domain, depend-
ing what is selected from the top of the panel (see below).
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In time domain, the selected wavelet is tapered by selecting a tapering percentage
(%), which is set from the slider available at the bottom of the window. This is done
by moving the slider left or right. Additionally, the amplitudes at zero frequency can
also be muted by setting check tomute zero frequency check box.

In frequency domain, the tapering can be applied to both ends of an amplitude spec-
trum, i.e. high and low frequencies. This is applied with a given slope (dB/Octave)
value and placing the slider to an appropriate min/max position (Hz). The red line in
the amplitude spectrum shows the resultant tapering pass, which is updated accord-
ing to the given settings.
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4.5.16.6 Merge Synthetic Wavelets
Two or more wavelets can be stacked using this option. The wavelets can be
'Normalized' and/or 'Center' at maximum amplitude/energy.
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4.5.17 Manage Wells
The Well Management window can be open from Survey > Manage > Wells... or
from the icon.

The available wells imported in the project are listed on the left. Wells can be
renamed, locked, removed or set as default with the buttons in the centre of the win-
dow:
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Renames the selected well

Toggles the well to be read only(locked)/editable(unlocked)

Removes the selected well

Sets as a default

The well track, checkshot and time/depth model can be loaded and/or edited using
the lower left row of icons:

Well Track Editor

Checkshot Editor

Depth/Time Model editor

The well log tools can be used to remove spikes, to smooth and to clip the logs for
the loaded wells.

Well log tools

Markers can be imported and managed from the following icon:

Markers editor

The Export button in the Well Track , Checkshot , Depth/Time Model and Markers
editors allows for the export of the corresponding tables to ASCII files. For Well
Logs, this export is to a column sorted ASCII file.

Wells can also be exported to be seen on Google Earth using the icon. It is also
possible to either import or create Multiple single wells from the icon .

When selecting a well on the left list, the loaded logs for this given well are listed on
the right hand side. They can be renamed, removed and exported with the buttons
on the right of the log list. The unit of measure of the logs can be checked or
changed if needed (this does not affect the log values). The logs themselves can be
moved up/down within the list. For removal and export, multiple logs can be selec-
ted.
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Renames the selected log(s)

Removes the selected log(s)

Exports the selected log(s)

View/Edit unit of measure for the selected log(s)

Edit Well log

Moves up the selected log in the list

Moves down the selected log in the list

Logs can be imported from Ascii files, click on Import..., or created using math-
ematical expressions from the well management window, click on Create....

Other relevant information is indicated at the bottom of the window.

It is recommended to give logs the same name in all the wells. For example, the
master density log should be called RHOB in every well. This enables the selection
of one set of logs in all wells, ie: for use in the cross-plot tool. Please note that logs
names and marker names are case sensitive during multiple selections.

The top Filter is used to filter-out the objects with selected names. For instance, to
display all wells that start with letter W use "W*". This works only with text, not num-
bers or symbols.
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4.5.17.1 Simple Multi-Well Creation
Multi-wells can be imported or edited through the Import > Well menu. This window
contains editable fields. The new wells can be created by either importing them or
entering directly the values and names. The Read file button can be used to import
an ASCII file containing all well information.

Select the input file (as shown below) and provide the appropriate format definition
settings. To provide the format definition, the selected input file can be examined by
pressing the Examine button. If the file contains the header lines, those lines can be
eliminated by providing the file header information.
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The file format definition is provided by pressing the 'Define' button. In the format
definition window, the default 'col:0' values can be modified according the the input
file. When the correct file format is defined, the wells can be imported by pressing
'OK' button in the multi-wells creation window. By default the wells are loaded with a
constant velocity. The velocity data or the time-depth model can be provided while
importing the Time-depth model.
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The simple multi-well file can now be imported and displayed after creation:
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4.5.17.2 Well Track Editor
This table shows the import relation between the X and Y coordinates (first two
columns), the TVDSS depths (Z, third column) and measured depths in the fourth
column. This table is fully editable: Double-click on a cell to edit it, type a new num-
ber and press enter or select another cell. Please note that other values will be
recomputed to reflect the changes.

The "Update display" button allows to update the displayed well track in the scene
based on the modified table content. Optionally a whole new track file can be read
from a file to replace the existing data, like during track import.

During edition the depths can be displayed in feet. Please note that this flag will be
kept in the survey defaults and will apply in other windows. However it is only a dis-
play setting and the data on disk will not be affected.
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The following window appears after having clicking on "Read new". The import set-
tings are fully similar to that of the import step.
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4.5.17.3 Checkshot and Time-Depth Models
Wells in OpendTect can have two different types of Time/Depth models:

1. An optional checkshot model, often the first available time/depth model or a measured
checkshot survey.

2. The Time/Depth model, that is always the active time/depth model for the well, used for
data extraction and visualization.

The main differences in usage are:

l If a Time/Depth model is flagged as being a checkshot model during import, the
Time/Depth model will be a copy of the Checkshot model.

l If a Time/Depth model is not flagged as being a checkshot model during import there
will be no checkshot model for this well.

l Checkshot models may be used during synthetic-to-seismic ties to constraint the out-
put Time/Depth model. On the contrary the time/depth model provides the actual input
mapping when starting the well tie.

Both types have a similar editing window. It shows the mapping between measured
depths and two-way travel time, respectively in the first and second columns.
Depths are displayed either in meters or in feet (toggle at the bottom of the window),
and times are always displayed in milliseconds. These tables are fully editable:
Double-click on a cell to edit it, type and new number and press enter or select
another cell. The "Update display" button allows the user to update the displayed
well data (track, markers and logs) in the scene to be updated based on the actual
table content.
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The following window appears after having clicking on "Import" in the edit Check-
shot or Time-Depth model window. The import settings are fully similar to that the
import step.

Please note that a user can expect to get less imported time-depth pairs, as,
in order to maintain a decent search speed in the imported table, the soft-
ware protects against duplicated time and/or depth values in the input TD
table by removing duplicated velocities. There should be no concern about
loosing time- depth pairs, as the underlying velocity function is kept,
although potentially converted to a more compact form. This compaction
greatly improves the performance of most search operations done on the
time-depth model. This applies for both OpendTect objects checkshot and
time-depth model, but in practice checkshot surveys hardly ever have
redundant data points.

The Export button allows to export the table in the same format to an output ASCII
file.
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4.5.17.4 Manage Markers
Well markers can be manually provided or imported. They can be exported.

Edit markers: Individual markers can to be added or deleted right-clicking the
mouse on an existing well marker in the marker table and choosing the appropriate
command. To edit the name or value, double click in the appropriate cell. Levels can
be set according to the stratigraphic framework, but please note that marker names
and color will be updated according to the framework when setting a level to a well
marker. The Stratigraphy manager can be access from the icon.

Add markers: Markers can be loaded from a file by clicking the Import button. The
following window will then be displayed:
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Select the input Ascii file. The main work is to specify the presence of a file header
and the file format definition. The header, if present, can be of fixed length (number
of lines), or delimited on its last line by a keyword.

Predefined and saved file formats are available by pressing the Open icon .
Otherwise the format must be manually specified. The Define button gives access
to the format definition window.
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You must specify in the format definition window the column numbers of the marker
name and depth. Please mind the spaces in the marker names that can break the
fixed column format. For that reason it is recommended to have the depth in the first
column, and to specify column 2 as the position of marker names. Then all strings
found in column 2 and up will be used to form the marker names. Depths can be
either measured depths or TVDSS depths. Data loading can be stopped at a spe-
cific line by providing the adequate keyword.

It is recommended to save the format definition for a later use and QC, by clicking
on the Save icon . In pop-up window, write the name of the format and store it.
The format can be stored at different levels (All surveys, Current survey, Current
OpendTect user level) depending on the usage. PressOk when done.

Update display: After adding and/or editing the markers, they can be refreshed in
the main display by clicking on theUpdate display button.

Export markers: Finally, the edited markers may be saved to a new file/location by
clicking on the Export button.
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4.5.17.5 Logs Import
Logs can be imported from the Well Manger window.

Import Logs: The file should be in LAS format, with either MD, or TVDSS. Altern-
atively, the log files can be pseudo-LAS, meaning LAS (with one line of data per
depth value) with the header replaced by a one- line definition: "Depth Gamma
Sonic" etc (without quotes). Log names should be separated by blank characters
(space or tab). For both LAS and pseudo LAS, the following units can be recog-
nized. The recognition process is case insensitive.

Once the file has been selected all recognized logs will be listed in the Select logs
section. Only the highlighted logs will be imported. Be careful that two logs do not
have the same name. The depth interval can be limited to a subrange. The start
depth, stop depth and step written in the LAS files are not used; instead the depths
found on the same line as the amplitudes will be used.
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In pseudo LAS, units should follow directly behind the log name in parentheses, e.g.
Depth(ft) Density(g/cc). Below are examples of text string that will match units:

l Time: s, msec, µsec
l Distance:m, feet, f, ft, in
l Density: kg/m3, g/cc, g/c
l Velocity:m/s, ft/s, f/s, feet/s, km/s
l Sonic: s/m, us/ft, µsec/f, us/m, usec/m
l Acoustic Impedance: kg/m2s, kg/m2us, g/ft2s
l Fraction (porosity, water saturation):%, PU, or blank for unitless
l Permeability: k
l Gamma Ray: API
l Electric Potential: V
l Resistance: ohm
l Compressibility: 1/Pa
l Temperature: K, deg.C, deg.F
l Pressure: Pa, bar
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4.5.17.6 Logs Creation
Logs can be created from log-log computations. Select one or more wells and click
on 'Create' in the well management to open the log creation window as shown
below:

There is an inbuilt list of functions which can be used for creating new logs.This is
supplemented by a Rock physics library containing more advanced resources.



- 540 -

The same syntax as the mathematics attributes should be used, with the following
changes:

l The computation is done in the depth domain. No upscaling is performed.
l The various quantities (e.g. density) in the formula are matched with the input logs on
which the calculation is being performed. The units of these quantities can also be
changed, if needed.

l If "Fill empty sections" is not set for any log then the output will be defined where all
logs do exist. Otherwise the input log that must be filled will be interpolated. In the shal-
low and deep parts the input log will be extrapolated by copying the data from the first
and last sample respectively. This interpolation/extrapolation is done prior to com-
putation.

l An automatic assignment of well logs based on the expression names is attempted
when pressing "Set".

l The inputs logs have probably different Z ranges. The output Z range will be a regular
array defined by the 'Output sample distance'.
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4.5.17.6.1 Rock Physics Library

A number of in-built advanced rock physics formulas can be selected to create vari-
ous types of logs from available well log data.

The type of output log quantity is chosen from Property Type list (e.g. Density, Velo-
city and Pressure). Afterwards, a specific formula out of a number of possible altern-
atives can be chosen to compute the required log quantity. The choice of equation
depends on several factors such as the type of available log quantity and the region
(e.g. a rock physics equations might work well in Gulf of Mexico but not in North
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Sea). After this selection has been made, the formula will be displayed along-with a
short description below it.
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The standard values for variables of the selected formula is also displayed.

It is extremely important to keep in mind that the input log quantities (e.g. Sonic)
MUST be converted in to particular units for the formula to work. These units are
already selected by default and should NOT be changed. Same applies on the out-
put unit of measure as well.
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4.5.17.7 Logs Export
All or a selection of logs can be exported to an output text file. The input well must
be selected, then select the logs to be exported, and click on the export icon .

The logs can be exported with respect to MD and TVDSS depths, optionally also
with X/Y or Inline/Crossline positions. The depth range and step will specify the reg-
ular array on which the input logs will be interpolated prior to the export. The output
file will be a column sorted Ascii file.



- 545 -

4.5.17.8 Export Well Surface Positions to Google
Earth
The well locations (surface coordinates) can be exported in Google earth using the

icon. Select a selection of wells (CTRL-left click to select several wells) to be
exported in the popup window, and specify a filename for the kml file to be created.
Press Ok, and open this file in GoogleEarth.
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4.5.18 Well Data Management

The new Well Data Management table can be accessed from the small drop-down
menu on the ‘ManageWells’ icon in the Manage Toolbar (right edge of scene).

This opens a spreadsheet containing all the wells imported into the project, along
with their info (UWI, X, Y, TD, KB and GL), all the logs and all markers present in
these wells.

The wells are along the rows with their details, logs and markers in their cor-
responding columns. The logs which are present in the particular well have the cor-
responding cell coloured green, in different shades, depending upon the availability
of logs in the selected zone(s) (decided by markers) and those unavailable are high-
lighted in red. Similarly, available markers have their corresponding cell coloured
with the marker colour along with their depth.

The colour coding for availability of logs follow a four-tier system and goes from
deep green to light green. The four tiers are: >75%, (75 - 50)%, (50 – 25)%, and
<25%

On the top of the Well Data Management table, there is a toolbar which has a num-
ber of menus for data management. They are described below in the order they are
in, going left to right:

Enable sorting by activating column. Default sorts the wells alphabetically.
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Set Display Filters: set filter on which data (Wells, Logs and/or Markers) you
wish to see displayed in the table (image below)

Log CrossPlot (Bokeh): Cross-plot logs within specific depth range or with the
markers’ depth.
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LogPlot (Bokeh): Plot logs and markers for a selected well within specific depth
range. Modify display setting e.g. plot width, lines width, colors, etc.
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On the right of the LogPlot Window, there are a number of menus:

Reload and refresh the data in the tab

Terminate bokeh server

Restart bokeh server

View Bokeh server Log file

View Selected logs: The selected logs in the table can be viewed using this
menu in the Log Plot Viewer:
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Merge Well Logs from the same well: This icon will merge the selected logs
for a particular well into one which can then be added to the database using the
Save icon.

Options are available to: extrapolate and/or interpolate when there are gaps, use
average or one of the logs in the overlap area:
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Enable editing well information (Well name, UWI, X, Y, TD, KB, GL): Wells
can be renamed, locked, removed or set as default. If the option is toggled off, then
the info cannot be edited.

Exports Well information in ASCII format.

Save: This writes all the changes made in the well table into the disc.

Reset Well Table: This button resets the table to its initial format.

This field allows the selection of a zone of interest (between
two markers). Once a zone is set, the availability of logs displayed in the table might
change depending on the zone.

This field allows the selection of a depth domain to work with. The three
options currently supported are MD (Measured Depth), TVD (True Vertical Depth),
TVDSS (Truth Vertical Depth Sub-Sea).
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4.6 Pre-load
In OpendTect, the user can pre- load seismics or horizons. The advantage is to
allow for faster display times in the scene. Your system must possess sufficient
memory to store the pre-loaded data.
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4.6.1 Preload Seismics
The pre- load seismic data functionality is introduced inside the OpendTect to
speed-up the working efficiency with large volumes. A common practice is to add an
inline/crossline/2D line in the tree and display it in the scene. Each time the line is
displayed, the stored volume is read. Therefore, the seismic volumes that are
routinely used, can be preloaded. Also if the same seismic data like attribute cube is
pre-loaded, the efficiency of displaying the data in the scene is improved.

Seismic data can be pre-loaded in OpendTect by going to Survey > Pre-load > Seis-
mics...

Clicking on Seismics.., the pre-load manager pops-up to allow the user to Add, i.e
select the data to pre-load.

Pre-load seismic data manager

Preload manager is used to load a 3D volume, 2D lines, 3D Prestack volumes or 2D
Prestack lines in the memory. Each data can be unloaded separately in selecting it
and clicking on Unload Selected.
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Additionally, after selecting a pre-load data, a user can optionally save the set-
tings for the later use. These settings can be opened when needed.
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Note: The functionality is available for all stored seismic (2D/3D-Pre/Post) data in
the relevant seismic data manager interface.

Pre-load 2D 3D data

Input Cube: Choose input volume.

Scan: Press Scan to populate a histogram by extracting a defined number of traces
from the selected volume.

Format on disk: Format of the selected volume as stored on disk.

Load as: Data can be optionally pre-loaded in another format (e.g. to reduce RAM
usage).

Scale values: Choosing of a different format may require scaling the values to
ensure nothing is left out.
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4.6.2 Preload Horizons
For fast visualizations, multiple horizons (2D/3D) can also be loaded in to the
memory. Thus whenever the preloaded horizons would be displayed in the scene, it
will take less time in reading the file from the disk. Therefore, the functionality
improves the visualization speed. Press the 'Add ..' button to select the desired hori-
zons to be loaded in the memory. If you want to unload some horizons, select the
horizons first and press 'Unload selected' button.

The Save and Open buttons are used to store/open the pre-loaded horizons
setup for a later use.
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4.6.3 Preload HorizonCube
For fast visualizations, HorizonCube (2D/3D) can also be loaded in to the memory.
Thus whenever the preloaded HorizonCube would be displayed in the scene, it will
take less time in reading the file from the disk.
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5 Analysis

5.1 Attributes
In OpendTect, seismic attributes are calculated/evaluated by using Attribute-set
Window. In this window, many single/multi trace, pre/poststack, dip-steered/non
dip-steered attributes are available. Moreover, it also contains special filters (e.g.
Gap decon, Frequency filters, dGB-special filters etc). The attributes are explained
individually in Appendix A.
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5.1.1 Attribute Set Window
The attribute set window contains a set of seismic attributes definitions to be eval-
uated/calculated. While defining the attributes it is possible to work in the active
scene. Attributes can also be calculated after saving the attribute set. In broad
sense following workflows are applicable in OpendTect attribute calculation process
(on sections and horizons):

l Evaluate attribute
l On-the-fly attribute calculation
l Creating an attribute output (2D/3D)

In following figure, different attributes are defined as an attribute set. It is considered
as a routine practice in OpendTect environment (especially to define a meta-attrib-
ute). These attributes can be: evaluated on sections and horizons, applied on-the-
fly and created as an output attribute. Importantly, some attributes show steering
selection in the input parameter settings : the dip steering plugin created by
dGBdGB provides various advanced steered attributes.

https://dgbes.com/software/plugins/dip-steering
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OpendTect works with the concept of an "active" attribute set. At start-up, there is
no active attribute set. To create a new one (New set...), or to select an existing set
(Open set ...) , select the corresponding option from the File menu (See below).
OpendTect is also delivered with a collection of default attribute sets for some gen-
eral testing (Fault, Chimney,Salt default attribute sets). This set can be selected
from the Default set option under the Filemenu. To use a default set, the input seis-
mic data and a SteeringCube (if steered attributes are available in the default set)
have to be selected.

Clicking any attribute in the list will show its parameter settings. Notice that
OpendTect uses SI units. For details on each of the attributes see Appendix A. Note
that some of the parameter options depend on whether you are using 2D or 3D data
as input. For example, the inline and crossline stepout field will be replaced by a
single trace stepout field. Generally, an attribute set can only contain 2D attributes
or only 3D attributes. Mixed attribute sets are not possible.

When parameters of an attribute are updated, the modified attribute can be added
to the attribute set with a new Attribute name by clicking Add as new. Clicking on
any other attribute in the list means that the updated parameters are accepted,
while keeping the original attribute name. The Revert changes button only reverts
changes to the original state before clicking on another attribute in the set. WhenOk
is pressed, the (updated) attribute set becomes the "active" attribute set. The attrib-
ute set is saved to disk when Save on Ok is ticked. To save an attribute set under a
different name, use the corresponding option under the Filemenu.



- 561 -

Allows for the creation of a new attribute set

Open an existing attribute set

Open one of the default attribute sets (provided within the OpendTect package)

Import an attribute set from another survey

Reconstruct an attribute set from file

Save the attribute set

Save as...

Re-display the element with the current attribute

Evaluate the attribute (parameters)

Cross-evaluate attribute (parameters)

Cross-plot the attribute.

View as graph. This icon allows the user to visualize the current attributes as a
graphical network, using Graphviz. Pressing the dropdown arrow adjacent to this
icon brings up a text box and clicking this shows an information window on how to
download and link Graphviz to OpendTect.

File - Change input... can be used to change the input data of all attributes in the
"active" set simultaneously, which is useful in case, for example, a new seismic
volume has become available.

File - Auto Load Attribute Set ...

It is now possible to have an attribute set already open at start up using the " Auto
load Attribute Set " option in the File menu. This enables to choose the attribute set
which will be active the next time the survey is opened.

https://graphviz.org/


- 562 -

5.1.2 Attribute Set Toolbar
The attribute set toolbar comprises the following icons.

Also accessible via the File menu, these are, from left to right:

l New set clears the window to create a new attribute set. The attribute set name can be
specified when saving it (press OK, or select File - Save set menu option).

l Open set opens a previously saved set in the current project (from the directory
Attribs/).

l Open default attribute set. Filenames for input data must be re-specified.
l Import attribute set from another survey. Filenames for input data must be re-specified.
l Reconstruct set from job
l Save set saves the "active" attribute set in the Attribs/ directory of the current project.
l Save as set saves the "active" attribute set in the chosen folder
l Redisplay element with current attribute is used for direct display of the selected attrib-
ute on the active display element (shown in reverse video in the tree). The main
graphic interaction buttons and options remain active while the attribute set window is
open, so the active element can be changed. However no new element can be added
to the tree

l Evaluate Attribute allows the automatic variation and evaluation of attributes and attrib-
ute parameters. If you have an "active" attribute and the current display element is a
slice (inline, crossline or Z slice) or a horizon, a new window will pop up where it can be
specified how to vary the parameters of the displayed attribute. For example, Spectral
Decomposition:
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l View as graph This icon allows the user to visualize the current attributes as a graph-
ical network by linking Graphviz to OpendTect. Click the dropdown arrow on this icon
and then on 'Graphviz installation' to see a text window outlining how to do so.

Here six slices are created, with time gates of [-4,4], [-8,8] etc.... Use the slider to
move through all the slices. When an attribute has been evaluated on a surface, the
parameter can be updated in clicking on Accept. Enable this by checking Store
slices on Accept.

As shown above, the "Evaluate Attributes" set contains a general selection of vari-
ous attributes. It is intended as a guide or starting point for a scan through the wide
range of different attributes and may be a starting point for an effective attribute ana-
lysis.

https://graphviz.org/
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For more information on Evaluate Attribute, watch the tutorial on the OpendTect
YouTube Channel.

l Cross-evaluate attributes Allows for the cross-evaluation of parameters within the
attribute.

l Crossplot attributes allows to crossplot attributes from the current attribute set and
saved volumes. Multiple attributes can be selected. The attribute values are extracted
at picked locations (see how to create a new pointset). Once attribute values are cal-
culated, a crossplotting table is generated and crossplot(s) can be achieved.
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5.1.3 Auto-Load Attribute Set
By default, no attribute set is loaded at startup. These settings can be over-ruled by
selecting a specific attribute set to be auto- loaded in the list each time the
OpendTect window is started. This can be set from the attribute set window under
File > Auto Load Attribute Set sub-menu. If selected, it will launch the auto-load
attribute set window. Selecting Yes will show the list of attribute set that can be be
auto-loaded. Select one attribute set and pressOk button. This will save the settings
and next time, whenever the OpendTect is started, the selected attribute set will be
auto loaded. Such practice becomes useful when working with attributes evaluation
at different stages of a project and that the same attribute set need to be updated.

Load Now will directly load the selected attribute set. If not selected, the attribute set
will be loaded the next time the survey is opened.
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Please note that a similar function exists for sessions.
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5.1.4 Default Attribute Sets
OpendTect is provided with "Default attribute sets" to get you started. By selecting a
default attribute set, a window appears to select the correct input volume(s) and the
correct SteeringCube (see images below). These attributes (except "Evaluate Attrib-
utes") require the following dGB plugins:

l SteeringCube: attributes and filters are calculated along user-driven, or data-driven dir-
ections

l Neural Network: Both supervised and unsupervised neural networks allow generation
of meta attribute volumes that highlight any object of interest (e.g: Chimney, Faults,
Salt,...).

The OpendTect version comes out with new "default attribute-sets" in addition to the
already existing attribute sets like NN ChimneyCube, NN SaltCube, Unsupervised
Waveform Segmentation, dGB Evaluate Attribute, etc .

l Evaluate Attributes: This default attribute set contains the default definitions of sev-
eral basic attributes grouped together to give an idea of attributes evaluation in
OpendTect. This default attribute set can be selected to start with OpendTect. After
selection, only input seismic data is required.

l dGB Evaluate Attributes: This default attribute set is similar to above attribute set
with additional dGB attributes (using dGB plugins). For this set, both seismic and steer-
ing data are required as input.

l AVO attributes from Intercept-Gradient: This attribute set requires two inputs; Inter-
cept and Gradient (from AVO analysis) as first and second inputs respectively. It com-
putes attributes like Envelope, Fluid Factor and Rp-Rs.

l AVO attributes from Near-Far: The input for this attribute set are the Near and Far
stacked data sets in the same order. This includes attributes like Envelopes and
Enhanced pseudo gradients.

l Dip-steered median filter: This default attribute set contains the definition of dip-
steered median filter. It cleans up the seismic data by removing random noise. Both
seismic and steering data are required as input.

l Dip-steered Diffusion Filter: This filter is mainly used to sharpen faults. Both seismic
and steering data are required as input.

l Fault Enhancement Filter: This type of filter is used in the Fault/Fracture analysis, it
dramatically sharpens the faults by suppressing random noise. It is a combination of
the diffusion filter and the dip-steered filtered. Both seismic and steering data are
required as inputs.

l Fault Enhancement Filter (Expert): This is a more sophisticated version of the basic
Fault Enhancement Filter and uses similarity and dip-steered filtering. It also requires
both seismic and steering data as input.
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l Ridge Enhancement Filter: This filter detects lateral lineaments using different
steered similarities (in inline, crossline and diagonal directions)

l Ridge Enhancement Filter (Expert): This filter is an advanced version of the above
described filter and uses steered similarities in addition with their second derivatives
(in inline, crossline and diagonal directions).

l NN Fault Cube: dGB standard default attribute set containing the definitions of all
attributes that are used in neural network (NN) training to create meta-attribute i.e. NN
Fault Cube.

l NN Chimney Cube: dGB standard default attribute set containing the definitions of all
attributes that are used in neural network (NN) training to create ChimneyCube (meta-
attribute).

l NN Salt Cube: dGB standard SaltCube meta-attribute.
l NN Slump Cube: dGB standard SlumpCube meta-attribute.
l Unsupervised Waveform Segmentation: attribute set containing the definition of
attributes that are used in unsupervised waveform segmentation (a.k.a UVQs).

l Seismic Filters Median-Diffusion-Fault-Enhancement: This is an advanced ver-
sion of the "Fault Enhancement Filter". It enables the user to have much control on the
input parameters by modifying the parameters of the dip-steered median filter, dip-
steered diffusion filter and fault enhancement filter.

l Fault Enhancement Attributes: expandable attribute set containing the list of the
attributes that are useful for fault visualization and fault interpretation.

l NN Fault Cube Advanced:most superior FaultCube (meta-attribute) attribute set that
is used as input for neural network training to create fault probability cube.
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Default attribute sets window containing the list of all available default attributes
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When one of these default attribute-sets has been selected, a window pop-ups (see
image below) to select the input seismic and optionally a steering (the attribute sets
based on AVO analysis, the Fault enhancement filter and the Ridge enhancement
filter require inputs as outlined in their respective descriptions).

Input selection Window
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5.1.5 Input Selection
Every attribute requires input data. Both stored data and already defined attributes
can be used as input to a new attribute. In other words, attributes can be embedded.
However, circular references are not possible.
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5.1.5.1 Input Selection for 3D Attribute Sets
Select from the stored data or from the list of defined attributes in the "active" attrib-
ute set.
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In case the input data is multi-component, it is possible to choose from the available
components as shown below (or include ALL).

The Filter section allows to quickly find the right input. e.g type *S will look for all
attributes/cubes started with S like Similarity.
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5.1.5.2 Input Selection for 2D Attribute Sets
Select from the stored data or from the list of already defined attributes in the current
attribute set.
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If the selected stored data set is multi-component, the user will get an option to
choose which component to select as input data:
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5.1.6 Import an Attribute Set from
Attributes are primarily stored in attribute set files of extension .attr Attribute defin-
itions can also be found in the parameter files of a processing job when an attribute
was used to process a volume or data set.

It is possible to import the attribute set of an attribute file from the menu: File >
Import set from file. Existing attributes are stored in the Attribs folder of each survey.
Optionally, attributes from another survey may also be imported: File > Import set.
or by using

Import set from file

Import set from another survey

Pressing select in the above window brings the user here:
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It is also possible to re-create the attribute set of existing processing file in the
menu: File > Reconstruct set from job file... (or ) brings the user here:

Existing jobs are stored in the Proc folder of each survey, with the extension par.
There are two options available to reconstruct the attributes definition: from an
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existing par-file or from a created cube file. In first case (from par-file) select the
input parameter (*.par) file. In second case (find from created cube), another win-
dow pops-up in which the input volume and the corresponding parameter file are
selected. The file name is found automatically.

Pressing 'Find from created cube...' will open up this search/select window:

Finds the attribute set from an existing (created) cube, which was calculated inside
OpendTect.

When importing, new input volumes must be selected to replace the references
stored in the input files.
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5.1.7 Calculate Attributes
The attribute evaluation process has been considered critically and thus several key
options are available for the user. For instance, Evaluate Attribute is considered
as intermediate (but not necessary) step to quickly analyze the different parameters
of any attribute within the working environment (View tutorial-Evaluate attributes).
Similarly, the user can create a list of seismic attribute definitions as a working set
that later on can be updated. The attribute set is then used to calculate the seismic
attributes along lines/surfaces.

There are two possible ways of calculating seismic attributes in OpendTect: First, in
order to calculate the results of any attribute in the foreground, user(s) can do it on-
the-fly. Second possibility is to calculate attributes after evaluation by running a sec-
ondary process in the background. In OpendTect, seismic attributes are applied on
several elements (inlines, crosslines, Z slices, random lines, 2D lines, volumes, hori-
zons etc).

The workflow to calculate the selected attribute is quite simple:

1. Define (or use existing) attribute Set and save. For details see earlier sections of this
chapter.

2. Calculate on-the-fly or Create Seismic Output or Create horizon attribute output.
3. If attribute is not calculated on-the-fly, retrieve results by displaying attribute in tree.

The example of first step is given in following figure. It highlights the sequential pro-
cess (notice green arrows form left to right) of on-the-fly attribute calculation. Firstly,
several attributes are defined. Secondly, by default, when a user presses Ok button
in Attribute Set window, the Save Attribute definition window will appear to save the
attributes definition as an Attribute set. The attribute can then be applied on an inline
(for instance) by adding a blank attribute (right-click on inline number). Right-click
on the blank attribute and select the attribute (Select Attribute > Attributes > "User
Attribute"). The listed attributes are those that are defined in the attributes set win-
dow. Selection of any one, would start a process of on-the-fly attribute calculation.
By following same workflow (as elaborated in figure) the same attribute can be cal-
culated along other elements (e.g. crosslines, Z-slices, volumes etc).
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Schematic flow of on-the-fly seismic attributes evaluation on an inline.

1. There are some attributes that can take too much time during the on-the-fly calculation
process.

This depends upon the type of attribute that how much calculation steps it considers
e.g. multi-trace (e.g. Similarity) attributes normally take more calculation time than
the single trace (instantaneous) attributes. Similarly, the attributes with steering nor-
mally takes more time in calculation. So, each time the attribute is displayed in the
scene (as shown above), it is calculated in the fore-ground. If the user is committed
with the attributes results, this can be resolved by creating seismic outputs (See
Create Seismic Output and Create Horizon Output sections) in the background.
This will also help to restore the saved sessions quickly.

2. Additionally,multi-component output seismics-2D/3D (like spectral decomposition)
are created by using create seismic output.

Another example of second step, is shown in following figures. The attribute can be
calculated along the horizon by following the same steps described above, for
inserting and displaying the attribute (as shown below). In this example, Similarity is
calculated on-the-fly along a horizon. This attribute normally takes time (depending
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upon amount of traces involved). So, user can take benefit of saving the on-the-fly
results that later on can be retrieved.

Schematic flow of on-the-fly seismic attributes evaluation at a horizon.

In order to save the calculated attribute as horizon data, right-click on the attribute
and select Save as Horizon Data.... In pop-up window edit the name accordingly
and press Ok. This will save the horizon attribute as its horizon data. That can be
managed later on by using horizon management window. (see Management hori-
zon)

Result of calculated similarity attribute. Saving the horizon attribute as horizon data

The stored attributes along horizon can be retrieved as horizon data. Right-click on
horizon and add blank attribute. Right-click on the newly inserted blank attribute and
locate Horizon data item in the sub-list of attribute (as shown below). In the horizon
data selection window, select the desired attribute. This will display the selected
attribute in the scene.
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Retrieving the stored horizon data (attribute) of a horizon.
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5.2 Volume Builder Setup
The volume builder setup is used to apply volume-based operations, unlike the
attributes that work trace-by-trace. The setup is launched via the Analysis > Volume
Builder menu. The setup is a very useful tool for gridding velocities or other rock
properties.

The volume builder setup window contains several available steps that are applied
sequentially to generate a volume. Any particular step can be selected from the
Available steps by double-clicking on it. The later steps may replace the earlier
ones, therefore care must be taken when ordering and setting up the workflow.

Once your workflow is defined, you will need to save this setup. This can be done by
writing the name of your setup.

The computation and storage of a volume processing setup can be found under
OpendTect's Processing menu: Processing > Create Seismic Output > Volume
Builder...
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5.2.1 Body Shape Painter
The body shape painter is used to define the inside and outside values for an
OpendTect body. The options for 'Inside Fill Type' are shown in the image below.
The same options are available for 'Outside Fill Type':

Fill Types:

Constant Value: Single, user-defined value:
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Previous step: takes the values of the previous step in the Volume Builder setup (ie:
a stored volume):

Undefined Value: Equivalent to 'transparency'
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One example of use would be: if one wants to create a salt velocity cube, the values
inside can be filled with a salt velocity and outside can be set to previous step. If no
other step exists the undefined value is written.
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5.2.2 Lateral Smoother
The lateral smoothing is a rectangular two-dimension smoothing filtering method of
the volume.

The average filtering will be done in the frequency domain by applying a 2D FFT to
the Z slices. This requires a rectangular dataset, while the input can be irregular.
The filtering type can be chosen between "Median" or "Average" which can option-
ally be "Weighted". Positions without data or with undefined values are first replaced
by the option "Mirror edges" and "Undefined substitution". The "Undefined sub-
stitution" can be done by taking Average values between the defined points, Fixed
value (one value needs to be specified which will be used everywhere) or using
Interpolate between the defined points.

Finally, this step can be saved by giving a name.
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5.2.3 Smoother
The smoother step is used to apply a three dimensional smoothing operator by spe-
cifying In- line, Cross- line and Vertical (ms) stepouts for 3D or two dimensional
smoothing with Trace and Vertical (ms) stepouts in case of 2D.

Various operator shapes can be chosen (e.g. Hamming) and can be visualized by
pressing on the View button. The CosTaper also requires specification of a "Taper
Length (%)".
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5.2.4 Horizon-Based Painter
The horizon-based painter is used to create a model between two surfaces. The ini-
tial top and bottom values are necessary to be filled in the input. The intermediate
values are interpolated to a survey or a horizon. In this window, horizons have to be
selected as top/base values. The slope type is used in interpolation to define a
slope.

The horizon-based painter paints velocities in a 3D area or on a 2D line. Geometry
of the velocities is defined by one or more horizons.

The painted velocities are referenced to a specific time. This time can be either con-
stant (user-defined), or retrieved from a horizon and not necessarily from one of the
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horizons defining the limit of the body. For example, an intermediary horizon could
be used.

Then velocities are painted from that reference time. The velocity must be provided
as a velocity/gradient pair. The values are once again either user-defined or extrac-
ted from a surface data (grid) attached to a horizon.

There is also a much simplified Horizon-based painter also available:



- 593 -

5.2.5 Velocity Gridder
The gridding will create a volume out of a sparsely sampled dataset. The input
source MUST be tagged with a velocity type. Indeed the gridding is applied to
the time-depth relation hold by the velocity source and not on the amplitudes of the
velocity source. This preserves the time-depth relation and blocky-ness of interval
velocity models. The gridded time-depth relation is converted back to the input velo-
city type in the output volume.

However any other data type could be gridded by this module (Thomsen para-
meters, temperatures, ...). These other types must be tagged as delta, epsilon or
eta before being used for gridding. The functions will be vertically interpolated using
a linear 1D interpolation before the lateral gridding.

Two interpolation methods are available for gridding: inverse distance interpolation
or triangulation. The first method is designed for the interpolation of sparse dataset,
while the second algorithm should be preferred if the input exists on a regular (but
coarse) grid. In general gridding is always followed by some filtering.
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The input data can be either a (coarse SEG-Y imported) volume, stored (ascii) func-
tions or velocity points (requires the Velocity Model Building plugin)

Clicking on the 'Properties' button will allow you to change the selected input for this
step:
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Velocity volumes have to be tagged to recognize their type.

Tip: If you have no velocity volume available, press 'Add' in the 'Edit Step' window
and then, in the window that pops up (shown below), press 'Create':

Here you may tag a volume with a velocity type, so that it can be used as input for
the gridding step. Or change the tag that the volume has. This can be useful for inter-
polation of velocity cubes (for example, we strongly advise against trying to inter-
polate Vint or Vrms, but Eta-tagged volumes can be interpolated):
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5.2.6 Input Volume
This step is in general used to provide a background volume or 2D data attribute
before using spatially constrained steps, for instance before the body shape painter
or horizon-based painter.
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5.2.7 Voxel Connectivity Filter
Voxel Connextivity Filter is a special tool to create continuous bodies based on the
amplitudes in a stored volume. A 'voxel' is defined as the volume around one
sample. It is thus linked to the survey bin size and sampling rate.

This volume builder step must be preceded by a step providing the necessary input
data, like "Stored volume".

This volume builder step implies a volumetric calculation. The result of the applic-
ation on a single inline will differ from the result of the application to the whole
volume.

The filter is based on a user-defined amplitude selection to compute the bodies. The
samples interconnection is computed based on an amplitude criteria and geo-
metrical spreading settings. It is a very useful tool to visualize seismic attributes in
3D. Other benefits of this tool are to get a volume of several bodies and visualize
them in 3D or use it as an input to supervised Neural Network. A general and most
popular use of this tool can be the DHIs detection. For instance, if creating a volume
that represents DHIs only, it may be interesting to clip the amplitudes to visualize
the DHIs present in the seismic data. For such case, when having the seismic amp-
litude attribute as a volume, this filter can be used to create new DHI volume.
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The voxel connectivity filter has a number of parameters to set:

Keep: Specifies the part of the input dataset used to compute the bodies, based on
their amplitudes.

l Values more than: The envelope of the amplitudes higher than the given value define
the bodies to be computed. Example: 0 will select all positive amplitudes.

l Values less than: The envelope of the amplitudes lower than the given value define the
bodies to be computed. Example: 0 will select all negative amplitudes.

l Values between: The envelope of the amplitudes between inside the given range
define the bodies to be computed. Example: 9000, 14000 will select all values in
between, like 12000.
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l Values outside: The envelope of the amplitudes between outside the given range
define the bodies to be computed. Example: -10000, 10000 will select all values lower
than -10000 or larger than +10000 (the extremes).
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Connectivity: Selects the method used to connect different voxels when computing
the bodies. Each sample in the input volume acts like a seed.

l Common Faces (6 neighbours): The propagation is done by strictly using the 6 faces
adjacent to the current seed.

l Common Edges (18 neighbours): The propagation is done by using the 6 faces and
the 12 edges adjacent to the current seed.

l Full (26 neighbours): The propagation is done is all directions, using the 6 faces, 12
edges and 8 corners adjacent to the current seed. This is the default mode.

The easiest way to visualize the connectivity is to imagine the reference voxel as the
central voxel in a 3x3x3 cube, such as the red one in the first image. Then the
second image shows the Face-, Edge- and Full (corner) conecctions:
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Keep bodies larger than [voxels]: It defines the minimum number of voxels
required to output a body. Actually all bodies are computed in the first pass. The
smallest bodies are then dismissed. Minimum allowed is one.

Keep output: The following value(s) will be output on the samples inside the com-
puted bodies:

Body-size rank:The output value is an integer with a constant, different value for
each body. The values are sorted by decreasing body size, starting at zero: 0 is the
largest body, 1 the second largest...

The example below is created using a similarity attribute to locate faults and frac-
tures in a volume. It is set-up to create bodies connecting low similarity values
(threshold of 0.5). All values that are above this threshold are ignored. Furthermore,
it is also ignores the very small bodies (size < 10 voxels).

It shows number of connected bodies (purple being the largest ones) in a volume.
Such a result can directly show which faults are connected and those that are not.
Visualizing such a VCF result can be a valuable method in performing direct inter-
pretation.
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Body-size: The output value is the size in number of voxels of each body. This gives
an approximation of the real-world volume, when multiplying by the bin size. For
example, a body of 2500 voxels (10 inlines, 50 crosslines, 5 samples), with a bin
size 25m x 12.5m, at 4ms sampling with a constant velocity of 2000 m/s: Vol = 2500
* 25 * 12.5 * 2000*0.004/2 = 10000 m3...

In this second example, the same volume is being processed for Body-size. It
shows the same patterns suggesting that the prediction is identical to the earlier res-
ult. However, the predicted voxels are being filled differently. Here the same bodies
are defined by largest volume in cubic meters (m3).
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Generally speaking, areas of higher faults/fractures density allow greater con-
nectivity between bodies.This example below shows this case.

l Value: The output value is a user-defined value specified in the "Kept value" field under-
neath.

l Transparent: The output value is taken from the amplitude in the input volume.

Rejected output: The value outside the computed bodies can be either the
undefined value or a user-defined value specified by the field "Rejected value"
underneath.

Name for this step: Provide a user-defined name for this volume builder step that
will appear in the Used-steps list of the Volume builder.
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5.2.8 Well Log Interpolator
This gridding step is used to populate a 3D volume using well logs by interpolating
along Z-slices.
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Vertical Extension: Select the method of vertical extension from the following
options:

l Log extension if needed: Extend the logs (if required) to match the Selected zone
l Extract Between: Extract data from a marker-defined, depth-defined or time-defined
range. You may also toggle on the option to extract the data in time.

l Selected zone: Set the extraction zone suing either markers or start and end of data
(or combination thereof).

l Distance above/below: Extend, if desired, the extraction zone above and below the
selected zone.

l Algorithm: Choose between inverse distance or triangulation.
l Search radius: For inverse distance only - set an optional maximum search radius for
the algorithm.

After the selection of well(s) and log, parameters and algorithm, provide a name for
this step at the bottom and proceed to the Volume Builder by pressing 'OK'.
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5.3 Cross-Plot
The Cross-plot tool is designed to create two dimensional cross plots between
2D/3D seismic data (attributes) and either other attributes or well data. The data can
be analysed in multiple maners, using different kinds of colour coding and data
selection tools. It may be launched from the menu Analysis > Cross-plot menu.
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5.3.1 Cross-Plot Data Extraction
The crossplot data must first be extracted, either on (a subset of) the horizon or
along (deviated) well paths. 2D or 3D attributes can be used, and well logs if the
extraction is done along the well paths. The extracted data will first be presented in
a table before actually selecting the features to cross-plot.

The extracted data can be saved in the cross-plot table window and reopened
without repeating the data extraction, from the menu Analysis > Cross-plot > Open.
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5.3.1.1 Well-based Data Extraction
This window presents the attributes and/or logs that can be extracted along well
path. The output will be presented in table before being used for cross-plot. At least
one well must be selected, and one attribute or one log. It is also possible to select
only attributes, or only logs.

The well track and time-depth model provide the locations where to extract the data.
Values will be vertically extracted along a specially built measured depth axis. This
axis is such that the step between two consecutive depth samples is constant but
with few jumps, such that the Z difference (time or depth depending on the survey
type) between consecutive depths is around the survey default sampling rate.
Therefore at shallow level 1 seismic sample can correspond to 4 meters, then 8
meters at intermediate depths, 12, 16 and so on.

l Attribute values are vertically interpolated along that created MD axis, since they are
unlikely to be along the Z axis defined by the survey geometry. A polynomial inter-
polation is performed.

l Log values are extracted in the depth domain around the depth to be computed, plus or
minus half of the distance to the previous and next depths. All collected values are then
processed (up-scaled) using a provided "Log resampling method" (see below).
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3D Data extraction for Well vs. Attributes Cross-Plot
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2D Data extraction for Well vs. Attributes Cross-Plot

The following specific extraction parameters are available:

Extract between: It is used to limit the z-range (depth or time) of the data to extract.
There are three options supported:Markers, Depth and Time.

IfMarkers is selected (which is default), the Start/Stop markers should also be selec-
ted from the combo boxes that are available below the extract between field.
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If Depth is selected in the extract between field, the start/stop (m) field will be
toggled on. In the later fields, starting and stopping depth range is typed in to restrict
the data extraction into an interval.

Similarly, if Time is selected in the extract between field, the start/stop (ms) field will
be toggled on.

Finally, the step-out for extracting both Attributes and Well data samples has to be
defined. This can be defined in meters (default), feet (if the survey is in feet) or mil-
liseconds. The Extract in time check box is usually toggled on if you want to define
the data extraction step-out in TWT. It is advisable to check this box when extracting
data for crossplotting against seismic volumes.

l Distance above/below: It is used to modify the vertical range of the extraction window
using a relative distance from the provided well markers, in depth. A negative number
will decrease the extraction window, a positive number will increase it.

l Log resampling method: Logs will be up-scaled using this method. 'Average' should
be used for most of the logs.Median, most frequent and nearest sample are more fit
for discrete logs like lithology, but can also occasionally be used for other types.

l Radius around wells: All traces that can be reached within the search radius will be
extracted. If several traces around a well are found, the same extracted log value is
posted in front of the collected attributes values. This option will only duplicate all data
if no attributes are extracted. The default value is the survey bin size, use value "0" to
extract only the nearest trace, i.e. one value per well per depth.

l Filter positions: See the location filters section in the same chapter.
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5.3.1.2 Attribute-based Extraction Window
Attributes based data extraction window is used to extract an attribute data (stored
volumes or a defined attribute) within a volume defined by a range, polygon, sur-
faces, body or a well path with lateral extension. The same window (shown below)
could also be used to extract an attribute data along a time slice or along a surface.

Note that at least one attribute must be selected prior to data extraction. "Attributes"
list shows all attribute currently loaded in the window, and the stored volume under
brackets. For multiple attributes selection, use the left mouse button by holding and
dragging it up/down-ward. For 2D data extraction one or more attributes along-with
their corresponding "Line names" (at least one) should be selected.
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3D data extraction for Attributes vs. Attributes Cross-plot
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2D data extraction for Attributes vs. Attributes Cross-plot

The volume/horizon based extraction is performed by selecting locations according
to one of the following criteria:

l Range: It is selected to extract the data on a regular 3D volume or a grid (if it is a time
slice). The steps are the increments in the corresponding range. To extract dense data
points for a crossplot, smaller steps should be used. Note that the larger steps will
decrease the amount of extracted data. Cubes coarser than the requested grid will not
be interpolated, undefined values will be posted to the cross-plot table instead. For 2D
data extraction this is the only possible option and only the time range can be
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specified.
l Polygon: The lateral extent for a crossplot data could also be defined by a polygon.
Once the Polygon option is chosen, the desired polygon is chosen by pressing the
Select button. The inline/crossline steps are the increments in the inlines/crosslines
range within the polygon. The time range is also an additional constrain in data extrac-
tion that defines a vertical restriction window for a polygonal type of volumetric cross-
plot.

l Table:Only positions listed in a table will be used for the extraction. The table might be
an OpendTect pointset, or a column-sorted ASCII file with inline, crossline and Z val-
ues in the first three columns respectively.

l Surface: Used for data extraction along a 2D/3D horizon, or between horizons. Please
note that the attributes will be interpolated if extracted along an horizon. If the extrac-
tion is done between two horizons (volume based extraction using a user-defined Z
step), it will not interpolate the attributes. The "Extra Z" values increase or decrease
the extraction window size, and work similar as the attribute set time gates (relatively).
The left value applies to the top horizon and the right value applies to the base horizon.

l Body: It is used to restrict the data extraction within a selected 3D body. The radio
boxes inside/outside are used to extract the data either inside or outside the selected
body. If it is outside, the further ranges are sub-selected in theWithin bounding box
field.

l Well: It is used to extract attribute data along the selected well paths. The data would
be extracted vertically and according to the (TWT/depth dependent) survey setup. The
time gate is defined by providing a time range with time steps (vertical sampling rate).

l Location filters can be added in order to add one or several restrictions to the area of
extraction.



- 617 -

5.3.1.3 Location Filters
The filters should be used to further limit the amount of data to be extracted for mak-
ing cross-plots. Several filters can be used simultaneously.

Filters are of two types:

The first two filters, Random and Subsample, are not position related. The Random
filter passes a certain percentage of random samples selected in the main extrac-
tion window, while the Subsample filter will pass a finite (user-defined) number of
samples. For instance, for the Random option, if the value is 1, only 1% of all extrac-
ted data would be selected for cross-plotting.

The last four - Range, Polygon, Table and Surface (see previous section for defin-
itions) are position based filters. These are used to define sub-areas that will
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complement the extraction settings provided in the main extraction window. Multiple
filters can be chosen out of these. Thus, the points satisfying the main extraction set-
tings and all defined filters will be used for the extraction of attributes.
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5.3.2 Cross-Plot Table
The crossplot table displays the extracted data. It is used to edit and plot the data for
a crossplot. A row in the table corresponds to one extracted data point, annotated
by its position (X, Y and Z) and followed by the collected attributes values (forming
at vector, from left to right: logs, attributes, stored data). The star adjacent to an
attribute name indicates sorted column. Empty cells represent attributes than could
not be extracted with the provided the settings for data extraction.

The table enables the manipulation and edition of the collected data, prior to making
cross-plots. For instance, it is possible to sort the data from an attribute, and to
delete the first or last rows, before plotting the data. Please note that the table win-
dow is interactively linked with the cross-plot window. Any editing done in the cross-
plot window will reflect in the table window that remains open and active while work-
ing in the cross-plot window.

Standard workflow: Save , edit, click in a column and then , click in another
column and then , launch the cross-plot window .

You can select a column by either clicking on its title cell or by clicking on any single
cell.

The toolbar contains the following editing tools:
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Saves the data shown in the table to a file (simple text file or OpendTect object).
OpendTect object is a special format to retrieve (open) the cross-plot. The format is
called position vector data and the data is saved in the survey sub- directory
(/Features/*.pvds). The Text file selection outputs the data to an ASCII (column sor-
ted) file that later on can be used in 3rd party software e.g. Excel.

Open/Retrieve the stored crossplot data. An alternative short-cut is present in
the menu Analysis > Cross-plot > Open Crossplot.

Assigns the X-axis of the cross-plot to a selected/highlighted column.

Assigns the Y-axis of the cross-plot to selected/highlighted column.

Removes the selected Y-axis for cross-plotting.
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Removes the selected rows in the table.

Moves the selection of the primary Y-axis one column to the left. The cross-plot
gets updated accordingly.

Moves the selection of the primary Y-axis one column to the right. The cross-plot
gets updated accordingly.

Sorts the selected column to an increasing order, from top to bottom.

Add an empty column in the table. In the pop-up window, the column name is
provided. The mathematical operation is done to compute the data for the new
column. An example is the Acoustic impedance data computed from the velocity
and density logs available in the crossplot table. For further information on the math-
ematical operators, please find the description on the Mathematics attribute in the
Appendix.

Removes the selected column from the crossplot.

Displays selected percentage of the data. If a lot a data was
extracted not all will be displayed in the table. Nevertheless the sort and remove
lines tools may still apply to all the extracted data, upon request of the user.

Toggles on/off the display of the coordinates.

Toggles on/off the display of Z values.

Shows histogram and statistics on the selected column.

Allows to achieve vertical variogram analysis. A variogram describes the spatial
continuity. The vertical variogram can be computed for any of the attribute or log
from the extracted data. To achieve a variogram analysis from well log, the log data
is resampled at the variogram processing step and de-trended prior to the vari-
ogram computation itself. In the pop-up windows, the different parameters can be
defined: the maximum range (maximum distance allowed between the pairs for the
analysis), the step and the minimum pairs per log distance. Once these parameters
provided, the variogram is computed and the analysis can be performed.
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Variogram analysis: Set parameters (left), main window(right) : blue = real data,
green = model

A synthetic variogram can be set in changing the sill, the range and also the vari-
ogram model (exponential, spherical, gaussian). The objective is to get a synthetic
variogram that best describes the real variogram. The data can be analyzed for
each well or for all of them. The analysis results can be used when achieving inver-
sion.

Launches the crossplot window.
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5.3.3 Cross-Plot Window
The cross-plot window shows the data previously extracted and shown the cross-
plot . The window may start empty if insufficient data was selected in the table win-
dow.

The cross-plot window contain three toolbars to perform various tasks:

Crossplot manipulation toolbar

Take the snapshot of the cross-plot.

Gives access to the main crossplot window properties: scaling, statistics, regres-
sion line, density plot parameters.
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Creates multivariate from the cross-plot data.

Colour code the points with respect to a .

Colour code the points with respect to the wells they were collected.

Crossplot display toolbar

Is used to update the amount of displayed
scattered points in a cross-plot. It increases the efficiency to display the data
quickly. Normally, a huge data slows down the machine performance, when dis-
played as scattered points. To avoid this, this option is used to display a selected
percentage of the points. Moreover, the percentage is only set for the data that has
values; undefined values are ignored in the percentage.

The scattered points of individual/all wells are displayed.

Used to show a coloured density cross-plot. Normally, if the displayed scattered
data points are too large, it consume huge memory to display the data. In that case,
the density plots are useful. In a density plot the data will not be filtered out in the dis-
play (% point displayed) as in the case of a scattered point display. In the cross plot
properties window, there is a tab available for the . In that tab, a user can set a num-
ber (currently displayed data) to display the data. When this plot is ON, there will be
a colour table displayed that can be changed. The colour spectrum designates the
distribution of the points per pixel.

Used to Toggle on/off the second Y-axis (Y2) scattered points. It may be noted
that when the second Y-axis (Y+) is selected to be cross plotted against Y1 and X,
the data points may become too large to be displayed. Therefore, in this case, the
system will prompt a warning to display a given percentage of the data (% points dis-
played).

Crossplot selection toolbar
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Is inactive, if a cross-plot is created with one Y-axis. It allows
to make section of the scattered points. The selection settings (Select only Y1/Y2,
both) are important to remove unwanted points from the extracted data. When dual
Y-axis are cross-plotted, a user can select individual or both Y-axis points by chan-
ging this option.

Toggles a pan/selection mode. Selection mode is used to select the scattered
points. When pan is toggled on, rest selection options (see below) become inactive,
which avoids editing/manipulation of the cross-plotted data.

Used to display the selected scattered point in an active scene. The selection of
the data points is done by using selection mode. By using this option, the selected
scattered data can be saved as a pointset/body. Right-click on a point in a scene
and from the pop-up menu select 'save as a pointset' or 'create body' option.

Selection mode (rectangle/polygon). The selection is made by holding the left-
mouse button down and selecting the desired area within the cross-plot.

Used to de-select the selected data points (using selection mode tools).

The unwanted data points can be removed by using selection mode and this
trash button. In order to remove the data points of Y1, Y2 or both, use selection
mode tools to select an area within which the data is to be removed. After that press
this button to remove the data.

Used to select the data from a cross-plot and display the corresponding selected
data in the spread-sheet (Well/Attribute data window).

You can do multiple selections by adding new groups (see below). It is launched
using this manage selection button. The multiple group selection allows you to
select different clusters/trends on a crossplot in the form of groups. Second and sub-
sequent selections are made by clicking on a group name and holding the CTRL
key down from a keyboard prior. Then the corresponding polygon (with a given col-
our) is drawn over the crossplot display area. It is a very useful tool for reservoir pre-
diction and characterization.
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This option is used to by using a mathematical logic over a range. It restricts the
selection according to the range set in the Refine Selection window (a pop-up win-
dow invokes when this button is pressed). For instance, a user may want to remove
a data (x0) within a range of 3-4 from a cross-plot in which 1-2 values are over-
lapping. To do that, press this button to launch Refine Selection window. In the
Enter Ranges field, an equation can be set i.e. X0 > 3 and X0 < 4. Where X0 is
desired data in a cross-plot. After this a section can be made within a cross-plot to
remove values within the polygon according to the equation.
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5.3.3.1 Cross-Plot Properties

The properties window (accessed via )can be used to adjust the scale, view stat-
istics, add regressing lines etc.

Scaling Tab: Sets the clipping state for each axis, or the amplitude range for the
chart. Default: 0, which means that the window is adjusted to fit the entire amplitude
distribution.
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Statistics Tab: Shows the parameters of a least square fit between the attributes
used as X and Y1 (values and errors). The regression line can be displayed in the
cross-plot window, as well as the correlation coefficient.
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User Defined Tab: Sets a user-defined regression line, that can be displayed as
well in the cross-plot window. A simple line can also be drawn in the cross-plot win-
dow, in which case the corresponding coefficients will be displayed in this tab.
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Display Properties Tab: Sets user-defined marker size, marker shape and the Y-
axis color.
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Density Plot Tab: This tab is used to set the minimum points for the automated
density plot. Scatter plots will not be allowed below that number. The tab settings
define the bin size prior to counting the number of occurrences.
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The following pictures shows an example of density plot. Please note that an addi-
tional colorbar has appeared. Units are the number of points that correspond to the
color.
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5.3.3.2 Probability Density Functions
Probability Density Functions (PDFs) can be created from the cross-plot toolbar
icon . This icon launches a pop-up dialog that can be used for selecting attributes
in order to create PDFs. The PDFs are stored in OpendTect Format, that can later
be used for running Bayesian classifications.

Please note that all attributes from the table can be selected. Attribute ranges are
generated automatically to fit the extracted data distribution. These can be edited
before creating the PDF.
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5.3.3.3 Overlay from a Third Attribute
Scattered points can be coded with respect to the amplitudes of an attribute using
that option. The popup window requires the selection of that third attribute, and col-
orbar specifications (type and amplitude range)
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5.3.3.4 Well-based Color Coding
The scattered points in the cross-plot window can be coded with respect to the wells
along which the data points were originally extracted. The following utility window
can be used to control the colour associated to each well:

The configuration above gives the following result:
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5.3.3.5 Selection Settings
The selections made interactively in the cross-plot window can be further refined
and managed in this window.

The 'Refine' option ( )utilizes mathematical logic to restrict the selection according
to the range set in the Refine Selection window (a pop-up window invoked when this
button is pressed). For instance, a user may want to remove a data (x0) within a
range of 3-4 from a cross-plot in which 1-2 values are overlapping. To do that, press
this button to launch Refine Selection window. In the Enter Ranges field, an equa-
tion can be set i.e. X0 > 3 and X0 < 4. Where X0 is desired data in a cross-plot. After
this a section can be made within a cross-plot to remove values within the polygon
according to the equation.
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The 'Manage Selection' option ( ) can be used to do multiple selections by adding
new groups (see below). It is launched using this manage selection button. The mul-
tiple group selection allows you to select different clusters/trends on a crossplot in
the form of groups. Second and subsequent selections are made by clicking on a
group name and holding the CTRL key down from a keyboard prior. Then the cor-
responding polygon (with a given colour) is drawn over the crossplot display area. It
is a very useful tool for reservoir prediction and characterization.

The selected scattered points can then be displayed in the active scene by clicking
on OK. This allows an interactive display of the cross-plot in a scene. The displayed
points (i.e. picks) can be saved in the OpendTect survey either as a pointset or as a
Body. Right-click on any point in the display, it will launch a pop-up menu (see
below).

l Properties: It can be used to edit the size of the points.
l Create Body: Create a Body from the selected points.
l Save as pointsets: To store the selected points as a pointset.
l Remove selected points: Removes the selected data.
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You can do multiple selections by adding new groups (see below). It is launched
using this manage selection button. The multiple group selection allows you to
select different clusters/trends on a crossplot in the form of groups. Second and sub-
sequent selections are made by clicking on a group name and holding the CTRL
key down from a keyboard prior. Then the corresponding polygon (with a given col-
our) is drawn over the crossplot display area. It is a very useful tool for reservoir pre-
diction and characterization.

In the column name, a new name should be given that would be added in the cross-
plot data table. Show selectedness as an overlay, if checked, would display the col-
our coded selection ranging (between 0-1) as an overlay in the crossplot area. The
colours represent the chosen colortable. Show selectedness in 3D scene would dis-
play the points within the selectedness range in the 3D scene.

The user can manage the groups (or selections) by saving them (Save groups)
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Furthermore, the user can also manage the groups (or selections) by opening
(Open groups) the saved groups.
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The Selectedness is a special data selection. It is a measure of how likely a point is
to be selected in a particular selection. If a point is present in and around the center
of a particular selection that has higher selectedness values. Whereas those belong-
ing in the border regions are less likely to belong to that selection and thus it will
have lower selectedness values. It is a measure of which points are better rep-
resentative of a particular selection. The value of Selectedness ranges from 0-1.
The points outside the selection has undefined values. It is added as a separate
attribute in the table and can be seen in the form of an overlay attribute. To mark
selectedness, one group is needed to be selected by using the selection mode.



- 645 -

5.3.4 Open Crossplot

This option allows you to open previously saved or imported crossplot data and will
directly open the data in the crossplot table.
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5.4 Wells
The Wells element in the Analysis menu gives you access to three features: Edit
logs...,Tie Well to Seismic... and Rock Physics...
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5.4.1 Well Log Tools
The well log tools can be used to remove spikes, smooth and clip the logs. it can
also accessed by using the icon in the Manage Wells window. Multiple wells can
be selected at once along-with the various logs. The logs can be extracted between:

Markers: The bounding markers have to be specified. If necessary, the distance
above/below these bounding markers (from where the actual extraction of the logs
is going to start/stop) can also be specified:

Depth range: The logs can be directly extracted between a particular depth range:
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Time range: The logs can be directly extracted between a time window. The extrac-
tion may be done in time domain by toggling on 'Extract in time'.

On pressing Go the extracted logs are displayed and 'smoothing', 'clipping' and
'spike removal' can be performed on these well logs:
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Smooothing: A window size (samples) should be defined in which the smoothing of
the well log data will be performed.

Clip: Percentage Clip rate has to be defined.

Remove spikes: De-spiking of the logs can be done by specifying a window size
(samples) and the Threshold for the Grubbs algorithm. Further, the removed spike
values can be replaced by 'Undefined values', 'Interpolated values' or can be manu-
ally specified.

Finally, the edited logs can be saved with an extension or can be overwritten.
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5.4.2 Tie Well to Seismic
Launch the Well-Seismic Tie window from the main menu or, optionally, the Well-
Seismic Tie window can be launched from the tree.

Well to the seismic tie is a major task for interpretation projects. It is used to cor-
relate the well information (logs) to the 3D seismic volume or 2D seismic lines. This
enables the comparison (crossplots, ...) of well-based and the 2D/3D seismic data.

Well-to-Seismic tie workflow:

1. Data preparation
l Import the seismic volume or 2D line.
l Extract a wavelet.
l Import the wells: Each well requires a track, checkshot or time-depth curve and
sonic log.

l Import the additional data: 3D/2D Horizons, well markers, additional time-depth
curve if a checkshot was loaded.

l Edit the log database: Fill the missing sonic parts, create a density log from the
sonic (constant value or Gardner's equation) if not available.

2. Synthetic-to-seismic tie
l The module is launched from the Analysis menu or via the right-click menu of each
well.

l The input fields must be selected.
l Based on the available data the density and sonic logs will be combined into imped-
ance and reflectivity, depth-time converted (includes an upscaling) and convolved
with the wavelet. The result is a synthetic seismic traces for the well. This trace will
be compared with a composite seismic trace extracted in the volume along the (devi-
ated) well path, on the nearest trace. Both synthetic and composite seismic traces
are cross-correlated, and the output value is an indication of the alignment and
matching quality.

l The alignment will be carried out either by shifting the synthetic trace up or down, or
by selecting several locations in both seismic traces, specifying and applying a shift
function that varies with the travel time.The applied changes must be validated,
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before being converted into a new time-depth function that replaces the previous
one. No changes are being applied to the well logs.

l At each step of the tie a deterministic wavelet can be estimated using the time-con-
verted reflectivity log and the composite seismic trace. This deterministic wavelet
should vary per well, and is known to link the well data to the seismic data more reli-
ably.
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5.4.2.1 Well-Tie Selection Window
The tie well to seismic window is used to select the necessary data for the Well-Seis-
mic tie workflow. Please have a look at the introduction to see how to prepare the
necessary data.

Well tie can be used to tie the well with the 3D seismic volume or 2D seismic line.

Well to 3D seismic tie window
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Well to 2D seismic tie window

In both the 2D and 3D windows, there are additional features accessed via the fol-
lowing icons:

Opens the Calculate New Log window

Displays the particular log in the log viewer

Opens the Wavelet Manager window
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5.4.2.2 Well-Tie Checkshot Editor
In OpendTect, CheckShot corrections are applied before launching the Well to Seis-
mic Tie window. If you have no depth/time model or have not selected any existing
one, you will be proposed to correct the sonic integrated depth/time model, provided
you imported a CheckShot model for your well.

The choices given are "None", "Automatic" or "Use editor". In the first case, the time
depth curve will be computed directly from the sonic log without any correction
(note, this is also the default mode if you do not have any CheckShot). In the auto-
matic mode, the time/depth curve will be calibrated to the CheckShot without any
user interaction. In the last case, you will be allowed to edit the calibration yourself
using an editor window.

When clicking on 'Run', the 'Apply Checkshots correction' window pops up.
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The above window is divided in two panels. On the left one, the sonic 'Integrated
Depth/Time Model' (red) and the 'Checkshot Curve' (blue) are plotted. The right
panel displays the drift curves. The original 'Drift Curve' (red) shows the variations
between the CheckShot and the sonic integrated model.

By adding points to the right display you can additionally generate a new 'User
defined Drift Curve' (green). This is done by clicking the icon. Once this is done,
select the correction to apply, either from the Original or from the User Drift Curve
and push the Apply button. The newly computed depth/time model will appear in
green on the left panel. You can modify the drift curve and re-apply the corrections
until you are satisfied with the depth/time model. Push the OK button and the main
well tie window will appear using the new calibrated depth/time model.
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5.4.2.3 Well-Tie Display Panel
The display panel is the main window where the wells are tied to the seismic data.
This module is primarly used to update the current (loaded) time-depth curve. Pre-
vious, intermediate and final TD curves can be exported to ascii at any moment
using the following icon .

A secondary output of the synthetic-to-seismic tie is the estimated wavelet, that is
estimated at any time and must be saved explicitly.

The view is separated in three frames, from left to right:

l The sonic (red) and density (blue) logs.
l The computed impedance (red) and reflectivity (blue) logs.
l The computed/extracted synthetic and composite seismic traces.

The raw logs are shown before upscaling. The vertical axis of all 3 frames is in travel
time.

Key points:

l The time-depth conversion and synthetic seismic traces computation is done using the
current time-depth curve and checkshot (if available).

l The checkshot data acts as a strong constraint, i.e. any input and output time-depth
curve will be forced to honour the checkshot.

l The time of the depth TVDSD=0 will always remain at TWT=0 even when applying a
bulk shift: The difference is absorbed between the point TVDSS=0 and the first sonic
log sample. The reference datum elevations definitions are summarized in the well
track import chapter.
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Display panel for the well-seismic tie.

At the bottom right corner of this display panel, there are several tracking controls.
The options are used to pick an event to match the seismic and synthetic traces.
After picking the event, press Apply Changes to reflect the changes and update the
time to depth model.

Launches the Edit Time/Depth model window. In the pop-up window, press
Export button to export the time-depth model as an ASCII file.

Launches the save option.

You can either save the created logs:



- 659 -

Or save the synthetic trace as a seismic volume.
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Takes the snapshot of the display panel

Display settings/properties for the panel. The settings are similar to that of the
normal 2D-viewer model

Zoom-in

Zoom-out

Toggles interact mode ON/OFF

Pick seeds on the seismic or synthetic to update the time to depth model.
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Change in depth/time model

l Choose a tracking mode (e.g. maxima, minima, zero-crossings etc.) and select events
in the synthetics/seismic displays by first selecting the Pick mode button. Events can
not be picked separately. Each event in the synthetics must be linked with an other
event in the seismic.

l Once all the events are selected on both synthetics/seismic displays, press Apply
changes button. The depth/time model and the whole computational workflow will be
recomputed. If needed, repeat the operation.

l The Display additional information button will open the Cross-checking parameters win-
dow, and provide useful cross-checking tools, such as correlation coefficient and estim-
ated wavelet in a specific depth range. The estimated wavelet displayed here can also
be saved:

l The depth/time table can be saved between each state by pushing the Save button, in
the toolbar to the right of the synthetics/seismic displays, and saving with an appro-
priate name. The View/Edit Model button allows the user to import a depth/time table.

l Once a good correlation has been established, click onOk/Save and save the depth/-
time model.
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5.4.2.4 Well-Tie Crosscheck Parameters
The cross-checking window is launched from the well ties display panel (Section-
Well Tie: Display Panel) by clicking on the Display additional information button.
The window contains the initial and estimated wavelet information. The wavelet can
be computed between the two levels (start-end of data in time/depth or markers)
that are provided at the top of this window. The window contains further key inform-
ation: wavelets plot and the correlation coefficient. By changing the compute data
between option, the correlation coefficient is auto-updated, this is done by using
either Markers (Default) or Time/Depth. After achieving a high and positive cor-
relation coefficient, the estimated wavelet can be saved. Importantly, the negative
correlation coefficient shows that the polarity of the estimated wavelet is reversed.
To avoid that the reference/initial wavelet's polarity has to be reversed.

Check-crossings window and correlation panel



- 663 -

To save the estimated wavelet, press the icon in the well tie main window .

The wavelet properties ( ) can be shown as a graphical display of the wavelet, its
amplitude spectrum and phase spectrum.
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Save the estimated wavelet

The user can also click on to open a slider interface for shifting phase of the
wavelet:

Rotate Wavelet: Using the slider, the user can edit the phase of a wavelet.

Taper Wavelet: This option enables the user to taper a wavelet by clicking on .
The User will see the real-time changes in the amplitude spectrum.
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5.5 Layer Modeling
Pseudo-wells are stratigraphic columns with attached well logs, but without geo-
graphical location. Any pseudo-well can be seen as a possible realization of a newly
drilled well in the area. The pseudo-wells generation is achieved following a model
that has to be defined. To achieve Layer Modeling, preliminary an extended well
data analysis has to be carried out. The stratigraphy must be defined and then the
well logs behavior have to be known in order to be used in the modeling.During the
modeling process, the stratigraphy description is fixed and cannot be edited.

The Layer Modeling is accessible from the Analysismenu but also from the Manage
Stratigraphy window.

Basic modeling can be achieved in OpendTect. More advanced modeling are avail-
able in SynthRock plugin.

The Layer modeling workflow is divided into three main steps:

1. Model definition: using the stratigraphy description, properties are assigned to the dif-
ferent lithologies within each units. These properties are fixed or can vary. The model
definition is used to generate the pseudo-wells.

2. Synthetic and Log generation: the pseudo-wells are generated and their associated
properties can be displayed. With a wavelet extracted from the real seismic, zero-off-
set synthetics are generated. Using a ray tracer synthetics can be computed for dif-
ferent offsets and restricted angle stacks can be created. Thus their behavior with
varying offset can be analyzed.
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3. Pseudo-well data analysis: the properties from modeled logs and synthetic seismic
can be compared and analyzed layer by layer, lithology by lithology.

Example of a basic block model
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5.5.1 Basic
Each layer in the stratigraphy column is characterized by different rock properties.
The model, based on the stratigraphy, is assigning properties to each lithology,
layer by layer. The model is built using a blocky approach. The different properties
are selected within a list. Their value can either be constant or vary within a given
range.
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5.5.1.1 Layer Description
First of all, the Layer Succession has to be defined and will be used to create the
pseudo-wells.

To start defining layers properties, the user has to click on "click to add" on the left
rectangle. Once one layer has been defined, click on Ok and the layer appears in
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the left rectangle. To add a layer, click-right on the rectangle and select "Add above/-
below": you can then define a new layer. "Edit Layer" is also accessible from this
right-click menu. The description can be saved in clicking on the icon and later
be accessed in clicking on the icon.

1. First of all the properties to be defined for the modeling have to be selected within a list.
The properties in the list have been defined in the Layer properties Manager which is
accessible from the icon and can be edited.

The selection can always be edited in clicking on the icon . To be able to gen-
erate synthetics, Density and Pwave velocity are selected by default. For the
moment, it is not possible to combine properties together. So for example to get the
Acoustic Impedance, you have to model the Acoustic Impedance log.
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2. The Layers have been defined in the Stratigraphy Manager. To each lithology of each
layer are assigned properties and if within the survey this property is expected to
remain constant or to vary within a given range. The thickness of each layer can also
stay constant or be varied. The variation is linear.

The thickness is a default property. When defining a thickness range, the starting
thickness can be set to a negative value: it will appear as a truncation in the pseudo-
wells.

The fluid content can also be specified. It had to be specified previously in the Con-
tent manager.

When clicking on OK, the Layer Description will appear on the left rectangle. To edit
the properties of one or more layer, just right click on the layer name in the left panel
and choose 'Edit... '.
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5.5.1.2 Synthetic- and Property-Log Generation
The property logs of the pseudo-wells only need the Layer Description to be cre-
ated. To generate synthetic traces for each pseudo-well, three elements have to be
provided:

1. To generate the synthetics: Wavelet
2. To generate synthetics for a range of offset :

l Ray tracer parameters
l Layer properties: The density, P-wave and S-wave have to be given, computed or
derived from other quantities that have been modeled.

The synthetic parameters window in the v 7.0 of OpendTect is designed to be
simple and easy to utilize. The 'Define Synthetic DataSets' icon allows the user
to create synthetic for different offsets and to perform different angle stacks.
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In the specify synthetic parameters window, the user can scale, rescale, remove
and update wavelets. Mind, that with this new interface window, when a new syn-
thetic wavelet is created and updated, the updated data set is not shown in the visu-

alization window. This icon allows users to specify how to obtain rock properties
such as density, velocity, etc. Synthetics can be saved or exported . The fol-
lowing icons allow users to access the wavelet manager, and extract wave-
lets from seismic volumes.
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5.5.1.2.1 Synthetic Layer Properties

The synthetic seismic generation requires different quantities : Density, P wave velo-
city and S wave velocity. These quantities can be specified in clicking on the icon
: they can be computed using formulas and the appropriate modeled quantities. If
the quantity has been modeled, it can be used as Defined quantity .

Possibilities to compute the layer properties
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5.5.1.2.2 Wavelet

The wavelet can be selected from the one already available in the project and listed
or a new one can be created in the Wavelet manager accessible from the icon .

Some workflows need to have the synthetic with the same amplitude that the real
seismic. The purpose to the scaler is to scale the wavelet by comparison between
the synthetic seismic computed at a given horizon and the real seismic extracted in
a defined time window regarding this same horizon. To do so click on Scale.
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First of all you need to select your reference seismic as Input Cube, then the ref-
erence horizon for the extraction of the real seismic data. The reference for the
extraction in the synthetics is the reference stratigraphic level selected in the main
window. The extraction must be done at a level interpreted in the pseudo-wells and
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in the real seismic. It is possible to restrict the extraction to an area defined by a poly-
gon. Also the reference level in the pseudo-wells does not necessary correspond to
a specific event in all the wells, on the contrary horizons are most often interpreted
following a same event. Thus it is possible to snap the synthetics to a specific event.
Finally the extraction window around this reference level has to be specified. It will
depends on the thickness of the interval of interest of your data. Once all these para-
meters have been given, you can extract values.

The histograms for the synthetics and the the real seismic are displayed side by
side to be easily compared. A similar point is identified in the two cases (the default
is average) and the factor between the two amplitude values is used to determine
the scaling factor. The scaled wavelet can then be saved and used afterwards.
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5.5.1.2.3 Ray Tracing

The ray tracer parameters allow the creation of synthetics for different offsets and to
perform different angle stacks. The source/receiver depths have to be provided.
The offset range has also to be specified. The arrival times are calculated by ray-tra-
cing through a horizontally layered isotropic earth model.

The ray tracer, available via the icon, allows the creation of synthetics for dif-
ferent offsets and to perform different angle stacks. The source/receiver depths
have to be provided. The offset range has also to be specified. The arrival times are
calculated by ray-tracing through a horizontally layered isotropic earth model.
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Ray Tracing parameters in the simple and advanced mode

In the advanced mode, the surface coefficient can also be defined if known as well
as the spreading geometry.
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When pressing Go , the synthetics for different offsets are computed. The view is
set to be Free view by default, you are then able to display a single offset or a limited
offset stack in ticking the Stack option.

When one offset is displayed, it is possible to make the offset vary from a given Step
using the arrows .

From the icon , it is possible to display the gathers for the different models.

For further information, please refer to Appendix E - Synthetic Data Generation
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5.5.1.2.4 Display

There are several display options within the Layer Modelling feature:

By default the property logs are displayed regarding the block. When toggled on the
icon, the representation is one color per lithology. The property displayed is

selected in the selection menu in the lower part of the window.

When the icon is on, if the user zoom on the synthetics, it will not affect the prop-
erty logs view. The icon is on by default.

The stratigraphic level is a marker. The marker position has been modeled and so
its position within the pseudo-well can be displayed. In the real wells, markers come
from the log data and geological information. It does not necessarily correspond to a
given seismic event. On the synthetic from the pseudo wells, it is possible to snap a
selected marker to a seismic event (point, trough, zero-crossing...). This has to be
done carefully as some information can be lost: there may be lateral variations of
the rock properties that may impact on the phase of the seismic.

Synthetics display parameters are accessible when clicking on
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The "Wiggle Variable area" section concerns the display of the synthetic log itself.
The "Variable density" section concerns the background, i.e the interpolation
between the synthetic traces.
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5.5.1.2.5 Layer Properties

Once the simulation has been run, the pseudo wells will have been generated and
these well properties are then displayed in the lower section. The synthetics are
also generated and display in the upper half of the window. When clicking on a
given pseudo-well, a line appears to show the selected pseudo-well and right-click-
ing on a particular layer of this selected pseudo-well gives a menu to various
options.

For this selected pseudo-well, the Properties... option gives access to the char-
acteristics of this specific layer in term of thickness and modeled properties. In the
layer-based modeling (basic or stochastic), these values can be manually modified.
The fluid content can also be edited. Changes are saved when clicking Ok and the
display is automatically updated.
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In the SynthRock plugin, in the Profile mode, a similar window is available on right-
clicking on any trace on the lower rectangle where a selected property is displayed
for the different pseudo-wells. In selecting Inspect values, the window opens. In this
case it is an informative window: the different property values can not be changed.
The fluid content however can be edited. The lithology in this case is unknown as it
is based solely on well log(s).
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5.5.1.2.6 Remove Layer

The existing layers of a model can be removed at any time, by right clicking on the
left hand side pane, containing the simulation information.
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Thereafter, the regeneration of the pseudo-wells can be done by clicking on .
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5.5.1.2.7 Export Synthetic Datasets

The synthetic seismic data (both poststack and prestack), the layer property syn-
thetics in Time (e.g. AI, Density etc.) and the stratigraphic levels/markers, from all
modeling modules (i.e. Basic, Profile and Stochastic) can be exported along 2D
lines. The stratigraphic levels/markers in the modeled pseudo-wells are essentially
exported as 2D horizons. This is achieved by clicking on the icon at the top right
of the modeling window (see below).

Export of the synthetics can be done onto an already existing 2D line or a new line
created on the fly.

Selecting an existing 2D line

If the 2D line is created on the fly, the Geometry for line has to be defined as well. It
can be done by defining a straight line between two X-Y coordinate pairs.



- 695 -

Creating a straight 2D line between two X-Y coordinate pairs

The 2D line can also be created, on the fly, along an existing polygon.

Creating a 2D line along a polygon

Finally, the 2D line can also be created along an existing random line.

Creating a 2D line along a random line

Now, a selection on poststack data, 2D horizons and prestack data can be made for
exporting along the 2D line.
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For poststack data, user can select synthetic seismic and various layer property syn-
thetics (e.g. Acoustic Impedance, Density etc.).

Poststack data selection for export

Similarly for 2D horizons, various levels present in the pseudo-wells can be selec-
ted.



- 697 -

2D horizon data selection for export

and finally (if any) prestack data can be selected.

Prestack data selection for export

Optionally, a prefix and/or postfix can be specified for various data items. Pressing
Ok will export the selected data items along the 2D line.
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5.5.1.3 Cross-Plots

The cross-plot tool in the Basic layer modeling can be started from the icon . It
allows to analyze seismic and layer attributes from the modeled data. On the main
window, the user select the attributes to be extracted and the extraction para-
meters.The extraction window is related to a reference level. Its length is user-
defined. The appropriate extraction window size has to be defined regarding the
interval of interest. The user has to provide a step that corresponds to the sample
rate within the extraction window.
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Once the attributes and the extraction parameters defined, the crossplot window
opens and is similar to the one available for the classic seismic/well analysis.
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5.5.1.3.1 Wavelet Scaling

If the wavelet has not been scaled to the real seismic, a pop up window will first
appear prior to access to the attribute selection window.

The user has 3 choices :

l [Start tool] to start the Scale wavelet window
l [Mark scaled] if the wavelet is considered as scaled or does not need to be scaled
l [Ignore] if the attributes that are going to be extracted will not need a scaled wavelet

Once the wavelet is scaled or marked as scaled, it will be remembered and the win-
dow will not appear again.
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5.5.1.3.2 Seismic Attributes

The seismic attribute selection/definition is comparable to the main attribute
window: the same attributes are available. An attribute can be selected in the list of
Available types and add to the Defined attributes using the button. The para-
meters of the attribute have to be specified. Synthetic seismic generated from the
models can be used as input data. All the listed attributes are not necessary using
synthetic seismic.
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5.5.1.3.3 Layer Attributes

For each modeled property, data can be extracted either along the log using a
defined extraction window or by layers:

Sliding: the property value is extracted within the extraction window where a cal-
culation window slides along the well. The size of the calculation window is defined
by the step provided by the user on the first crossplot window. The output is the
nearest sample, the average, the median, the RMS or the most frequent. At the end
the attribute has [number of pseudo-wells* round up (Extraction window size/Step)]
samples.

Integrated: Different lithologies have different properties. In the Layer Description,
the behavior of each lithology has been defined for the modeling. The modeled prop-
erties can then be extracted and easily compared with the crossplot tool. Each
modeled property can be extracted at the different level of the framework, for one or
more lithology of one or more layer. One value corresponds to one model. The out-
put will be the average, the median, the standard deviation, the minimum or the max-
imum of the extracted data for each model. The number of sample depends on the
step and the thickness of the extraction block. The thickness of the block may vary
from one pseudo-well to another depending on the model definition. Thus the num-
ber of sample can vary from one pseudo-well to another. For one attribute, the num-
ber of sample is equal to the sum of the round up (Extraction block thickness/Step)
of each pseudo-well.
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In both case, it is possible to transform the attribute value in applying the function
power, log or exponential. The attribute is extracted on each pseudo-well.
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6 Processing

6.1 Create Seismic Output
The Create Seismic Output option leads to a number of further choices, detailed in
the following subsections:
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6.1.1 Attributes
In this module any (attribute) volume can be calculated and saved to disk. In case of
2D attributes, the output is a new data set. The volume output module can be run in
batch mode, allowing to continue working in the main window while the processing
is running.

This module creates, for example, attribute cubes, neural network cubes, or filtered
data cubes.
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6.1.1.1 2D - Create Output
A data set attribute can be created through the following procedure: Processing >
Create Seismic output > Attribute > 2D

First, Select the output quantity : it can be either a stored 2D volume or an attribute
from the active 2D attribute set.

Note that only attributes from the current attribute set can be selected in the "Select
quantity to output" window. To output an attribute from another attribute set, you
must select this attribute set in the attribute module.

Though the default is set to 'All Lines', a selection of lines can be specified by click-
ing 'Select':
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Optionally, the output can be scaled with a Shift and a Factor:

Output = Factor * Input + Shift

Null traces can be discarded.

It is also possible to choose between Single Process and Multi-Job/Machine pro-
cessing:

And to set the job priority (if deemed necessary):
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6.1.1.2 3D - Create Output
To create a 3D seismic output from an attribute, follow the path Processing > Create
Seismic Output > Attribute > 3D.

First, Select the output quantity. Optionally, a sub-volume can be specified.

Note that only attributes from the current attribute set can be selected in the 'Select
output quantity' window. To output an attribute from another attribute set, you must
select this attribute set in the attribute module.

Null traces can be discarded.

It is also possible to choose between Single Process and Multi-Job/Machine pro-
cessing:
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And to set the job priority (if deemed necessary). This is equivalent to the 'Nice level'
on Linux, determining how much priority the process will take on the remote
machine:

Optionally, the output can be scaled with a Shift and a Factor:

Output = Factor * Input + Shift

Storage:OpendTect can store data internally in 8-, 16-, 32-, and 64-bit seismic data
formats. 8-bit signed has a data range between -127 and +127. 8-bit unsigned
ranges between 0 and 255. Similarly, 16-bit signed ranges between -32767 and
+32767 (unsigned 0 - 65535). The data is stored in the same byte-format as the
input by default (Storage is set to 0 - auto). This is chosen when specifying the
Format/Scaling.
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Adjust Z range to survey range: this option adjusts the new scaled seismic to the
survey range.

Optimize horizontal slice access: For better performance when loading time
slices, set this option to 'Yes'. This compromises some speed in loading crosslines,
but it loads time slices significantly faster.

Processing: OpendTect batch jobs for 3D volumes can be processed on a single-,
multiple machines, or Clustering. For more information look at batch processing.
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6.1.1.3 Multi Attribute
Multi-attribute output enables the user to create a volume with several attributes.
'Available Attributes' lists all possible components of the possible multi-attribute out-
put and any combination can be selected. Once moved across into the 'Selected
Attributes' list, these attributes are processed into a single volume.

It is not necessary to check the boxes next to the attributes in the Selected Attrib-
utes list in order for them to be included in the output volume. All attributes in the
'Selected' list are included by default.
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Also note that a Spectral Decomposition attribute will show a list of all possible out-
puts in the 'Available attributes' field:

On loading the volume onto an inline (for example), the user is prompted to select
which of the available attributes he wishes to use:

The component of the multi-attribute cube that is actually being displayed in the
scene is appended on the volume name in the tree:
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6.1.1.4 Multi-Cube Data Store
Multi-components cubes for some attributes (e.g Spectral Decomposition, Steering
attributes) can be created.

First, create your attribute in the attribute engine.

Create the volume output: Go to Processing > Create Seismic Output > Attribute >
Multi-cube data store and select a volume that contains multiple components (here,
Spectral Decomposition as example):

Select a component of the cube and assign it a 'pseudo-offset' value. Repeat this
process of pseudo-offset assignment for all of the components that you wish to be
present in the output, name it and press 'Go'.
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Multi-component cubes can be exported as SEG-Y or simple ASCII file but only one
component per output. The choice of which component is given to the user during
the export process.
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How to display the Multi Component Volumes?

Whenever displaying a multi-component attribute volume on an inline/crossline, the
component selection dialog box (below) will pop up. In this dialog one or more out-
puts to be displayed on the same section must be selected.

Once several components are selected and displayed for an element (e.g. an
inline), place the mouse in the scene, and use the keyboard's PAGE-UP/PAGE-
DOWN keys to view the next/previous slice in real-time.
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6.1.1.5 Along Horizon
To create a seismic output in a time interval relative to a single horizon, the quantity
to output has first to be selected from the list of stored data or attributes from the cur-
rent attribute set. Specify the horizon and the Z interval relative to this horizon. A
sub-area can be specified.

The Value outside the computed area is the undefined value. The standard
undefined value in OpendTect is 1e30, but any other value can be specified.

Optionally, the horizons can be interpolated. The interpolation can be full or partial.

A calculation parameter file is automatically created with a default name in the Store
Processing Specification field. This file allows to re-start the calculation process eas-
ily if needed. The 'Execution Options' can be set to use either single or multiple
machines processing.
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6.1.1.6 Between Horizons
To create a seismic output between two horizons, first the quantity to output has to
be selected from the list of stored data or attributes. Specify the horizons that form
the upper and lower boundaries of the output volume. A Z shift to be specified can
be applied to the upper boundary and/or to the lower boundary. A sub-area can be
specified.

The Value outside the computed area is the undefined value. The standard
undefined value in OpendTect is 1e30 or Undef, but any value can be specified.
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In Extra options, horizons can be interpolated. The interpolation can be full or par-
tial. When partial, only the gaps smaller than a user-defined number of traces are
filled. A fixed Z interval length can be added to the leading horizon when the second
surface is missing or in case of conflict during the interpolation. To constraint the
interpolation, the Z limits for the output cube can also be specified.

For 'Execution Options', please see: Batch Execution
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6.1.2 2D to 3D Conversions
There are several ways to convert data between 2D and 3D:
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6.1.2.1 Create 2D Grid
The Create 2D from 3D option is an interactive tool for creating 2D-lattices from a
3D volumes.

This option can be used to create a 2D grid with a fixed grid spacing. When selec-
ted, the Create 2D Grid window is launched (see below). Here, specify the input 3D
seismic volume and the output data set name. The output grid is generated accord-
ing to the dip (parallel) and strike (perpendicular) direction of the selected volume.
The prefix labels are used as prefixes to the output line names, stored to the spe-
cified new data set name. The grid spacing is the constant spacing between the two
lines. At the bottom, the total number of parallel and perpendicular lines will be
updated according to the grid spacing. By pressing Ok, a batch process will start to
generate the 2D grid. When the batch program is finished, the lines and data can be
displayed in the scene

l Input Cube: 3D seismic data for conversion into 2D line-set.
l Volume Subselection: Restricts the extent of the 3D volume (optional). Choose
inline/cross-line/time ranges for the selected volume.

l Create Grid from: Define the output grid geometry and orientation of the 2D lines. If
Inl/Crl is selected, the inline/cross-line orientation (or geometry) of the selected 3D
data will be used within the defined inline/cross-line/z-range and corresponding steps.
Optionally, the inline/crossline range can be edited manually by using loosely spaced
inline/cross-line numbers separated by commas.
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Another option is to define the 2D grid geometry based on a Random Line. The grid
can be created both parallel- and perpendicular to the direction of the random line.
Set the fixed spacing in the line spacing(m) fields.

l Prefix: Label the 2D-line names.
l Output Data Set:Output for the 2D line-set. Provide a name for the line and the seis-
mic data (attribute).

l Extract Horizons: Convert existing 3D horizons into 2D horizons by checking the box
(optional). In the Select horizons list, select one or more horizons and, if desired, set a
prefix for these selected horizons.

l Execution Options: Launches the 'Batch Execution Parameters' window and gives
the option to execute the job remotely:
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6.1.2.2 Extract 2D from 3D
Extract 3D data onto selected 2D lines. Input data is required in the form of a stored
3D volume. One or more 2D lines can be selected for the 3D data to be extracted
onto. The output data set requires naming:

If just one line is selected, you may also sub-select a trace range.
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6.1.3 Angle Mute Function
This module creates angle-based Z-Offset functions from velocity volumes. The
primary input is a velocity model that provides the time-depth relation.

If you have no velocity volume available, click 'Create'. This will bring up a window in
which you can select a volume and tag it with a velocity type:
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Vertical 1D ray-tracing is performed assuming a fully flat, isotropic earth model. The
travel-time 0ms corresponds to the depth of the Seismic Reference Datum, defined
in the survey definition window.

The offset range must be provided since the angle mute computer is not aware of
any prestack datastore. It does not necessarily need to match the prestack data.
The output function will have one point at the start and stop of the Z range, and one
point at each offset specified by the offset range parameters.

The main output parameter is the incidence angle in degrees at which the mute func-
tion must be computed. By default the functions will be computed on a relaxed grid,
every 20th time the inline/crossline stepout. This can be changed by selecting other
"Volume subselection" parameters. In general it is not necessary to decrease that
stepout.
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6.1.3.1 Advanced Angle Mute Paramaters
The ray-tracing can be performed in two ways:

Simple: The ray is going directly from the source to the depth of the target layer,
and up to the receiver in the same way. This does not account for ray bending, or
velocity inversions.

Advanced: Will honour the ray bending according to Snell's law and thus velocity
inversions as well. To reduce the processing time, the layers may be blocked: Con-
secutive layers with similar Vp, (and density, Vs if present) values are concatenated
together. The ray is propagated in a straight line inside a concatenated layer.
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6.1.4 Bayesian Classification
Bayesian classifications are used to link several attributes based on one or several
Probability Density Functions.

First, one or several PDF(s) need to be provided. More will allow to select more
PDFs.

After clicking on Next >>, the PDF(s) can then optionally be normalized based on a
priori weights per PDF. The a priori weights can be provided by attribute volumes
which will vary at every sample location.
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The processing will be based on (inverted) stored volumes that should correspond
to the variables used for generating the PDF. Please note that OpendTect cannot
make this check.

If only one PDF was used as input, the Bayesian classification volume will generate
two volumes:

1. A probability volume "P:PDF name"
2. A determination strength volume, mainly for QC.
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If more than one PDF were used as input, the Bayesian classification volume will
generate:

1. A probability volume "P:PDF1 name"
2. A probability volume "P:PDF2 name" (one for each input PDF)
3. Two classification volumes : Class (with the most likely class) and Confidence (the dif-

ference between the two most likely)
4. A determination strength volume, mainly for QC.
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6.1.5 Create from Well Logs
The Create seismic output from wells option writes loaded logs as seismic volumes.

The dialog is accessed from the Processing menu in the main toolbar; choose the
Create fromWells.. option.

Select the well(s) in the left and the log(s) in the right list, note that several wells and
logs can be selected at once.

The log extraction can be done either between markers or by selecting a depth
range. For the latter, select start/stop depths in meters. For extraction between
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markers select the wanted markers and add distance above/below (optional) for
including intervals above and/or below the marker depths.
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The logs need to be resampled in order to display correctly on seismic sections and
volumes. Choose a resampling method from the dropdown list:

l Take Nearest Sample
l Use Average
l Use Median
l Use RMS
l Use Most Frequent

Next, choose how many traces should be duplicated around the well track. Essen-
tially this will determine the dimension and geometry of the output cube. Finally give
a name (suffix) to the CBVS volume (seismic volume), the volume itself will auto-
matically be named according to logs selected in the list.
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6.1.6 Pre-Stack Processing
Prestack processing can be applied using different methods. It is the only place
where prestack data can be output in OpendTect based on another prestack data-
store.

Open the Pre Stack processing window: Processing > Create Seismic Output > Pre-
Stack Processing

The processing can be done by a number of sequential steps. Either select a pre-
defined set up (as above, which may be further 'Edit-ed') or press 'Create'...
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Which brings you to the following window...

To use a preprocessing step, select it in the preprocessing methods and click on
Add. It will then be listed in the used preprocessing methods, click on Properties to
define the step parameters. Move up or Move down to change the preprocessing
steps order for the processing.
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The following sections describe the available different steps.
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6.1.6.1 Mute
Mute functions may be applied to Prestack gathers. This window will allow you to
choose the mute definition, as well as to specify settings such as:

Mute type:Outter (top) or Inner (tail)
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Taper length (in samples)
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6.1.6.2 Automatic Gain Control
Automatic Gain Control (AGC) is one of the processing methods available for
Prestack gathers. It will adjust the amplitude level using a sliding window of user-
defined size (window width). Optionally, part of the lowest energy may be discarded
from the amplitude level computation (in percent of the amplitude distribution).
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6.1.6.3 Super Gather
A Super Gathermay be used to laterally stack the traces in order to increase signal-
to-noise ratio of Prestack gathers. The stack is controlled by an inline/crossline
stepout, and the Shape (Cross or Rectangle). The computation is similar to a (non-
steered) volume statistics attribute with a zero time-gate.
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6.1.6.4 Angle Mute
This processing method computes and applies a mute function. See the processing
method documentation. The only difference is that this method reads the offset
range from the input prestack datastore, such that there is need to specify it. See
here where and when the input velocity source needs to be edited.

The application of the computed mute function is strictly identical to the application
of a stored mute function.

The ray-tracing can be performed in two ways:

Simple: The ray is going directly from the source to the depth of the target layer,
and up to the receiver in the same way. This does not account for ray bending, or
velocity inversions.
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Advanced (not in the GPL version): Will honour the ray bending according to
Snell's law and thus velocity inversions as well. To reduce the processing time, the
layers may be blocked: Consecutive layers with similar Vp, (and density, Vs if
present) values are concatenated together. The ray is propagated in a straight line
inside a concatenated layer.
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6.1.7 SEG-Y Scanned Re-Sort
The SEG-Y Scanned re-sort uses a scanned SEG-Y file and outputs it as a new file
and re-writes the file-header. This tool is useful in case information in the header is
poor or poorly sorted.

In the Type field select the type of volume, either Pre-Stack or 3D volume.

Next, select the scanned input file and optionally area sub-selection. Note that a
SEG-Y file must be scanned prior to resorting. Choose a name for the output file
and (optionally) restrict the number of inlines to be written per file. In case the latter
option is used, multiple files will be written to disk, either using sequential numbers
or the inline ranges included in the separate files.
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6.1.8 Velocity
Under 'velocity' sit two velocity-based conversion options:
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6.1.8.1 Time-Depth Conversion
To create an time-depth converted output, follow: Processing > Create Seismic Out-
put > Time-Depth Conversion...

Time-depth conversion is done by applying Dix's equation, based on a interval- or
RMS velocity volume. A velocity model and input time volume must be provided,
and the direction of the conversion has to be set.

The Z transform options are as follows:
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Each options has various additional choices:

l Simple Time-Depth Model: Select or Create/Edit

l Velocity Volume: Select or Edit an existing model

l Well's Depth model: Select (though these may be edited via the Well Manager)

l Linear Velocity: set an Interval Velocity and Gradient directly in this UI.

It is also possible to convert from Depth to Time, where, instead of an input Time
volume, a input Depth model has to be provided.
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6.1.8.1.1 Simple Time-Depth Model

In the Time-Depth Conversion windows, it is possible to chose 'Simple Time-Depth
Model' as one of the conversion options.

Select will allow choice of a stored Simple Time-Depth Model from your existing
database:

The models are by default stored in ...\<survey name>\Models\

Create/Edit provides a choice between two options in a drop-down:

Both options use the same UI:
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Create is blank, ready for your input. Edit opens the currently selected model.
Entries may be renamed, locked, deleted or set as favourites, as in all other selec-
tion windows.
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6.1.8.1.2 Velocity Volume

In the Time-Depth Conversion windows, it is possible to choose 'Velocity Volume'
as one of the conversion options.

Select will allow choice of a stored Simple Time-Depth Model from your existing
database:

The models are by default stored in ...\<survey name>\Seismics\

Edit allows for the selection of an existing Velocity Volume, plus options for its type
conversion:
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See Tagged Seismic Data for more info on Velocity types.



- 754 -

6.1.8.1.3 Well's Depth Model

In the Time-Depth Conversion windows, it is possible to choose 'Well's Depth
Model' as one of the conversion options.

Select will allow choice of a Well from your existing database:

OpendTect will then use the T/D model form the selected well for the conversion.

Clicking the Well Log icon on the left allows for import of further logs:
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6.1.8.2 Velocity Conversion
This tool is started from Processing > Create Seismic Output > Velocity conversion.
It can be used to convert interval velocity volumes to RMS velocity volumes and vice
versa. The conversion is applied using Dix's formula. Please note that for this
reason it can only be applied in the time domain.
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6.1.9 Volume Builder Output
Volume-builder creator window can be launched from Processing > Create Seismic
Output > Volume Builder. It is used to create the output volume that has been
defined in a volume builder setup. Optionally, if the initial volume builder setup is not
defined, press the Edit button to define the setup. Press 'Ok' to launch a batch pro-
cessing window.
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6.2 Create Horizon Output
This menu is used to create 2D/3D-grid based output. The data is stored as horizon
data (or attribute) to the selected horizon.
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6.2.1 Attribute
Some attributes consume significant calculation time e.g. curvature, spectral decom-
position etc. It also depends on the size of the input seismic volume. Therefore, to
create on-the-fly a horizon data in a scene may take significant time. Following Pro-
cessing > Create Horizon output > Attribute (2D or 3D), the attribute calculation is
there processed in the background (batch processing) and thus other tasks can be
done at the same time. By using a Horizon output, horizon attributes can be created
at desired horizons independently.

Select the quantity to output (2D/3D) from the list of stored data or attributes. The
attribute is (by default) saved with its own name, but it can be edited. Select the hori-
zon on which the selected attribute will be calculated.

The parameter file, which is automatically created in the Store Processing Spe-
cification field, can have any name (a default name is provided) so that the cal-
culation process can be easily re-started if needed. The batch processing can be
achieved using a single or multiple machines. More information on this window is
provided in single machine batch processing section. After the batch processing is
finished, the result will be available as a horizon data: right-click on a blank horizon's
attribute in the tree to select the horizon data (Select Attribute > Horizon Data).
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If the option for 'Fill undefined parts' is toggled on, then the 'Settings' button can be
used to enter the interpolation settings:

For the 'Execution Options', please refer to the following topic: Batch Execution
Parameters
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6.2.2 Stratal Amplitude
Stratal Amplitude is a processing tool available to compute statistics (min, max, rms,
etc.) from an attribute along a horizon or between two horizons. The window can be
launched from Processing > Create Horizon output > Stratal Amplitude. The output
will be stored as horizon data (grid) saved on the top or base horizon.

This feature operates based on a single-trace calculation only (ie: no step-out). For
multi-trace calculations (using step-out), you are advised to use the Volume Stat-
istics attribute.



- 762 -

In this window, select the input attribute from which the values will be extracted. The
extraction may be guided by a single horizon (Single Horizon) or between two hori-
zons (Double Horizon).

l Single Horizon is used to extract amplitude along a horizon within fixed window rel-
ative to the point.

l Double Horizon is an option of amplitude extraction between two horizons. In this
case, the Z-offset parameters (see below) may be defined to increase or decrease the
area defined by the horizons.

l Z-offset is the offset window specification above (negative values) or below (positive
values) a horizon to restrict or extend the calculation interval. For example:

Settings to extract the average amplitude between 16 and 24 ms above ('-' values)
the selected horizon.
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Settings to extract the average amplitude between 8 and 32 ms below (for positive
values there is no need to prefix with a '+' sign) the selected horizon.

Settings to extract the average amplitude 8ms equally around the selected horizon.
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l Area subselection is used to specify the area within which the attribute is output.
l Amplitude options are the available statistics for amplitude extraction. Five amplitude
statistics are available: Min, Max, Average or RMS and Sum.

l Output fold as an extra attribute optionally outputs data fold, i.e the number of point
used for the processing, as separate horizon data.
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6.2.3 Isochron
In OpendTect isopach maps can be quickly calculated. The Create isopach window
is launched either from the Processing > Create Horizon Output > Isopach or from
the right click menu of any horizon loaded in the tree:Workflows > Create Isopach.
In this window, select two horizons between which the isopach has to be computed.
The isopach map will be saved as a horizon data of the first selected horizon in the
window or the horizon .
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6.3 (Re-)Start Batch Job

Batch jobs in OpendTect are stored under a job name in a file containing the inputs,
parameters, log file and other relevant information. This information can be read by
clicking on the 'Information' icon, :
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Jobs may also be removed using the icon.

Batch Execution: The batch job may be executed as a Single Process or as a
Multi-Job/Machine Process. When opting for 'Single Process', the user may use his
local machine or choose to send the whole job to a remote machine for processing:
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'Execute remote' toggled on to send the job to a remote machine. The job priority
can be changed (-19-lowest to +19 highest).

Multi-Job/Machine option. Selecting this options brings up the Multi-Machine Pro-
cessing window.
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If a job is selected that was created in OpendTect prior to the 5.0 upgrade, a warn-
ing will pop-up, stating "Pre 5.0 Job". These jobs can not be (re-) processed.
Attempting to do so will bring up the Error message: "Can not run selected job".
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6.4 GMT
GMT (Generic Mapping Tools) is an open source collection of more than 60 tools for
manipulating Geographic and Cartesian data sets. It can produce Encapsulated
Postscript File illustrations ranging from simple x-y plots, via contour maps, to arti-
ficially illuminated surfaces and 3D perspectives views. OpendTect supports an
open source plugin that uses GMT tools to create scaled maps.

For more details please visit the official GMT website.
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6.4.1 Initial Setup
To launch GMT tools, click on the icon in the OpendTect main toolbar. The first
time you launch the GMT mapping tools, a warning message will pop up, if GMT is
not already installed on your computer. This can be downloaded from the GMT web-
site.

After successful installation of the package, the GMT user interface will be
launched:

GMT User Interface
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6.4.2 Create Postscript Maps
Several tabs have been arranged to specify the respective settings. The later part of
this section shows a typical OpendTect example of a postscript map.

l Basemap: This tab is used to set the scale of the map and other map settings.
l Contours: It is used to create a horizon contour map.
l Faults: It is used to post the intersection of faults with constant times or the intersection
with a surface.

l Wells: It is used to post wells in the map.
l Locations: It is used to post pointset data in the map overlay.
l Polyline: It is used to add polygons (e.g. lease boundaries) in the map overlay.
l Random Lines: It is used to post Random Line(s) in the map.
l 2D Lines: It is used to post 2D-Line(s) in the map.
l Coastline: It is generally used to draw coastal lines.
l Clipping: It is used to set up polygonal clip paths.
l Advanced: It is used to use customized GMT commands.

For all the sections it is possible to Reset the parameters and thus go back to the
default ones. For all the section (except Basemap), Add will add the defined object
to the map overlays and Replace will update it if the object has been previously
defined.

In the Map overlays are listed all the elements that have been defined to be dis-
played on the final Basemap. You can modify the order in using the icons or
remove an object using the icon. The map will be created only when clicking on
Create Map.
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Basemap settings

The basemap tab is filled with default parameters including the X/Y range from the
Survey setupSurvey setup. You can go back at any point to the default X/Y range in
clicking on Reset to Survey.

The map can be renamed. The scale can be modified. Scale, map width and height
are linked : any change of the scale, map width or height will affect the other two
parameters.

The label interval can be also be modified. The grid lines can be shown if you toggle
on Draw Gridlines.Optionally you can also add Remarks.

Once the different parameters defined, give an appropriate name to the output file
and specify the disk location and press Create Map button. View Map will display
the map.
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Create a Contour Map

In Contour Map tab, first of all, select the horizon on which you want to create con-
tours. The different parameters are then filled by default. It is possible to edit the
value range and/or the number of contours. This will change the step. If you modify
the step, it will automatically change the number of contours.

It is possible to change the display parameters. The contours can appear as simple
contour lines or the space between the contours can be filled using a selected col-
ourbar.

Once the parameters all defined, press Add button: the selected 2D data set(s) will
appear on leftMap overlays panel.

'Attribute' allows the user to select either Z-values (default option) or any of the Hori-
zon Data saved to this horizon.
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Insert faults

Insert Wells location

In Wells tab, specify:

1. Select OpendTectWells
2. Optionally, edit the settings (symbols, size, color etc)
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3. Press Add button... the selected Wells will appear on leftMap overlays panel.

Insert locations

Create a Polyline

In Polyline tab, specify:
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1. Select Polygon
2. Give a Name to the Polyline
3. Optionally, edit the settings (symbols, size, color etc)
4. Press Add button... the selected Polygon will appear on leftMap overlays panel.

Insert random lines

Insert 2D lines
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In 2D Lines tab, specify:

1. Select 2D line(s)
2. Name the line(s) (group).
3. Edit the settings (symbols, size, color etc)
4. Press Add button... the selected 2D line(s) group name will appear on leftMap over-

lays panel.

Insert coastline
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Clipping

The final map will be restricted to the inside or outside of a given polygon.

Insert advanced commands
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Typical output:
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6.5 Madagascar
A generic user interface exists to Madagascar, an open source seismic processing
package that is very popular in seismic R&D communities. In the builder, seismic
pre- and poststack input and output files are either OpendTect or Madagascar
formatted. The processing flow is constructed as a sequence of Madagascar pro-
grams, using their parameters. These programs are selected from a list of available
programs (presently over 300), with a search field included to guide the user.

Madagascar processing results can be further analysed in OpendTect.

1. First Madagascar must be installed in order to use this interface between OpendTect
and Madagascar.

2. It's not possible to view Madagascar plots directly from the OpendTect user interface
onWindows. If the user wants to see the plot, she/he has to make her/his own arrange-
ments like starting the xserver etc ...

Problems may occur occasionally when using Madagascar on aWindows system.
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6.5.1 Madagascar Installation
Madagascar is an open-source, standalone software. To be used with OpendTect,
Madagascar must first be installed, otherwise, when starting Madagscar , the next
window will display an error message and missing program boxes.

TheMadagascar package needs to be installed (see install) and the RSFROOT vari-
able has to be set to the installation directory. In order to get the full UI, ensure that
the text doc is installed. This can be done with:

$RSFROOT/bin/sfdoc -t $RSFROOT/doc/txt

OnWindows, Please ensure the following to be able to use the Madagascar link in
OpendTect:

1. In Advanced System Settings -> Environment Variables, the variable RSFROOTmust
be set to the Madagascar installation folder. Setting this variable only in the Cygwin
environment is not enough.

2. The variable PATHmust include the Cygwin bin folder (e.g. C:\cygwin\bin).
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6.5.2 Madagascar Processing Window
The Madagascar processing window can be launched from the OpendTect toolbar
by pressing theMadagascar icon.

Select the input cube to be processed, and then choose a program or combination
of programs. Programs are organized into groups of programs. Once one program
is selected, a description of program's functions are shown in the neighboring
frame.
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The different steps, as well as a synopsis, of the computation are provided. The
descriptions of each program are available on the Madagascar website.
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6.5.3 Toolbar
The toolbar is composed of the file option and three shortcut items.

The file option is as follows:

The toolbar contains three shortcuts to create, open, and
save the flow:

This creates a new processing flow.

This will open a saved flow.

This will save a newly created flow.



- 786 -

6.5.4 Processing Input
The first step is to select an input cube.

The input can be a 3D volume, a Prestack volume, a Madagascar volume, or None.
It is possible to choose a volume sub-selection.
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6.5.5 Madagascar Processing Output
The final step is to chose an output volume type.

Similar to the input selection, it can be a 3D volume, a Prestack volume, a Mad-
agascar volume, or None.
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6.6 Batch Processing
Though Batch Processing does not actually appear in the pop-out menu under Pro-
cessing, this is a convenient place in this User Documentation to present the inform-
ation on these processes.



- 789 -

6.6.1 Single Machine Batch Processing Win-
dow
In single mode processing, the data can be processed either on a local machine or
on a remote host. All relevant information on the progress of the calculation will be
stored, (see Job information file).

'Execute remote' toggled on to send the job to a remote machine. The job priority
can be changed (-19-lowest to +19 highest).
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6.6.2 Distributed Computing Window
The distributed computing window controls on which machines a volume output or
SteeringCube batch job will be processed. Jobs are distributed over the Used hosts
on a line-by-line basis (the number of inlines per job can be specified). Hosts can be
Added and/or Stopped at all times. Processed results are stored in a Temporary
storage directory.

At the end of the processing sequence, OpendTect will merge all processed lines
and store the data in the output file that was specified in the Volume output or
Create SteeringCube window, and it will delete the temporary disk files. If for any
reason OpendTect fails to perform this data transfer, this can also be done manually
in the File - Managemodule. The temporary data store appears with a name starting
with Proc_. Select this item and copy it to a new cube.

It is possible that at the end of a distributed computing batch job not all data was pro-
cessed successfully. Some jobs may have failed (e.g. because one of the hosts was
temporarily not available). OpendTect will come back with a warning message stat-
ing which jobs (i.e. which inlines) have not been processed yet. It is then advised to
re-submit these jobs until all data are processed. The Auto-fill option automatically
scans and fills gaps in the processed volume.

The Nice level sets the priority the process gets. With the nice level set on 19 for
exemple the process has very low priority and other processes that run on the same
computer get priority. If the nice level is set to 1 the process gets the highest priority.

The Processes menu allows to set the Run, Pause, or Go - Only between options.
The Go - Only between option, pauses and runs the processes at user-defined
times.

OpendTect calls the system utilities of the 'hostent' (sethostent, gethostent, etc.)
type to get a table of hosts that can be selected. How the Operating System builds
the lists is dependent on the particular system setup; most likely /etc/hosts and/or
the NIS tables are consulted. OpendTect supports multi- threading which means
that all processors of multi-processor machines will be used.
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Though we support multi-threading, not all calculations can be run this way due to
some of the algorithms involved (ie: recursive calculations). See the following table:

Multi-threaded Not multi-threaded
BG Steering* Constant Steering
Central Steering Convolve (Wavelet option)
Convolve (all except Wavelet option) DeltaResample
Curvature Energy (Gradient option)
Dip Angle Event Steering
Velocity Fan Filter (=DipFilter) Fault Dip
Energy (all except Gradient option) FingerPrint
Event GapDecon
FreqFilter* HorizonCube Curvature
Frequency* HorizonCube Dip
Full Steering HorizonCube Spacing
HorizonCube Data Horizon
HorizonCube Density Match Delta
HorizonCube Layer Maths (recursive expression)
Hilbert Perpendicular Dip Extractor
Instantaneous** SampleValue
Local Fluid Contact Finder Scaling (scaling type AGC and

stats type = detrend)
Maths (except when expression is
recursive)

Shift

Polar Dip
Position
PreStack
Reference
Scaling (all except scaling type AGC
and stats type = detrend)
Semblance
Similarity
Spectral Decomposition*
SpectrogramDip (create Steer-
ingCube, FFT steering)
Texture
Tutorial
Volume Statistics
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Distributed Computing on Windows OS

The new system works with a Daemon Service running in background on every
remote machine to be used for processing. The communication works with TCP/IP
and requires some configurations to actually make things working.

Mapping of Survey folder:We assume a DataRoot folder ($DTECT_DATA) to be
in a centralized server. This folder has to be mapped on the same drive in every PC
to be used as hosts. For example, we have 4 PCs (A,B,C,D). A is a server and the
ODData is in drive D. Then map D:ODData on e.g. S: on B, C and D. PCs B, C, and
D can then be used as your processing nodes.

OpendTect installation: You need to have OpendTect installed on all hosts, and
make sure they all use the same survey at the same time (have access to). For
example if B is using F3_Demo and want to process something in F3_Demo. then it
has to be made sure that the rest of the two PCs also use the same folder as long as
the processing is needed.

BatchHosts file: Add the IP addresses of C and D in the BatchHosts file inside the
application data folder.

Start the daemon:The remote daemon must be running on all nodes that receive a
job submitted either from or to a Window client machine. Hence only Unix to Unix
connections may skip running the daemon on the processing nodes. Use od_
RemoteServiceMgr.exe to launch the daemon (od_remoteservice.exe) which will
also add a notification icon to the system tray. Once the service starts, the remote
machines are ready to be utilized.

Start processing: Select the PC's B, C and D from the list of machines and 'Add'
these to the 'Used Hosts' list in the distributed computing launch window and start
processing by clicking 'Run':
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Distributed Computing progress window: Select machines to use for processing
from the list

For more information, please refer to the OpendTect YouTube Channel for the
webinar on: Distributed Computing Set-Up
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6.6.3 Batch Log File
A batch log file is produced for every volume output run. The information is
streamed to a file if the batch job is executed on a remote computer. If the pro-
cessing is done locally the log file is either streamed to a new, dedicated window, or
to the standard output window. Every N traces the program will output a symbol to
reflect the progress. There are five symbols the program can use. Which symbol it
uses depends on the speed in number of traces times N per sec (given towards the
end of a line in brackets after the percentage of traces processed) and the estim-
ated remaining time until completion. The symbols indicate the following:

l a period (.) means 1 trace processed
l a colon (:) means 10 traces processed
l an equal sign (=) means 100 traces processed
l a pipe marker (|) means 1000 traces processed
l an asterisk (*) means 10000 traces processed
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The following options are available:

Stops the process.

Saves the log file.

Brings you to the help menu.
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6.6.4 Cluster Processing
Batch jobs can be run from OpendTect to cluster management tools. So far dGB
has successfully tested SLURMwhich is easy to install and even easier to use.

Cluster processing is enabled by following this prerequisites:

l The environment variable DTECT_CLUSTER_PROC is set to yes before starting
OpendTect

l The cluster management tool must be up and running. In the case of SLURM it means
that the daemon 'slurmctld' should be running on the master computer and that the dae-
mon 'mlurmd' must be running on every node.

l This cluster management tool (SLURM) bin directory is included in your PATH variable

Cluster processing is started by choosing "Cluster" in the 'Submit' options menu of
the volume processing window. Only 3D attributes can make use of cluster com-
puting so far.

A new window will pop up that will list a number of directories use for the storage of
temporary files. The jobs will be split using a user-defined number of inlines. The
field named 'Cluster Processing command' represents the name of the binary from
the cluster management tool used to run a process.

You can run the "Main script file" (default: ~/yoursurvey/Proc/clusterprocscript) from
a command line which will run each job one-by-one using the above command and
will also launch the UI to show progress and do post-processing merging of tem-
porary data.
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7 Scenes

The OpendTect main window can have multiple scenes, most of them opened using
this menu. The scenes behave like sub-windows within the main window: Each
scene has its own tree and can be minimized, maximized, reduced or enlarged in
size, without ever going out of the main window. The trees of different scenes can
be move on top of each other and sorted as tabs, or completely separated from the
main window (they are utility windows).

The Cascade option will restore a default size for each scene and sort them starting
on the upper left corner of the main window.

The Tile option is a shortcut to maximize each scene by sharing the space of the
main window equally:

l Auto: The scenes are sorted automatically along the best fitting grid.
l Horizontal: The scenes are arranged along a single line.
l Vertical: The scenes are arranged along a single column.
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If all scenes are maximized the active scene will be annotated on the left in the
Scenesmenu. Clicking on another scene will make that one active.
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7.1 Time- and Depth-Converted Scenes
OpendTect can display time data in the depth domain and depth data in the time
domain.

This is done using a user-selected velocity volume and computing the new Z range
(depth or time) based on the original Z range (time or depth respectively). In all trans-
formed scenes each and every display elements is re-positioned on-the-fly.
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Pressing 'Create' will pop up a dialog that allows you to specify the velocity type for
a given volume:

(See Tagged Seismic Data for more detail.)

The only exception is 3D volume for which the on-the-fly transformation can be
slow. Therefore time volumes can be depth converted (i.e. they become stored
volumes) using an additional option in the right-click option of inlines and crossline,
in the transformed scene:
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Please note that depth-stored volumes can also be imported via SEG-Y by settings
the appropriate tag in the SEG-Y import wizard.
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7.2 Flattened Horizon Scenes
This option will generate a new scene flattened about the selected horizon. The Z
range has the same unit as the original scene, but it is now relative to that horizon
and no longer absolute.



- 803 -

7.3 Wheeler Scenes
TheWheeler Scene is a transformation (flattening) of HorizonCube into relative geo-
logical time (RGT). Therefore, before adding a Wheeler Scene, the HorizonCube
will need to be selected. You will be prompted for this if not already selected.

This option is only available if the SSIS plugin is installed.
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8 View

8.1 Work Area
The Work area dialog is opened from the 'view' menu. The Work area sets the area
bounded by the survey box. Displayed items will be cropped automatically to fit the
set inline, cross-line and z-ranges.

Set ranges to full survey – to fully maximize the inline, crossline and Z

Open subselection – brings a list of all available subselections
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Save subselection
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8.2 Z-Scale
The Z-scale option allows scaling of the survey box vertically.

There are three options for Z-scaling: The slice bar, setting scaling according to cur-
rent scene "Fit to scene" and resetting the scaling "To Home".

You can set any position/orientation of the scene by clicking on as default Home.
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8.3 Stereo Viewing

The Stereo viewing menu allows setting the stereo viewing on/off. Note that in order
to use Red/Cyan stereo, appropriate glasses are needed. The offset between the
red and cyan view can be manipulated with the Stereo Offset menu. The Quad buf-
fer option has special hardware requirements in order to get passive stereo view on
a screen with dual and polarized projection.
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8.4 Toolbars

All elements available in the main OpendTect window can be switched on/off here.
See Toolbars for the various actions of the buttons on the toolbars.
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9 Utilities

9.1 Settings
The settings for Fonts, Mouse, Keyboard, etc., can be changed from Utilities > Set-
tings >
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9.1.1 Look and feel

This option brings up an interface containing several tabs for defining various set-
tings in OpendTect:

These are explained in detail below:

General
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Default Icon Size is 32. For systems with smaller screens (esp. laptops) it may be
useful to reduce this value to 28 or even 24. In combination with reduction of Font
size, this can prevent windows be 'oversized' for the screen.
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Visualization

In the visualization tab , you may choose for OpenGL shading, also for volume ren-
dering, or switch off this option.You may also define the texture resolution factor to
one of these three settings:

Users facing data visualization issues may significantly improve their results by turn-
ing off the shading and setting the resolution to Standard.
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Fonts

Clicking on any of the listed buttons brings up a standard font definition window:
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Processing
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Please see the following sections for full details of Batch Processing and Cluster
Processing.



- 816 -

Horizons

Using this option, one may set both the default resolution and default colortable for
horizons. This is an especially helpful option for orientation in the early stages of a
project when many horizons are loaded.

As with many of the other settings, a restart is required to apply these defaults.

The mouse buttons can be set differently. System administrators can implement
user-defined mouse button actions.
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9.1.2 Keyboard Shortcuts
The user can define his/her own keyboard shortcuts to move a slice for-
ward/backward. The user can use one key (set the first key to no-button) or a com-
bination of control or shift key, plus another key which can be selected from a long
list.



- 819 -

9.1.3 Language

The language settings contain two options: English or Chinese.



- 820 -

9.1.4 Petrel Connection
Petrel* connection settings can be set/modified by clicking on PetrelDirect status

button (located in the lower right corner of the main OpendTect window).

Link status: the icon shows the status of connection to Petrel* and can be clicked
on to change it:

- disabled (click on it to Enable connection)

- uninitialized (connection is enabled, i.e. will be activated once PetrelDirect is
used; click on it to Initialize now or use drop-down menu next to it to Disable con-
nection)

- active (click on it to Disable connection)

TCP port to use: TCP port number must be the same as the port number specified
on the Petrel* side. The default value of 57375 should work in most cases.

The default value of TCP port can be changed using DTECT_PETREL_PORT
environment variable. In doubt consult your system administrator.

*is a mark of Schlumberger.
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9.2 Tools
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9.2.1 Batch Programs
To run the batch program go to: Utilities > Tools > Batch programs

Choose the batch program you need to run, the available are: cbvs_browse, cbvs_
dump, lmhostid, glxinfo, ivfileviewer. The text box will show comments and details.

If another OpendTect batch program is chosen, fill in the required and (if needed)
the optional parameters (indicated by the square brackets "[ ]").

The batch program will start in a new xterm window. For example, if a batch pro-
gram is cbvs_browse like shown below, the cube to browse should be selected to
run a batch program.
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9.2.2 Position Conversion
Position Conversion is a utility that can be used to convert the position pairs or
coordinate system. The user specifies an X/Y coordinate, or In-line/Cross-line, or
Latitude/Longitude pairs, then presses Convert to obtain different position pairs or
to convert to a different X/Y coordinate system.

This utility can be launched either from Utility >Tools > Position Conversion, or from
Survey selection menu (Survey > Select/Setup > icon).

In the position conversion window, there are two modes available: Single Position or
File.

In the Single Position mode, the following conversions are supported:

l X/Y coordinates to In-line/Cross-line and vice versa

l X/Y coordinate to Latitude/Longitude and vice versa
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l X/Y coordinate CRS1 to X/Y coordinate CRS2

For Latitude and Longitude, output can either be in Decimal or Decimal-Minute-
Second (DMS).

In File mode, the user browses the input file, defines the file’s format and creates a
new output file. By specifying the output types (X/Y coordinate, In-line/Cross-line,
Latitude/Longitude), the coordinate system to convert to, the output file, and press-
ing the Convert button. The desired conversion is written to an output file.

Input fields are not allowed to use ‘!’ symbol in their name.

The user should be able to select which columns are e.g.: X/Y. The output should be
identical to the input file (header and all data columns) and just add columns for new
values.
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The Format Definition can specify which row holds values for conversion. The rest
of the values in the file will be kept the same in the output file.
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9.2.3 Command Driver
The Command Driver offers automated control of the current OpendTect application
from a command script. The command script is a replacement for a series of key-
board and mouse interactions performed by the user. It can be used to automate
parts of the workflow, and helps to speed up executing repetitive tasks or giving
automated demonstrations in OpendTect.

The Command Driver was created as a tool to make automated testing of the
OpendTect releases possible. That means it is not optimized for usage as a script-
ing tool. It is clear, however, that power users have been starting to use the Com-
mand Driver tool for this purpose.

The list of available commands, their syntax, and semantics can be found in the
Command Driver Manual.
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9.2.4 Presentation Maker Plugin

Introduction

Python-pptx is a Python library for creating and updating PowerPoint (.pptx files).
The OpendTect 'Presentation Maker' plugin uses this library to create a PowerPoint
presentation from scene, window or desktop screenshots.

Miniconda3

OpendTect 7.0 comes with a basic Python environment (Miniconda3). This basic
Python environment includes python-pptx. This package needs to be installed to
use the Presentation Maker out of the box. The additional Python environments
Math Kernel Library (MKL) and/or Cuda113 can also be installed. These packages
also include python-pptx. Therefore it is no longer needed to install Python sep-
arately. Of course this is still possible and might be what you want.

How to make the presentation
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A presentation can be made in 2 different styles, as a blank presentation or by using
a custom template (master) PowerPoint presentation. When you use a blank option,
the template which is part of the python-pptx installation will be used and all slides
will have a whit background. When you choose the custom option, you need to
select an existing PowerPoint presentation. The plugin expects a PowerPoint file (a
pptx file, not apotx!) with 2 slides. The first slide should be the title slide, i.e. a slide
with the 'Title Slide' layout. The second slide should be a regular slide with 'Title and
Content' layout. New slides will use the layout of the 2nd slide. Click on the settings
icon to specify the slide format and the image margins.

Three different images can be added as slides: Scene, Window or Desktop.

l Scene: the scene will be captured in an image. if you have multiple scenes, choose the
scene you'd like to add. The name of the selected tree item will be the name of the
slide.

l Window: image of the selected window will be added. Note that windows on top of the
selected window will also be captured in the image.

l Desktop: an image of the full desktop will be added.

The Settings can be adjusted by using the window that pops up on clicking the Set-

tings icon :
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9.3 User Commands

Without a Python environment installed and setup, there is no option available here
and you will see this:

PowerShell is a more advanced version of Command Prompt. It is not only an inter-
face but also a scripting language that is used to carry out administrative tasks more
easily.

For details of how to setup the Python environment, please refer to Python Settings,
Data Flow and Data Management

Once you have installed and set up an appropriate Python environment, you will see
the respective item in the User Commands menu:
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The selected editor can also be started/accessed from the icon which gets added to
the main OpendTect toolbar:

Each of the particular editors have their own documentation and tutorials available
via their respective interfaces. In this case, Spyder, the following window will be
launched:
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9.4 Installation
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9.4.1 Update (Installation Manager)

Some improvements in the installation manager:

l Removing individual packages is now supported
l Windows program feature to update or uninstall OpendTect
l Improvements to proxy handling

The Installation Manager is available for download via the appropriate platform link
on the download page of the dGB Earth Sciences website.
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The installation manager is a wizard to install/upgrade the existing OpendTect (Cur-
rent / Previous) releases. The release type field is used to select the release that is
needed to be installed/upgraded. The installer gives you the choices as seen below:
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The information following in this section deals with online installation or upgrade.
For creating offline installation packages, please see Offline InstallationOffline
Installation

The figure above suggests to select the package type: OpendTect Pro. To read
more about OpendTect packages type, please refer to our web-page of licensing
types.

The OpendTect Installation Manager identifies the platform on which it is running.
This information is then anonymized prior to it being sent to OpendTect. We use this
anonymous data solely for the purpose of getting a picture of OpendTect usage and
thus improving our support capabilities.

To facilitate using Python with OpendTect, it is possible to install a pre-formatted
Python ecosystem based on Miniconda3, with virtual environments setup to run the
machine learning plugins workflow.
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A GPU enabled environment will also be provided to take full advantage of the GPU
processing capabilities of the Python package Tensorflow.

Two virtual environments will be provided with the Machine Learning plugin:

l A CPU-only (fallback) environment

l A GPU enabled environment (requires an NVIDIA GPU)

Both will be available on Windows and Linux. On macOS only the CPU-only envir-
onment will be available (Recent macOS systems no longer come with a
NVIDIA GPU and thus are not supported by Tensorflow).
We can provide packages to test Machine Learning on macOS.

https://www.tensorflow.org/
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9.4.2 Auto-Update Policy

The auto-update policy can be defined and changed by a user. By default the option
is set to [Inform] when the updates are available. On Windows, this can be changed
to [None] Never check for updates should you prefer.
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On Linux, there are two additional options - [Manager] and [Auto]:
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9.4.3 Python Settings, Data Flow and Data
Management
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Users can change the Python environment here. OpendTect Machine Learning
comes with its own Miniconda Python environment. If it has been installed then
make sure that the Python environment is set to Internal. Users who prefer to work
in a private Python environment will have to change the Python environment to Cus-
tom. When Custom environment is selected you need to specify the root of the
environment. The remaining option System can be used if you want to use a sys-
tem Python installation that is not a miniconda or anaconda installation. If you want
more information about installing the Python environments please take a look in the
Administrator's Manual.

The Virtual environment: odmlpython-cuda113 runs models on the GPU; odm-
lpython-cpu-mkl runs on the CPU. Computations on a GPU are many factors faster
than computations on a CPU. If the GPU in your environment is too small for certain
jobs to run you can switch virtual environments to CPU usage.

The Custom Module Path is the path for Python developers in which they develop
private Machine Learning Models in this environment. All models in the given dir-
ectory, which are named: ‘mlmodel….” will appear in the UI of the Machine Learn-
ing Control Center and can thus be applied to other data sets.

https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm#installation/python_environments.htm
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When the Python ecosystem has been installed, the link between OpendTect and
Python can be set up and customized through a dedicated settings dialog in the
OpendTect utilities menu (above image).

The default Python environment will point to the Python packages installed using
the installation manager, if they have been installed.

Three options are available:

1. Internal(default option) if the environments provided by the installer
are installed.

2. System installation of Python

3. Custom if a user has their own Python environment installed:

l For advanced users who have their own Python envir-
onment or which are using a distribution of Python such
as anaconda, the Python settings can be altered to have
OpendTect to use it directly instead of the Python dis-
tribution provided with OpendTect.

l The user must ensure that the selected “Custom” envir-
onment contains all the Python modules required by the
OpendTect Machine Learning plugin. These are specified
in the plugin’s documentation.

l The user can add the path of its Python source code, to
locally installed Python modules in the “Custom Module
Path”. Such that it becomes accessible to extend the

https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm#machine_learning.htm?TocPath=3%2520Machine%2520Learning%257C_____0
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capabilities of the Machine Learning plugin by adding new
custom models to train on. This path will be added to the
PYTHONPATH of Python environments launched by
OpendTect. The default location is under ($HOME, or
$HOME/.od).

l The Edit button allow easy editing of the file without leav-
ing OpendTect.

This testing tool option, checks if OpendTect can run Python
commands and retrieve their output. It shows a list of the installed modules for the
selected setup.

The user can also launch a terminal/ console prompt with the selected environment
activated. Such window can be launched anywhere in OpendTect using the short-
key CTRL-T.

The Python IDE Command is the Python editor you wish to use. You can launch
the IDE using the specified Command, Optionally with some Arguments from a
Python Command Window. Alternatively, you can add an icon to your plugin
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toolbar by pressing the corresponding icon in this window. In this case the Spyder
icon with Spyder Tool Tip is added to the icon toolbar, as seen in the image below:

Pressing this icon from the toolbar will launch Spyder with the correct settings. The
Python environment can be tested with the Test icon.

The Python modules in the Python environment can be scanned for vulnerabilities
and checked for licenses with the Safety Check button. You can either use PyUp's
Commercial orOpen-source database. The free open-source database is 30 days
old and limited. The Commercial database provides real- time enhanced vul-
nerability data and fix recommendations. In order to use the Commercial database
or the scan for licenses feature you need a valid API key, which can be filled in the
API key field. For more information about the API key please send an email to

info@dgbes.com. With the icon the safety report can be saved.

mailto:info@dgbes.com?subject=Request information about Safety API key
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The general flow of a Machine Learning workflow is as follows:

1. Based on the data you have and the problem you want to solve: Select a workflow
from the control center

2. Create a Training Set. Construction starts with a selection of the Target (output) fea-
ture. Next you select the input features and the dimensions of the input features. Train-
ing Sets can be constructed from real data over multiple surveys or from synthetic data
(SynthRock). Training Sets selection files can be saved, restored and edited. Training
Sets themselves are stored in hdf5 format. These files can be managed from theMan-
age Machine Learning icon.

3. Select a Model. Depending on the workflow the plugin supports Machine Learning
Models from Scikit Learn and/or from Keras (TensorFlow). Set the Training Para-
meters and train the model. A Test Set to monitor Overfitting is automatically split off
from the Training Set by the software. Models are also stored in hdf5 format and can
be managed from theManage Machine Learning icon.

https://en.wikipedia.org/wiki/Hierarchical_Data_Format
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4. Monitor training. This is done in a log file that outputs information about the loss and
accuracy of the model for both Training and Test Sets. Kerasmodels are also mon-
itored graphically in TensorBoard, which is started in your default browser when train-
ing starts. Models can be trained from scratch (New), continued from a stored model
(Restore) and continued from a trained model with new data (Transfer). In Transfer
training the convolutional parts of a deep learning model are not updated to safe time.
Only the weights of the last layer are updated with the new training examples.

5. Apply the trained model. Select the input data set(s) on which the trained models will
be applied.

Training Sets can bemanaged in the “Machine Learning Deep Example Sets” win-
dow that is launched from all windows with a “Manage Example Sets” icon next
to a Select button. The “Machine Learning Deep Example Sets” window pops up.

In this window you can use the corresponding icons in the ribbon on the right to
rename, lock, remove and set defaults. The info box in the middle gives detailed
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information on the file. Personal textual information can be added in the bottom
field. Press the save button to save this information with the file.

Example data sets can be viewed with an hdf5 viewer that is launched from all win-
dows with the “View Example Sets” icon next to the “Manage Example Sets”
icon. The “View Example Sets“ viewer pops up.
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The hdf5 viewer is a 2D viewer that allows you to inspect 2D and 3D input - and tar-
get images. Use the sliders to select the input attribute (typically 1, but more are
possible) and the input image to view. In the case of 3D images (3D cubelets) you
can slide through the selected cubelet in the inline, crossline and Z directions with 3
additional sliders.

The display can be changed by changing the color palette and the zoom factor.

Note, the hdf5 viewer is developed in Bokeh, a Python library for interactive dis-
plays. The icons above the image are standard Bokeh plot icons to control zoom,
pan, reset etc.

The Bokeh server icons in the ribbon on the right-hand side of the viewer can be
used to start, stop and restart the Bokeh server in case something goes wrong. The
Bokeh server is a separate process that is started by OpendTect. Information about
this process is given in the log file that can be inspected by pressing the cor-
responding icon.
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9.4.4 Connection Settings

To enter the proxy information, the correct proxy server information must be added
in the Connection Settings before running the installation. This is done in the fol-
lowing dialog. This dialog is also available directly through the Installation Manager
on clicking the Proxy Settings button.
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9.4.5 Plugins

The plugins window lists all the available plugins and the plugins that are currently
not into OpendTect. It also provides relevant information about the plugin and the
license.
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Developers might want to use the option "Load a plugin" to manually load their plu-
gin. The developers documentation describes how to add a plugin to the automatic
loading procedure.

In OpendTect, there are several commercial plugins available. Each plugin adds
extra functionality to OpendTect. To load a new plugin, browse to the appropriate
file. More information on plugin design is available in the Programmer manual.

In general most plugins are loaded automatically at startup, based on the chosen
options:

If you choose to toggle off the option "Show this dialog at startup" all plugins will be
loaded at startup. It is recommend to install only the plugins for which you do have a
license and to load them all automatically at startup.
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9.4.6 Setup Distributed Computing

In order to utilize OpendTect's capability for Distributed Computing, a BatchHosts
file must be created and used. This file contains the list of remote machines (host
machines or nodes) and some relevant details about these machines and the path
to the Survey Data Root. OpendTect will use this file to communicate to the remote
hosts and launch processes remotely on them. Follow the example format (shown
below) to add the list of remote machines and their details in the respective fields.

In order to minimize complications, the Setup Distributed Computing tool (formerly
known as Setup Batch Processing tool) can be used to create a tailor-made
BatchHosts file (via Utilities > Installation > Setup Distributed Computing...).

As default OpendTect will try to create a new or edit the existing BatchHosts file in
it's 7.0.0/data directory. If this directory is not writable OpendTect will advise you of
this:
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It is also possible to use a custom BatchHosts filepath by setting environment vari-
able DTECT_BATCH_HOSTS_FILEPATH:

BatchHosts file: This field is not editable in the User Interface.

Status:Will be given on testing - unknown, available or unavailable.

Host Lookup Mode: Select how the machine is found on the network - Hostname
DNS or Static IP.

IP address: IP address of the node machine(s). If the background of this field is in
red then there is a problem with the resolving of the hostname into the IP address.
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Hostname: Hostname of the node machine(s). If the background of this field is in
red then there is a problem with the resolving of the hostname.

Display name: Free-text field. Text entered here appears in the Distributed Com-
puting Processing window.

Platform: Select platform type, the options are: Linux (64 bits), Windows (32 bits),
Windows (64 bits) and macOS.

Survey data root: Location of the survey (the path to the survey data root folder
from the host machine)

Advanced Settings:

l Here you may change the first port value (in the case that it is blocked
or in use). By default this first TCP port is 37500. We advise to open
up to 5 ports, e.g. 37500-37504.

l Linux users may decide to change the remote shell command from
the default ssh to rsh.

l When setting to ssh it is required that the user who is running
OpendTect is able to login to the other nodes without a password.
This can be done by setting up public key authentication between the
nodes. We will not go into detail of how to do this. In short this is done
by generating the SSH key on the machine you are using to start the
jobs, the public key then needs to be uploaded to the nodes and
added to the user's .ssh/authorized_keys file.

l The Nice level sets the priority on the host machines, 19 being nicest
and 1 being least nice).

l Finally, the Default Data Root can be set per platform.
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Description of icons:

Add new host.

Remove selected host.

Move host up or down.

Test hosts. Will perform tests to ensure that the server and nodes can com-
municate to the necessary extent to participate. (ie: can the nodes find the data root
folder and read/write into it). If any hosts fail to be reached, then information will be
given to aid you to correct the error.
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For more information on this topic, please refer to OpendTect's Youtube Channel
where you may find the webinar: Distributed Computing Processing Setup.

Note: The remote daemon must be running on all nodes that receive a job sub-
mitted either from or to a Window client machine. Hence only Unix to Unix con-
nections may skip running the daemon on the processing nodes. Use od_
RemoteServiceMgr.exe to launch the daemon (od_remoteservice.exe) which will
also add a notification icon to the system tray. Once the service starts, the remote
machines are ready to be utilized.



- 861 -

9.4.7 Graphics Information

This will pop up a window showing all the information that OpendTect can gather
about your GPU.

You may want to refer to the System Requirements information in the OpendTect
Administrator's Manual for comparison and advice.

https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm#system_requirements.htm%3FTocPath%3D1%2520System%2520Requirements|_____0
https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm
https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm
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Laptops with an Intel CPU usually come with two integrated graphic cards. The
default card at start-up would most likely be Intel HD graphics. OpendTect however
will have the best performance when using the Nvidia GPU. Therefore that one
should be used instead.

Please follow these instructions in the Administrator's Manual for setting up the
Nvidia card as the preferred GPU for OpendTect.

https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm#installation/opendtect/setup-the-preferred-gpu-with-windows-settings.htm?TocPath=2%2520Installation%257COpendTect%257C_____9
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9.4.8 System Information

This option scans your system, and lists relevant System Information (HostID,
Name, Operating System, User Name).

This information can be copied using the Copy to Clipboard button, convenient for
contact with support when requesting licenses etc.
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Additionally, on Windows, accessing the HostID of the machine can be done via the
LM Tools (available via the Start Menu or directly from
..\OpendTect\7.0.0\bin\win64\lm.dgb\lmtools.exe):
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The option 'Save HOSTID Info to a file' will simply save the information displayed
above into a .txt file.

Note: On some Windows 10 and 11 systems there is an option Random hardware
addresses in Windows Settings > Network & Internet > WiFi . Please make sure that
the Use random hardware addresses option is toggled off when using the Show
HostID utility and supplying us with the information needed for generating the
license. Also this option should be toggled off when using the OpendTect license
that you received back. When a random HostID is supplied to us we can not guar-
antee that the generated OpendTect license will keep working. Therefore we ask
you to supply us with a HostID that will not change.
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Figure: Random hardware addresses option in Windows Settings > Network & Internet > WiFi
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9.4.9 Firewall Management

This will launch a simple window wherein you may add, edit or remove firewall
exceptions for both OpendTect and the Python executables:
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9.4.10 Licenses
Under Utilities > Installation > Licenses you will see two sets of options, differing per
platform:

License options under Windows
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License options under Linux

For information about floating or server-based licenses, please refer to the flexnet
installation guide page

For more general information about OpendTect licensing options, please see the
support licenses page

A more complete explanation of OpendTect license Installation can be found in the
License Installation Webinar, available on OpendTect's Youtube Channel.
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9.4.10.1 Install or Edit licenses
Plugins to OpendTect can be run either by using a license server or by using demo
(evaluation) licenses. This second case is case called "node-locked license install-
ation".

This will bring up the following window which you can use to point OpendTect to the
license file:

Here you can:

l Specify the License Type:

File (Node-locked):
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Server:

l Select the location of the license file

l Examine the license file:
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l Install the license file. On pressing Install, you will see a prompt warning that a
restart will be necessary:

Pressing Continue will complete the installation of the license file and bring
up this window:
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Pressing Continue again will restart OpendTect.

l Clear the license file. On pressing Clear, you will see a prompt warning that a
restart will be necessary:

Pressing Continue will complete the clearing of the license file and bring up
this window:

Pressing Continue again will restart OpendTect.

In addition to the core functionality, you may click 'Request Evaluation License' to
bring you to the contact page of the dGB website where you can request an eval-
uation license and/or request a quote.

https://dgbes.com/contact
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And, for Windows users only, you may access the 'License Manager Tools' button
to pop up the Flexera LM Tools window:

Please note: The method of clearing licenses via OpendTect License Settings will
clear the registry entries from the User's profile but not from the System.

So it will clear licenses installed via OpendTect License Settings or licenses
installed using DGBLD_LICENSE_FILE as a User (environment) Variable but not if
DGBLD_LICENSE_FILE is set as a System Variable.

If DGBLD_LICENSE_FILE is set as a System Variable, it is necessary to use
LMTools via Install/Edit Licenses and, on the Config Services tab, use Remove Ser-
vice.

This will clear the System Variable and the registry setting.
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9.4.10.2 Open License Manager Tools
This will open the Flexera License Manager Tools (LMTools).

Please refer to the OpendTect Administrator's Manual for more information.

Note: This is a Windows-only application.

https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm#installation/license_server/installing-license-server-on-windows.htm
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9.5 Show Log File
The user can check the log file from Utilities > Show log file. This will show the log of
low traffic signals e.g. warning messages if a plugin (or license) is not properly
loaded.
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10 Help

10.1 Documentation

This leads to a choice of documentation. Depending on whether or not you have
installed the documentation alongside OpendTect, selecting one of these options
will either take you to the installed version or the online version of the respective doc-
ument.
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Please take a look at the respective documents themselves for more information:

l OpendTect User Documentation

l OpendTect Pro and dGB Plugins

l Programmer's Manual

l Administrator's Manual

https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm
https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm
https://doc.opendtect.org/7.0.0/doc/Programmer/Default.htm
https://doc.opendtect.org/7.0.0/doc/admindoc/Default.htm
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10.2 How-To Instructions

This will take you directly to the How-To Instructions document.

It contains a series of detailed workflows ranging from the basics on how to setup a
survey and import data, to Fault Extraction and Crossplots etc.

Note: not to be confused with the Training Manual (explained in the next section).

https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm
https://doc.opendtect.org/7.0.0/doc/HTML_TM/Default.htm
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10.3 Training Manual

This will take you directly to the Training Manual.

You will find many guided exercises here, helping you get to know OpendTect and
the various plugins.

It contains series of detailed workflows differing from those in the How-To Instruc-
tions.

https://doc.opendtect.org/7.0.0/doc/HTML_TM/Default.htm
https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm
https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm
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10.4 Videos

This will take you directly to our OpendTect Videos webpage.

You will find here dozens of instructional and informative videos, ranging from
Machine Learning webinars to Training Classes on various topics.

Depending on your permitted internet access, clicking on any of the videos will
either play it via the OpendTect YouTube Channel or directly from our own server.

https://videos.opendtect.org/
https://www.youtube.com/channel/UCiaLX2p5rCcovOK_NAwpaOQ
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10.5 Attributes Table

Takes you to the Attributes Table on the dGB Earth Sciences website.

This table gives a reasonable overview of the various attributes in OpendTect, their
uses and to which plugin(s) they are linked. Each entry is referenced.

https://www.dgbes.com/software/attributes-table
https://dgbes.com/
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10.6 Online Support

Takes you directly to the Support page of the OpendTect website.

Scrolling down the page, you may access links to all our documentation, Com-
munities page, FAQs, publications and videos.

https://dgbes.com/support
https://dgbes.com/
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10.7 Keyboard Shortcuts

This will pop open a new window detailing all the possible keyboard shortcuts:
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It can be accessed either via the menu, as explained above, or by [Shift]?
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10.8 Legal

This will pop up a window, allowing you to view all the various license agreements
for the open source projects from which OpendTect has incorporated code:



- 888 -

10.9 About OpendTect

This will bring up a simple window showing the build information:
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Clicking on the 'here' link will take you to the licenses section of the dGB website.

https://dgbes.com/software/licenses
https://dgbes.com/
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11 Appendix A - Attributes and
Filters
OpendTect attributes and filters are divided into 'dip-steering attributes' and 'no-
steering attributes'.

A comprehensive list of all the attributes and filters available in the free, open source
OpendTect core software is shown below (the so-called 'no-steering attributes'):

Note that other attributes and filters are only available if the corresponding plugin
has been installed. Information on commercial dGB plugins, please read the dGB
Plugins Documentation.

Attributes related to Earthworks and ARK CLS plugins are documented in their cor-
responding UserDocs. These can be found by using following link:

l OpendTect support page and then clicking the Documentation link.
l CEEMD -- Group of Spectral Decomposition algorithms which are based on Empirical
Mode Decomposition.

l Convolve (2D/3D) -- Attribute that returns a filtered response
l Delta Resample -- Attribute that enables residual alignment of seismic volumes
l Energy -- Response attribute that returns the energy of a trace segment
l Event -- Attribute that quantifies an events shape or distance relative to a next event
l Fingerprint -- Attribute that computes the similarity between a user-defined vector of
attributes and the equivalent vector taken at each position in a cube

l Frequency -- Response attribute that returns frequency properties
l Frequency Filter -- Attribute that returns filtered data using FFT or Butterworth filter
types

l GapDecon -- Attribute that aims to attenuate repetitions of primary reflections (mul-
tiples)

l Grubbs Filter -- Attribute that removes outliers from normally distributed data
l Horizon -- Attribute that enables advanced calculations on horizons
l Instantaneous -- Attribute that returns a value at a single sample location
l Log -- Attribute that returns a well log value.
l Match Delta -- Attribute that extracts time shifts between similar events in different seis-
mic volumes

l Mathematics -- Attribute that returns the result of a user-defined mathematical expres-
sion

l Position -- Attribute that returns any attribute calculated at the location where another
attribute has its minimum, maximum or median within a small volume



- 891 -

l Prestack -- The prestack attribute can be used either to extract statistics on the gathers
and their amplitudes, or to extract AVO attributes

l Reference -- Attribute that returns the definitions of the extraction position
l Reference shift -- Attribute that moves the extraction position in 3D space
l Sample Value -- Attribute that returns the input value at the sample location
l Scaling -- Attribute used for scaling of amplitude
l Similarity -- Multi-trace attribute that returns trace-to-trace similarity properties
l Spectral decomposition -- Frequency attribute that returns the amplitude spectrum
(FFT) or waveletcoefficients (CWT)

l Texture -- Group of attributes that return statistical properties of a Grey-Level Co-occur-
rence Matrix (GLCM)

l Texture - Directional -- a multi-trace attribute that returns textural information based on
a statistical texture classification.

l Velocity Fan Filter -- Attribute that returns energy with apparent velocities/dips inside a
specified Min/Max range

l Volume static -- Attribute that returns statistical properties
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11.1 CEEMD - Spectral Decomposition
Name

CEEMD (Complete Ensemble EMD) – Group of Spectral Decomposition algorithms
which are based on Empirical Mode Decomposition (Huang et al., 1998).

Description

The Empirical Mode Decomposition (EMD) algorithms implemented in OpendTect
follow the work published by Jiajun Han and Mirko van der Baan (2013). Compared
to Short Window FFT and Continuous Wavelet Transforms, the other two spectral
decompositions methods supported in OpendTect, EMD methods reportedly yield
significantly higher time-frequency resolutions.

EMD is a data-driven spectral decomposition method developed by Huang et al.
(1998). The method decomposes a time series (e.g. a seismic trace) into a set of
intrinsic oscillatory components called Intrinsic Mode Functions (IMF’s). An IMF is
defined as a function that satisfies two conditions:

1. The number of extrema and the number of zero-crossings must either be equal or dif-
fer at most by one

2. At any point the mean value of the envelope defined by the local maxima and the envel-
ope defined by the local minima is zero.

These conditions ensure that IMF’s contain only one mode of oscillation per cycle
whereby a cycle is defined by the zero crossings. No riding waves are allowed. Rid-
ing waves can result in negative instantaneous frequencies, a major problem in any
application that relies on instantaneous frequencies. An important characteristic of
IMF’s that is utilized in EMD is that instantaneous frequency can be defined every-
where.

To decompose the signal into the IMF components the algorithm performs a pro-
cess called sifting. In sifting the local mean of the signal is subtracted from the sig-
nal. The local mean is computed from the envelopes (below). If the difference signal
fulfils the IMF conditions defined above the first component is found. This will be the
component with locally the highest frequencies. This component is subsequently
subtracted from the original signal and the process is repeated until all components
have been found. The last component contains the lowest frequencies, or rep-
resents the trend.
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The sifting process. Envelopes of the signal are constructed by fitting a polynomial
function through picked minima and maxima. From the envelopes the local mean of
the signal is computed, which is subtracted from the input signal. It is then checked
whether the difference signal (bottom) meets the IMF conditions. If not, the sifting
process is repeated until the IMF conditions, or the sifting stopping criteria, are met.

EMD is a relatively slow decomposition method and it has a problem called mode
mixing. This is defined as either a single IMF consisting of widely disparate scales,
or a signal of similar scale captured in different IMF’s.

To overcome mode mixing two noise assisted methods have emerged, both of
which are supported in the OpendTect attribute.

Ensemble Empirical Mode Decomposition (EEMD) adds a fixed percentage of white
noise to the signal before decomposing it. This step is repeated N times after which
all results are averaged. EEMD improves the mode-mixing problem but it cannot
completely reconstruct the input signal from the resulting components.

Complete Ensemble Mode Decomposition (CEEMD) is also a noise- assisted
method. Similarly the method decomposes the signal with N different noise real-
izations but here the results are averaged after each component is found. CEEMD
solves the mode mixing problem and it provides an exact reconstruction of the input
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signal. CEEMD is however, a CPU intensive process and in the current imple-
mentation rather slow.

Input Parameters

Input Data is the seismic data to be decomposed. The current implementation
decomposes the entire trace, hence decomposition along one horizon takes as
much computing time as a decomposition in batch mode of a cube over the same
area.

To evaluate the results along one horizon, e.g. with RGB blending, it is
faster to run a batch process on a time slice that encompasses the horizon-
slice than to run the job interactively using the evaluate attribute option.
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Method: Select the decomposition algorithm:

l EMD – slow and possibly suffers from mode-mixing (see Description above)
l EEMD – slower but partly solves mode-mixing, however signal cannot be recon-
structed exactly

l CEEMD – slowest but solves the mode-mixing problem and the signal can be recon-
structed exactly from the components.

Maximum No. of IMFs is the maximum number of components into which a signal
can be decomposed.

IMF threshold is a value below which the decomposition process is stopped. The
value is computed as the standard deviation of the component divided by the stand-
ard deviation of the input signal.

Maximum no. of sifts and Sift threshold are stopping criteria for the sifting pro-
cess. The Sift threshold is defined as the standard deviation of the signal after the
sifting step divided by the signal before the sifting step. The typical range is between
0.2 and 0.3

Display Time Frequency Panel will decompose the selected trace and displays
the result in a time-frequency plot with frequencies ranging between 0 and Nyquist
Hz.
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Time-Frequency plot of the synthetic test trace, below(zoomed in to show only fre-
quencies from 0 to 150Hz.)

Output

The current version supports four output Attributes:

Frequency is computed from the instantaneous frequency of the IMF components
and by re-gridding these irregularly sampled frequencies to the requested output fre-
quencies. Output Frequency is the frequency that is output if the attribute is com-
puted interactively. In Batch mode you can output all frequencies from Output
Frequency to Nyquist with an increment of Step, e.g. 5, 10, 15, …, 120, 125 for an
Output Frequency of 5, a Step of 5 and an input signal with 4ms sampling rate
(Nyquist is 125 Hz). Please note that computing one output (interactively) takes
nearly the same amount of computing time as computing all frequencies (in batch
mode).

Peak Frequency is the frequency with the largest amplitude in all IMF components.
It captures information from the spectral decomposition into a single attribute that is
related to tuning effects at varying thicknesses.

Peak Amplitude is the highest amplitude in all components.

IMF Component outputs the IMF components (below). This corresponds to the real
parts of the decomposed signal. The first component corresponds to the highest fre-
quency oscillations in the signal. A decomposition may result into an unknown num-
ber of components. When running a job in batch mode the output is stored in a
multi-attribute file (cbvs format) with N+1 number of attributes where N is the max-
imum no. of IMF’s. If a trace is decomposed into less than N components the remain-
ing attributes are filled with zeroes. The N+1 attribute contains the average of the
input trace (= DC component) that was removed at the start of the decomposition.
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Synthetic trace (top) decomposed with CEEMD into its IMF components (bottom).

Examples

Line 425 of F3 Demo is the input for the decomposition with CEEMD. The IMF com-
ponents; Peak Frequency components; and Peak Amplitude are shown below
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IMF components (CEEMD) of Line 425.

Peak Frequency (CEEMD) of Line 425.
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Peak Amplitude (CEEMD) of Line 425.

References

Han J. and Van der Baan M., 2013. Empirical mode decomposition for seismic time-
frequency analysis. Geophysics, 78 (2), O9-O19.

Huang, N.E., Shen, Z., Long, S.R., Wu, M.C., Shih, H.H., Zheng, Q., Yen, N.C.,
Tung, C.C. and Liu, H.H., 1998. The empirical mode decomposition and the Hilbert
spectrum for nonlinear and non-stationary time series analysis: Proceedings of the
Royal Society A: Mathematical, Physical and Engineering Sciences, 454, no. 1971,
903-995.
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11.2 Convolve (2D & 3D)
Name

Convolve (2D/3D) -- Attribute that returns a filtered response.

Description

The input data is convolved with a three-dimensional kernel specified by Filter type
and associated parameters. Lowpass, Laplacian, and Prewitt are well known filters
in image processing.

Input Parameters

Lowpass

Lowpass is an arithmetic averaging filter which is used to smooth seismic data. The
smoothness is determined by the Filter size. The shape parameter specifies
whether the input samples are collected in a sphere or a cube centered around the
evaluation point. The output is the sum of the sample values divided by the number
of samples.
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Laplacian

The Laplacian filter is an edge enhancement filter. The sharpness is determined by
the Filter size. The shape parameter specifies the input samples to the filter. In a
3x3x3 Laplace filter, the output is calculated by multiplying the central sample value
with 26 and subtracting all surrounding sample values. The convolution is char-
acterized by the following kernel:

l (-1,-1,-1) (-1,-1 ,-1) (-1,-1,-1)
l (-1,-1,-1) (-1,+26,-1) (-1,-1,-1)
l (-1,-1,-1) (-1,-1 ,-1) (-1,-1,-1)

In case all sample values are equal and non-zero (either positive or negative), the
effect of this operation is zero.
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Prewitt

Prewitt is a contrast enhancement filter. This filter computes the gradient in different
directions from a 3x3x3 input cube. The Output is returned in the specified direction
(inline, crossline, or Z-plane). A 3x3x3 Prewitt kernel to calculate a horizontal gradi-
ent is given by:

l (1,0,-1) (1,0,-1) (1,0,-1)
l (1,0,-1) (1,0,-1) (1,0,-1)
l (1,0,-1) (1,0,-1) (1,0,-1)

Note that the inline gradient returns the difference in amplitude in the inline dir-
ection. This is best visualized on a crossline. Similarly, a crossline gradient is visu-
alized best on an inline.

A 3x3x3 Prewitt kernel that returns the vertical gradient is given by:

l (-1,-1,-1) (-1,-1,-1) (-1,-1,-1)
l ( 0, 0, 0) ( 0, 0, 0) ( 0, 0, 0)
l ( 1, 1, 1) ( 1, 1, 1) ( 1, 1, 1)
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Wavelet

This option enables the user to convolve the data with a wavelet. In this context, a
wavelet is the time series response of a filter. The wavelet should be imported into
OpendTect first or it can also be created in OpendTect (FromWavelet management
or ARKCLS Spectral blueing attribute).
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11.3 Delta Resample
Name

Delta Resample -- Attribute that enables residual alignment of seismic volumes

Description

This attribute is used to make shifts inside seismic volumes. By defining an input
cube and a delta cube, which represents the shifts that should be applied to the
input data, a correctly aligned output volume can be generated. The delta cube can
be generated by using the attribute "Match Delta". Note that you must use the Z-unit
of the input cube. Also note that you must apply a negative shift to move the cube
down and a positive shift to move the cube up. Using the "Delta Resample" attribute
is very useful in case of working on, for example, multi-azimuth volumes which fre-
quently show some degree of misalignment. This technique can also be very useful
for time-lapse seismic data and NMO-corrected data. Only after aligning, a correct
comparison can be made between two different volumes.

Input Parameters

The delta cube can be generated by using the Match Delta attribute. An advanced
option in the attribute engine is that, when the input is periodic and contains phases,
it is possible to define a (maximum) period. The box "Input is periodic" should be
clicked and the period should be defined in the box. However, a situation like that is
very exceptional and, in 99 out of 100 cases, the shift can be applied without using
this option.

One of the side-effects of this residual alignment is that existing horizons are not
consistent with the data any more. The horizons should be re-snapped to the
aligned seismic data by using the option "Algorithms" when right-clicking a horizon
in the tree. The third option "Snap to event" enables the user to make the horizon
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consistent again. Only after snapping the horizons can the user, for example, cal-
culate horizon-steered attributes or performing waveform segmentation.

Flattening or Unflattening a Cube:

Another useful application for this attribute is to flatten or unflatten a cube. The
example given below outlines how you would unflatten a cube that you have
flattened (for example, using the Flattening option under the Horizon Workflows
fold-out):

You would create a cube that would have, as a function of the position only, the Z dif-
ference between flattened and unflattened volume. For example, you may have set
the TWT of the flattened cube to 1000 ms. Using the Horizon attribute you would
read the TWT values of the horizon, let's say 1300ms for a particular trace. The shift
is thus defined with a mathematics attribute as:

shift(ms) = ( FlatTWT(s) - HorTWTAttrib ) * 1000 = ( 1 - 1.3 ) * 1000 = -300

Applying this shift attribute as 'Delta Cube' for your flattened volume (your 'Input
Cube') will undo the flattening (in this case, with a negative value, thus shifting the
cube down).
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11.4 Energy
Name

Energy -- Response attribute that returns the energy of a trace segment

Description

This attribute calculates the squared sum of the sample values in the specified time-
gate divided by the number of samples in the gate. The Energy is a measure of
reflectivity in the specified time- gate. The higher the Energy, the higher the
Amplitude. This attribute enhances, among others, lateral variations within seismic
events and is, therefore, useful for seismic object detection (e.g. chimney detec-
tion). The response energy also characterizes acoustic rock properties and bed
thickness.

Input Parameters

Output

Energy, Sqrt(Energy) and Ln(Energy)
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Examples

Seismic data showing anomalously high values

Energy attribute (time-gate [-28,28]) enhances anomalously high values (yellow)
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11.5 Event
Name

Event -- Attribute that quantifies an events shape or distance relative to a next event

Description

The event attribute is a useful tool when determining the quality of horizons in seis-
mic data that can also be applied to in-lines, cross-lines, or z-slice elements. A
sketch of the several event attribute applications is shown below:

Input Parameters
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In the single event mode, the algorithm searches for the extremum and quantifies
the shape around the event in terms of either Peakedness, Steepness or Asym-
metry.

l Peakedness: The ratio between the Extremum value and distance between next and
previous zero crossings (ZC)

l Steepness: The slope of tangent to the seismic trace at a zero crossing
l Asymmetry: The asymmetry of event. Mathematically it can be presented as: (L-R)/
(L+R) where L is the distance between previous ZC and extremum and R is distance
between next ZC and extremum

In the multiple event mode, the event type needs to be specified from the Event type
drop-down list:

l Extremum
l Maximum
l Minimum
l Zero Crossing
l Negative to Positive Zero Crossing
l Positive to Negative Zero Crossing
l Maximum within the gate
l Minimum within the gate



- 912 -

Output

The output is either the distance between the chosen event and the next/previous
similar event or the amplitude of the event. The output is determined by the check-
box below the event type drop-down list.

For the event types Maximum within the gate and Minimum within the gate, a time-
gate (in milliseconds) needs to be specified. The algorithm computes the distance,
within the specified time-gate from the current point, e.g. on a horizon, to the
nearest maximum or minimum.
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The Event attribute is for example useful while quality-checking horizon grids. The
attribute can also aid in finding the distances between two events and using it as an
estimate of relative thickness changes between them. The adaptive use of Volume
Statistics along with the Event attribute can also bring relative changes to derive
meaningful geological aspects.
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11.6 Fingerprint
Name

Fingerprint -- Attribute that computes the similarity between a user-defined vector of
attributes and the equivalent vector taken at each position in a cube.

Description

This attribute computes the similarity between a user-defined vector of attribute val-
ues and the equivalent vector taken at each sample position inside the cube. The
reference vector can be constructed from one or more positions. A statistical prop-
erty (average, median, variance, minimum or maximum) is calculated after the con-
struction of the vector. Also, it is possible to construct the vector manually by editing
the attribute values of the fingerprint vector. The similarity between the fingerprint
vector and the equivalent vector at the evaluation point is computed as the nor-
malized Euclidean distance between the two vectors and ranges between 0 (vec-
tors are not identical at all) and 1 (vectors are 100% identical).

If you want to insert/remove the reference attributes, right click in the empty area of
Reference attribute window.
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Advanced options

In order to compare vectors, you can use the "Advanced" option to obtain the
ranges for the input values. The ranges are automatically calculated using random
points when you press the button "Calculate parameters". You can also use a point-
set to find the ranges or even manually introduce them. In the "Advanced options"
window, a weight can be assigned to each individual attribute. The default value of
the weight is set to 1.
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Example of result application fingerprint attribute
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11.7 Frequency Filter
Name

Frequency Filter -- Attribute that returns filtered data using FFT or Butterworth filter
types

Description

The specified Input Data is bandpass filtered with the commonly used Fast Fourier
Transform or Butterworth filter.

Input Parameters



- 919 -

The difference between using the FFT or Butterworth filtering method is that, for the
FFT, one considers the complete trace while for the Butterworth filter, only a "small"
segment, depending on the selected number of poles, is taken into account. The
user should keep in mind that using the Butterworth Filter results in a small shift in
the seismic data.



- 920 -

The curves of the Butterworth filter for various numbers of poles

The Filter type is set to LowPass, HighPass or BandPass according as it is dis-
criminating against frequencies above or below a certain limiting frequency or out-
side of a given band of frequencies. The top frequency tapering applied to the
extracted data in the time domain.

Frequency Taper:

Additionally, a frequency taper can be applied by setting the min/max Hz tapering
window. This could be done by toggling Specify Frequency Taper ON. Press the
View button to specify an appropriate frequency taper.
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Frequency taper settings in the attribute definition (for filter type: 'BandPass').

Once the Frequency Taper is displayed (red line in a pop-up window), a spectrum
on any inline/crossline can be viewed by pressing the Preview Spectrum button. It
will prompt to select an inline/crossline ("Select line from Data"). In that dialog select
either inline or crossline radio button and press Next. Sub select the part of
inline/crossline and proceed. A blue coloured amplitude spectrum will be displayed
(as shown below). Now adjust the parameters (Slope or Start/Stop Frequency) and
finalize the frequency taper settings.
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Interactive display of the frequency taper parameters (for filter type: 'BandPass').
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11.8 Frequency
Name

Frequency -- Response attribute that returns frequency properties

Description

Input Parameters
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The specified time-gate is transformed to the Fourier domain and the requested out-
put is calculated. The time-gate is tapered with the specifiedWindow/Taper prior to
Fourier Transform. The shape of the various tapers is shown in the figure below.

If Normalize is enabled, the frequency spectrum is normalized with regard to its
area. This will make it possible to compare attributes from areas with high and low
energy.
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Output

All possible Frequency outputs are in X-axis, Y-axis = Amplitude values

Dominant frequency
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Returns the dominant frequency from the frequency spectrum--the frequency with
the highest amplitude

Average frequency

Returns the arithmetic mean of the frequency spectrum.

Median frequency

Returns the weighted median value of the frequency spectrum, which is the fre-
quency at half the spectral area on each side. The median frequency might be some-
what more robust than average frequency, at the cost of lower precision.

Average frequency squared

Returns the average of the squared frequencies.

Maximum spectral amplitude

Returns the maximum amplitude of the frequency spectrum, i.e. the amplitude of the
dominant frequency.

Spectral area beyond dominant frequency

Returns the spectral area beyond the dominant frequency (see figure below).

Absorption quality factor

Returns the area beyond the dominant frequency weighted by frequency.

Frequency slope fall

Returns the peakedness of the spectrum. It is defined as: 1+(MSA-Spectral Area)/
(MSA+Spectral Area). A value approaching zero indicates a flat distribution while a
value approaching one indicates a peaked distribution.
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11.9 GapDecon
Name

GapDecon -- Attribute that aims to attenuate repetitions of primary reflections (mul-
tiples).

Description

The type of multiple removal algorithm chosen for this application is the well known
inversed filtering method also known as Gap deconvolution. This filter aims to atten-
uate a user-defined part of an auto-correlation function. The underlying idea is that
multiples in the data are secondary reflections, i.e repetitions of the primary reflec-
tions that show up in the auto-correlation function at a time that corresponds with
the extra travel time. The filter can be applied on-the-fly or in batch-mode to produce
a filtered output cube.

This attribute consists of 3 steps:

l The energy attribute is first calculated in the user mentioned window(by default [0,0])
l A Hilbert transform is applied on this Energy amplitude
l The output of the above step is multiplied by -1 to get the phase rotation of +90 degree

The user defines the GapDecon attribute from the list and specifies a number of
input parameters.

l Correlation window = the window for calculating the auto-correlation function.
l Examine = pressing this button will open a new window where the user selects a sub-
set of the data (e.g one inline, or one cross-line) on which the result of the auto-cor-
relation will be calculated and displayed for filter design purposes. This result can be
used to determine the lag and gap size (see example below).

l Lag-size = the window length in the auto-correlation function that is unaffected by the
filter. This window contains the wavelet-shape information.

l Gap-size = the window length in the auto-correlation function that the filter aims to
blank. This window contains repetitive (multiple) information.

l Noise level = random noise that can be added to stabilize the filter derivation. The
noise level is set to 1% by default.

l Stepout = a moving average across neighbouring traces that is applied prior to the cal-
culation of the auto-correlation function. This trace averaging results in a smoother
end-result. The higher the stepout, the smoother the result.

l Input is = The user can set the input to minimum or zero phase; if the input is zero
phase, a phase rotation of 90 degrees is applied before applying the GapDecon filter.
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l Output is = The user may set the output to zero phase, then the inverse 90 degrees
rotation is applied after the filtering.

l Check parameters = check whether the (multiple) energy has indeed been removed.
A QC of the parameters : the GapDecon-filter with the selected parameters, lag 44 and
gap 100 (see example below), is applied on a user defined line and the auto-cor-
relation of the filtered data is displayed in a 2d-viewer to check whether the parameters
are correct. If they are not correct, the parameters can still be changed.

Spiking Deconvolution.

The Gap Decon attribute can also be used for Spiking Deconvolution or Whitening.
The goal of Spiking Deconvolution is to flatten the output spectrum. This is achieved
by shortening the embedded wavelet and attempting to make it as close as possible
to a spike (zero-lag spike). One should keep in mind that the frequency bandwith of
the data might limit the extent to which this whitening is possible. At higher fre-
quencies, Spiking Deconvolution might cause an increase in noise.

Example
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In the attribute defined above, we define an auto- correlation window between
300ms and 1200ms. After pressing 'Examine' we can see that the following para-
meters could give us the result we desire: a lag of 44 ms and a gap of 100ms. Press-
ing 'Check Parameters' shows the effect this would have if we were to output this
attribute with the current parameter settings:
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11.10 Grubbs Filter
Name

Grubbs Filter -- Attribute that removes outliers from normally distributed data.

Description

Grubbs' test , (also known as the maximum normed residual test), is a statistical test
used to detect outliers in a univariate data set assumed to come from a normally dis-
tributed population. It is based on the assumption of normality. That is, one should
first verify that the data can be reasonably approximated by a normal distribution
before applying. The test detects one outlier at a time. This outlier is expunged from
the dataset and the test is iterated until no outliers are detected.

Please note: Multiple iterations change the probabilities of detection, and the test
should not be used for sample sizes of six or less since it frequently tags most of the
points as outliers.

For a full definition, including formulas, please see the Wikipedia entry.

Input Parameters
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11.11 Horizon
Name

Horizon -- Attribute that enables advanced calculations on horizons

Description

This attribute is designed to extend the use of horizon data and can be used for sev-
eral purposes. When applying it to a horizon only, it will give similar results as cal-
culating attributes on the horizon.

However, when using the output of this attribute as input to a mathematical expres-
sion, the output can vary from just a simple thickness calculation to a highly
advanced combination of several attributes. You can think of this attribute as dif-
ferent to the other attributes in OpendTect in the sense that it takes horizon data and
converts it into seismic data which can be applied as input in volumes.

Input Parameters
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As shown above, there are two possible outputs, namely Z (depth) and horizon
data. For each position on the horizon, the value (Z or horizon data) is used as out-
put along the complete trace.
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11.12 Instantaneous
Name

Instantaneous -- Attribute that returns a value at a single sample location.

Description

Instantaneous attributes are computed sample by sample, and represent instant-
aneous variations of various parameters. Instantaneous values of attributes such as
trace envelope, its derivatives, frequency and phase may be determined from com-
plex traces. (see figure below)

Complex Seismic Trace Attributes (From Taner et al.,)

The imaginary part of the complex trace is computed via the Hilbert transform. Poss-
ible outputs are:
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Instantaneous Amplitude (Trace Envelope)

Outputs the instantaneous amplitude (or envelope) of the selected data volume at
the sample location.

It can be used as an effective discriminator for the following characteristics:

l Mainly represents the acoustic impedance contrast, hence reflectivity,
l Bright spots, possible gas accumulation,
l Sequence boundaries,
l Thin-bed tunning effects,
l Major changes in depositional environment,
l Spatial correlation to porosity and other lithologic variations,
l Indicates the group, rather than phase component of the seismic wave propagation.
l Amplitude 1st derivative: Time derivative of the instantaneous amplitude i.e time
rate of change of the envelope. It shows the variation of the energy of the reflected
events. It is used to detect sharp interfaces and discontinuities.

l Amplitude 2nd derivative: Second derivative of the envelope. It provides a measure
of the sharpness of amplitude peak. It can be used to identify all reflecting interfaces
within the seismic bandwidth.

Instantaneous Phase

Calculates the instantaneous phase at the sample location, it emphasizes spatial
continuity/discontinuity of reflections by providing a way for weak and strong events
to appear with equal strength.

This attribute is of central importance since it describes the location of events in the
seismic trace and leads to the computation of other instantaneous quantities.
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The instantaneous phase makes strong events clearer and is effective at high-
lighting discontinuities of reflectors, faults, pinch-outs, angularities and bed inter-
faces. Seismic sequence boundaries, sedimentary layer patterns and regions of
onlap/offlap patterns often exhibit extra clarity

The instantaneous phase relates to the phase component of wave-propagation, it is
also used to compute the phase velocity.

l Cosine phase: Cosine of the instantaneous phase, also called normalized amplitude.
It has the same uses as instantaneous phase with one additional benefit: It is con-
tinually smooth. By providing the +/-180 degree discontinuity that occurs with instant-
aneous phase, the cosine of instantaneous phase can be further processed (e.g,
filtered and stacked) using conventional seismic processing tools. Amplitude peaks
and troughs retain their position, but with strong and weak events now exhibiting equal
strength

l Envelope weighted phase: Instantaneous phase, weighted by the envelope over the
given time window

l Rotate Phase: Phase output is rotated through a user-specified angle

Instantaneous Frequency

Outputs the instantaneous frequency at the sample location.

The instantaneous frequency attribute responds to both wave propagation effects
and depositional characteristics, hence it is a physical attribute and can be used as
an effective discriminator.

It uses include:

l Hydrocarbon indicator by low frequency anomaly.
l Fracture zone indicator, since fractures may appear as lower frequency zones.

Bed thickness indicator. Higher frequencies indicate sharp interfaces such as exhib-
ited by thinly laminated shales, lower frequencies are indicative of more massive
bedding geometries, e.g. sand-prone lithologies.

l Envelope weighted frequency: Instantaneous frequency, weighted by the envelope
over the given time window

l Phase acceleration: Time derivative of the instantaneous frequency
l Thin bed indicator: Difference between instantaneous frequency and Envelope
weighted frequency

l Bandwidth: The absolute value of the envelope time derivative
l Q factor: Instantaneous frequency divided by the bandwidth
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Hilbert (Quadrature Amplitude)

The quadrature trace is the imaginary part of the complex seismic trace (see image
above), and can be computed from the real trace via the Hilbert transform.

Both the real trace and its quadrature counterpart share the same amplitude spec-
trum; the quadrature however is phase rotated by 90 degrees. Zero-crossings on
the real trace transform to peaks and troughs on the quadrature trace and peaks
and troughs on the real trace transform to zero-crossings on the quadrature trace.

The quadrature is used in various mathematical combinations to compute other
complex trace attributes such as instantaneous phase and instantaneous fre-
quency. it is sensitive to energy, frequency, and phase.
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11.13 Localized Velocity Fan Filter
Name

Velocity Fan Filter - - Attribute that returns energy with apparent velocities/dips
inside a specified Min/Max range.

Description

The velocity fan filter passes energy with apparent velocities (for Time surveys) or
apparent dips (for Depth surveys) inside the specified Min/Max velocity/dip range.
The filter supports three options:

l pass low velocities/dips (i.e. suppress high velocities/dips)
l pass high velocities/dips (i.e. suppress low velocities/dips)
l pass velocities/dips within a specified cone.

Therefore, this attribute can be used to filter out or enhance certain dip/azimuth
events.

Input Parameters

The Filter size is the size of the 3D kernel. Filter size 3 means the data is convoluted
with a 3x3x3 kernel. To reduce edge effects it is recommended to apply a cosine
square taper. A Taper length of N means (100-2N)% of the specified velocity range
will be flat. Azimuth filter is a special option that allows the dipping energy to be
passed inside the specified Azimuth to pass direction only.
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The different shapes of the filter ( low pass, high pass, interval velocity/dip) are
shown below:
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Note: Please be aware that in Time surveys, flat events have infinite velocity, and
vertical events have a zero velocity. The opposite is observed in Depth surveys
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where not velocities but dips are used: Horizontal events have zero dip, while ver-
tical events have 90 degrees dip.

Display F-K Panel:
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This option allows you to display a two-dimensional Fourier transform over time and
space where F is the frequency (Fourier transform over time) and K refers to wave-
number (Fourier transform over space).

Examples

An example of a velocity fan filter (high-pass) applied on a time slice. By applying
the appropriate filtering parameters, the random noise has been suppressed thus
enhancing the amplitudes visibility. Also notice the comparison of this filter with the
DSMF (Dip-Steered Median Filter) that is almost same with an assumption of high
pass of velocities in the middle image.
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11.14 Log
Name

Log -- an attribute that returns a well log value.

Description

This attribute takes the value form an input well log and returns this value through-
out the volume at the corresponding Z value.

Input Parameters

Firstly, the 'Input Well' is chosen and, secondly, one of the associated logs from the
auto-filled 'Select Log' list.

Output

There are five possible outputs:

Examples

Below is a shot of the Gamma Ray log from F03-4 displayed on inline 441 (F3 Demo
dataset), as 'Take Nearest Sample':
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11.15 Match Delta
Name

Match Delta -- Attribute that extracts time shifts between similar events in different
seismic volumes

Description

This algorithm extracts the time difference delta t between peaks in different seismic
volumes. A search window is set to avoid loop-skips. After extracting all delta t val-
ues, they are interpolated. The resulting cube is the delta cube in ms or meter/feet
which can be used for the Delta Resample attribute.
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Extraction of delta t from two neighboring traces.
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In a little more detail, the algorithm proceeds along these lines:

l For each trace, all peaks are found.
l Result: a list of peaks and the time of occurrence.
l Each peak is coupled with a counterpart if it is found to be within the specified search
window. (If none are found, there is no addition to the list of differences.)

l Result: a list of time differences (deltas)
l The delta list is interpolated (linear, constant extrapolation at the ends)
l Result: a delta value for each sample

After using this attribute, it will be clear that there are many 'jumps' and 'skips' in the
displayed sections. Because we know that the deltas should not vary that quickly -
not going from trace to trace, but also not going from sample to sample, these can
be effectively removed by utilizing a double filter: first a rather large median filter
over many traces and a 2 to 3 samples, then an average or FFT-based filtering in all
directions. The resulting output should now be relatively 'noise-free'.

Input Parameters

Besides the reference and the match cube, a maximum time-window must be
defined in order to avoid loop-skips.
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11.16 Mathematics
Name

Mathematics - - Attribute that returns the result of a user-defined mathematical
expression

Description

The Mathematics attribute is a way to combine data from stored data and attributes
into a new data.

The input data can be volumes, 2D lines or well logs. The output data has always
the same dimension (3D, 2D, 1D respectively) as the input, with the exception that
3D and 2D attributes can also be computed along surfaces (horizons and faults).
The mathematical expression is calculated at each sample position.

Input Parameters

A mathematical expression is specified in the Formula text field with variables, con-
stants, numerical values and/or recursive operators.

l Constants must start with the letter C and be following by a number: C1, C5, C9... The
number does not necessarily start at 0 and does not have to be consecutive. Con-
stants can be evaluated just like stepouts and time gates for the other attribute. They
are not available for logs creation

l Variables expressions can be any string: seis, energy, sim, ... They can be called with
a number between brackets like seis[-1] or seis[4], in which case the value represents
a shift in number of samples. seis[-1] represents seis on the sample above, seis[4] rep-
resents seis four samples below

l Recursive expressions are a way to call back the result of the mathematical formula on
a sample above for computation. This result is called with the expression OUT[-i] (case
insensitive) where i is a number of samples
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There is no limit in number of variables/constants used in an expression.

There are special constants for which it is not necessary to provide the numerical
value: DZ is the sampling rate of the input data, Inl and Crl are respectively the inline
and crossline numbers of the current trace. The special constant are case sensitive.

Mathematics attributes containing a recursive equation should only be applied to
the full volume/lines, not along a surface because of the integration length.

Parentheses ( ) are allowed. Once the mathematical expression has be entered you
must press Set. Then a table will appear where you will be able to assign data to the
variables and values to the constants and recursive settings: Start time (or depth) of
the recursive function and value at this time.
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Supported operators are:

+, -, *, /, ^, >, <, <=, >=, ==, !=, && (and), || (or), |xn |(absolute value), cond ? true stat
: false stat.

Supported mathematical functions are:

sin(), cos(), tan(), asin(), acos(), atan(), ln(), log(), exp(), sqrt(), min(), max(), avg(),
sum(), med(), var(), rand(v) and randg(std).

Where avg is the average, med is the median, and var is the variance of the input
parameters. The input parameters in parentheses should be separated by a
comma.

The function rand(v) gives a random number from a uniform distribution between 0
and v. The function randg(std) generates a random number from a Gaussian (nor-
mal distribution) with standard deviation std and expectation 0.

Supported constants are:

pi (3.1415927), undef or null (The OpendTect undefined value: 1e+30), e (2.71...),
DZ (Z step), Inl (Inline number), Crl (Crossline number), XCoord (X Coordinate),
YCoord (Y Coordinate), Z (Z value), THIS, seis[-1]

In addition it is possible to make logical operations using IF .. THEN .. ELSE state-
ments. The following syntax must be used:

CONDITION ? OUTPUT IF TRUE : OUTPUT IF FALSE

The three parts can be any set of variables and/or constants. IF..THEN..ELSE state-
ments can be embedded like here:

CONDITION1 ? TRUE : (CONDITION2 ? TRUE : FALSE)

Other options

Predefined functions, constants, and operators can be inserted into the 'Formula'
field using a combination of the drop-downs, followed by the 'Insert' button. These
are grouped so:
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The grouping 'Other' contains the above.

Pressing this button, , will open the 'Rock Physics' library of for-
mulas. Clicking 'Ok' in this additional window will directly insert the chosen formula
into the 'Formula' field.

Formulas in Mathematics can be saved ( ) and loaded from a stored location ( ).

Examples of expressions

l X0 == X1 returns 1 if X0 equals X1, 0 is returned if the statement is false, i.e. X0 is not
equal to X1

l X0 != X1 returns 1 if X0 is not equal to X1 and 0 if X0 equals X1
l X0 && X1 returns 1 if X0 and X1 are not equal to 0. If one of these equals zero a 0 is
returned

l X0 || X1 returns 1 if X0 or X1 is not equal to 0. If both are zero a 0 is returned
l |X0| returns the absolute value of X0
l X0 > 1 ? X1 : X2 means if X0 is larger than 1 return X1, else return X2
l sin(X0) returns the sine of X0

Let's say you have one input cube, say 'Cube1' and one attribute already defined,
Energy40, which is the Energy per sample calculated in a [-20,20] ms window
around the current sample. Then, you could define 'Damped amplitude' as;

l Select Mathematics attribute
l Enter formula: seis / energy
l Press Set
l Select 'Cube1' for seis and 'Energy40' for energy
l Provide a name for the attribute, and press Add as new

Additional examples
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1. Centred differentiation example: Centred differentiation can be coded using the for-
mula (seis[+1]-seis[-1])/(2*DZ) where DZ is the sampling rate. Please note that for lat-
eral shifts the reference shift attribute must still be used.

2. Recursive filters can be created using the syntax "OUT[-i]". The most general form of
recursive equation is the following:
l y[n] = a0*x[n] + a1*x[n-1] + a2*x[n-2] + ...
l + b1*y[n-1] + b2*y[n-2] + ...
l where x[] is the input volume, y[] is the output volume and the a's and b's the coef-
ficients. n is the current sample number.

l In the mathematics attribute the current sample index "n" does not need to be spe-
cified. Therefore the equation above can be entered as:

l c0*x0 + c1*x0[-1] + c2*x0[-2] + c3*OUT[-1] + c4*OUT[-2] + ...
l where OUT[-1] stands for y[n-1] and OUT[-2] stands for y[n-2]
l For each instance of OUT[-i] a starting value and attached time/depth must be
provided.

l Two examples of low pass and high pass recursive filters are provided in the default
attribute set "Evaluate attributes":

l "Single pole low pass recursive filter" and "Single pole high pass recursive filter".
Best results are achieved when providing an input of impedance or velocity type.

3. The phase rotation is an attribute available in the Evaluate attribute set and in the dGB
Evaluate attribute set.
l This attribute allows the user to apply a phase rotation of any angle to the data.
l It applies the formula: seis*cos(c0*PI/180)-hilbert*sin(c0*PI/180)
l where seis is the seismic data
l hilbert is the Hilbert transform of the seismic data
l c0 is the applied angle for the rotation
l c0 is in degrees.



- 954 -

11.17 Position
Name

Position - - Attribute that returns any attribute calculated at the location where
another attribute has its minimum, maximum or median within a small volume.

Description

The input attribute is the criteria used to determine the position at which the output
attribute has to be calculated. The stepouts and time-gate define the volume in
which the input attribute is evaluated. In case of a 2D attribute as input, the
inline/crossline stepout is replaced by a single trace stepout.

The Operator determines which position is returned from this analysis; the position
of the minimum, maximum, or median of the input attribute. This position is the pos-
ition at which the output attribute will be calculated.

Examples

The position attribute can be used for several purposes. For example, one can
determine where in a small volume the energy is minimal and output the frequency
at the location of this lowest energy. Also, application of the position attribute is an
important step for Fault Enhancing Filtering. In this case, the user takes the Min-
imum Similarity as Input attribute and as Output, for example, filtered data (using
Max as Operator). The stepout is set to, for example, 1 in both inline and crossline
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direction and the time-gate is defined [0,0]. The result below shows a sharply
defined fault:

Before applying the position attribute After applying the position attribute
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11.18 Prestack
Name

Prestack -- The prestack attribute can be used either to extract statistics on the gath-
ers and their amplitudes, or to extract AVO attributes.

This attribute requires prestack data as input, but will output poststack data. The fol-
lowing workflow is used in the above example:

l Pre-processing is applied to the gathers, like mute and AGC
l The data is extracted in the offset range [500, 3000] m and sorted per CDP and depth
sample

l For each CDP and depth a crossplot of amplitude vs. square root of the offset is made
l A least square regression is computed
l The intercept value is returned



- 957 -

The pre-processing of the gathers is optional. When used it must be setup in a sep-
arate window either by selecting an existing setup or creating a new one.

The offset range is used to define the extraction window. It requires absolute offset
values, in meter or feet (depending on the survey unit definition). Optionally if angles
were used instead of offsets while loading, then angle ranges can be used. Once
again they have to be in the same unit as in the input trace (SEG-Y) headers.

After optional pre-processing and data extraction, a vector of amplitudes is available
for each CMP/CIG, at each depth. From each vector either statistics or a least-
square regression can be made.

Statistics:

The above list of statistics can be returned. The highlighted output option provides
the fold of each bin, while average or RMS may be used to generate full or partial
stacks (partial stacking occurs if the offset range defined is not full). At the foot of
this list are also: Sum, SquareSum andMostFrequent

Least Square:

The Least-Square calculation type is cross-plotting the extracted amplitudes, com-
puting a least-square regression and returning one of its property.

Before the crossplot the amplitudes can be transformed using the following axis
transformation (left hand-side):
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Similarly the offset values that are associated with those amplitudes can also be
transformed (right-hand side). This is useful, e.g. to have the sin2 of the angle as x-
axis.

AVO attributes will become AVA attributes if the X axis becomes Azimuth (i.e.
angle). Please note that the azimuths (angles) must be provided in the trace head-
ers when extracting AVA attributes.

The extractable AVO (Least-Square) attributes are Intercept, Gradient, their stand-
ard deviation and the Correlation Coefficient. It is also possible to have angle/offset
constrained AVO attributes; by specifying the required angle/offset range instead of
using the full range. Please note that further transformations can be achieved using
the output as input to another attribute.
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11.19 Pseudo Relief
Pseudo relief attribute is applied on seismic in order to create a more consistent
image for an easier interpretation of faults and horizons. It is particularly useful
when applied in 2D.

This attribute consists in 2 steps:

l The energy attribute is first calculated in a [-4;+4]ms window
l A Hilbert transform is applied on this RMS amplitude.
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11.20 Reference
Name

Reference -- Attribute that returns the definitions of the extraction position

Description

The X, Y, Z, Inline number, Crossline number, Sample number, Inline index, Cross-
line index and Z index position of the reference (extraction) point is returned.

Output

l X: outputs the X-coordinate
l Y: outputs the Y-coordinate
l Z: outputs the depth according to the survey setup (e.g. miliseconds, meters or feet)
l Inline nr: outputs the inline number
l Crossline nr: outputs the crossline number
l Sample nr: outputs the sample number starting from 0 ms or the top of the survey
when the survey has a negative start time. The first sample has sample number 1. If
the survey has 4 ms sampling and starts at 0 ms, at 400 ms the sample number is 101.
If the survey has 4 ms sampling and starts at 2500 ms, the first sample has sample
number 626. If the survey has 2 ms sampling and starts at -200, the sample number at
0 ms is 101

l Inline index: outputs the number of inlines from the edge of the survey starting at 1
(e.g. If you have an inline range of 2000 to 3000, the inline index will range from 1 to
1001)

l Crossline index: outputs the number of crosslines from the edge of the survey starting
at 1 (e.g. If you have a crossline range of 2000 to 3000, the crossline index will range
from 1 to 1001)
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l Z index: outputs the sample number from the top of the survey starting at 1. (Note: this
attribute is identical to sample number if the survey has a negative starting time or
starts at 0.)

The Reference attribute replaces the old Reference time attribute. Attribute sets con-
taining the old Reference time attribute will be automatically updated to the Refer-
ence attribute, with Z as output, which gives an identical output.
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11.21 Reference Shift
Name

Reference shift -- Attribute that moves the extraction position in 3D space

Description

The Input attribute is extracted at the shifted position. The original reference (extrac-
tion) point has inline/crossline coordinates (0,0). Relative number 1 means the next
inline or crossline, respectively. In case of input of a 2D attribute, the inline/crossline
shift is replaced by a single trace shift. The vertical shift is specified in milliseconds
using the Time option. There is also the option to use Steering while calculating the
Reference shift.

The Input attribute is extracted at the shifted position. The original reference (extrac-
tion) point has inline/crossline coordinates (0,0) and Time 0.

The attribute will take the value from the shifted position and display it at the original
reference point. Say that an original position (inl:0,crl:0,Time:0) has a shift of
(25,25,100) applied to it, then this will take the output value at (25,25,100) and dis-
play it at (0,0,0). (In case of input of a 2D attribute, the inline/crossline shift is
replaced by a single trace/time shift - ie: 25,100.)

It is important to remember that the vertical element of the shift is 'positive upwards'
and 'negative downwards'.

l Think of a time-shift of +100:
l Original TWT = 500
l Shifted TWT = (500 + 100) = 600
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l The value from TWT = 600 will be displayed at TWT = 500, giving the impression of
a upward shift.

l Think of a time-shift of -100:
l Original TWT = 500
l Shifted TWT = (500 - 100) = 400
l The value from TWT = 400 will be displayed at TWT = 500, giving the impression of
a downward shift.

l Think of an horizontal shift of (Inl:5,Crl:8):
l Original position = 100,150
l Shifted position = 105, 158
l The value from 105,158 will be displayed at 100,150.

Shifting the reference position is a form of directivity that is useful in multi-attribute
analysis. Examples of use:

l calculating reflectivity in an Acoustic Impedance volume. Values extracted at +4 and -4
ms would be as input to a Mathematics attribute to perform the actual calculation.

l highlighting flat spots - one may consider attributes that are extracted in a horizontally
aligned window.

l measuring differences across a fault plane and comparison of such values.
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11.22 Sample Value
Name

Sample Value -- Attribute that returns the input value at the sample location

Description

'Sample value' gives the value of the input volume at the sample location.
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11.23 Scaling
Name

Scaling -- Attribute used for scaling of amplitude

Description

Input Parameters

The amplitude of the Input Data can be scaled in five modes:

l Using a time/depth variant weighting function
l Using weight(s) extracted in static time/depth window(s)
l Using Automatic Gain Control (single dynamic window)
l Using Squeeze ('non-clipping' limiter of range input)
l Using Gain Correction (correct/apply gain)

Output

The output amplitudes are always the ratio of the input amplitudes over a weighting
function w(i), i being the sample index.

1. Z^n scaling

The weight function is defined by Z^n where Z is the time/depth of the current
sample and n is a user-defined exponent:

w(i) = Z(i)^-n where is Z is the time or depth of the ith sample.
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The exponent is a float and thus it can be negative, positive and equal to zero (unity
operator). An exponent larger than zero will apply a correction proportional to the
depth, while an exponent smaller than zero will apply an inversely proportional cor-
rection with depth. The output amplitude is the normalized sum of the input amp-
litude using a weight equal to Z^n.

2. Window(s) scaling

The weight function is a step function: w(i) is constant over a static time/depth win-
dow, equal to the "basis" value than is computed from the input amplitudes using
the following mathematical definitions:

l The Root Mean Square (RMS)
l The arithmetic mean
l The maximum
l A user-defined value (float)
l Detrend. This option removes the trend but rather than doing so following a constant α,
it will detrend following αɣ + β. (See: Trend estimation for further info.)

Please note that the window time/depths are float and do not need to be on a
sample. The time/depths will be round to the nearest sample when defining the
extraction window. Unlike most of the window definitions in the attribute engine you
must provide in this scaling attribute absolute time/depths values and not values rel-
ative to the actual sample. A weight of 1 (no scaling) will be given to the samples not
covered by a user-defined time gate. The weights are cumulative: If several win-
dows overlap the output weight will be the sum of the "basis" output for the samples
belonging to multiple windows.
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3. Automatic Gain Control scaling

The AGC is a special case of the window scaling. In this case the window is defined
relative to the actual sample and the "basis" is the energy value in that sliding win-
dow. The window width is a total size, i.e. the relative width corresponds to +/- half
of the total window width. The low energy mute will mute the output samples that
have an energy lower than a ratio of the trace energy distribution: The energy of the
input trace is computed and the output values are sorted per increasing energy
value.

Given 1000 samples, the energy of sample 250 (for a low energy mute at 25%) cor-
responds to the mute level: If the energy computed in the AGC window is lower than
this level the value 0 will be output. Otherwise the sum of the squares over the num-
ber of (valid) samples will be output. Undefined values are not used for the com-
putation and a zero is output if all values of a time window are undefined. In other
words, the energy of all elements within the defined window are calculated and then
ranked, then the (user-defined) percentage of the lowest energy levels are muted
out.

4. Squeeze

The purpose is to put a limit to the value range of the input. Rather than clipping the
value (which would be equivalent to a simple Mathematics formula like 'x0 > c0 ? c0
: x0'), the value can be squeezed into a range.

The first parameter is the 'Value range'. it defines the hard limits to the value range.
One of these limits may be empty, signifying 'unlimited'.

The second parameter is the 'Untouched range'. If no limits are entered there,
Squeeze will degrade to a simple clipping operation. If specified, it will squeeze
rather than clip, constraining the squeezing to the ranges outside this range.
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For example, Value range [0,10] and untouched range [2,8]. Values outside the
[2,8] range will be modified to fit between [0,10]. This means the values in the range
[-infinitiy,2] will be squeezed into the range [0,2] via a hyperbolic function. That func-
tion is continuous in value (and first derivative) at 2. Similarly, values higher than 8
will go somewhere between 8 and 10.

Example application: predicted porosities. Predictions of porosity tend to have val-
ues below 0. To counter this, you could squeeze all values below 1%. Use value
range [0, ] and untouched range [1, ]. If you also want a more fuzzy upper limit, start-
ing at 25% to absolute maximum 30, you may specify [0,30] and [1,25].

This is shown in the attribute set below:

5. Gain Correction

This attribute is used to correct for any undesirable gain applied previously or to
apply a new gain function on the seismic data. This is applied by first selecting the
input data for gain correction and clicking on Analyse button.
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The newly popped Select data window requires specifying a number of random
traces in the 'Nr of Traces for Examination' field for visually analyzing and defining
the gain behavior in time/depth. The volume from which these random traces will be
selected is outlined by modifying the inline, crossline and time ranges. Finally, OK is
pressed to begin the examination of the random traces.

The Analyse Gain window has the 'Z' range (in seconds) of the seismic data as the
horizontal axis, while the left vertical axis shows the 'Scale Factor' and the right ver-
tical axis is the 'RMS Amplitude'. The amplitude scale can be set to 'Linear' or 'dB'
(i.e. decibel) for visualization purposes. Further, the 'Scale Range' could be
changed to use a different scale. The 'Gridline step' could be changed as the name
says to modify the gridline steps.
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Finally, a 'Gain correction trend' can be defined by moving the red curve such that
for any particular 'Z' interval a specific 'Scale Factor' range is used to scale the seis-
mic amplitudes in that interval. For defining boundary points of these intervals user
can double click on the red curve and move the curve as desired.

PressingOK will save the 'Gain correction curve'.
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11.24 Semblance
Name

Semblance -- Attribute that returns a value (semblance coefficient) which is a meas-
ure of multichannel coherence.

Description

Semblance is, essentially, a measure of how similar a particular trace is to a group
of traces within a user-defined correlation window. This attribute will calculate the
semblance coefficient and return a value between 0 (completely dissimilar) and 1
(identical). This is done by summing the squares of the energies within the stack
and dividing by the sum of those energies.

Whereas the Similarity attribute works by comparing pairs in given positions, Semb-
lance uses all points within the window to create the score.

Input Parameters

The size of the correlation window is defined by the Time Gate and Stepout, with the
'Extension' defining its shape.

Steering may be used to enhance the results, if the DipSteering plugin is installed
(with a valid license.)

Time-Gate:

Defines the size of the vertical element in the correlation window (ie: the trace length
to be used in the calculation).

Stepout:

Applies for 'Extensions' of shape Full block, Cross, All Directions and Diagonal.
Defines the extent of the horizontal element in the correlation window (see 'Exten-
sion' below for more detail).
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Trace Position:

Applies for 'Extensions' of shape None, Mirror 90 degrees and Mirror 180 degrees.
Defines the positions of the traces to be used in the correlation window (see 'Exten-
sion' below for more detail).

Extension shapes:

l None: Semblance is calculated using only the traces defined in 'Trace positions'.
l Mirror 90 degrees: Semblance is calculated using two additional traces: the defined
trace pair (as in 'None') and the trace obtained by 90° rotation. (Not available for 2D
data)

l Mirror 180 degrees: Semblance is calculated using two additional traces: the defined
trace pair (as in 'None') and the trace obtained by 180° degree rotation.

l Full Block: Semblance is calculated using all possible traces in the column defined by
the time-gate/step-out. Beware of potentially long processing times with large time-
gates/stepouts.

l Cross: Semblance is calculated using all possible traces in the '+' -shaped column
bounded by the time-gate/step-out.

l All Directions: Semblance is calculated using all possible traces in the '✴ ' -shape
bounded by time-gate/step-out. This is the extension found to be most useful: it gives a
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degree of accuracy almost equal to that of 'Full Block' but with significantly less pro-
cessing time (depending on the step-out, up to a factor of 10).

l Diagonal: Semblance is calculated using all possible traces in the 'x' -shaped column
bounded by the time-gate/step-out.

References

For a very concise explanation of semblance, please see: Dictionary: Semblance
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11.25 Similarity
Name

Similarity -- Multi-trace attribute that returns trace-to-trace similarity properties

Description

Similarity is a form of "coherency" that expresses how much two or more trace seg-
ments look alike. A similarity of 1 means the trace segments are completely
identical in waveform and amplitude. A similarity of 0 means they are completely
dis-similar.

In OpendTect, we favor a different approach. We first try to find the direction of best
match at every position, which is a result by itself: the dip. By using this dip we can
then calculate the best Similarity between adjacent traces. Similarity is based on fun-
damental mathematics: the samples of the trace are seen as components of a vec-
tor, and the Similarity is defined in terms of distance in hyperspace.

The point about using the Similarity is that it's mathematically simple; it is very clear
what is going on. Then, by combining different kinds of similarities and other attrib-
utes, you can always get much better results with lots less computing time.

Consider the trace segments to be vectors in hyperspace. Similarity is then defined
as one minus the Euclidean distance between the vectors, normalized over the vec-
tor lengths.

The trace segments is defined by the time-gate in ms and the positions specified in
relative coordinates. In case of using input from 2D data, the trace positions are
defined by a trace step-out only, not by inline and crossline stepout. The Extension
parameter determines how many trace pairs are used in the computation. This is
visualized in the image below.
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Definition of trace positions relative to the reference point at (0,0).

Input Parameters

Extension Definitions

l None: Only the similarity between the pair of traces defined in 'Trace positions' is cal-
culated.

l Mirror 90 degrees: Two similarities are computed: one for the defined trace pair (as in
'None') and one for the pair obtained by 90 degree rotation. (Not available for 2D data)

l Mirror 180 degrees: Two similarities are computed: one for the defined trace pair (as in
'None') and one for the pair obtained by 180 degree rotation.

l Full Block: Similarities between all possible trace pairs in the rectangle defined by the
step-out are computed.

l Cross: Similarities between all possible trace pairs in the '+' -shape defined by the
step-out are computed.

l Diagonal: Similarities between all possible trace pairs in the 'x' -shape defined by the
step-out are computed.
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l All Directions: Similarities between all possible trace pairs in the ' ' -shape defined by
step-out are computed. This is the extension found to be most useful: it gives a degree
of accuracy almost equal to that of 'Full Block' but with significantly less processing
time (depending on the step-out, up to a factor of 10).

The attribute returns the statistical property specified in Output statistic. The Steer-
ing option enables the user to follow the local dip to find trace segments that should
be compared instead of comparing two horizontally extracted trace segments. The
Steering option supports five different modes of data-driven steering: None, Central,
Full, Constant direction Steering and Browse dip.]

Similarity "None" Steering: This option is used when non SteeringCube algorithm is
used. This is ok in the case the layering is mainly horizontal (with less dip).

However, in very complex geology, the similarity result using "None" as steering
option will deteriorate. Full steering should be used instead. The Dip-Steering plugin
is required.
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Another steering option to use is the "Browse dip". This is a similarity feature acting
as a 'Coherency' attribute.

It enables the calculation of 'Similarity' by comparing one trace with the next trace.
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Then a value between 0 (not similar at all) to 1 (completely similar) is awarded. In
order to compare traces, two variables should be specified:

The 'Maximum dip' represents the maximum dip in microseconds per metre (μs/m),
relative to an event in one trace, in which the algorithm will look for similar events
along the neighbouring trace. Default is 250.

The "Delta Dip" is a variable which represents the window in microseconds per
metre (μs/m) which is shifted along the neighbouring trace to detect similar events
whithin the earlier specified 'Maximum Dip'. The closer the value to 1 the more pre-
cise the results will be. The default value is 10. Using this value will result in a good
balance between calculation time and quality of the results, this also depends on the
quality of the data itself.

Mathematical description

The similarity function has as input two vectors with the same dimension N.

N is the vertical running window length of the similarity attribute in samples, thus N =
(timegate_max - timegate_min) / sample interval + 1

The similarity is 1 minus the Euclidean distance between the vectors divided by the
sum of the length of each vector.

Please note that the length of a vector is its L2 norm, also called RMS value:
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Examples

An example timeslice is highlighting fault structure: (a) Dip-steered Filtered Seismic,
(b) Non-Steered minimum Similarity, (c) Steered minimum Similarity. Notice that the
definition of faults has been improved with the Similarity attributes. The steered min-
imum Similarity (c) is highlighting precise fault definitions as compared with the res-
ult of non-steered minimum Similarity (b).
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11.26 Spectral Decomposition
Name

Spectral decomposition -- Frequency attribute that returns the amplitude spectrum
(FFT) or wavelet coefficients (CWT)

Description

Spectral Decomposition unravels the seismic signal into its constituent frequencies,
which allows the user to see phase and amplitude tuned to specific wavelengths.
The amplitude component excels at quantifying thickness variability and detecting
lateral discontinuities while the phase component detects lateral discontinuities.

It is a useful tool for "below resolution" seismic interpretation, sand thickness estim-
ation, and enhancing channel structures.

Input Parameters

The user can choose between two types of transform:

l FFT the Fast Fourier Transform. The FFT requires a short window (time-gate) and a
step-size between the analyzed frequencies. This step can be interpreted as the fre-
quency resolution.

l CWT the Continuous Wavelet Transform. The CWT requires a wavelet type.

When choosing the CWT, you can set the wavelet type:

l Morlet
l Gaussian
l Mexican Hat
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In FFT only, the signal within the time-window will be transformed into frequency
domain. The given step determines the output resolution, if necessary zeros will be
added to acquire this resolution. The amplitude spectrum is calculated for the
requested frequency. The time-window slides from top to bottom to cover the com-
plete signal. In an ideal situation, the time-window encompasses one seismic event,
which may be a superposition of multiple geological events which interfere in the
seismic trace.

Output and Examples

The CWT is defined as the sum over the signal multiplied by a scaled and shifted
wavelet. The wavelet is shifted along the signal and at each position the correlation
of the wavelet with the signal is calculated. The result is called a wavelet coefficient.
The given frequency corresponds to the central wavelet frequency. The step determ-
ines the output resolution, which is especially interesting when evaluating this attrib-
ute.
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Spectral Decomposition (CWT) applied to a horizon. Notice that each index fre-
quency is describing the specific parts of channels (NNE-SSW oriented). Also thin-
ner and thicker parts of horizon along channels are highlighed clearly.
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Time-frequency spectrum

The output frequency is best determined using the time-frequency spectrum panel.
This panel displays the spectral decomposition output for all frequencies between 0
and the Nyquist frequency of the data, computed with a step of 1Hz. One must first
select a position for this single trace analysis:
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The time-frequency is then displayed in a 2D panel like this:
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Color blended display:

RGB(A)* blending attribute display is used to create a normalized color-blended dis-
play that often show features with greater clarity and enhances a detail map view.
Traditionally, it is used to blend the iso- frequency responses (Spectral Decom-
position), but a user can blend three/four different attributes that define a spectrum
that is comparable. For instance, spectral decomposition outputs the amplitude at
discrete frequencies. So, it renders the same output (unit=amplitude). Depending
upon a geological condition or the objective, FFT short window or CWT (continuous
wavelet transform) can be chosen. Results are best displayed on time/horizon
slices, volume.

(* RGB(A)- Red, Green, Blue, (Alpha) -channel)

A color blended map view (image on right) of the spectral decomposition (red-10hz,
green-20Hz, blue-40hz). Compare the results with the coherency map (image on
left). Note that the yellowish colored fault bounder region is thicker as compared to
the surrounding regions. The faults throw (red-color) are also clearly observable.
Coherency/similarity together with color blended spectral images can reveal better
geological information.
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11.27 Texture
Name

Texture -- Group of attributes that return statistical properties of a Grey-Level Co-
occurrence Matrix (GLCM)

Description

The texture attributes implemented in OpendTect are described in detail in the
GLCM Texture Tutorial by Mryka Hall-Beyer.

GLCM texture attributes come from image processing and were developed to cap-
ture roughness / smoothness of an image. The attribute response is calculated in
two steps: First the GLCM is computed for an area (volume) around the evaluation
point. Secondly a statistical property from the GLCM is returned. The GLCM is a 2D
matrix that captures how often the neighbor values A and B occur in an image. Look
at the GLCM as a matrix of N x N dimensions that captures the amplitude response
of the reference position in the columns and the amplitudes of the neighboring pos-
ition in the rows. N is the range of all values the data can have. Let's say we have a
data set in which amplitudes can have values 0,1,2,or 3 (GLCM matrix is 4 x 4). We
then fill the matrix by comparing each amplitude in the input area (volume) with its
direct neighbor and increase the occurrence of the corresponding matrix cell. The
matrix is made symmetrical by comparing neighbors in both directions: reference vs
neighbor and neighbor vs reference, and it is normalized by dividing through the
total number of occurrences. The normalized GLCM matrix is a kind of a probability
matrix that tells us how probable it is to find pairs of neighboring amplitudes in the
area (volume) around the evaluation point.

In OpendTect the GLCM is computed on re-scaled data. The input data is re-scaled
linearly to 4-bits (values ranging from 0 to 15; GLCM 16 x 16), or to 5-bits (values
from 0 to 31; GLCMmatrix 32 x 32). To re-scale the data the user must give the clip-
ping range of the input data. Neighbors are compared in the inline and cross-line dir-
ections. The matrix is further filled by looping over the user-defined time-gate. Note
that when dip-steering is used the input extraction area (volume) follows the local
stratigraphy, which leads to better responses in dipping strata.

Texture attributes in seismic interpretation are typically used in facies analysis.
They can be used in their own right, or (when you have access to the Neural Net-
work plugin) as inputs to a neural network to create 3D seismic facies volumes. This
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can be done in a supervised approach (MLP network), or in an unsupervised
approach (UVQ network).

Input Parameters

Time-gate, step-out and Dip-steering (optional; requires Dip-steering plugin) set-
tings determine the input area (volume) for which the GLCMmatrix is computed. Lar-
ger step-outs results in smoother outputs that will follow the stratigraphy better if
dip-steering is used.

GLCM-size is the size of the GLCMmatrix. 32 x 32 may give somewhat sharper out-
puts at the expense of more CPU time.

Input Data Minimum and Maximum define the clipping range of the data, which is
needed to rescale the data to 4-bits (16 x 16), or 5-bits (32 x 32).Input data range is
automatically calculated from the compute option.In the "analysis" window number
of traces need to be selected which computes the scaling range from the selected
input traces.

Output

OpendTect supports three groups of Texture Attributes:

1. Contrast group: Measures related to contrast use weights related to the distance from
the GLCM diagonal along which neighboring values are equal. Attributes in this group:
Contrast, Dissimilarity, Homogeneity
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2. Measures related to orderliness. Attributes in this group: Angular Second Moment
(ASM), Energy, Entropy

3. Group using descriptive statistics of the GLCM texture measures. Attributes in this
group: GLCMMean, GLCM Variance, GLCM Standard Deviation, GLCM Correlation

In all equations given below N denotes the size of the GLCM matrix; i refers to the
column and j to the row. P is the GLCM Probability matrix.

Contrast

When i and j are equal, the cell is on the diagonal and (i-j)=0. These values rep-
resent amplitudes entirely similar to their neighbor, so they are given a weight of 0.

If i and j differ by 1, there is a small contrast, and the weight is 1.

If i and j differ by 2, contrast is increasing and the weight is 4.

The weights continue to increase exponentially as (i-j) increases.

Dissimilarity

In Dissimilarity the weights with which GLCM probablities are multiplied increase lin-
early away from the diagonal (along which neighboring values are equal).

Homogeneity
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Dissimilarity and Contrast result in larger numbers for more contrasting windows. If
weights decrease away from the diagonal, the result will be larger for input areas
(volumes) with little contrast. Homogeneity weights values by the inverse of the Con-
trast weight, with weights decreasing exponentially away from the diagonal.

Angular Second Moment

ASM and Energy use the GLCM probability as a weight for itself. The name for ASM
comes from Physics, and reflects the similar form of Physics equations used to cal-
culate the angular second moment, a measure of rotational acceleration. High val-
ues of ASM or Energy occur when the input area (volume) is very orderly.

Energy

See above.

Entropy

Entropy is the opposite of energy; it is a measure of chaos. In physics (ther-
modynamics) entropy refers to the quantity of energy that is permanently lost to
heat ("chaos") every time a reaction or a physical transformation occurs. Entropy
cannot be recovered to do useful work. Because of this, the term is used in non tech-
nical speech to mean irremediable chaos or disorder. Also, as with ASM, the
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equation used to calculate physical entropy is very similar to the one used for the
texture measure.

GLCM Mean

The left hand equation calculates the mean based on the reference pixels, i. The
right-hand equation calculates the mean over the the neighbor pixels, j. These two
values are identical because OpendTect computes a symmetrical GLCM, where
each amplitude is counted once as a reference and once as a neighbor.

GLCM Variance

Variance is a measure of the dispersion of the values around the mean. It is similar
to entropy. It answers the question "What is the dispersion of the difference
between the reference and the neighbour pixels in this input area (volume)?"

GLCM Variance in texture measures performs the same task as does the common
descriptive statistic called variance. It relies on the mean, and the dispersion around
the mean, of cell values within the GLCM. However, GLCM variance uses the
GLCM, therefore it deals specifically with the dispersion around the mean of com-
binations of reference and neighbor amplitudes, so it is not the same as variance of
input amplitudes that can be computed with the "Volume Statistics" attribute.

Variance calculated using i or j gives the same result, since the GLCM is sym-
metrical.

GLCM Standard Deviation
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There is no particular advantage to using Standard Deviation over Variance, other
than a different range of values.

GLCM Correlation

The Correlation texture measures the linear dependency of input amplitudes on
those of neighboring amplitudes.

GLCM Correlation is quite a different calculation from the other texture measures
described above. As a result, it is independent of them (gives different information)
and can often be used profitably in combination with another texture measure. It
also has a more intuitive meaning to the actual calculated values: 0 is uncorrelated,
1 is perfectly correlated.

GLCM Correlation can be calculated for successively larger window sizes. The win-
dow size at which the GLCM Correlation value declines suddenly may be taken as
one definition of the size of definable objects within an image.

If the input is completely uniform the GLCM variance is 0 and the correlation func-
tion is undefined. OpendTect will in that case return the value 1.

Examples

DS in the examples below stands for Dip-Steering.
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Seismic
Contrast: 3 x 3 x [-
8,8], DS

Dissimilarity: 3 x 3 x
[-8,8], DS

Homogeneity: 3 x 3 x [-
8,8], DS

ASM: 3 x 3 x [-8,8],
DS

Energy: 3 x 3 x [-
8,8], DS
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Entropy: 3 x 3 x [-8,8]
GLCM Mean: 3 x 3 x
[-8,8], DS

GLCM Variance: 3
x 3 x [-8,8], DS

GLCM Standard Devi-
ation: 3 x 3 x [-8,8]

GLCM Correlation: 3
x 3 x [-8,8], DS

References
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l Chopra, S. and Alexeev, V., 2005. Application of texture attribute analysis to 3D seis-
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l Hall-Beyer, M. GLCM Texture Tutorial. Available: Online [Accessed 9 Oct. 2012].
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11.28 Texture - Directional
Name

Texture - Directional -- a multi-trace attribute that returns textural information based
on a statistical texture classification.

Description

Texture- Directional uses the grey level co-occurrence matrix (GLCM) and its
derived attributes are tools for image classification that were initially described by
Haralick et al. (1973). Principally, the GLCM is a measure of how often different com-
binations of pixel brightness values occur in an image. It is a method widely used in
image classification of satellite images (e.g. Franklin et al., 2001; Tsai et al., 2007),
sea-ice images (e.g. Soh and Tsatsoulis, 1999; Maillard et al., 2005), magnetic res-
onance and computed tomography images (e.g. Kovalev et al., 2001; Zizzari et al.,
2011), and many others. Most of these GLCM applications are for classification of
2D images solely. The application of GLCM for seismic data has been a minor topic
in comparison to common seismic attributes such as coherence, curvature or spec-
tral decomposition. Today, a high percentage of the available seismic data is 3D
seismic. Therefore, it is important for the classification of seismic data to adapt the
GLCM calculation to work in the three- dimensional space. Few authors have
described the application of GLCM for 3D seismic data with various approaches to
this topic (Vinther et al., 1996; Gao, 1999, 2003, 2007, 2008a, 2008b, 2009, 2011;
West et al., 2002; Chopra and Alexeev, 2005, 2006a, 2006b; Yenugu et al., 2010;
de Matos et al., 2011; Eichkitz et al. 2012, 2013, 2014).

The calculation of GLCM-based attributes can be done in separate space dir-
ections. For the 2D case 4 space directions exist. For the 3D case the number of
possible space directions is extends to 13. The principal workflow of GLCM-based
attribute calculation consists of transformation of the amplitude cube into a grey
level cube, the counting of pixel co-occurrences within in a given analysis window,
and the calculation of attributes based on the co-occurrence matrix. In Figure 1 the
principal calculation of 2D GLCM in four space directions is shown for a sample
image.



- 998 -



- 999 -

Figure 1: Example for the calculation of grey level co-occurrence matrix-based attrib-
utes using eight grey levels for a randomly generated 2D grey-scale image (a). The
grey-scales of the image can be represented by discrete values (b). The number of
co-occurrences of pixel pairs for a given search window are counted and a grey
level co-occurrence matrix (c) is produced. Based on this co-occurrence matrix, sev-
eral attributes can be calculated. In this example, the grey level co-occurrence
matrices are determined for the horizontal (d), the vertical (e), the 45° diagonal (f),
the 135° diagonal (g), and for all directions at once (h). The first step in calculation is
the determination of co-occurrences (column 2). Zero entries are marked in light
grey and the highest value of each matrix is marked in dark grey. It is evident that
calculations in single directions lead to sparse matrices. The GLCM is normalized
by the sum of the elements to get a kind of probability matrix (column 3). Finally, the
probabilities are used for the calculation of GLCM-based attributes. In column 4 the
results for Entropy, Contrast, Homogeneity, Entropy, and Cluster Tendency are
shown.

In the case of 3D data the number of possible directions increases to 13. In Figure 2
a simple Rubik’s cube is taken to explain the 13 possible directions for a 3D dataset.
This Rubik’s cube is build-up of 27 small cubes. The small cube in the center (the
turning point in a Rubik’s cube) is the point of interest for which the calculations are
performed. This center point is surrounded by 26 neighboring cubes. If we now take
the center point and draw lines form it to all neighboring cubes, we get 13 directions
on which the neighboring samples are placed.
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Figure 2: The number of principal neighbors for one sample point can be best
explained by looking at a Rubik’s cube (a). The center of the Rubik’s cube (core
mechanism for rotating the cube, red box in (b)) has in total 26 neighboring boxes
(including diagonal neighbors). These boxes are aligned in 13 possible directions.
Analogous to this, a sample point within a seismic sub-volume has 26 neighbors
aligned in 13 directions (c). In the developed workflow it is possible to calculate the
GLCM along single directions, along combinations of directions (e.g. inline dir-
ection, crossline direction, …), or all directions can be calculated at once (after Eich-
kitz et al., 2013).

Input Parameters

Input Data

The input for the GLCM-based attribute calculation can be any seismic amplitude
3D cube/2D section. In the process of GLCM calculation this amplitude cube is con-
verted to a grey level cube.

Compute Amplitude Range

For the transformation of the amplitude cube to a grey level cube the range of the
amplitude values is needed. This can either be inserted manually, or be computed.
In the case of computed amplitude range, the amplitude range will be symmetrical
around zero.

Number of Grey Levels

The number of grey levels used for the transformation of amplitude cube to grey
level cube. Higher numbers generally improve the quality of the GLCM output. Com-
mon numbers for the grey levels are 16 to 256.

Number of Traces

The number of traces defines the horizontal analysis window. This horizontal ana-
lysis window is always symmetrical around the center trace. Number of traces equal
1 means 1 trace left and right of the center trace (thus 3 traces).

Vertical Search Window

The vertical search window defines the number of samples included in the search
window. The vertical size of the analysis window should be according to the aver-



- 1002 -

age wavelength (Gao, 2007). This is typically in the range of 15 samples (+/- 7
samples).

GLCM Attribute

In total 23 GLCM-based attributes can be calculated (see below in Mathematical
description)

Direction of Calculation

The GLCM-based attribute calculation can in principal be done in 13 space dir-
ections for 3D input data (4 space directions for 2D data). The algorithm allows the
calculation in single directions or the combined calculation of several directions
(inline, crossline, time-/depthslice) or all 13 space directions can be calculated at
once. Multiple directions give smoother results, but subtle features might be missed.
Detailed analysis of single directions might give information about fracturing or
facies distribution of the subsurface.

In this process azimuth of 0° is equal to inline direction; azimuth of 90° is equal to
crossline direction. Dip of 0° is equal to horizontal direction, dip of 90° is equal to ver-
tical direction.
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Figure 3: Definition of directions.

Steering

GLCM attribute calculation can be done with or without steering. The integration of
dip steering generally improves the signal-to-noise ratio in calculated attributes.
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Figure 4: Texture attribute window within OpendTect.

Mathematical description

The GLCM is a measure of how often different combinations of neighboring pixel val-
ues occur within an analysis window. For a 2D image the immediate neighboring
pixels can be in four different directions (0°, 45°, 90°, and 135°). For the calculation
of 2D GLCM the following equation is used:

where i and j vary from 1 to Ng (number of grey levels).
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In this equation G(x,y) are the center sample points and G(x+dx, y+dy) are the
neighboring sample points. Usually, the distance between center and neighboring
samples is one, but in general greater distances could also be taken for the cal-
culation. It is, in principal also possible to combine the four principal directions to
form an average GLCM. By this approach the spatial variations can be eliminated to
a certain degree (Gao 2007). In the case of 3D data the number of possible dir-
ections increases to 13. The 3D case implies a modification of the above given equa-
tion:

Similar to the 2D case, it is possible to calculate the GLCM in single directions, to
combine several directions, or to calculate an average GLCM. Previous works on
3D GLCM calculation use 2D GLCM calculations in various directions and combine
the results of these calculations to form a pseudo-3D GLCM attribute cube.

Based on the grey level co-occurrence matrix, it is possible to calculate several
attributes. Haralick et al. (1973), in their work, describe 14 attributes that can be cal-
culated from the GLCM. In literature a few more attributes based on the GLCM have
been developed (e.g. Soh and Tsatsoulis, 1999; Wang et al., 2010). For the cal-
culation of any of these GLCM-based attributes it is necessary to normalize the
GLCM to generate a kind of probability matrix. This is done by dividing each matrix
entry by the sum of all entries. The different GLCM-based attributes can be divided
into three general groups. The first group is the contrast group and includes meas-
urements such as contrast and homogeneity. All the attributes from this first group
are basically a function of the probability of each matrix entry and the difference of
the grey levels (i and j). Therefore, these contrast group attributes are related to the
distance from the GLCM diagonal. Values on the diagonal (where i and j are the
same) result in zero contrast, whereas the contrast increases by increase of dis-
tance from the diagonal.

The second attribute group is the orderliness group, which includes attributes such
as energy and entropy. Attributes in the orderliness group measure how regular
grey level values are distributed within a given search window. In contrast to the first
group all attributes from this group are solely a function of the GLCM probability
entries.
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The third attribute group is the statistics group, which includes attributes such as
Haralick et al.’s (1973) measure of mean and variance. These are common mean
and variance calculations applied onto the GLCM probabilities.

The following tables summarize all GLCM equations:
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Examples
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11.29 Volume Statistics
Name

Volume statistics -- Attribute that returns statistical properties

Description

This attribute extracts data from a cube or line using a small 3D probe and returns a
statistical property from the samples collected.

Input Parameters
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The probe is defined using relative times/depths and trace stepouts with respect to
the actual location. The probe shape can be set by the shape field. Supported
probes are:

l Cube: The three dimensions listed above define the 3D cube.
l Cylinder: The cylinder option requires the same settings as the cube, but traces out-
side of the ellipsoid will not be used.

l Optical stack: The probe is not 3D but a 2D vertical plane in the direction of the data, or
perpendicular to it. This settings is useful only when applied on random lines where the
azimuth is different from the inline and crossline direction.

Please note that the probe direction can be reduced by using:

l A [0,0] time gate: The probe becomes a flat rectangle or disk. Only one sample per
trace is used at the actual time/depth.

l A 0 stepout: Only one sample is used in one or both directions.

Output

The following statistical properties can be output:

l Average
l Median
l Min, Max, Sum
l Variance
l Norm Variance
l Most Frequent
l RMS: Root Mean Square

Undefined values collected by the probe will not be used for the computation. In the
case of a stack only the valid values will define the number of values.
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12 Appendix B - Command
Driver Manual

l Introduction
l Command Driver control window
l Execution from the command line
l Window management
l Search keys
l Identifiers and expressions
l Command specifications
l Expressional specifications
l Repetitive task example
l Standard test scripts
l User history recording

Introduction

Around 2006, it became clear that OpendTect was growing so fast that extensive
testing of every part was becoming a real big task. This is a well known issue in the
Agile development literature. The usual approach is to implement automated test-
ing.

When designing the implementation, the main issues we had to cope with were:

l A dynamic user interface that is defined by relations between fields. Therefore, the
exact layout of windows can change considerably by small changes

l Small changes or fixes in algorithms can produce slightly different outputs for the same
input

l A test system should be programmable, not just be a replay of previously run tasks

Therefore, we couldn't use approaches based on replay of clicks, or comparison of
outputs with known previous runs. Instead, we create a series of screen snapshots
that can quickly be inspected by the test manager.

This resulted in a Command Driver based on the following principles:

l Fields are addressed by names, wildcards supported
l Operations are defined to select, fill, push, manipulate, ...
l Additional flow control operations can be used
l Scripts can call other scripts
l Variables can be set or used from the environment
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Examples:

ListClick "Calculated attri*" "F03-2" Double

Include "$SCRIPTSDIR$/EvalutionEnergyAttrib.odcmd"

Almost immediately we noticed that finding out the names of the fields was very
hard without some tool. Therefore, we made the 'Tooltip name guide', which will put
OpendTect in a state where the name of a field is shown as a tool tip (overriding any
existing tool tip). When it became clear that our automated test facility would be
used as a scripting system for power users, we implemented a tool to record
actions.

A webinar held in March 2010 gave an extensive overview on the use of
OpendTect's Command Driver plugin. A forty-minutes flash video is available here:
Command Driver webinar

The Command Driver control window

Provided that the CmdDriver plugin has been (auto)-loaded, one can access the
Command Driver control window in two ways. Firstly, it can be launched from the
menu bar of OpendTect Main Window:

Utilities->Tools->Command Driver ...

Secondly, this so-called Command Controller also pops up when pressing Ctrl-R
with the mouse pointer inside any OpendTect window or dialog. This is particularly
useful if the Command Driver menu bar is greyed out or menu access is blocked
after a modal dialog has been popped up. Only a few Qt-borrowed QDialogs like the
QMessageBox, QFileDialog and QColorDialog will nevertheless prevent any user
input to the Command Controller, and have to be clicked away first.
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"Command Controller (Ctrl-R)"-window in run-mode and record-mode respectively.
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The Command Controller has a combobox to switch between two appearances.
One for running and one for recording a command file. The TooltipNameGuide
checkbox can be (un)checked at both appearances. It sets a tooltip mode that dis-
plays the hidden name of any uiObject pointed to. Tooltip names are displayed
double-quoted on a cyan background. Go to the Survey->Select/Setup window for a
small demo-example. Click the '(X,Y) <=> I/C' -button and unveil the hidden names
of buttons and input fields with your mouse pointer. OpendTect (plugin) developers
might have a look in the file $WORK/src/uiIo/uiconvpos.cc to see how these names
are annotated in the code.

Running the Command Driver requires selecting an input command file with the
extension '.odcmd', or the obsolete '.cmd'. Filenames without a full path are defined
relative to the 'Proc'-directory of the current survey. The 'Edit'-button launches a
simple text editor to view and edit the input command file directly from OpendTect.
One can also specify an output log file to have the Command Driver write its pro-
gress and error messages. The 'Examine'-button launches a scroll window to view
this log file even while running. The Command Driver starts running when pushing
the 'Go'-button, after which 'Pause' and 'Abort'-buttons allow a temporary stop or
premature termination.

The Command Recorder is able to record a sequence of user interface actions per-
formed by the user. One has to specify an output command file with the extension
'.odcmd'. Filenames without a full path are defined relative to the 'Proc'-directory of
the current survey. The 'Examine'-button launches a scroll window to view which
commands are written during recording. Recording starts after pushing the 'Start'-
button. Next perform a sequence of user actions and push the 'Finish'-button. The
Command Controller will automatically switch to run-mode afterwards, so that one
can play back the recorded script in order to verify its correct operation. View the log
file for eventual errors. Finally, the recorded script can be edited to avoid these
errors, improve robustness and general applicability, and insert auxiliary com-
mands.

Executing scripts from the command line

One does not necessarily have to run a command script from OpendTect's user
interface. One or more scripts can also run straight from the command line, and with
that they might be called from shell scripts as well. An example of the command line
syntax on Linux:

start_dtect --cmd /full_path_1/my_script_1.odcmd ... /full_
path_N/my_script_N.odcmd
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This line opens a new instance of OpendTect and starts running the given scripts in
there. OpendTect will not automatically close when all scripts are finished. If neces-
sary, this must be done from the last script using the 'Close All' command. Note that
command line execution is only possible if your OpendTect auto-loads the Com-
mand Driver plugin at startup.

The user can also create command scripts named autoexec.odcmd. If available,
these scripts will be run at start-up before any script specified on the command line.
The first autoexec-script to be run is searched in the settings directory. This is the
.od subdirectory of your personal home directory, unless the DTECT_SETTINGS or
DTECT_WINSETTINGS environment variable specifies otherwise. The second auto-
exec-script to be run is searched in the Proc directory of the start-up survey. Next,
the command line scripts will be run in order. Moreover, every time a new survey is
selected in OpendTect, the Proc directory of this new survey will also be searched
for an autoexec-script to be run at that moment.

Apart from the availability of autoexec-scripts, their execution can always be dis-
abled by adding - - noautoexec, - - nosettingsautoexec or - - nos-
urveyautoexec as an extra argument on the command line. Command line
argument --cmdlog /full_path/my_odcmdlog.txt will override the location
of the output log file. Its default name is odcmdlog.txt and it is located in the
Proc directory of the start-up survey, if writable, or in the personal user directory oth-
erwise.

To run a command file other than autoexec.odcmd on Windows, one has to cre-
ate a DOS batch file. That file must contain a command line similar to this:

X:\full_path_0\bin\win64\od_main --cmd "X:\full_path_1\my_
script_1.odcmd" ...

Go to your OpendTect installation folder to ascertain the right name and location of
the OpendTect executable (i.e. which disk, bin-path, win32 / win64, and '.exe'-file
name?). Executing your DOS batch file will open a new instance of OpendTect and
run the given script at startup.

Window management

Commands always apply to the current window. This is OpendTect Main Window
when starting the driver. Any modal window popping up will automatically become
the current window. Modeless windows that pop up can be appointed current win-
dow by using the Window-command. In case a modal current window closes, its par-
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ent will become the current window. If a modeless current window closes, the latest
former current window still existing will be restored as current window.

Subwindows in the workspace of another window cannot become current window.
No commands can be addressed to the progress window popped up by a
uiTaskRunner, since the driver will await its decease before executing a next com-
mand. Neither addressible are the Command Controller window and its des-
cendants.

QDialog windows popping up are a special case. OpendTect is borrowing the QMes-
sageBox, QFileDialog, QFontDialog, and QColorDialog from Qt. It is impossible for
the command driver to manipulate the contents of these windows. The only QDialog
parts that can be manipulated by the driver are those buttons resulting in closing the
QDialog. One may use the standard commands Button, Ok, Cancel and Close for
this aim. The special commands ColorOk, FileOk and FontOk will be available to
specify the desired color, file, or font from the command script directly, meanwhile
closing the QDialog.

Neither can the command driver manipulate the contents of windows popped up by
batch programs that were launched from OpendTect. An example of this is the
multi-machines processing window. Except for manual intervention, there is no
workaround yet.

A higher form of window management is provided by the so-called window asser-
tions. These are square-bracketed window names in between the command lines.
All commands succeeding a window assertion are expected to be executed in the
asserted window. If the current window does not match the latest window assertion,
this results into the detection of an error. A window assertion is cancelled either by
the next window assertion or by an empty assertion: [].

The benefit of window assertions is in error recovery. If OpendTect does not pop up
a window that was expected by the command file or does pop up a window that was
not expected by the command file, the Command Driver is able to proceed under
guidance of these window assertions. This already solves a lot of cases in which the
flow of OpendTect happens to be mildly data or environment dependent. For
example, if an error message like "File already exist! Overwrite?" appears but is not
handled in the command file (or the other way around), the Command Driver can
continue as it was most probably intended by the user: close the window and write
the file. Another example is any command to switch on/off a button or menu item. If
it happens to be switched on/off already, window assertions enable the Command
Driver to skip all commands following from that switch as well.
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Although not compulsory, it is advised to make systematical use of window asser-
tions. It also improves the readability of your command file. See any file generated
by the Command Recorder to get an idea.

When using window assertions in combination with control flow commands, the
most easy-going and efficacious method is having each individual command (If,
ElseIf, Then, Fi, For, Rof, DoWhile, Od, Do, OdUntil) both preceded and succeeded
by the window assertion in force. Wrongly omitting a window assertion around a con-
trol flow command will not result in an assertion violation error, but it does severely
reduce the possibilities of the Command Driver to recover in case of other errors.
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Search keys

Many commands supported by the Command Driver use search keys to address
window names, names of buttons, input fields and other GUI-elements, item names
of menus, lists, trees and tables, etc. The matching of these search keys is strict
where necessary and accommodating where practical. The matching process hon-
ors the following principles:

The asterisk '*' is used as a wildcard character. It may appear any number of times
in the search key to match an arbitrary substring.

Any sequence of white space characters like spaces, tabs, newlines, etc. will be
removed at the beginning and at the end of both the match name and search key,
and compressed into one single space when found in between.

The ellipses found at the end of menu item names and button texts are ignored. Any
dot after the last non-white space character of the match name and search key is
removed.

Underscores denoting keyboard shortcuts in menu item names, tab item names and
button texts are ignored. The ampersands denoting these shortcuts in Qt-interface
programming code should not appear in your search key, unless you want to match
an actual ampersand of course.

If the name to match contains a symbol interpreted by the Command Driver as
something special, the symbol must be preceded by the escape character '@' in
your search key. Symbols for which this may apply include '*', '#', '$', '`', '"', '[' and ']',
depending on the context in which the search key occurs. Escaping of symbols that
do not have a special meaning is unnecessary but harmless. In the rare case that
the match name happens to contain '@' characters preceding a symbol, these them-
selves have to be escaped in the search key. Alpha-numerical and white space char-
acters are not considered symbols, so a single '@' character in a search key like
"jaap.glas@dgbes.com" does not have to be escaped.

One example to demonstrate the use of escape characters. The table column
header "* [All lines]" will be matched exactly by the search key "@* [All lines]". The
asterisk must be escaped to prevent it from being interpreted as a wildcard for post-
fix matching, while the brackets do only need escapes when occurring inside win-
dow assertions.

Any pair of bracket-like characters enclosing a name to match are ignored, unless
the search key does explicitly specify them. Outer character pairs that may be
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stripped include "...", [...], <...>, and >...<. This matching protocol is recursive. If the
match name and search key do not match, eventual outer brackets of the match
name are removed, and the whole matching process is repeated.

The Case-command allows the user to determine whether upper-case and lower-
case alphabetical characters will match each other. The default is case-insensitive.

Identifiers and expressions

Command scripts may contain identifiers to store data and (re)use its values. Every
identifier consists of a letter followed by any sequence of letters, digits and under-
scores ('_'). Identifiers are treated case insensitive. Identifiers can represent con-
stants, script variables, environment variables, built- in function names, or user-
defined procedure names.

The Command Driver has only one internal data type. All identifier values are rep-
resented as character strings. The string can be a boolean value, an integer value
(even octal or hexadecimal), a fixed or floating point value, one single character or
indeed a whole character string. The operator or built-in function using the identifier
will define into which data type the string has to be converted, and will produce an
error if the conversion fails. User-defined procedures should do the same. Boolean
values are actually mapped onto numbers, where 0 is false and 1 is true, and any
other number is also interpreted as true.

Predefined identifier constants include FALSE==0, TRUE==1, PI==3.14159265...,
and UNDEF==1e30. Command actions may assign either SUCCESS==1,
FAILURE==0, or WARNING==-1 as return value. Any 'Is...On'-question command
returns ON==1, OFF==0, or UNSWITCHABLE==-1 as an answer.

Expressions are assembled from identifiers, numbers, string constants ( "..." ), par-
entheses, built-in functions, and about twenty mathematical and logical operators
(see Expressional specifications). The assign command ( <ident> = <expr> ) stores
the evaluated result of an expression into an identifier.

The value of an identifier can be substituted anywhere in the command script by put-
ting the identifier between dollar-signs ( $<ident>$ ). Identifier substitution is the
only and most flexible method to give command actions a variable meaning. Mul-
tiple substitutions in one command are allowed, but nested substitutions will be mis-
interpreted. Assign the result of the inner substitution to an auxiliary identifier, and
use that one in the outer substitution.
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In order to keep the parsing of command actions tractable, few commands will dir-
ectly accept expressions as argument(s). Apart from the assign command, the only
ones are control flow commands: If, ElseIf, For, DoWhile, OdUntil, Return, and any
user-defined procedure call with value parameters. If you want to use an expression
in an arbitrary command action, assign the expression result to an identifier and sub-
stitute its value.

Identifier substitution can also be used to simulate array variables (e.g. array
[index]). The Command Driver does not explicitly support them, but index sub-
stitution can be applied for that purpose: array_$index$.

The predefined directory identifiers BASEDIR, DATADIR, PROCDIR, APPLDIR,
USERDIR, SCRIPTSDIR, SNAPSHOTDIR, IMPORTDIR and EXPORTDIR are
environment variables that can be substituted in file-path specifications. Their pur-
pose is defining a file-path relatively to either OpendTect, the current survey, user
directories, etc. The Command Driver will automatically change Unix-style file-paths
into Windows-style file-paths on Windows-platforms and vice versa. The special
identifier FILEIDX represents an integer variable that is automatically incremented
after every occurrence in the command stream. It may be substituted in file-paths to
generate unique filenames, although meanwhile more sophisticated methods exist
as well (see Repetitive task example).

The scope of any identifier used in the body of a command script is global. The
scope of any identifier used inside a user-defined procedure is local by default, and
may shadow a global identifier with the same name. Attach the scope operator '@'
in front of an identifier to force access to its global namesake. That is all for
(re)assigning an identifier or (re)defining a procedure. Two extra scope rules apply
for reading an identifier or calling a procedure. If an unscoped identifier value is loc-
ally undefined, the search will continue at the global scope level directly. If an
unscoped procedure call is locally undefined, the search will continue at the pre-
vious scope level, and recursively descend to the global level as long as no defin-
ition is found.

Command specifications

Any text editor can be used to produce or modify OpendTect scripts. Every com-
mand file has to start with the following four-lines header. The correctness of ver-
sion number, date and time is not vital for a successful execution of the command
file.

dTect V4.0

OpendTect commands
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Mon Apr 20 09:20:09 2009

!

The Command Driver expects one command per line and one line per command by
default. Multiple commands on one line must be separated by a semicolon (';'). Long
commands exceeding the width of one line may be broken by adding a backslash
('\') as last non-white character on the line. Never put a break before white space,
since preceding white space on the next line will be considered indentation. Instead
of using a backslash break, one can also leave the Enter-key unpressed at all and
simply have the line run through the right margin. Empty lines and (commentary)
lines starting with a '#'-symbol are allowed and ignored.

One can make a quick start by having the first command file generated by the Com-
mand Recorder, and start editing from there.

The specification of available commands is currently written in a top- to-bottom
sequential form. This means that command arguments are explained only at their
first appearance. Placeholders between angular brackets are used to specify the
command syntax. If a syntax placeholder is not defined at a particular command, it
has already been defined at an earlier command or is considered atomic. The online
user documentation will provide a hyper-link in the former case. Our tabular rep-
resentation might cause lengthy command (argument) specifications to be format-
ted over multiple lines. Beware that the Command Driver itself will not accept this,
unless the lines are explicitly broken by backslashes. All syntax definitions are using
the following tags:

<abc> syntax placeholder
| exclusive-or between altern-

atives
? zero or one occurrences
* zero or more occurrences
+ one or more occurrences

<action> I. Basic commands (also gen-
erated by Command Recorder)

Window "<winname>"

<winname> = <search-
str><disambiguator>?

Switches the focus between dif-
ferent windows on screen. Any
window not having a modal child
displayed may be specified as the
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<searchstr> = (<wild-
card>?<textstr>)*<wildcard>?

<wildcard> = '*'

<disambiguator> = '#'<selnr>

<selnr> = <posint> | <negint>

new current window. This com-
mand is needed to access mode-
less windows, since only modal
windows that pop up will auto-
matically become the current win-
dow.

Window names may contain one
or more wildcards to match arbit-
rary substrings. If a (wildcarded)
window name matches more than
once, a number can be attached
to disambiguate the search. Win-
dows are numbered in order of
appearance. A negative number
will count the windows in reverse.

'[' <winname>? ']' This window assertion tells the
Command Driver what is sup-
posed to be the current window
when the commands succeeding
the assertion are processed. A
mismatch will result into an error.
The latest assertion is cancelled
by either a next assertion or the
empty assertion: [ ].

If a window assertion refers to a
modeless window, it will be set as
the new current window. This
makes the Window- command
above obsolete in case window
assertions are used.

Menu "<menupath>" <onofftag>?

<onofftag> = (On | 1) | (Off | 0)

<menupath> = <pathstr>

<pathstr> = <itemname> (  <sep><item-
name> )*

Selects a menu (sub)item by
providing the whole menu path.
Checkable menu items are
toggled, unless the optional
On/Off- argument specifies their
desired state. Any search name
provided to the Command Driver,
including menu (item) names,
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<sep> = '`'

<itemname> =
<searchstr><disambiguator>?

may contain one or more wild-
cards to match arbitrary sub-
strings.

If a (wildcarded) item name
matches more than once in a (sub-
)menu or any other list, a number
can be attached to disambiguate
the search. A negative number
will count the matching items in
reverse. To give a few exotic
examples: the menu path "Sur-
vey`*#- 1" would select the last
item of the Survey-menu, while
the path "Survey`#1" would refer
to its first empty-named item.

Button "<keystr>" <onofftag>?

<keystr> = <objname>( <sep><objname>
)*<disambiguator>?

<objname> = <searchstr>

Press a (push/radio/check/tool)-
button by providing one or more
search keys. Multiple search keys
are not allowed for QDialog win-
dows. Checkable buttons are
toggled, unless the optional
On/Off- argument specifies their
desired state. The best search
key is of course the button name,
but some objects do not have a
(visible) name and lots of times
names are not unique.

Therefore, a key may just as well
refer to another object in the
neighbourhood of the button to
click. The list of possible buttons
will be narrowed down for every
next key provided. If the referred
object is closer to one button than
another, the latter will be dropped.
The vicinity criterion is based on
the youngest common ancestor of
referred object and button in the
object tree.
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If the user is unable to specify a
set of keys that leaves exactly
one button, as a last resort one of
the remaining buttons can be
selected by attaching a dis-
ambiguation number after the last
key. Beware that the order of
those buttons will be fixed, but
unlike menus not always in a left-
right top-down fashion. The but-
tons will be counted in reverse in
case the disambiguator is neg-
ative.

ButtonMenu "<keystr>" "<menupath>"

<onofftag>?

Selects an item from the menu
attached to a button. Some tool-
buttons contain a left- clickable
arrow part to have such a menu
appeared. Checkable menu items
are toggled, unless the optional
On/Off- argument specifies their
desired state. Selection of the but-
ton is analogous to the button
selection described above. Selec-
tion of the menu (sub)item is ana-
logous to the Menu-command.

Input "<keystr>" <inpdata>? <entertag>?

<entertag> = Enter | Hold

<inpdata> = "<inputstr>" | <number> |
FilePath "<filepathstr>"

Inputs a string or number into one
of the fields of the current window.
The field selection is analogous to
the button selection described
above. The Hold-option only trig-
gers actions defined on changing
the input field, while the Enter-
option also triggers actions
defined on pressing the enter-
/return-key afterwards.

The latter is the default. If no input
data is provided, the current con-
tents of the selected field will be
entered. The FilePath- option



- 1028 -

forces the input string to be
treated as a file-path concerning
platform independence. This will
happen automatically in case the
input string contains any directory
identifier substitute ( $...DIR$ ), or
in case the input field comes
together with a Select-button and
perhaps an Examine-button into a
graphical element called uiFileIn-
put.

Spin "<keystr>" <spinsteps> <entertag>?

<spinsteps> = <posint> | <negint>

Clicks a spinbox any number of
steps upward (positive) or down-
ward (negative). The spinbox
selection is analogous to the but-
ton selection described above.
The Hold- option only triggers
actions defined on changing the
spinbox value (after each step),
while the Enter- option also trig-
gers actions defined on the spin-
box losing its focus afterwards.

The latter is the default. If no num-
ber of steps is provided, the spin-
box will keep its current value
while losing its focus. Multiple
steps are only supported as long
as no action triggered in between
does pop up a modal window.
One can also edit the input field of
the spinbox directly by using the
Input-command instead.

Slider "<keystr>" <percentage>
<nrsteps>?

<nrsteps> = <posint>

Shifts a slider towards the spe-
cified percentage of its range dis-
played on screen. Beware that
the relationship between this per-
centage and the actual scale rep-
resented by the slider is not
necessarily linear. It is optional to



- 1029 -

perform the shift in more than one
step, but it may yield nice anim-
ations on screen.

Multiple steps are only supported
as long as no action triggered in
between does pop up a modal
window. Selecting the slider is
analogous to the button selection
described above.

Wheel "<keystr>" <degrees> <nrsteps>? Rotates a thumbwheel a specified
number of degrees upward-
s/downwards or left-
wards/rightwards. The number of
degrees will only have a direct
meaning if the thumbwheel rep-
resents an angular scale. It is
optional to perform the rotation in
more than one step, but it may
yield nice animations on screen.
Multiple steps are only supported
as long as no action triggered in
between does pop up a modal
window. Selecting the thumb-
wheel is analogous to the button
selection described above.

Combo "<keystr>" <itemsel>

<itemsel> = "<itemname>" | <selnr>

Sets the selected item of a com-
bobox, either by its name or by its
ordinal number in the list. The list
will be traversed in reverse if the
number is negative, so for
instance -1 refers to the last item.
Using a selection number is just a
shortcut for composing an item
name "*#<selnr>" from merely a
wildcard and a disambiguator.
The selection of the combobox
itself is analogous to the button
selection described above. The
Input- command may be applied
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to edit the input field of the current
item of an editable combobox.

ListClick "<keystr>" <itemsel>
<mousetag>?

<mousetag> = <ctrl-
click>?<doubleclick>?<leftrightclick>?

<ctrlclick> = Ctrl

<doubleclick> = Double

<leftrightclick> = Left | Right

Clicks and (de)selects precisely
one item in a listbox. Selection
possibilities for listbox and item
are analogous to combobox selec-
tion. The optional mousetag is
defining whether the item is
(de)selected by means of optional
control- or double- clicking of
either the left or right mouse but-
ton. Left is default in all cases.
Beware that the mousetag is one
united word and order counts.

Some listboxes pop up a menu
when (right)-clicking on an item,
in which case one has to apply
the ListMenu-command instead.
Single-selection listboxes will only
select the clicked item and
deselect all others. Multi-selection
listboxes act different in the fol-
lowing cases. Control- clicking
toggles the selected state of the
clicked item, while any other item
keeps its current state. Right-click-
ing an already selected item
leaves the whole selection
unchanged.

ListButton "<keystr>" <itemsel>

<mousetag>? <onofftag>?

(Un)checks the button in front of a
listbox item. The check-button is
toggled unless the optional
On/Off- argument specifies its
desired state. (De)selection of
item and listbox is fully analogous
to the ListClick- command.
Beware that mousetags with
Double or Right are known not to
have a (lasting) effect on the
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check-button.
ListMenu "<keystr>" <itemsel>
<mousetag>? "<menupath>" <onofftag>?

Selects a (sub)item from the
menu attached to a listbox item.
Checkable menu items are
toggled, unless the optional
On/Off- argument specifies their
desired state. The selection of
both listbox and item is analogous
to the ListClick- command.
However, since OpendTect is nor-
mally hiding its popup menus
under the right mouse button, the
default for no mousetag at all is
set Right over here. Selection of
the menu (sub)item is analogous
to the Menu-command.

ListSelect "<keystr>" <firstitemsel>
<lastitemsel>? <onofftag>?

<firstitemsel> = <lastitemsel> = <itemsel>

Selects any number of items in a
multi- selection listbox. Selection
possibilities are more com-
prehensive than those at the
ListClick-command. Now all items
matching a given (wildcarded)
item name can be specified. One
can also specify the whole range
between a first and a last item at
once. The list will be traversed
cyclically in case the first item suc-
ceeds the last. Without the
optional On/Off-argument, all spe-
cified items will be selected and
all other items deselected. With
the On/Off- argument set how-
ever, only specified items will be
selected/deselected respectively,
while unspecified items keep their
current state.

TableClick "<keystr>" <tableitemsel>
<mousetag>?

<tableitemsel> = <headitemsel> | <cellsel>

Clicks either a row- head, col-
head or cell in a table, and select
precisely the one row, column or
cell attached to it. Selection pos-
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<headitemsel> = <headtag> <itemsel>

<headtag> = RowHead | ColHead

<cellsel> = <rowsel> <colsel> | Cell <item-
sel>

<rowsel> = <colsel> = <itemsel>

sibilities for the RowHead-,
ColHead- and Cell- options are
analogous to the item selection
for list- and comboboxes. The
Cell-option puts all cells row-after-
row in a virtual list for this pur-
pose. Another way to address a
single cell is by selecting both its
row and its column. Also these
row and column selections are
analogous to the item selection
just mentioned.

If the row or column selection is
not made by number but by
name, then the search for a
match will start in its header. In
case the table shows no header
or no row/col-head is matching,
then the search will proceed in the
next column/row until a match is
found. The selection of the table
itself is analogous to the button
selection described above. The
option specifying a left, right or
double mouse-click will be Left by
default. Some tables pop up a
menu when right-clicking a cell, in
which case one has to apply the
TableMenu-command instead.

TableFill "<keystr>" <cellsel> <inpdata> Fills one cell in a table with new
text data. Alike the Input- com-
mand, this might be a text string,
a file-path string or a number. The
selection of both table and cell is
analogous to the TableClick-com-
mand, except that table headers
cannot be filled.

TableMenu "<keystr>" <cellsel>
<mousetag>? "<menupath>" <onofftag>?

Selects a (sub)item from the
menu attached to a table cell.
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Checkable menu items are
toggled, unless the optional
On/Off- argument specifies their
desired state. The selection of
both table and cell is analogous to
the TableFill-command. Selection
of the menu (sub)item is ana-
logous to the Menu-command.

TableExec "<keystr>" <cellsel> <action> Executes a local command driver
action within one cell of a table
(instead of within the current win-
dow). The selection of both table
and cell is analogous to the
TableFill- command. Only those
commands accepting a keystring
argument might be appropriate
actions to execute within a cell.
For example, if the top-left cell of
a table contains a single com-
bobox, its selection can be made
as follows:

TableExec "my table" 1 1 Combo
"*" "my item"

Tables with cells containing mul-
tiple user-interface objects of the
same or different kind can be
handled too.

TableSelect "<keystr>" <tableitem-
rangesel> <onofftag>?

<tableitemrangesel> = <head-
itemrangesel> | <cellrangesel>

<headitemrangesel> = <headtag>
<firstitemsel> <lastitemsel>?

<cellrangesel> = <firstcellsel> <last-
cellsel>?

Selects any number of rows,
columns or cells in a table. This
command is the table-equivalent
of the ListSelect-command. Selec-
tion possibilities are more com-
prehensive than those at the
TableClick- command. Now all
row- heads, col- heads or cells
matching a given (wildcarded)
item name can be specified.



- 1034 -

<firstcellsel> = <lastcellsel> = <cellsel> One can also specify the whole
block between a first and a last
row, column, or cell at once. The
table will be traversed cyclically in
case the first (cell) row or (cell)
column succeeeds the last.
Without the optional On/Off-argu-
ment, all specified cells will be
selected and all other cells
deselected. With the On/Off-argu-
ment set however, only specified
cells will be selected/deselected
respectively, while unspecified
cells keep their current state.

Tab "<keystr>"? "<tabname>"

<tabname> = <itemname>

Puts a tab on top of the stack by
name. Since windows with more
than one tab-stack will be rare, its
selection is optional. The selec-
tion is analogous to the button
selection described above.

TreeClick "<keystr>"? <treenodesel>
<mousetag>?

<treenodesel> = "<treepath>" | PathCol
"<treepath>" <colsel>

<treepath> = <pathstr>

Clicks and selects precisely one
node in a tree. The selection of a
tree node is analogous to the
selection of a menu (sub)item. In
which column to click is optional,
but it will be the first one by
default. This column selection is
almost analogous to the column
selection for tables. If the selec-
tion is not made by number but by
name, then the search for a
match will start in the column
header, and next proceed at the
selected tree node if not suc-
cessful.

Selection of the tree itself is ana-
logous to the button selection
described above. It is optional
because the current window will
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often contain only one (data) tree.
The data tree with the lowest
scene number is guaranteed to
be the default for OpendTect
Main Window. The option to spe-
cify a left, right or double mouse-
click will be Left by default. Any
tree node might pop up a menu
when right-clicking on one of its
columns, in which case the
TreeMenu- command has to be
applied instead.

TreeExpand "<keystr>"? "<treepath>"
<onofftag>?

(Un)expands the subtree of a
node in a tree. The expander is
toggled unless the optional
On/Off- argument specifies its
desired state. The selection of
both tree and node is analogous
to the TreeClick- command,
except that column selection is
not an issue here.

TreeButton "<keystr>"? "<treepath>"
<mousetag>? <onofftag>?

Presses the button in front of a
node in a tree. The button is
toggled unless the optional
On/Off- argument specifies its
desired state. The selection of
both tree and node is analogous
to the TreeClick- command,
except that column selection is
not an issue here.

TreeMenu "<keystr>"? <treenodesel>
<mousetag>? "<menupath>" <onofftag>?

Selects a (sub)item from the
menu attached to a column of a
tree node. Checkable menu items
are toggled, unless the optional
On/Off- argument specifies their
desired state. The selection of
tree, node and column is ana-
logous to the TreeClick- com-
mand. Selection of the menu
(sub)item is analogous to the
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Menu-command.
CanvasMenu "<keystr>" "<menupath>"
<onofftag>?

Selects a (sub)item from the
menu popping up at a canvas
area. Checkable menu items are
toggled, unless the optional
On/Off- argument specifies their
desired state. Selection of the can-
vas area is analogous to the but-
ton selection described above.
Selection of the menu (sub)item is
analogous to the Menu- com-
mand.

Ok

Cancel

These are special commands that
'Ok' or 'Cancel' a dialog. Usually,
this has the same effect as press-
ing the Ok- or Cancel-button.

Close <closeoption>?

<closeoption> = All | <subwinsel>

<subwinsel> = "<keystr>"? "<winname>"

Clicks on the Close-button in the
title bar of the current window.
The All- option will close all
OpendTect windows at once. This
option is compulsory in case
OpendTect Main Window is the
current window, so that
OpendTect cannot be killed by
accident. The optional subwindow
selection is available to close a
window in the workspace of the
current window by name. Since
windows with more than one work-
space will be rare, selection of the
workspace is optional. This selec-
tion is analogous to the button
selection described above.

Show <subwinsel>? <showtag>

<showtag> = Minimized | Maximized |
Normal

Clicks on the Minimized-, Max-
imized- and Restore- buttons in
the title bar of the current window.
The optional subwindow selection
is available to resize a window in
the workspace of the current win-
dow by name. Since windows
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with more than one workspace
will be rare, selection of the work-
space is optional. This selection is
analogous to the button selection
described above.

ColorOk <colorsel>

<colorsel> = "<rgbtcolorstr>" | <color>
<transparency>?

<color> = "<rgbcolorstr>" | <R> <G> <B> |
<colortag>

<rgbtcolorstr> = <rgbstr><sep ><trans-
parency>

<rgbcolorstr> = <R><sep><G><sep><B>

<R> = <G> = <B> = <transparency> =
<byte>

<colortag> = Black | Blue | Brown | Cyan |
Green | Grey | Lilac | Lime | Magenta |
Olive | Orange | Purple | Pink | Red |
White | Yellow

Specifies the desired color while
closing a QColorDialog window.
One may specify a color either by
its RGB-values (0-255) or a color
tag. In case the QColorDialog
offers the possibility to specify
transparency, the value of the
optional t- channel (0- 255) is
passed as well. Its default value is
0 (non-transparent). The RGB-val-
ues and optional t- channel can
also be specified in one com-
posite RGB(t) color string.

FileOk "<filepathset>"

<filepathset> = <filepathstr> ( <sep><file-
pathstr> )*

Specifies one, or more file-paths
while closing a QFileDialog win-
dow. The command will yield an
error message if their number,
type (file/directory), extension,
and/or writability is not in agree-
ment with the current mode of the
QFileDialog. File- paths will be
interpreted platform inde-
pendently. Both absolute and rel-
ative file-paths are accepted.

The current directory of the
QFileDialog will be taken as base
directory in the latter case. Also a
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set of directory identifiers has
been predefined for substitution ( 
$...DIR$  ) in file- paths. The
FileOk- command does not
provide the functionality of the
QFileDialog- button "Create new
folder". If a file-path specifies a
non-existing file or directory, its
parent directory must exist.

<action> II. Auxiliary commands (to be inserted by the
user)

Include "<filepathstr>" Inserts another command file into the command
stream. The file- path will be interpreted platform
independently. In order to specify the file-path rel-
ative to either OpendTect, current survey, or user
directories, one of the predefined directory iden-
tifiers can be substituted ( $...DIR$ ).

GreyOuts <grey-
outstag>

<greyoutstag> = Count |
Skip

Specifies whether to count or skip disabled (greyed
out) user interface objects, tabs, menu and tree
items. 'Skip' is the default. 'Count' means that also
grey-outs will be counted when using selection num-
bers. Furthermore, it allows (question) commands
to retrieve information from grey-outs. Command
actions trying to manipulate a grey-out will be pen-
alized.

Case <casetag>

<casetag> = Sensitive |
Insensitive

Switches between case-sensitive and case-insens-
itive searching in menus, windows, lists, etc. Insens-
itive is the default. The command parsing itself
(command names and options, function names,
identifier names) is case-insensitive by nature and
will ignore this setting.

OnError <errortag>

<errortag> = Stop |
Recover

Switches between different procedures to handle an
error. The Stop- option will exit the driver imme-
diately. The Recover-option will make use of win-
dow assertions to safely proceed execution in
specific cases. The default option is Recover.

LogMode <logtag>

<logtag> = Basic |

Regulates the amount of warning and error mes-
sages in the log file. The All-option will show any
message generated. The Normal- option is the
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Normal | All default. It shows all parsing messages, but action
messages are only shown if the action result is not
assigned to an identifier. The Basic-option will also
omit all warning messages.

Snapshot "<image-
filepathstr>"
<frametag>?

<frametag> = CurWin |
ODMain | Desktop

<imagefilepathstr> =
<filepathstr><imageext>

<imageext> = .bmp |
.jpg | .jpeg | .png |
.ppm | .xbm | .xpm

Writes a snapshot of the current window (and its
environment) to file. The default grabbing area is
bounded by the CurWin-frame, but can optionally be
enlarged towards the ODMain-frame or the whole
Desktop-frame. The snapshot filename must have
one of the prescribed image extensions. The file-
path will be interpreted platform independently. Both
absolute and relative file-paths are accepted. Also
one of the predefined directory identifiers may be
substituted ( $...DIR$ ) in the file-path.

Sleep <seconds>
<sleeptag>?

<sleeptag> = Regular |
Extra

Sleeps a period of time so that spectators can dis-
tinguish the consecutive steps from a command file
on screen. The Regular-option will sleep until further
notice between every two commands with a visual
effect. The Extra-option is the default and will take
an (additional) nap only once.

Wait <seconds> <sleep-
tag>?

Tells the next command to wait a period of time only
if it is uncertain whether it has finished processing.
This can happen to any command closing a modal
dialog that was already open when the Command
Driver started. The Regular- option will allow this
waiting time to every command until further notice.
The Extra-option is the default and will allow an
(additional) wait only to the next command.

Pause "<textlines>"?

<textlines> = <textstr> ( 
<sep><textstr> )*

Temporarily hold the execution of the command
script and have the Command Controller pop up a
message dialog with a 'Resume'-button so that the
user can decide when to continue. Specifying lines
of text is optional.

Guide "<textlines>" ( 
<guidetag>
"<winname>" )?

Temporarily hold the execution of the command
script and have the Command Controller pop up a
dialog requesting the user to take action. The text
lines describe which actions the user has to per-
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<guidetag> = Existent |
Inexistent | Accessible
| Inaccessible

form. The Command Driver will automatically
resume if some window matching a given name is
no longer (in)existent or (in)accessible. If this option
is not specified, the user gets a 'Done'-button to
have the Command Driver resume manually.

Comment "<textlines>" Inserts comment lines into the log file. Command
lines starting with a '#'-symbol are containing com-
ments that are not shown in log files.

<action> III. Control flow commands (to be inserted by the
user)

Assign <ident>
<expr>

<ident> '=' <expr>

<ident> =
<scope>?<identstr>

<identstr> = <let-
ter><identchars>*

<identchars> = <let-
ter> | <digit> | '_
'<scope> = '@'

<expr> = <ident> |
<number> |
"<textstr>" | '(' <expr>
')' | <functioncall> |
<operatorexpr>

<functioncall> = <fun-
cname>' (' <expres-
sions>? ')'

<funcname> =
<ident>

<expressions> =
<expr> ( ',' <expr> )*

Assigns the evaluated result of an expression to an
identifier. The command syntax is available in both pro-
cedural style and operator style. Identifiers consist of a
letter followed by any sequence of letters, digits and
underscores. Expressions are assembled from iden-
tifiers, numbers, string constants, parentheses, built-in
functions, and about twenty mathematical and logical
operators. Notice that a function call allows no space
between the function name and its opening par-
enthesis. All functions, operators and predefined iden-
tifiers are listed below in Expressional specifications.



- 1041 -

If <expr><actions>

(  ElseIf <expr ><ac-
tions> )*

( Else<actions> )?

Fi

Executes a number of command actions if a boolean
expression evaluates to true. The ElseIf- and Else-
branches are optional, but note that the terminating Fi-
command is compulsory.

For <ident> '=' <expr>
( To <expr> )? ( Step
<expr> )?

<actions>

Rof

Initializes an identifier with the evaluated result of a
numerical expression and repeats a number of com-
mand actions as long as the identifier value does not
exceed the evaluated result of the optional To-expres-
sion. After every loop iteration, the identifier is incre-
mented by the evaluated result of the optional Step-
expression. The default step is 1, but even negative
values are allowed. Only the Break- command can
escape from a For-loop in absence of a To-expression.
Note that the terminating Rof-command is compulsory.

DoWhile <expr>

<actions>

Od

Repeats the execution of a number of command
actions as long as a boolean expression evaluates to
true. Note that the terminating Od-command is com-
pulsory.

Do

<actions>

OdUntil <expr>

Repeats the execution of a number of command
actions until a boolean expression evaluates to true.

Break Escapes immediately from the innermost For-, While-,
or Until-loop.

Continue Skips the remaining actions in the current iteration of
the innermost For-, While-, or Until-loop.

Try <ident> <action>

<ident>? '~' <action>

Tries to execute a command action and assigns its res-
ult to an identifier. The command syntax is available in
both procedural style and operator style. The possible
outcomes are success (1), failure (0) and warning (-1),
for which the identifier constants SUCCESS, FAILURE
and WARNING have been predefined. The operator
style syntax is also usable without identifier for the
side- effect, because error messages will be tem-
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porarily ignored.
Questioncmd <ques-
tioncmd> <ident>
<questionargs>

<ident> '?' < ques-
tioncmd ><ques-
tionargs>

Stores the answer from a question command into an
identifier. The command syntax is available in both pro-
cedural style and operator style. All question com-
mands implemented so far are listed below in Table IV
to VII.

Def ( <returnpar> '?'
)? <procname>'(' <val-
pars>? ')' <varpar>*

<actions>

Fed

<returnpar> = <var-
par>

<procname> =
<ident>

<valpars> =
<identstr> ( ',' <ident-
str> )*

<varpar> = <identstr>

Specifies a user-defined procedure in which a number
of command actions are executed. Note that the ter-
minating Fed-command is compulsory. Nested pro-
cedure definitions are allowed. A definition may occur
anywhere, as long as it precedes the first call to it. The
course of a procedure depends on an optional number
of value parameters (between the parentheses) and
variable parameters (behind the parentheses).

Procedure names can only be overloaded if there is a
difference in the number of value or variable para-
meters. Distinction on data type is not possible, having
only one internal (string) type. The optional return para-
meter is not counted at overloading, but acts like a vari-
able parameter apart from that. It can be applied to
give the procedure a more function-like appearance.
Unlike built- in functions however, this does not at all
mean that procedure calls can be used as (sub-
)expressions.

Return <expr>? Escapes immediately from the current procedure. In
case its definition includes a return parameter, it will be
assigned with the optional expression that is returned.

Procname (  <ident>
'?' )? <procname>' ('
<expressions>? ')'
<ident>*

Calls a user- defined procedure specified earlier by
means of the Def-command above. Its optional value
parameters will accept expressions. Its optional return
and variable parameters only accept identifiers, and
these might be modified. Notice that a procedure call
allows no space between the procedure name and its
opening parenthesis.

End Finishes the command stream immediately.

<questioncmd> <ques- IV. Question commands (to be inserted by the
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tionargs> user)
IsMatch "<searchstr>"
"<textstr>" <casetag>

True (1) if the text string matches the search key
according to the rules described in the Search keys
paragraph, false (0) otherwise. The identifier con-
stants TRUE and FALSE have been predefined for
convenience. If the optional case-sensitivity of the
match is not specified, the global settings defined by
the Case- command will apply. The options are
'Insensitive' or 'Sensitive'.

IsWindow
"<winname>"? <win-
proptag>?

<winproptag> = Exist-
ent | Accessible |
Modal | QDialog |
<showtag>

True (1) if a specified window has a particular
boolean property, false (0) otherwise. The optional
property tells whether the window is either existent
(default), accessible, modal, maximized, minimized,
normal or a QDialog. The optional selection of the
window is analogous to the Window-command. By
default, the current window will be selected.

IsMenuItemOn "<menu-
path>"

On (1) if the selected menu (sub)item is checked, off
(0) if it is unchecked, and unswitchable (-1) if it is not
checkable at all. The identifier constants ON, OFF
and UNSWITCHABLE have been predefined for con-
venience. The selection of the menu (sub)item is
analogous to the Menu-command.

NrMenuItems "<menu-
path>?"

Returns the number of (enabled) items in the selec-
ted (sub)menu. The GreyOuts- command defines
whether disabled items are counted as well. Selec-
tion of a sub-menu is analogous to the selection of
menu items in the Menu-command. The root menu is
denoted by an empty menu- path (""). Zero is
returned if the menu-path leads to a leaf menu item.

GetMenuItem "<menu-
path>" <formtag>?

<formtag> = Text | Num-
ber

Returns the text or number of a selected menu (sub-
)item. In which form is optional and 'Text' by default.
In the 'Number' case, the GreyOuts- command
defines whether disabled items are counted as well.
Selection of the menu (sub)item is analogous to the
Menu-command.

IsButtonOn "<keystr>" On (1) if the selected radio-, check-, or toolbar button
is checked, off (0) if it is unchecked, and unswitch-
able (-1) in case of a push button or a non-checkable
toolbar button. The identifier constants ON, OFF and
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UNSWITCHABLE have been predefined for con-
venience. The button selection is analogous to the
Button-command.

GetButton "<keystr>"
<buttonformtag>?

<buttonformtag> = Text
| Color

Returns the text or color of a (push/radio/check/tool)-
button. In which form is optional and 'Text' by default.
The RGBt color string format returned in the 'Color'
case is defined at the ColorOk-command. If the but-
ton has no text or color, an empty string or trans-
parent white is returned respectively. The button
selection is analogous to the Button-command.

IsButtonMenuItemOn
"<keystr>"
"<menupath>"

On (1) if the selected menu (sub)item of a button is
checked, off (0) if it is unchecked, and unswitchable
(-1) if it is not checkable at all. The selection of button
and menu (sub)item is analogous to the But-
tonMenu-command.

NrButtonMenuItems
"<keystr>"
"<menupath>?"

Returns the number of (enabled) items in the selec-
ted (sub)menu of a button. The GreyOuts-command
defines whether disabled items are counted as well.
The selection of button and sub-menu is analogous
to the ButtonMenu- command. The root menu is
denoted by an empty menu- path (""). Zero is
returned if the menu-path leads to a leaf menu item.

GetButtonMenuItem
"<keystr>"
"<menupath>"
<formtag>?

Returns the text or number of the selected menu
(sub)item of a button. In which form is optional and
'Text' by default. In the 'Number' case, the GreyOuts-
command defines whether disabled items are coun-
ted as well. Selection of button and menu (sub)item
is analogous to the ButtonMenu-command.

GetInput "<keystr>"
<inputformtag>?

<inputformtag> = Text |
FilePath

Returns the current content of a selected input field.
In which form is optional and 'Text' by default. Selec-
tion of the input field is analogous to the Input-com-
mand. In case the input field comes together with a
Select-button and perhaps an Examine-button into a
graphical element called uiFileInput, the 'FilePath'
option forces the current filename to be preceded by
the absolute file path to the current selection dir-
ectory. Otherwise an empty string will be returned.

GetSpin "<keystr>"
<spinformtag>?

Returns the text, value, minimum, maximum or step
of the selected spinbox. In which form is optional and
textual by default. Selection of the spinbox is ana-



- 1045 -

<spinformtag> = Text |
Value |Minimum |Max-
imum | Step

logous to the Spin-command.

GetSlider "<keystr>"
<sliderformtag>?

<sliderformtag> = Text |
Value |Minimum |Max-
imum | Percentage

Returns the text, value, minimum, maximum or per-
centage of the selected slider. In which form is
optional and textual by default. Beware that the
returned percentage of the range displayed on
screen will not necessarily have a linear relationship
with the returned value. Selection of the slider is ana-
logous to the Slider-command.

GetWheel "<keystr>"
<wheelformtag>?

<wheelformtag> = Text
| Angle

Returns the text or angle (in degrees) of the selected
thumbwheel. In which form is optional and textual by
default. Selection of the thumbwheel is analogous to
the Wheel-command.

NrComboItems "<key-
str>"

Returns the number of items in a selected com-
bobox. The selection of the combobox is analogous
to the Combo-command.

CurComboItem "<key-
str>" <formtag>?

Returns the text or number of the current combobox
item. In which form is optional and textual by default.
The selection of the combobox is analogous to the
Combo-command.

IsComboItemOn "<key-
str>" <itemsel>

On (1) if the specified combobox item is currently
selected, and off (0) if it is currently deselected. Spe-
cification of the combobox and its item is analogous
to the Combo-command.

GetComboItem "<key-
str>" <itemsel>
<formtag>?

Returns the text or number of a selected combobox
item. In which form is optional and textual by default.
Selection of the combobox and its item is analogous
to the Combo-command.

NrTabs "<keystr>"? Returns the number of (enabled) tabs in a selected
tab-stack. The GreyOuts-command defines whether
disabled tabs are counted as well. The optional
selection of the tab-stack is analogous to the Tab-
command.

CurTab "<keystr>"?
<formtag>?

Returns the text or number of the current tab. In
which form is optional and 'Text' by default. In the
'Number' case, the GreyOuts- command defines
whether disabled tabs are counted as well. The
optional selection of the tab-stack is analogous to
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the Tab-command.
IsTabOn "<keystr>"?
"<tabname>"

On (1) if the selected tab is currently on top, and off
(0) if it is currently underneath. Selection of tab-stack
and tab-name is analogous to the Tab-command.

GetTab "<keystr>"?
"<tabname>"
<formtag>?

Returns the text or number of a selected tab. In
which form is optional and 'Text' by default. In the
'Number' case, the GreyOuts- command defines
whether disabled tabs are counted as well. Selection
of tab-stack and tab-name is analogous to the Tab-
command.

IsCanvasMenuItemOn
"<keystr>"
"<menupath>"

On (1) if the selected menu (sub)item in the pop-up
menu of a canvas area is checked, off (0) if it is
unchecked, and unswitchable (-1) if it is not check-
able at all. The selection of canvas area and menu
(sub)item is analogous to the CanvasMenu- com-
mand.

NrCanvasMenuItems
"<keystr>"
"<menupath>?"

Returns the number of (enabled) items in the selec-
ted (sub)menu popping up at a canvas area. The
GreyOuts-command defines whether disabled items
are counted as well. The selection of canvas area
and sub-menu is analogous to the CanvasMenu-
command. The root menu is denoted by an empty
menu-path (""). Zero is returned if the menu-path
leads to a leaf menu item.

GetCanvasMenuItem
"<keystr>"
"<menupath>"
<formtag>?

Returns the text or number of the selected menu
(sub)item in the pop-up menu of a canvas area. In
which form is optional and 'Text' by default. In the
'Number' case, the GreyOuts- command defines
whether disabled items are counted as well. The
selection of canvas area and menu (sub)item is ana-
logous to the CanvasMenu-command.

IsShown <subwinsel>?
<showtag>

True (1) if a selected subwindow in the workspace of
the current window is minimized, maximized, or nor-
mal size respectively, and false (0) otherwise. Spe-
cification of size property and optional subwindow is
analogous to the Show-command. Not selecting a
subwindow will yield the size properties of the cur-
rent window itself.

<questioncmd> V. List question commands (to be inserted by the
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<questionargs> user)
NrListItems "<key-
str>"

Returns the number of items in a selected listbox. The
selection of the listbox is analogous to the ListClick-com-
mand.

CurListItem "<key-
str>" <curtag>?
<listformtag>?

<curtag> = Framed
| Selected <list-
formtag> = Text |
Number | Color

Returns the text, number or background color of the cur-
rent listbox item. In which form is optional and 'Text' by
default. The RGBt color string format returned in the
'Color' case is defined at the ColorOk-command. If there
is no current listbox item, an empty string, zero or trans-
parent white is returned respectively. By default, the cur-
rent listbox item is the one that is 'Framed'. Optionally, if
precisely one item is 'Selected' (i.e. highlighted), it can
be requested as current listbox item instead. The selec-
tion of the listbox is analogous to the ListClick-command.

IsListItemOn "<key-
str>" <itemsel>

On (1) if a specified item in a listbox has been selected
(i.e. highlighted), off (0) if it has been deselected, and
unswitchable (-1) if the listbox does not support item
selection at all. The specification of listbox and item is
analogous to the ListClick-command.

GetListItem "<key-
str>" <itemsel> <list-
formtag>?

Returns the text, number or background color of a selec-
ted listbox item. In which form is optional and 'Text' by
default. The RGBt color string format returned in the
'Color' case is defined at the ColorOk-command. Selec-
tion of both listbox and item is analogous to the ListClick-
command.

IsListButtonOn
"<keystr>"
<itemsel>

On (1) if the button in front of a listbox item is checked,
and off (0) if it is unchecked. Selection of both listbox and
item is analogous to the ListButton-command.

IsListMenuItemOn
"<keystr>"
<itemsel> "<menu-
path>"

On (1) if the selected menu (sub)item of a listbox item is
checked, off (0) if it is unchecked, and unswitchable (-1)
if it is not checkable at all. The selection of the listbox, its
item and the menu (sub)item is analogous to the
ListMenu-command.

NrListMenuItems
"<keystr>"
<itemsel> "<menu-
path>?"

Returns the number of (enabled) items in the selected
(sub)menu of a listbox item. The GreyOuts-command
defines whether disabled items are counted as well.
Selection of the listbox, its item and a sub-menu is ana-
logous to the ListMenu- command. The root menu is
denoted by an empty menu-path (""). Zero is returned if
the menu-path leads to a leaf menu item.
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GetListMenuItem
"<keystr>"
<itemsel> "<menu-
path>" <formtag>?

Returns the text or number of the selected menu (sub-
)item of a listbox item. In which form is optional and 'Text'
by default. In the 'Number' case, the GreyOuts- com-
mand defines whether disabled items are counted as
well. The selection of the listbox, its item and the menu
(sub)item is analogous to the ListMenu-command.

<questioncmd>
<questionargs>

VI. Table question commands (to be inserted by
the user)

NrTableRows "<key-
str>"

Returns the number of rows in the selected table. The
selection of the table is analogous to the TableClick-
command.

NrTableCols "< key-
str>"

Returns the number of columns in the selected table.
The selection of the table is analogous to the
TableClick-command.

CurTableItem "<key-
str>" <curtag>?
<tableformtag>?

<tableformtag> =
Text | Number |
Color

Returns the text, number or background color of the
current table item. In which form is optional and 'Text'
by default. The RGBt color string format returned in the
'Color' case is defined at the ColorOk-command. If
there is no current table item, an empty string, zero or
transparent white is returned respectively. Like the
CurListItem- command, the current table item is by
default the one that is 'Framed'. Optionally, if precisely
one item is 'Selected' (i.e. highlighted), it can be
requested as current table item instead. The selection
of the table is analogous to the TableClick-command.

CurTableRow "<key-
str>" <curtag>?
<tableformtag>?

Returns the row-header text, number or background
color of the current table row. In which form is optional
and 'Text' by default. The RGBt color string format
returned in the 'Color' case is defined at the ColorOk-
command. If the table has no row header or no current
row, an empty string, zero or transparent white is
returned respectively. Like the CurListItem-command,
the current table row is by default defined by the item
that is 'Framed'. Optionally, if precisely one (entire row
of) item(s) is 'Selected' (i.e. highlighted), the row at
issue can be requested as current table row instead.
The selection of the table is analogous to the
TableClick-command.
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CurTableCol "< key-
str>" <curtag>?
<tableformtag>?

Returns the column- header text, number or back-
ground color of the current table column. In which form
is optional and 'Text' by default. The RGBt color string
format returned in the 'Color' case is defined at the Col-
orOk-command. If the table has no column header or
no current column, an empty string, zero or transparent
white is returned respectively. Like the CurListItem-
command, the current table column is by default
defined by the item that is 'Framed'. Optionally, if pre-
cisely one (entire column of) item(s) is 'Selected' (i.e.
highlighted), the column at issue can be requested as
current table column instead. The selection of the table
is analogous to the TableClick-command.

IsTableItemOn "<key-
str>" <tableitemsel>

On (1) if a specified item in a table has been selected
(i.e. highlighted), off (0) if it has been deselected, and
unswitchable (-1) if the table does not support item
selection at all. The specification of table and item is
analogous to the TableClick-command. A row-head or
col-head item is considered selected only if all table
cells in that row or column are selected.

GetTableItem "<key-
str>" <cellsel> <table-
formtag>?

Returns the text, number or background color of a
selected table cell. In which form is optional and 'Text'
by default. In the 'Number' case, the table cells are
counted row- by- row. The RGBt color string format
returned in the 'Color' case is defined at the ColorOk-
command. Selection of both table and cell is ana-
logous to the TableFill-command.

GetTableRow "<key-
str>" <tableitemsel>
<tableformtag>?

Returns the row-header text, number or background
color of a selected table item. In which form is optional
and 'Text' by default. The RGBt color string format
returned in the 'Color' case is defined at the ColorOk-
command. Selection of both table and item is ana-
logous to the TableClick-command. If the selected item
is not a row-head item itself, it refers to the row-head
item straight above it.

GetTableCol "< key-
str>" <tableitemsel>
<tableformtag>?

Returns the column- header text, number or back-
ground color of a selected table item. In which form is
optional and 'Text' by default. The RGBt color string
format returned in the 'Color' case is defined at the Col-
orOk-command. Selection of both table and item is
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analogous to the TableClick-command. If the selected
item is not a col-head item itself, it refers to the col-
head item left next to it.

IsTableMenuItemOn
"<keystr>" <cellsel>
"<menupath>"

On (1) if the selected menu (sub)item of a table cell is
checked, off (0) if it is unchecked, and unswitchable (-
1) if it is not checkable at all. The selection of the table,
its cell and the menu (sub)item is analogous to the
TableMenu-command.

NrTableMenuItems
"<keystr>" <cellsel>
"<menupath>?"

Returns the number of (enabled) items in the selected
(sub)menu of a table cell. The GreyOuts- command
defines whether disabled items are counted as well.
Selection of the table, its cell and a sub-menu is ana-
logous to the TableMenu-command. The root menu is
denoted by an empty menu-path (""). Zero is returned if
the menu-path leads to a leaf menu item.

GetTableMenuItem
"<keystr>" <cellsel>
"<menupath>"
<formtag>?

Returns the text or number of the selected menu (sub-
)item of a table cell. In which form is optional and 'Text'
by default. In the 'Number' case, the GreyOuts-com-
mand defines whether disabled items are counted as
well. The selection of the table, its cell and the menu
(sub)item is analogous to the TableMenu-command.

<questioncmd> <ques-
tionargs>

VII. Tree question commands (to be inserted by
the user)

NrTreeItems
"<keystr>"?
"<treepath>?"

Returns the number of (enabled) items in a selected
tree node. The GreyOuts-command defines whether
disabled items are counted as well. The optional selec-
tion of the tree is analogous to the TreeClick-com-
mand. This also holds for its tree node, except that
column selection is not an issue here. The root node is
denoted by an empty tree path (""). Zero is returned if
the tree path leads to a leaf tree item.

NrTreeCols
"<keystr>"?

Returns the number of columns in a tree. The optional
selection of the tree is analogous to the TreeClick-
command.

CurTreeItem
"<keystr>"? <curtag>?
<formtag>?

Returns the text or number of the current tree item. In
which form is optional and textual by default. In the
'Number' case, the GreyOuts- command defines
whether disabled items are counted as well. If there is



- 1051 -

no current tree item, an empty string or zero is
returned respectively. Like the CurListItem-command,
the current tree item is by default the one that is
'Framed'. Optionally, if precisely one item is 'Selected'
(i.e. highlighted), it can be requested as current tree
item instead. The optional selection of the tree is ana-
logous to the TreeClick-command.

CurTreePath
"<keystr>"? <curtag>?
<formtag>?

Returns the path to the current tree item. In which form
is optional and textual by default. The 'Number' case is
especially useful if 'Text' would yield an ambiguous
tree path. The GreyOuts-command defines whether
disabled items are counted as well. If there is no cur-
rent tree item, an empty path ("") is returned. Like the
CurListItem- command, the current tree item is by
default the one that is 'Framed'. Optionally, if precisely
one item is 'Selected' (i.e. highlighted), it can be
requested as current tree item instead. The optional
selection of the tree is analogous to the TreeClick-
command.

CurTreeCol
"<keystr>"?
<formtag>?

Returns the column text or number of the current tree
item. In which form is optional and textual by default.
Note that the current tree item is merely column-spe-
cific in case of the default 'Framed' setting. The
optional selection of the tree is analogous to the
TreeClick-command.

IsTreeItemOn "< key-
str>"? "<treepath>"

On (1) if a specified item in a tree has been selected
(i.e. highlighted), off (0) if it has been deselected, and
unswitchable (-1) if the tree does not support item
selection at all. Specification of the tree and its node is
analogous to the TreeClick- command, except that
column selection is not an issue here.

IsTreeItemExpanded
"<keystr>"?
"<treepath>"

True (1) if a specified item in a tree has been expan-
ded, false (0) if it has been collapsed, and unex-
pandable (- 1) if it is a leaf node. Beware that an
expanded tree node can have a collapsed ancestor.
Specification of the tree and its node is analogous to
the TreeClick-command, except that column selection
is not an issue here.

GetTreeItem
"<keystr>"? < treen-

Returns the item number of a tree node or the text in
one of its columns. In which form is optional and tex-
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odesel> <formtag>? tual by default. In the 'Number' case, the GreyOuts-
command defines whether disabled items are counted
as well. The selection of the tree, its node and column
is analogous to the TreeClick-command.

GetTreePath
"<keystr>"?
"<treepath>"
<formtag>?

Returns the path to a selected tree node. In which
form is optional and textual by default. In the 'Number'
case, the GreyOuts-command defines whether dis-
abled items are counted as well. It can be used for con-
verting a path from one form to another. Specification
of the tree and its node is analogous to the TreeClick-
command, except that column selection is not an
issue here.

GetTreeCol
"<keystr>"? <tree-
colsel> <formtag>?

<treecolsel> =
<colsel> | PathCol
"<treepath>" <colsel>

Returns the text or number of a selected tree column.
In which form is optional and textual by default. In the
'Number' case, the GreyOuts- command defines
whether disabled items are counted as well. Selection
of the tree, its column and an optional node is ana-
logous to the TreeClick-command. If the column selec-
tion is made by name, the search for a match will start
in the column header. If not successful, it proceeds at
the specified tree node in the 'PathCol' case, or tra-
verses all tree nodes breadth-first otherwise.

IsTreeButtonOn
"<keystr>"?
"<treepath>"

On (1) if the button in front of a tree node is checked,
and off (0) if it is unchecked. Selection of both the tree
and its node is analogous to the TreeButton- com-
mand.

IsTreeMenuItemOn
"<keystr>"? < treen-
odesel>
"<menupath>"

On (1) if the selected menu (sub)item attached to a
column of a tree node is checked, off (0) if it is
unchecked, and unswitchable (-1) if it is not checkable
at all. The selection of the tree, its node and column,
and the menu (sub)item is analogous to the
TreeMenu-command.

NrTreeMenuItems
"<keystr>"? < treen-
odesel>
"<menupath>?"

Returns the number of (enabled) items in the selected
(sub)menu attached to a column of a tree node. The
GreyOuts-command defines whether disabled items
are counted as well. Selection of the tree, its node and
column, and a sub- menu is analogous to the
TreeMenu-command. The root menu is denoted by an
empty menu-path (""). Zero is returned if the menu-
path leads to a leaf menu item.
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GetTreeMenuItem
"<keystr>"? < treen-
odesel>
"<menupath>"
<formtag>?

Returns the text or number of the selected menu (sub-
)item attached to a column of a tree node. In which
form is optional and 'Text' by default. In the 'Number'
case, the GreyOuts-command defines whether dis-
abled items are counted as well. The selection of the
tree, its node and column, and the menu (sub)item is
analogous to the TreeMenu-command.

Expressional specifications

The logical and mathematical operators to be applied in Command Driver expres-
sions are almost equivalent to those used in OpendTect's mathematics attribute
definitions. Only the |x| operator is not provided to keep the parsing of expressions
straightforward. Use the abs()-function instead. The AND-operator, OR-operator
and conditional operator only evaluate their second (or third) sub-expression if
needed for the result. For example, the reciprocal expression ( x==0 ? UNDEF : 1/x
) will not generate a division-by-zero error. The list of operators is sorted in order of
precedence.

Precedence Associativity <operatorexpr> VIII. Logical and
mathematical oper-
ators (to be used in
expressions)

1 right-to-left ! <expr> Logical not
right-to-left + <expr> Unary plus
right-to-left - <expr> Unary minus

2 right-to-left <expr> ^
<expr>

Raise to power

3 left-to-right <expr> *
<expr>

Multiplication

left-to-right <expr> / <expr> Real division
left-to-right <expr> | <expr> Integer division
left-to-right <expr> %

<expr>
Modulo

4 left-to-right <expr> +
<expr>

Addition

left-to-right <expr> -
<expr>

Subtraction

5 left-to-right <expr> <
<expr>

Less than
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left-to-right <expr> <=
<expr>

Less than or equal

left-to-right <expr> >
<expr>

Greater than

left-to-right <expr> >=
<expr>

Greater than or equal

6 left-to-right <expr> ==
<expr>

Equality (numerical if
possible, string oth-
erwise)

left-to-right <expr> !=
<expr>

Inequality (numerical if
possible, string oth-
erwise)

7 left-to-right <expr> &&
<expr>

Logical AND

8 left-to-right <expr> ||
<expr>

Logical OR

9 right-to-left <expr> ?
<expr> : <expr>

Conditional operator
(if-then-else)

The mathematical and statistical functions to be applied in Command Driver expres-
sions are a superset of those used in OpendTect's mathematics attribute
definitions. Many other (string) functions have known equivalents in the C-library of
the C++ programming language.

<functioncall> IX. Mathematical functions (to be used in expressions)
abs( <expr> ) Absolute value
acos( <expr> ) Arc cosine
asin( <expr> ) Arc sine
atan( <expr> ) Arc tangent between -PI/2 and PI/2
atan2 (  <y_
expr>, <x_expr>
)

Arc tangent of y/x between -PI and PI

ceil( <expr> ) Smallest integer not less than
cos( <expr> ) Cosine
exp( <expr> ) Exponent
floor( <expr> ) Largest integer not greater than
ln( <expr> ) Natural logarithm
log( <expr> ) Base-10 logarithm
rand (  <max_ Uniform random value between 0 and optional maximum, 1
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expr>? ) by default
randG( <stddev_
expr>? )

Gaussian random value with mean 0 and optional standard
deviation, 1 by default

round( <expr> ) Round to nearest integer
sgn( <expr> ) Sign (1 if greater than zero, 0 if zero, -1 if less than zero)
sin( <expr> ) Sine
sqrt( <expr> ) Square root
tan( <expr> ) Tangent
trunc( <expr> ) Round to integer in direction of zero

<functioncall> X. Statistical functions (to be used in expres-
sions)

avg (  < expres-
sions> )

Average

max (  < expres-
sions> )

Maximum

min (  < expres-
sions> )

Minimum

sum (  < expres-
sions> )

Sum

var (  < expres-
sions> )

Variance

med (  < expres-
sions> )

Median

<functioncall> XI. String functions (to be used in expressions)
curWindow() Title of current window
isAlNum( <expr>
)

True (1) if all characters are alpha-numerical, false (0) oth-
erwise

isAlpha (  <expr>
)

True (1) if all characters are letters, false (0) otherwise

isDigit( <expr> ) True (1) if all characters are digits, false (0) otherwise
isInteger ( 
<expr> )

True (1) if representing an integer, false (0) otherwise

isLower ( <expr>
)

True (1) if all characters are lower-case letters, false (0) oth-
erwise

isNumber (  True (1) if representing a number, false (0) otherwise
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<expr> )
isSpace( <expr>
)

True (1) if all characters are white space, false (0) otherwise

isUpper ( <expr>
)

True (1) if all characters are upper-case letters, false (0) oth-
erwise

strCat( <expres-
sions> )

String concatenation

strLen( <expr> ) String length in characters
strSel (  <str_
expr>, <firstpos_
expr>, <lastpos_
expr>? )

Character selection. Last position is optional. Negative pos-
itions count in reverse.

sepStrCat ( 
<expressions> )

Concatenation of separation-strings (menu- and tree-paths,
RGB(t) color strings)

sepStrLen ( 
<expr> )

Number of separated substrings

sepStrSel ( <str_
expr>, <firstpos_
expr>, <lastpos_
expr>? )

Selection of separated substring (s). Last position is
optional. Negative positions count in reverse.

toLower( <expr>
)

Converts all letters to lower-case

toUpper( <expr>
)

Converts all letters to upper-case

wildcard ( 
<selnr_expr>? )

Matching substring for a wildcard in the latest successful
wildcarded command action. Default selection number is 1.
A negative number counts the wildcards in reverse.

wildcardStr ( 
<selnr_expr>? )

The whole matching string around a wildcard in the latest
successful wildcarded command action. Wildcard selection
is analogous to the wildcard()-function above.

All predefined identifier constants and environment variables are listed below. The
Command Driver will automatically change Unix-style file-paths into Windows-style
file-paths on Windows-platforms and vice versa. Redefining any predefined iden-
tifier will result in a warning, but is not forbidden. It allows the command script to
overrule the values of the directory identifiers ( $...DIR$ ) as set by the system envir-
onment in which OpendTect is running. Or you can reset the "increment"-identifier
FILEIDX with the start value you like. Beware that most of the predefined identifier
constants are unfit for change. They are only there to make command scripts more
readable. The Command Driver will keep using the original values internally! For
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example, you can exchange the values of TRUE and FALSE, but the function call
isAlpha("a") still returns 1. Therefore, an expression like isAlpha("a")==TRUE would
suddenly get an opposite meaning.

<ident> $<ident>$ XII. Predefined identifiers
(to be used in sub-
stitution and expres-
sions)

TRUE

FALSE

1

0

Logical constants

PI 3.14159265 ... Trigonometric constant
UNDEF 1e30 OpendTect's undefined

value. Treated as such by
all logical, mathematical,
and statistical operators
and functions defined
above.

SUCCESS

FAILURE

WARNING

1

0

-1

Possible results of 'Try'-
command

ON

OFF

UNSWITCHABLE

1

0

-1

Possible results of any
'Is...On'-question command

BASEDIR Base data directory ( 
setenv DTECT_
[WIN]DATA )

DATADIR $BASEDIR$/<cur_ sur-
vey>

Survey directory

PROCDIR $DATADIR$/Proc Processing directory
APPLDIR Installed software directory

(  setenv DTECT_
[WIN]APPL )

USERDIR Personal home directory ( 
setenv DTECT_
PERSONAL_DIR )

SCRIPTSDIR $PROCDIR$ Overruled by setenv
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DTECT_SCRIPTS_DIR
SNAPSHOTSDIR $DATADIR$/Snapshots Overruled by setenv

DTECT_ SNAPSHOTS_
DIR

IMPORTDIR $DATADIR$/Import Overruled by setenv
DTECT_IMPORT_DIR

EXPORTDIR $DATADIR$/Export Overruled by setenv
DTECT_EXPORT_DIR

FILEIDX 1000++ Integer variable that is auto-
matically incremented after
every occurrence in the
command stream. It may be
substituted in file- paths to
generate unique filenames.

Repetitive task example

One of the recurring user questions about OpendTect is whether there is a quick
way to do some kind of repetitive task. Loading a huge amount of wells, importing
multiple 2D line SEG-Y data, etc. Such a service can only be offered by OpendTect
itself if the task is very simple, common and straightforward. For example, one does
have the possibility to select multiple horizons with the mouse in order to load them
in one go. However, if the repetitive task is more complex, unique, or variant, the
workflow can be automatized by means of a command script.

The current Command Driver capabilities are demonstrated by automizing a case
raised by Magnus Lidgren. His scene contained a big number of 2D lines, and a
number of attributes on each line. He needed to generate a picture for every attrib-
ute of every 2D line, and wanted to avoid doing that manually.

Automizing a repetitive task consists of three stages. Firstly, the Command
Recorder is applied to record the mouse and keyboard actions needed to perform
the task once. Secondly, a text editor is used to modify the recorded script. Some of
the recorded actions have to be generalized, and a few new commands have to be
added to make the script iterative. These commands are listed in Table III. Thirdly,
the Command Driver is applied to run the modified script, initially to debug it and
finally to perform the repetitive task.

Listed below is the recorded command script that makes a snapshot of one attribute
on one 2D line. The passages that need to be generalized have been printed in red.



- 1059 -

[OpendTect Main Window]
TreeMenu "2D Seismics`LS 5k`i5007`Seis" "Display in a 2D
Viewer as`VD"

[2D Viewer - Line: i5007]
Button "Save image"

[Create snapshot]
Button "Screen" On
Input "Select filename" "/d43/-
jaap/surveys/Demo2D/Snapshots/dump.png" Hold
Button "Ok"

[2D Viewer - Line: i5007]
Close

[OpendTect Main Window]

Listed below is the modified command script after it has been generalized and made
iterative. All changes with regard to the originally recorded script have been printed
in green.

Def res ? dumpAttribute( setnr, namenr, attrnr )
[OpendTect Main Window]
res ~ TreeMenu "2D Seismics`*#$-

setnr$`*#$namenr$`*#$attrnr$" \
"Display`2D Viewer - VD"

If res==FAILURE ; Return ; Fi

pic_name = strCat( wildcard(1), "_", wildcard(2), "_" )
pic_name = strCat( pic_name, wildcard(3), ".png" )

[2D Viewer - Line: *]
Button "Save image"

[Create snapshot]
Button "Screen" On
Input "Select filename" "$SNAPSHOTSDIR$/$pic_name$" Hold
Button "Ok"
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[2D Viewer - Line: *]
Close

[OpendTect Main Window]
Fed

For setidx = 1
For nameidx = 1

For attridx = 1
res ? dumpAttribute( setidx, nameidx, attridx )
If !res ; Break ; Fi

Rof
If attridx==1 ; Break ; Fi

Rof
If nameidx==1 ; Break ; Fi

Rof

The command script example above demonstrates a number of more advanced
Command Driver features:

l Def-inition of procedure(s) to modularize, reuse and/or hide command sequences.
l "Try"-command ( res ~ ... ) to check whether a command executes.
l Wildcards ('*') to match arbitrary substrings.
l Disambiguators ('#') to select the n-th match out of multiple matches.
l Substitution ( $...$ ) of identifier values into command actions.
l Backslash ('\') to spread a long command over multiple lines.
l If-command to execute command actions conditionally.
l Use of predefined identifiers: constant FAILURE and environment variable
SNAPSHOTSDIR.

l Semicolons (';') to separate multiple commands on one line.
l Return-command to terminate a procedure immediately.
l Use of assignment and built-in function calls ( pic_name = strCat(...,...) ).
l Wildcard(.)-function to get matching strings from the latest successful wildcarded com-
mand action. Note that these strings must be secured before the next use of a wildcard
( i.e. in window assertion [2D Viewer - Line: *] ).

l (For)-loops to make a script iterative.
l Call to a user-defined procedure ( res ? dumpAttribute(...,...) )
l Break-command to escape from loops immediately.

Note that different operators are used to store the result of an expression (=), a com-
mand action (~), or either a user-defined procedure (?) or a question command (?)
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into an identifier. This eases the parsing of commands by the Command Driver, and
it should make the user aware that the allowed complexity of (sub)-expressions
does not go beyond the built- in function calls. The results of command actions,
user-defined procedure calls, and question commands have to be assigned to aux-
iliary identifiers first.

The introduction of question commands allows the body of the previous script to be
written in a different style. An identifier can take the answer to one of the many ques-
tions (Nr..., Cur..., Is..., Get...) from Table IV to VII about some property of a user-
interface element. Instead of applying the Break-command to escape from loops
when the procedure call to dumpAttribute(...,...) fails, now the number of items to iter-
ate over can be asked and set before entering a loop ( nritems ? NrTreeItems ... ).
Note that a procedure defined with a return parameter can also be called without.
Listed below is the restyled body of the command script above.

nrsets ? NrTreeItems "2D Seismics"
For setidx = 1 To nrsets

nrnames ? NrTreeItems "2D Seismics`*#$setidx$"
For nameidx = 1 To nrnames

nrattrs ? NrTreeItems "2D Seismics`*#$setidx$`*#$nameidx$"
For attridx = 1 To nrattrs

dumpAttribute( setidx, nameidx, attridx )
Rof

Rof
Rof

Standard test scripts

In the 'doc' directory of the release, you can find a 'Scripts' subdirectory. It contains
the standard test scripts for OpendTect. These test scripts all work on a survey 'F3_
Demo', the demo data set for OpendTect.

The directory contains several scripts, many of which can be run stand-alone, but
certainly not all. There is also an execute-all script: 'AllScripts.cmd'. Another com-
posite script is 'AllAttributes.cmd', which will make snapshots in the Snapshots dir-
ectory. This Snapshots directory is created automatically; the location is your_
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surveys/F3_Demo/Snapshots. The snapshots are created as an index followed by
the file name.

Another script is 'ExportData.cmd'. While running this script an 'Export' directory is
automatically created as a subdirectory of 'F3_Demo'. All the exported data will be
stored in the above directory.

Some scripts are dependent on PlugIns like SSIS, VMB etc. These scripts are loc-
ated in dgb/doc/Scripts. To run these scripts you should make sure the related plu-
gins are loaded.

User history recording

The CmdDriver plugin also offers the possibility to record the user action history in
the background from the moment OpendTect is started. It will be stored in the file
userhistory.odcmdin the Proc directory of the starting survey. It is not guaranteed
that the Command Driver can offer a full reproduction of the past by running this file,
since not all possible user actions are covered yet. Mouse actions performed in 3D
scenes or 2D viewers are recorded nor executed for the time being. Actions per-
formed in the Command Controller window are recorded, but not executed as long
as the difficulty of calling the Command Driver recursively has not been solved.
Nevertheless, the recorded history can be of great help in reproducing a bug or
crash reported by the user.

In order to enable recording of the user history, the user setting dTect.User history
buffer must be set with a value other than zero. The magnitude of this value defines
the size (in characters) of the buffer in which the user actions are stored temporarily.
A positive size value means flushing the content of the buffer to file every time it
overflows. A negative size value means dropping the oldest content once the buffer
starts overflowing, and flushing only the newest actions to file when OpendTect
finally exits or crashes. The menu item Utilities->Settings->Advanced->Personal set-
tings will pop-up a dialog in which this user setting can be added or adapted.
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13 Appendix C - SEG-Y Check-
list
This document contains examples of SEG-Y loading problems and proposes solu-
tions for the most often encountered problems.

In all cases, the SEG-Y import tool must be launched from the survey menu (Import
--> Seismics --> SEG-Y). Enter the settings needed for the first step and press OK.
In the next window (main import window) press scan and perform the scan. An
examine window will pop up. Display the first traces in the 2D viewer.

You should have on your screen:

l The main import window
l The examine window
l The scan report
l The first traces displayed in a 2D viewer

Once you have this on screen check the most appropriate situation in the list below:

1. The textual header is not readable
2. The line header is not readable
3. None of the trace headers are readable
4. The first trace header is readable but no other - zero sample rate - last trace incom-

plete
5. The examine/scan reports incorrect coordinates
6. The loaded volume contains wrong amplitudes
7. The loaded volume contains holes - traces were rejected
8. The loaded volume is shifted with respect to the others - does not start at zero

Excel utilities

1. SEG-Y file size computation
2. SEG-Y trace numbers computation
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SEG-Y checklist

The textual header is not readable

The top of the examine window may look like any of those two windows, although
there is an enormous variety in textual headers:
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The left picture is a very common empty (automatically filled) textual header. Some-
times an operator fills the empty parts, but you can expect mistakes to occur. The
second picture is a textual header from an OpendTect exported SEG-Y file. All the
fields were directly copied from the project database (additional edits are possible).

Every SEG-Y file begins with 40 times 80 characters encoded in ASCII, or EBCDIC
for old files. The main difference between them is that your favorite text editor (word-
pad, vi or text edit) will not be able to translate EBCDIC encoded characters if you
open the SEG-Y file with it, while if you open an ASCII SEG-Y textual header you
will see the same as in the OpendTect examine window, without the line breaks.

l Problem: If you do not see the above described structure youmight not be reading a
SEG-Y file at all, but maybe a seismic file written in a different format (binary, SEG-D,
...).

l Solution: Translate your file if possible.
l Problem: Some characters in the textual header areweird.
l Solution: They were badly translated from EBCDIC to ASCII (or the opposite), either
when writing the file or when reading it. Unfortunately there is no 1 to 1 translation
between EBCDIC and ASCII, therefore this issue cannot be solved. That is why
EBCDIC coding has been banned from the SEG-Y revision 1 norm.

The line header is not readable

The line header overview is provided in the top part of the examine window below
the textual header. Use the right scroll bar to reach it. Only the non-zero values are
shown, on the contrary to the other headers where the entire content is reported. A
correct line header will look like this in the OpendTect examine window:
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The title line, field names (first column), byte offsets (second column) and explan-
ations between brackets (fourth column) are provided by OpendTect. Only the num-
bers in the third column originate from the file. The byte numbers indicate where
those values were found.

Look at the field isrev1 (301): If the value is zero your file is revision 0 compliant. If
the value is equal to 1 then your file in (normally) revision 1 compliant. This enables
to answer to the revision 1 question.

Problem: If none of the values are reasonable but contain a lot of 256 and
16777216, or in general if none of the numbers make sense, the file might be byte-
swapped (i.e. written using "little-endian" byte ordering instead of "big-endian"). See
example below:

l Solution 1: In that case cancel the import window (that will bring you back to the first
step), and put the "Byte swapped" parameter to "all".

l Solution 2:.If this is not enough then the textual and/or line headers might be cor-
rupted. Try to re-create your SEG-Y file if possible.

>

None of the trace headers are readable

Problem: The line header is truncated: The line header should be 400 bytes long. It
will not be possible to deduct the start position of the first trace if any of the first 3600
(=3200 + 400) bytes are missing. If the line header is truncated then you should see
a lot of non-standard entries in the examine window, like in the example below:

l Solution: Use the excel utilities to determine if your file may be missing some bytes. If
that is the case you need to re-create your file unless you know exactly how many
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bytes are missing and how to lengthen your line header.
l Problem: The bytes are swapped.
l Solution: See above.

The first trace header is readable but no other - zero sample rate - last trace
incomplete

This happens when the trace size could not be computed successfully. The trace
size is function of the sample size (format) and number of samples. The problem
then occurs when either of those variables was not correctly written in the headers.

Action 1: Check if the sample size (format) is correct in the line header: The sample
format is reported in the examine window in the line header in front of the "format"
field. It must report a value of 1, 2, 3, 5 or 8. If not the following warning will be
shown when scanning the file or loading it:

l A value of 1, 2, 5 represents a sample size of 4 bytes.
l A value of 3 represents a sample size of 2 bytes.
l A value of 8 represents a sample size of 1 byte.



- 1070 -

Furthermore the warning "Err: Warning: replacing zero sample rate with survey
default" is printed (but that is not the only cause) if the actual sample size is larger
than the sample size deducted from the headers of overruled.

On the contrary the warning "last trace incomplete" is printed (but that is not the only
cause) if the actual sample size is smaller than the sample size deducted from the
headers or overruled.

l Solution:Overrule the SEG-Y format to another format until the line header and all
trace headers are readable in the examine window. Scan your file and check the out-
put amplitudes since three different formats are available for a sample size of 4 bytes.
A proper display of the data in the 2D viewer will indicate a success.

l Action 2: Check if the number of samples was correctly extracted from either the line
or trace headers: The number of samples is reported at multiple positions in the SEG-Y
file:

l In the examine window in the line header overview in front of the "hns" field.
l In each trace header at byte offset 115 (field "ns").
l OpendTect will only use the number of samples defined in the trace headers. There-
fore the line header field "hns" might be missing or in contradiction with the trace head-
ers, with no consequence upon the data loading as long as the trace headers "ns" field
are correctly written.

l Solution:Overrule the SEG-Y number of samples to another value until all trace
headers are readable. The excel utilities might be helpful to check the correct value
and to check if the file is not missing some bytes.

The examine/scan reports incorrect coordinates

The coordinates may be found in each trace headers on bytes 73 (CDP-X) and 77
(CDP-Y) or 181 and 185 respectively with SEG-Y revision 1 files. However those val-
ues will be scaled during scan and loading by the scaler coordinate that should
always be found on bytes 71-72.
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l Problem: The coordinates found in the trace headers do not make sense: Your file
might contain coordinate trace header encoded as floats instead of integers. This is not
allowed by any SEG-Y standard, although still being encountered sometimes.

l Solution: Get a SEG-Y compliant file.
l Problem: The unscaled coordinates are reasonable but after scan/loading the scaled
coordinates are not correct.

l Solution: Overrule the scaler coordinate to the right value in the import window. You
need to specify a number that when multiplied by the trace header coordinate will
return the actual (scaled) coordinate. Therefore the trace header scalco "-10" would
have to be overruled by 0.1 in order to get the same scaling.

Please note the it is not possible to apply a static shift (easting/northing) to the
coordinates, however this is not needed by OpendTect. Nevertheless you can load
the SEG-Y file first and apply your shift to the survey coordinates afterwards in the
survey definition window.

The loaded volume contains wrong amplitudes

This is linked to the sample format not being correctly set. The three formats 1, 2, 5
code the data on four bytes. You may need to switch and overrule between 1, 2 and
5.

The loaded volume contains holes - traces were rejected

Neither a SEG-Y file nor and OpendTect volume need to be rectangular, i.e. they do
not need to contain all traces of rectangular survey. This is normal, except if you
expect a rectangular volume. Please note that the default setting in OpendTect is to
dismiss null traces, i.e. traces where all samples have a zero value.

l Problem: The warning "during import 123450 traces were rejected" appers when load-
ing the file.

l Solution 1: Display the loaded file. The warning sometimes pops up by mistakes such
that your file may be already correctly loaded.

l Solution 2: Make sure that the survey area is large enough to accommodate your new
volume.

In general

Solution: Use the excel utilities to compute the number of traces you can expect to
have in your SEG-Y file, and compare it with the actual number of loaded traces,
reported in the scan report. OpendTect will be able to load all full traces until the first
missing byte is found in the input file or until the end of the file, even if the end of the
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file is in the middle of a trace. In that case only the last non-complete trace will not
be acccessible.

The loaded volume is shifted with respect to the others - does not start at
zero

Sometimes the first sample does not correspond to the time or depth 0. If that is the
case the corresponding time or depth should be reported in each SEG-Y trace
header at bytes 109-110 (delrt) and/or 105-106 (laga) with the opposite polarity like
in this example:

"laga" is equal to -200, delrt is equal to 200: both mean that the first sample cor-
responds to time 200ms.

l Problem : The start time is not specified in the trace headers but is expected to be dif-
ferent that zero.

l Solution: Overrule the start time parameter in the import window.
l Problem: An incorrect start time was applied during loading.
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l Solution: Either re-import the file by overruling the start time or use the reference shift
attribute to apply a static shift to your traces.

Please note that in all cases you must have a priori knowledge of the start time.
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Excel utilities

The following two utilities can be used to:

l Compute the SEG-Y file size based on the sample format, number of traces and num-
ber of samples. A successful application will be the indicator of a SEG-Y file without
missing bytes.

l Compute the number of traces present in the SEG-Y file based on its size, the sample
format and the number of samples per trace, assuming a constant trace length. If the
returned number os an integer the SEG-Y file does not contain holes (except for a very
unlikely occasion).

Please note that extended textual headers are not supported.

SEG-Y file size computation

SEG-Y file trace number computation

Go to the second tab in the excel sheet to fill in the trace numbers.

SEG-Y_file_size.xls
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SEG-Y_file_size.xls


- 1076 -

14 Appendix D - Wacom Digit-
izing Tablets

l Introduction
l Pen Device
l Basic Interaction
l Draw Polygons
l Create Bodies
l Interpret Horizons
l Manually Edit Horizons
l Interpret Faults
l Supported Platforms

OpendTect is the first Seismic Interpretation System to support Wacom Digitizing
Tablets. Workflows for horizon tracking, fault interpretation, drawing of polygons
and bodies etc. have been adapted to benefit from the superior hand-eye co-ordin-
ation offered by the pen/tablet combination device.
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Introduction

OpendTect combined with a Wacom Tablet has become a key application for hand-
eye coordination. It has proven to be vital in manual interpretations with OpendTect.
Many of the OpendTect interpretation- workflows were modified in version 4.2 for
optional use of a tablet device. This documentation is thus written to provide a brief
introduction on seismic interpretation on a tablet. The documentation assumes
basic familiarity with the OpendTect environment.

Several aspects of 3D interpretation will be covered:

l How to use the Wacom Pen device instead of a conventional mouse
l How to draw interpretations in OpendTect with a Wacom tablet
l Polygon/pointsets
l Horizon Interpretation
l Fault Interpretation

Before you start using the documentation, a general introduction will be given on the
pen device and the features which are supported by OpendTect.

Pen Device

The following list describes how the pen device replaces traditional mouse features:

l Mouse clicks are replaced with the clicks being made by the tip of the pen device
l The mouse drag function is replicated by dragging the tip of the pen on the tablet
device

l The right/left/double click buttons are supported via the DuoSwitch
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The only thing required is to hold the pen device in your hand and begin interpreting
the seismic data. If you want to draw a seismic object e.g. a horizon/polygon, you
will simply need to drag the tip with a light pressure on the tablet. Light pressure
here simply means that you touch the tablet screen using the tip of the pen. The tab-
let is pressure sensitive and will automatically detect that the user is intending to
draw on screen. It will convert the screen coordinates back to the survey coordin-
ates and will store the object.

Furthermore, the Eraser can be used to remove (parts of) the interpretation (spe-
cifically, the seeds). The eraser feature is accessed either by clicking on the node/-
seed to remove it, alternatively by rubbing it over the interpretation (drawn lines).
The DuoSwitch is used to launch pop-up menus or for double clicking on an ele-
ment. The single left mouse-button click is accessed through the tip of the pen (by
'tapping' on the screen).

Precautions:

l When the pen is not in use, please place it back in the pen stand
l Please avoid using the mouse while the pen device is in your hand. You may either use
a pen supported by the Wacom tablet or regular installed mouse

Basic Interaction
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Menus/Icons:

The menus/icons are clicked using the tip of the pen device. The tip is tapped over
the (sub ) menu/icon to launch the corresponding dialog/application.

Display an Element:

To display an element in a scene, you will need to use the Tree of OpendTect. For
instance, to display an Inline, simply place the tip of the pen at inline and select the
Add option.

Pop-Up Menus:

Pop-up menus are launched using the lower button of the DuoSwitch. The pop-up
menu options are selected by tapping the item with the tip of the pen.

Lines/Seeds/Points:

The lines, seeds or points (pointsets) in OpendTect are drawn by dragging the tip of
the pen over the displayed element in the 3D scene, similarly to drawing with a pen
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on regular paper. The drawn line/point data can be removed interactively using the
Eraser at the end of the pen.

Draw Polygons

The first example in this tutorial is creating a simple polygon on a horizon on the tab-
let device. Although the workflow is simple, several options and features are intro-
duced so that you will familiarize yourself with other important features
simultaneously. Please follow the steps set out below:

In the following workflow, use the pen device instead of mouse. Tap/Press/Select in
this workflow refers to the tip of the pen device.

1. Hold the pen device in your hand
2. Drawing a polygon on a seismic horizon:

First, display a seismic horizon. Tap the tip of the pen on the Horizon element in the
tree; a pop-up sub-menu appears

Select Load

The Horizon Selection dialog is then launched from where you can select one or
more saved horizons

Select a horizon by tapping on it, or multiple horizons by tapping and dragging

Press Ok to display the selected horizon(s)

Once a seismic horizon on which you want to draw a polygon is displayed, you can
continue to the next steps; drawing a polygon

3. From the tree, tap on the pointset/Polygon element
4. From the pop-up menu select New Polygon
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5. The Polygon Creation dialog box is opened, type a name for the new polygon. For typ-
ing, you may use either the conventional keyboard attached to your computer or the vir-
tual keyboard supported in OpendTect. The virtual keyboard is launched using the
lower DuoSwitch button (equivalent to the right-click button on a conventional mouse)
whilst pointing the pen at the name field. Once done typing, simply close the virtual key-
board: the new polygon name is automatically inserted in the field

6. Hit Ok in the parent Polygon Creation dialog
7. A blank polygon is added in the tree, with the given name (step 5)
8. Optional: before drawing on the horizon, change to map-view by selecting View North-

Z in the main toolbar to the left

9. Make sure the polygon element in the tree is active (tap it) and start drawing the poly-
gon on the horizon. Two methods are available: (1) drag and release, in which you will
have to drag the pen over the area where you want to draw a polygon or (2) tap pen,
where you tap on the horizon to insert seeds, the seeds are then connected auto-
matically

10. Whilst drawing the polygon, unwanted points can be removed with the eraser at the
end of the pen

11. Finally, close the polygon: Right click (lower button on the DuoSwitch) on the polygon
name in the tree and select Close Polygon option from the pop-up menu.
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Create Bodies

Bodies are easily created after drawing a polygon. The workflow requires a com-
bination of a saved polygon and top and bottom horizons between which the body
will be created.

1. Display a stored (Load) or draw (New) a polygon by following the workflow above
2. From the polygon pop-up menu (use the lower DuoSwitch), select Create body
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3. In this dialog, select top and bottom horizons
4. Hit theOk button
5. The above step (4) creates the body with an empty name and displays it in the scene.

In the tree, the <NewMCBody 1> sub element under the Bodymenu appears. Save it
by launching the pop-up menu for the body by using the lower DuoSwitch

Interpret Horizons

Seismic horizon interpretation is fast and convenient on the Wacom tablet device.
This is mainly due to the human adaptability with the pen. To help you get started
with interpreting seismic horizons with OpendTect on the tablet device, simply grab
your pen and follow the workflow set out below.

Please use the pen device instead of mouse in the following workflow.
Tap/Press/Select all refer to the tip of the pen device.

Setup an orthogonal Display:

1. A flat (orthogonal) display has proven useful when interpreting horizons on seismic
data. This view enables you to view the inlines/crosslines/z-slices as '2D' planes. Sim-
ply switch the default perspective view to orthographic:

Use the pen device to tap the button to toggle the orthographic view on/off.

2. If you wish to interpret horizons on inlines, you may want to select the View Inline dis-
play option from theGraphical Toolbar.

3. Optional: You may also adjust the zoom of the display using the touch strips available
on the back side of the table.

Display seismic data:
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4. Display seismic data in the scene by tapping either Inline or Crossline in the tree. By
default data is being displayed as a white colored 'empty' element in the centre of the
survey. Select data by tapping the <right-click> sub-element. Use the lower DuoSwitch
to access the sub-element and select seismic data to be displayed (as shown below).

Once the seismic data is loaded, you can proceed to the next step

Add a New Horizon:

5. Use the pen tip to add a new horizon in the tree. Tap the Horizon element in the tree
using the pen. A drop-down list appears; select New...

6. A new horizon is added in the tree, labeled <New Horizon 1> by default. A pop-up dia-
log also appears (i.e. the Tracking Setup).

Pick seeds and Auto-track:

7. The tracking setup window features four tabs, presented briefly below. Please refer to
the general help documentation of OpendTect for detailed descriptions.
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Mode: Select tracking mode i.e. auto-tracking, tracking on a line, or tracking manu-
ally.

Event: Used if the mode is set to either auto-tracking or line tracking. Select seismic
data in the Input data field and provide the event type (Peak/Trough/Zero-crossing).
Please, note that Max refers to peak, Min refers to trough, 0+/- refers to positive to
negative zero crossing, and 0-/+ refers to negative to positive zero crossing. Use
the default search window as a starting point. These settings can be accessed and
changed later. Also, use the default step-wise-tracking options i.e. Relative (amp-
litude) difference of 1, 2, 5, 10, 20 â€¦%. Leave the other settings to default.

Similarity: Matches the seismic events based on the picked seeds and searches
for the corresponding signal in the immediate vicinity. Please, leave this blank for
now. [Tip: For fast tracking in a good quality area, reduce the threshold (e.g. 0.5),
and the time gate (e.g. -16 and +16).
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Properties: Change horizon colour and the seed properties (e.g. size, colour and
shape).

8. By default the seed mode is toggled on in the OpendTect tracking toolbar (shown
below). Note that volume tracking is set on by default (i.e. tracking in a small sub
volume)

9. Next, start interpreting by picking a seismic event using the pen device. [Tip: Drag the
pen over a seismic event if the area is coherent and of good quality, otherwise use the
pen clicks on the event to drop seeds]

10. Move the inline position and continue interpreting over the entire survey.
11. In order to remove a seed, simply use the Eraser on the end of the pen. Optionally, use

the ExpressKeys on the tablet device (subject to availability).
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Pen tap on a plane = pick and local track

Pen tap with Ctrl + Shift express keys pressed = drop/undrop a seed at a pen loc-
ation

Pen tap with Ctrl express key = remove the seed and track locally

Pen tap with Shift express key = remove the seed and erase auto-tracking from that
seed until the next seed(s)

12. After interpreting a good part of the survey area, test the auto-track settings by spe-
cifying a small auto-tracking area. Select the show tracking area button in the track-
ing toolbar.

13. A 3D boundary box appears around the interpreted horizon. Use the green anchors at
the corners of the box to re-size ormove it: place the pen tip at one of the anchors and
drag in the respective directions (diagonal anchors resize the entire box in 3D with
equal proportion, whilst the others stretch/squeeze the box horizontally/vertically).
[Tip:toggle viewmode to perspective to see the whole box.]

14. Once the tracking area is defined, tap anywhere in an empty area in the scene to read/-
load seismic data within the specified tracking volume. [Tip: Preferably, tap outside the
survey area with a zoomed-out view.]

15. Press the auto-track button to start auto-tracking the horizon within the tracking
area. [Tip: It is recommended to save the raw interpretation as a separate file before
attempting to auto-track.]

Manual Tracking:

16. Manual tracking is accessed by changing the tracking setup to Line manual

in the tracking toolbar drop-down list.
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17. With Line manual selected, you will just need to draw horizons using the pen [Tip:
Drag the pen over the event and release once done.]

18. Move about 5 or 10 inlines (or cross-lines) forward/backward and repeat manual inter-
pretation. [Tip: Instead of interpreting the data in 3D, you may interpret the data in a
2D viewer]

Save Horizon(s):

Click on the save button that is present in the tracking toolbar to Save the <New
Horizon 1>>, alternatively right click the horizon in the tree menu and choose either
Save or Save as...

Save Session:

Save the session to continue interpreting the horizon at a later time if not completed

Manually Edit Horizons

This is an important exercise where you will learn how to edit a Horizon in
OpendTect with your tablet device.

1. Inmap view, draw a polygonal area using the polygon selection tool (from the
Graphical Toolbar to the left).

2. Click the horizon from the tree (to activate it) and press the trash icon to remove the
outlined portion of the horizon
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3. Now switch to inline/cross-line view in the area of the removed polygon
4. Enable the tracking mode; use the DuoSwitch to launch the use the pop-up menu of

the horizon and select the Enable tracking option under the Tracking sub-menu. This
will enable the tracking controls and now you can either edit the horizon in the 3D
scene or in a 2D Viewer

5. From the tracking controls available at the bottom of OpendTect by default, set setup
to Line manual
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6. In this exercise, we will edit the horizon in a 2D viewer:
7. Display the inline in a 2D Viewer (use the lower DuoSwitch as shown above)
8. In the 2D viewer, you will have to display the same horizon
9. Toggle Edit modeON (or as shown below)

10. Now, start editing the horizon by drawing over an event using the pen
11. Move the inline/cross-line to next/previous 10 lines, and repeat the interpretation
12. Save the horizon after editing. This can be done directly from the tree available in the

2D Viewer
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Interpret Faults

Faults in OpendTect can be interpreted as a FaultStickSets or directly as fault
planes. The FaultStickSet (in the tree) is a set of sticks that can be converted to 3D
fault planes. The FaultStickSet element can be used for a 2D line or for a 3D volume
(inline/crossline/timeslice). Contrary to the FaultStickSet, the Fault element in the
tree is generally used to interpret a single 3D fault plane in a 3D survey, however
FaultStickSets can be converted and merged to new or existing single or grouped
faults at any time (and vice versa).

In this manual, you will learn the use of both mentioned methods of interpreting
faults in a 3D survey.

In the following workflow, use the pen device instead of mouse. Tap/Press/Select in
this workflow refers to the tip of the pen device.

Basic Fault Interpretation for 3D Seismic Data:

1. Display an inline (or a cross-line) in the scene. [Make sure that the seismic data has
already been displayed along the displayed inline].Optional: Position the inline to a
location at where you want to start the 3D fault interpretation. To position, you may use
the slice position controls
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2. Click on the Fault element to add a New Fault sub-element in the tree. Next, make sure
that it is selected / active

3. Now in the scene, start drawing the fault stick on the inline. [Drag the pen over the
inline at fault plane location]

4. To remove a seed of a fault plane, you may use the Eraser of the pen
5. To position a seed to a new location, you may move the seed by clicking and dragging

it in any direction
6. Move (step) the inline to the next position to interpret another stick of the fault in a new

location (5 or 10 inlines forward or backward or smaller steps if continuation is
unclear). [Tip: Display the fault plane on sections online. For this use may use the
lower button of the DuoSwitch to launch the pop-up menu. In the pop-up menu please
select the Display option]

7. Repeat the steps to interpret the fault on other inline/cross-lines
8. Use the lower button of DuoSwitch to Save the <New Fault 1>

Interactive Fault Interpretation using Auto-scroll method:

This is an alternative workflow for quick 3D fault interpretation.
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1. Preload the seismic data on which you are intended to interpret faults. [Tip: Use the
Survey menu i.e. Survey > Preload > Seismics]

2. Display an inline (or a crossline) in the scene. [Make sure that the seismic data has
already been displayed along the displayed inline]

3. Click on the Fault element to add a New Fault sub-element in the tree. This will add a
<New Fault 1> fault under Fault element. [Make sure that it is clicked / active]

4. Use the lower button of DuoSwitch on the Inline to launch the drop-down list and select
Position... In the Positioning dialog, please click on the Scroll button
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5. In the scrolling dialog, set the scroll step (i.e. number of inlines/cross-lines to move,
use positive number for forward scrolling and negative number for backward scrolling)
and time to scroll the inline to the next position (use for example 5 seconds)

6. Click on the to activate it
7. Now in the scene, start drawing the fault stick on the inline. Drag the pen over the inline

at where you observe the fault. Once you have interpreted a fault stick on the current
inline, wait for a few seconds for the inline to be moved forward/backward auto-
matically

8. Continue the fault interpretation on all lines (step p-q)
9. Use the lower button of DuoSwitch to Save the <New Fault 1>

Fault Sticks Interpretation for 3D Seismic Data:

This workflow allows for interpreting fault sticks only, which can later be converted
to 3D fault planes. The benefit of this workflow is that you can interpret multiple
sticks on an inline/crossline.

1. Display an inline/crossline in the scene. [Tip: Click on the Inline element to add a new
inline]

2. Add a new FaultStickSet in the tree. [Click on the FaultStickSet, and select the Add
option in the pop-up menu.]

3. Start drawing multiple fault sticks in the scene. To split sticks, use lower DuoSwitch
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4. If you want to move a node of a fault stick, place the tip of the pen over the node to be
modified. Click and drag the node in 3D and position it to a correct location

5. Save the FaultStickSet by launching the drop-down list [Tip: Use the lower DuoSwitch
button.]

6. Move the inline/crossline to the next position and continue the interpretation
7. While moving the inline/crossline, you may still observe the sticks from previously inter-

preted sections. To hide them (and therefore avoid confusion), please display the fault
sticks at sections only. [Tip: Use the pop-up menu for the fault stick set.]

Optional: Optionally combine the FaultStickSet interpretation workflow above with
the auto-scrollingmethod.

Convert Fault Sticks to Fault Planes:

To convert fault sticks into fault planes, you will need to familiarize yourself with the
Fault Sticks Toolbar (shown below). By default, this toolbar appears at the bottom of
the OpendTect window.

1. Display a time slice of similarity attribute, so that you can identify the fault trends
2. Display the fault sticks in a 3D scene. [Tip: Use the pop-up menu for the fault stick set.]
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3. Optional: Position the time slice (step-a) at where you can see the tops of the fault
sticks

4. Activate the select sticks button
5. Make sure that you are in interact mode
6. In the scene, draw a polygon to select the sticks that you want to convert into a fault

plane. [Use the pen device and draw a red colored polygon.]
7. Once the tip of the pen is lifted away from the tablet, observe that the sticks within the

polygon turn green. This means that the sticks have been selected (and can be con-
verted to a fault plane)

8. Next, copy ormove the selection to a single new fault plane. This option is illustrated in
the above fault stick toolbar

9. Give a name in the text field of the toolbar
10. Hit the Go button to save and display the fault plane in the scene and tree

Useful Notes on Fault Sticks Toolbar:
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l The 'Copy selection to' option is used to copy the selected fault sticks to a fault plane
without remove the fault sticks from the original fault stick set. Contrary to this, the
'Move selection to' option removes the selected fault sticks from the original fault stick
set and moves them to a fault plane.

l The Fault/FaultStickSet option is used to convert the selected fault sticks to a fault
plane or to another fault stick set.

l There are different ways to name faults/FaultStickSets. This is done via the output
operations list box i.e. Create single new (to create a new single fault plane or a fault
stick set), Create new in series (automatically labels the faults with a numeric index),
Merge with existing (to merge the fault plane to an existing fault plane or fault stick set),
and Replace the existing (replace the selected fault plane with the newly selected
sticks).

l The trash button in the toolbar is used to remove the selected fault sticks

Supported Platforms

Officially the Wacom Cintiq 21UX and Wacom Cintiq 24HD are only supported on
Windows and macOS.

However it is possible to get it to work on Linux.

There is an Open Source group that writes and maintains drivers for the Wacom tab-
lets.

For more information please go to this the Sourceforge Linux Wacom page.
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15 Appendix E - Synthetic Data
Generation

l Ray Tracing
l Computation of the Zero Offset Reflection Coefficient
l Computation of the Reflection Coefficient at any non-zero offset
l Elastic Model

Synthetic seismic data is generated in SynthRock by clicking on the edit icon ( ) in
the top-left corner of the main Layer Modeling. This will bring up the following win-
dow:
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Here various types of synthetic data can be generated: Zero Offset Stack, Pre Stack
gathers, Angle Stack and AVO Gradient:
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Ray tracing

While Zoeppritz equations are used to compute angle-dependent reflectivity; ray tra-
cing is required to compute the angle of incidence, at various interfaces of elastic
model, of seismic rays recorded at various offsets. The 2D ray-tracing can be per-
formed in two ways:

Simple Ray Tracer:

The ray is going directly from the source to the depth of the target layer, and up to
the receiver in the same way. This does not account for ray bending, or velocity
inversions. Here the user has to specify the offset range and the step for creating
pre stack gathers; they could in theory be same as defined in acquisition/processing
of the seismic data. It can model both Downgoing and Upgoing P-waves and S-
waves. Now, ray tracer and Zoeppritz equations have produced angle-dependent or
offset-dependent reflectivity traces, which can be convolved with user defined wave-
let to produce pre stack gathers. It may be noted that in SynthRock, the conversion
from offset domain to angle domain and vice-versa is done using the Vp of the
Elastic Model [hyperlink with Elastic Model] (which is essentially the upscaled and
time converted Vp log of pseudo-wells).

Simple RayTracer parameters

Advanced Ray Tracer (not in the GPL version):
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This works in a more sophisticated way than the simple ray tracer. It honours the ray
bending according to Snell's law and thus velocity inversions as well. To reduce the
processing time, the Elastic Model layers may be blocked: Consecutive layers with
similar Vp, Vs and Density values are concatenated together, as defined by the
threshold. For example the default threshold is 1%, which means if there is less than
1% difference in the elastic model values of two layers, they will be blocked. The ray
is propagated in a straight line inside a concatenated layer.

It is also possible to compute internal multiples in the advanced ray tracer. Fur-
thermore, incorporation of spherical divergence, is also possible, by defining the
spreading geometry as either "Distance" or "Distance *Vint" .

Advanced RayTracer parameters

Afterward, NMO corrections can also be applied to create NMO corrected synthetic
gathers. Here in the Advanced options, one can specify the % stretch mute typically
applicable at far offsets. If the length of a full seismic waveform increases by more
than the mute %, it will get muted. Moreover, the taper-length of the muting function,
can be defined under this advanced options menu of NMO corrections:
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Advanced RayTracer: Advanced corrections options

Computation of the Zero Offset Reflection Coefficient For the simplest Zero Off-
set Stack, calculation of reflection coefficient at any interface is done using the
simple formula:

where Z1 and Z0 are the impedance of the top and bottom layers, respectively.
These layers are basically upscaled and time converted version of various logs
(Rho, Vp and Vs) in pseudo-well models, and as such comprise the Elastic Model
[hyperlink with Elastic Model] for synthetic seismic generation. The upscaling is
done using the Backus averaging algorithm in depth, but at a (variable) depth
sampling rate which is equivalent to the seismic sample rate in time. Depth-to-time
conversion of the pseudo-well logs, is done using the velocity model of the pseudo-
wells itself.

Backus upscaling is done only for Vp, Vs and Density logs (and other logs based on
them e.g. AI, LambdaRho, MuRho etc.). All other logs e.g. Phi, Sw etc. are upscaled
using thickness weighted averaging (i.e. weights used for the averaging are the
thicknesses of various pseudo-well layers) and are afterwards converted into time
(using the velocity model of the pseudo-wells), at survey sample rate. A Nyquist fil-
ter, as defined by the survey sample rate is also applied on these time converted
rock property traces; e.g. if seismic survey sampling is at 4 ms, Nyquist filter will
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allow a maximum frequency of 125Hz. These are accessible to user in real-time on
the Variable Density View:

Now, computation of above described reflection coefficient, at all the possible acous-
tic impedance contrasts in upscaled pseudo-well layers, gives rise to a reflectivity
trace in time.

This reflectivity trace is then convolved with a user defined wavelet, to create the
Zero Offset Stack for all the pseudo-well models:
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Computation of the Reflection Coefficient at any non-zero offset Pre Stack
data (i.e. offset gathers) can be generated in OpendTect using full Zoeppritz equa-
tions and ray tracing (simple or advanced).

Full Zoeppritz equations are used to compute angle-dependent reflectivity from the
elastic model (i.e. upscaled and time converted version of various logs (Rho, Vp and
Vs) from pseudo-wells) at various interfaces as:
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(above images are fromWikipedia)
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Elastic Model

This Elastic Model can be accessed by clicking the icon, just left of 'Wavelet'.
This model is required by OpendTect for generating synthetic seismic data (both
zero offset stack and pre stack gathers). The elastic model essentially tells the soft-
ware which quantities to use for the reflection coefficient computation and ray tra-
cing, in terms of Density, Vp and Vs:
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If "Compute from: Defined quantity" is chosen, OpendTect can use appropriate
(upscaled and time converted) quantities from pseudo-wells. User can also chose to
compute missing quantities (not modeled in pseudo-wells) using pre-filled rock-
physics relations, e.g. Vs from Vp using Castagna's equation:
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Glossary
A

Absolute Impedance
Full-bandwith impedance inversion response in which the "missing" low-fre-
quency part of the spectrum has been added by the inversion method. For
example - in model-driven inversions the low-frequency model is typically created
by interpolating impedance well logs guided by mapped seismic horizons.

Accomodation Space
The available space for sediments to fill (measured from seafloor to base-level).

AI
Acoustic Impedance: the product of seismic velocity and density.

Attribute
An attribute is a derived quantity from a seismic input set. Attributes in OpendTect
are defined by a name, a value, and a position in 3D space (inline, cross-line and
Z (2WT or depth)). Attributes can be calculated from single-trace, multi-trace, and
multi-volume inputs. They can be steered and/or chained. Steered attributes are
multi-trace attributes in which the trace segments are found by following a (pre-
e-)calculated dip-azimuth. Chained attributes are attributes derived from other
attributes. For example, Similarity and Energy are separate attributes that can be
chained to calculate the Similarity of the Energy using the "Position" attribute.

Attribute Set
An attribute set is an entity consisting of a group of attributes. Usually attributes in
a defined attribute set have something in common. For example, all attributes in a
set have the potential to highlight an object type of interest, or a combined attrib-
ute, using all other attributes as intermediate results. This would be a desirable out-
put.

B

Base level
The surface at which sediment supply, relative sea level changes and wave
energy are in balance. This is the surface at which the accommodation space
equals zero: there is neither deposition, nor erosion.
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Body
A body is an element that defines an arbitrary three dimensional geological shape
(or a geo-body). The body can also be created manually or by using polygons.

C

ChimneyCube
A volume that highlights vertical disturbances in seismic data. The cube is used in
fluid migration path studies, in prospect ranking and for fault seal analysis. A Chim-
neyCube is generated by a neural network that was trained on picked examples
(chimneys and non-chimneys). It gives at every sample location the "chimney
probability" i.e. the likelihood of belonging to the class of identified seismic chim-
neys.

Chrono-stratigraphy
A set of relative geologic time lines as stored in a HorizonCube.

CLAS
A plugin for petrophysical analysis. CLAS stands for Computer Log Analysis Sys-
tem.

Closed Source
Software that is released in binary form only. The commercial plugins to
OpendTect are released as closed source extensions. Such extensions are only
permitted if OpendTect is run under a commercial (or academic) license agree-
ment.

Color Blending
Combined display of three (four) attributes that are displayed in the Red Green
and Blue color channels. Optionally the fourth channel (alpha) displays trans-
parency. Color blending is aka as RGB (RGBA) blending.

Crossline Dip
Dip in the direction of the Crossline axis, or in the direction of increasing cross-
lines.

D

Dip-Steering
The process of auto-tracking seismic data by following the pre-calculated, local
dip and azimuth of the seismic. Dip-steering is used for: a) extracting seismic trace
segments along seismic reflectors as input to multi-trace attribute calculations, b)
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computing special attributes such as polar dip, azimuth, and volume curvature
attributes, c) filtering seismic data (known as dip-steered filtering, aka structurally
oriented filtering), and d) auto-tracking chrono-stratigraphic horizons in the cre-
ation of a HorizonCube.

Dip-Steering Cube
A volume computed from seismic data with at every sample position information
about the local dip and azimuth of the seismic data. In a 3D Steering Cube this
information is stored in two attributes per sample: inline dip and cross-line dip. On
2D seismic only one value is stored: the line-dip. Dips in a Steering Cube are
measured in the line direction and expressed in us/m or mm/m, for time and depth
data, respectively.

E

EEI
Extended Elastic Impedance. Scaled and rotated impedance response at a paar-
ticular angle. Rotation is typically optimized to predict a certain well log property of
interest.

EI
Elastic Impedance. Impedance response at a particular angle of incidence.

Element
An element is a sub-division of various items (of the tree) that are displayed in a
3D scene. Inline, crossline, timeslices, horizon, wells etc are some elements.
Each element is sub-divided into a sub-element. For instance an inline element
can have further sub-elements e.g. inline # 120 that can contain upto eight dif-
ferent attributes.

Eustatic sea-level
Sea-level relative to center of earth.

Explicit Representation
A representation of a 3D object in OpendTect in the form of a triangulated surface.

F

Fault Stickset
The faults are interpreted on a section as a stick, and all sticks that belong to one
fault are grouped in one sticksets. Therefore, a fault stickset contains an
unordered collection of the interpreted sticks.
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Forced regression
Deposition characterized by progradation and incision. Base-level is falling
decreasing accomodation space, forcing the system to prograde. Forced regres-
sion occurs during the Falling stage systems tract.

G

GMT
An open source mapping package developed and maintained by the University of
Hawaii (http://gmt.soest.hawaii.edu/). GMT stands for Generic Mapping Tools.

GPL License
Gnu General Public License (http://www.gnu.org/licenses/gpl.html) is an open
source license under which OpendTect can be run. The license allows redis-
tribution of (modified) source code under the same licensing conditions (copy left
principle). It is not allowed to combine the open source part with closed source plu-
gins, which is why OpendTect is also licensed under a commercial license agree-
ment and under an Academic license agreement.

H

Horizon Data
It refers to a stored attribute grid in a horizon. An attribute is calculated on-the-fly
or in a batch process. On-the-fly, a user needs to store by right-clicking on it an
selecting Save attribute... option. The saved attribute can also be managed in the
Manage horizon. It may be noted that a horizon can contain unlimited stored attrib-
ute/horizon data.

HorizonCube
A dense set of auto-tracked (or modeled) seismic horizons that is indexed and sor-
ted according to relative geologic time (= chrono-stratigraphy).

I

Implicit Representation
A representation of a 3D object in OpendTect in the form of an iso-surface through
a cube of values.

Incision
Depositional feature caused by erosion.
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Inline Dip
Dip in the direction of the Inline axis, or in the direction of increasing inline num-
bers.

M

Madagascar
An open source seismic processing package. See: http://en.wiki-
pedia.org/wiki/Madagascar_(software)

Meta Attribute
Ameta-attribute is an attribute created from multiple input attributes. In
OpendTect, a meta attribute is created either through neural networks, or through
mathematical manipulations and/or logical operations. For example, TheChim-
neyCube and TheFaultCube are meta-attributes. See the Ridge enhancement fil-
ter attribute set from the Default attribute sets for an example of a meta-attribute
created through math and logic. The meta-attribute in this set is the last attribute in
the list.

MLP Neural Network
Multi-Layer-Perceptron type of neural network. The network is used for seismic
object detection (creating Chimney Cubes, Fault Cubes, Salt Cubes etc.) and for
predicting rock properties from seismic data (Porosity, Vshale, Sw etc). An MLP
network is trained on a data set with known examples (supervised learning). In the
training phase the network aims to find the optimal, non-linear mapping between
input attributes and target attributes. The network in OpendTect is a fully-con-
nected, three-layer MLP (input layer, hidden layer, output layer). The non-linear
transformation takes place in the hidden layer.

MPSI
A plugin for stochastic acoustic impedance inversion. MPSI stands for Multi-Point
Stochastic Inversion.

N

Normal regression
Deposition characterized by aggradation and progradation. The base level is
rising but the consumption of accommodation space by sedimentation exceeds
the creation of accommodation space by the base level rise. Normal regression
occurs during high stand and low stand systems tracts.
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O

Open Source
Software that is released with its source code. OpendTect is released as open
source product that can be extended with closed source plugins. Such extensions
are only permitted if OpendTect is run under a commercial (or academic) license
agreement.

P

PDF
PDF is Probability Density Functions. In OpendTect these are created in the
cross-plot tool by selecting a desired area in the cross-plot domain. The density of
the points in the selected area is a measure for the probability of the desired target
variable that can then be predicted by applying the derived PDF function to
(scaled) input volumes in a Bayesian classification scheme.

pointset
A pointset is a collection of picked locations, i.e. inline-crossline-Z information.
pointsets are part of a pointset Group. For example a pointset Group containing
points at fault locations may consist of different fault pointsets to differentiate
between large faults and small faults, or to reflect points on different inlines.

pointset Group
A pointset group is a collection of different pointsets. Usually pointsets are
grouped because they refer to the same object, e.g. Chimney_yes or Chimney_
no.

R

Regression
Seaward shoreline and facies shift. Regression can be Normal (base level rises)
or Forced (base level falls).

Relative Impedance
Band-limited impedance inversion response computed by methods such as
colored inversion.

Relative sea-level
The net effect of eustatic sea level changes and local tectonic fluctuations.
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Retrogradation
Depositional trend characterized by sediments building landwards aka back-step-
ping.

S

SEG-Y
A file format for exchanging seismic or seismic-like data. It is used for both 2D and
3D pre- or poststack data. A file being SEG-Y compliant does not mean that it can
be loaded into OpendTect. There are several possible problems. One of these is
missing trace identification and/or positioning. Another issue is lack of true com-
pliance ->SEG-Y Rev 0, -> SEG-Y Rev 1). The different types of SEG-Y are
shown below: * SEG-Y Rev 0: The initial SEG-Y specification in 1975. It is very pre-
cise in some areas but totally unspecified in other, crucial areas. This has led to an
almost uncountable number of variants. Some are sort-of SEG-Y standard, others
blatantly non-compliant. * SEG-Y Rev 1: In 2002 the Revision 1 document made
an end to the most obvious shortcomings of ->SEG-Y Rev 0, especially in the area
of ->trace positioning and ->trace identification. Still many SEG-Y files or files
claimed to be SEG-Y are Rev 0 or badly (i.e. not) compliant with Rev 1. This is
why OpendTect has numerous options for the SEG-Y reading process. * SEG-Y
Textual header: The first 3200 bytes of a SEG-Y file must be filled with textual com-
ment on the contents of the SEG-Y file. Older textual headers are encoded in
EBCDIC rather than ASCII, which makes them impossible to read in a standard
text editor. * SEG-Y EBCDIC header: -> SEG-Y Textual header. * SEG-Y Tape
Header: The part of a SEG-Y file that gives information about all traces in the file.
This information is in the ->SEG-Y Textual header and ->SEG-Y Binary header. *
SEG-Y Binary header: The second part of the SEG-Y Tape header contains bin-
ary information about, amongst others, values for number of samples per trace,
byte encoding, sample interval, and SEG-Y Revision. * Trace identification: Every
trace in OpendTect needs to have an identification in form of a trace number (2D
data) or inline/crossline (3D data). For prestack data the offset forms and extra
trace identification. * Trace positioning: In OpendTect, every seismic trace needs
to be located in 3D space. For 3D data, the position can be derived from the-
>Trace identification (inline- and crossline numbers). Traces in 2D lines have their
own, separate X- and Y- coordinate. For prestack data there must also be an off-
set available.

SSIS
A plugin to perform a sequence stratigaphic analysis (systems tracts, Wheeler
transforms) from seismic data using HorizonCube input. SSIS stands for
Sequence Stratigraphic Interpretation System.
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Stratal Slicing
The process of cutting through a seismic volume along surfaces that are com-
puted proportionally between mapped top and bottom horizons, aka proportional
slicing.

Systems Tracts
Subdivisions of sequences that consist of discrete depositional units that differ in
geometry from other systems tracts and have distinct boundaries on seismic data.
Different systems tracts are considered to represent different phases of baselevel
changes.

T

Trace Identification
Every trace in OpendTect needs to have an identification in form of a trace num-
ber (2D data) or inline/crossline (3D data). For prestack data the offset forms and
extra trace identification.

Trace Positioning
In OpendTect, every seismic trace needs to be located in 3D space. For 3D data,
the position can be derived from the->Trace identification (inline- and crossline
numbers). Traces in 2D lines have their own, separate X- and Y- coordinate. For
prestack data there must also be an offset available.

Transgression
Landward shoreline and facies shift characterized by aggradation and ret-
rogradation. The base-level is rising and more accommodation space is created
than is consumed by sedimentation

Tree
The tree is the docking window, which is detachable and movable. This is used to
display the data into a scene. The tree is attached to a scene and is labeled as
Tree Scene 1. Where '1' is the scene number. Each tree has its own elements that
are displayed in corresponding scene.

U

UVQ Neural Network
Unsupervised Vector Quantizer type of neural network. This network is used for
clustering (segmenting) data into a user-defined number of clusters. Cluster cen-
ters are found in a training run on a subset of the data. In the application phase the
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network generates two outputs: 1) the index number of the winning cluster and 2)
the match, a value between 0 and 1 indicating how close the input vector is to the
vector representing the winning cluster. UVQ segmentation can be performed in
2D mode (waveform segmentation along mapped horizons) and in 3D mode (gen-
erates 3D bodies). A display of the cluster centers is a useful diagnostic in wave-
form segmentation (Neural Network module: Info button).

V

VMB
A plugin for picking velocities from semblance gathers, and in a surface-con-
sistent-manner. VMB stands for Velocity Model Building.

W

Waveform Segmentation
Process of clustering seismic trace segments with a UVQ network along a
mapped horizon into a user-defined number of clusters.

WCP
A plugin to pick and QC well log markers with the help of seismic data and (option-
ally) the HorizonCube. WCP stands for Well Correlation Panel.

Wheeler Transform
Process of flattening seismic data (or attributes) according to the chrono-strati-
graphic horizons in a HorizonCube. In a Wheeler scene the vertical axis represent
relative geologic time.
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